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Course Details

Instructor Contact Information

Douglas F. Robertson

Professor, Developmental Mathematics and Computing
Department of Curriculum and Instruction

College of Education and Human Development
University of Minnesota

Office: 270D Peik Hall, 612-625-1075
Postal Mail: 125 Peik Hall, 159 Pillsbury Drive SE, Minneapolis, MN 55455-0208

Email: droberts@umn.edu
Web Site: http://www.z.umn.edu/robertson

Prerequisites

You should have some familiarity with Microsoft Windows, which is the operating
system! most PCs run on. The textbook and this Study Guide are written for
Microsoft Windows 10. Globally, there are about 74% Windows users compared to
about 16% Macintosh users.

Mac: Even though the course is written for the Windows versions of the apps, it is
possible to do the course on a Macintosh computer, but it will be more
difficult. For the most part, Macs and PCs can do the same things, but the
interfaces, menus, and keyboard shortcuts often are different. For example,
the 38 (Command) key on the Mac usually does the same thing as the
Ctrl (Control) key in Windows. So, for example, Ctrl + s will save a file 2 in
Windows; this corresponds to Command + s on the Mac. If the directions say
to use the Ctrl key, try that on the Mac. If it does not work, try the Command
key. The textbook and this Study Guide have tips for Mac users to help you
get through some of the rough spots, but some places will be a challenge. If it
becomes too frustrating, you can do the work in one of the public computer
labs on campus. For locations, see
https://it.umn.edu/services-technologies/computer-labs

If you have never used Windows, you will find it useful to read the first hundred or so
pages in the textbook. These pages contain basic information on Windows that will
make the rest of the course go more smoothly for you. You do not have to do the
activities on those pages.

Computer Access

You may use any Windows or Macintosh computer that has the 2019 version of
Microsoft Excel, Word, and PowerPoint. Or, you may use the apps contained in
Office 365, which you may get free through the U. See the syllabus for detalils.
Browser versions of the apps generally do not have all the features you will need to
complete the assignments so do NOT use those.

1 An operating system, like Windows 10 or Mac OS, is a program that manages other programs, like
Microsoft Word. A program (AKA application or simply app) is a set of instructions that accomplishes
specific tasks.

2 A computer file is electronic information, such as a Word document, an Excel workbook, or a
photo, that is stored and organized in a container known as a folder.

— SG1 —


http://www.z.umn.edu/robertson
https://it.umn.edu/services-technologies/computer-labs

SG?2 COURSE DETAILS

Honesty

You may get help and work with others on the projects, but you must submit your
own work. That is, someone can help you figure out what to do but you must, in the
end, do it yourself. Copying the work of someone else is academic misconduct and
may result in your receiving a grade of 0 on a project or failing the entire course.

Credits and Workload Expectations

For undergraduate courses, one credit is defined as equivalent to an average of three
hours of learning effort per week necessary for an average student to achieve an
average grade in the course. Because this is a four-credit course, you should expect
to spend 3 x 4 = 12 hours per week working on projects and studying for exams.

Course Grade

The course grade will be determined by your scores on 12 required homework
projects and three exams. You may earn extra credit on your homework score by
submitting Project 6 Excel practice exam questions OR Projects 14 and 15, which
cover Access, a database app (not available on the Mac). These are extra credit
and so submission is NOT required. If you do them, your scores will be added to
your homework total when final grades are calculated. Thus, it is possible to earn up
to 110% on homework projects.

The letter grades will be determined according to the following chart.

Letter Grade Points Needed Definition
A =4.00 100 - 96 Represents achievement that is outstanding
B relative to the level necessary to meet course

A- =3.67 95-90 requirements

B+ =3.33 89 - 86 Represents achievement that is significantly

B =3.00 85 -—82 above the level necessary to meet course

B- =267 81 —80 requirements

C+ =233 79-76 _

c ~ 200 75 _ 73 Represents _achlevement that meets the
course requirements in every respect

C- =1.67 72-70

D+ =1.33 69 — 68 Represents achievement that is worthy of

B credit even though it fails to meet fully the

D =1.00 6765 course requirements

S none 100 — 73 _Repl_resent_s achievement that is satisfactory,
i.e., is equivalent to a 2.00

= ~00 under 65 Repr_esents a failure to meet course
requirements

N ~00 under 73 Repr_esents a failure to meet course
requirements
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| will email you a four-character HWID (HomeWork IDentification number) that I will
use to keep track of your homework and exam scores. It will have three digits and a
letter, such as 100A. Be sure to include that on all submissions and any emails you
send me.

Student Learning Outcomes (SLOs)

Cl 1871 addresses the following SLOs:

1. Identify, define, and solve problems You will gain experience identifying,
defining, and solving problems by creating mathematical models that will help
you make predictions to see how a situation will evolve over time. For example,
in Project 5 you will use Excel to find out how much a person would need to sell
in order to make a certain level of income. The assessment will be based on the
computer output you produce.

3. Master a body of knowledge and a mode of inquiry You will increase your
technological knowledge base, especially in the area of data analysis, and you will
gain insights into how computers can be used to collect, analyze, display, and
present data and information. For example, in Project 5 you will use Excel to
calculate and summarize sales commissions for employees. The assessment will be
based on the computer output you produce and also your performance on exams.

5. Communicate effectively You will use word processing, spreadsheet, and
presentation software to communicate ideas, data, and charts from a wide variety
of disciplines including business, economics, and social science. For example, in
Project 13 you will create a presentation that includes text, tables, charts, audio,
animation, and video to inform people about the benefits of computer-mediated
instruction. In Project 10 you will modify a thirty-five page book chapter by
including a Table of Contents, charts, cross references, mathematical equations,
styles, and an index.

7. Effective citizenship and life-long learning The skills, concepts, and
knowledge you acquire in this course will help you to be an effective citizen in
that you will be better able to understand how yourself and others can use
computers to help store and retrieve data, make decisions, predict future events,
and communicate with others.






Introduction

In this course, you will learn concepts and develop competencies in the computer
technologies that are most often used in the social sciences and in business to help
solve problems.

i o
Textbook @'

. : : : : m’»@o“
Gaskin, Vargas, Geoghan & Graviett. GO! with Microsoft Office <
365, 2019 Edition Introductory. New York: Prentice Hall, 2020. .‘*x

= e
The course is set up to use Inclusive Access, which is a ©

textbook model that uses an eText rather than a print text. On the bookstore
website, the textbook title will appear as (Inclusive Access) Go! With Microsoft
Office 365 2019 Edition, Author: Gaskin, ISBN: 9780135417881 You will receive
access to this digital course material through Canvas 2 on the first day of class by
clicking Modules in its menu. Then, click the textbook link. The Inclusive Access
charge will be automatically billed to your account. Coffman Union Bookstore (612-
625-6000, http://www.bookstore.umn.edu/) will notify you about the fees, and how
and when they will be billed to your student account.

If you want to use a print copy of the textbook, you may opt out of Inclusive Access
via the link provided to you, or by emailing inclusiveaccess@umn.edu with your
course information and requesting to opt out. At your request, the Bookstore will
issue a refund to your student account. Opt-outs are only accepted within the first
seven days of the semester. If you opt out, you may rent or buy the printed version of
the textbook from the bookstore or Amazon.com (search for ISBN 9780135417812).

The print text and eText have the same basic content. So, which should you get?

Print Text
A traditional softcover textbook.

Have to page through the text or use
the Index to find things.

Can use the Glossary to find the
definitions of words.

More expensive.

eText
Can use online or offline.

Can electronically search for specific
pages, words, or phrases.

Pointing to highlighted words opens a
box that contains the definition.

Is cheaper than renting a print text.

Have to continually switch between the
eText screen and the app screen you
are working on (e.g., Excel). This will be
very annoying and time-consuming if
you have only one monitor.

No need to switch between screens.
This will be useful if you have only one
screen (e.g., a laptop without an
external monitor). Easy to make hand-
written notes in the margins.

The front material of the text contains all sorts of information about the book and the
specific features it contains to help you learn. Feel free to page through this material
but reading it in detail will not be all that useful.

3 Canvas is a cloud-based system that manages digital learning tools and resources. For more
information see https://it.umn.edu/services-technologies/canvas
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In the textbook, the authors use the word press when they want you to tap one of
the keys. So, when you see “press Enter” don’t hold down the key but quickly tap it.
If you hold down the key it will be like hitting the key multiple times.

In the textbook and in this Study Guide, when you are to hold down one key and
then tap another, the two keys will be shown connected with the + sign. For
example, “Press Ctrl + s to save the document.” Ctrl + s tells you to hold down the
Ctrl key and, while holding down that key, tap the s key. The first key, Ctrl, is called
a modifier key because it modifies the action of the second key. The +in Ctrl + s is
there to tell you to hold down the first key while you tap the second key; you do NOT
touch the + key on the keyboard.

To save time, when the textbook instructs you to print something DO NOT PRINT IT.
When you complete all the work for a chapter, return to this Study Guide to find out
exactly what output to create and submit for grading.

At the very back of the textbook, page G-1, you will find a Glossary that you can use
to look up the definitions of many words that have particular meanings when used in
relation to computing.

G-1

Glossary

3-D
The shortened term for three-dimensional, which refers to an image that appears to have all three spatial

dimensions—length, width, and depth.

In the print text, the Index is located right after the Glossary. You can use the Index
to find places in the textbook that contain instruction on specific topics. If you forget
how to do something, look it up in the Index. The eText does not contain an index
because you can use the search feature to find key words.

Companion Web Site for Cl 1871

In addition to a Canvas site, where you will submit homework projects and exams,
this course has a website where you will find links that will allow you to download
the files you will need, the syllabus, this Study Guide, and exam instructions. The
URL (Uniform Resource Locator) is http://www.z.umn.edu/robertson

Study Guide

This Study Guide has four components.
Introductory material: You are reading that part right now.

Projects: There are 12 required projects for you to complete, each of which contains
several parts. The projects tell you what to read in the textbook and which hands-
on activities to complete. The projects also contain additional instruction on how to
do some things that are not covered in the textbook but which | think are important.
The projects contain the details of what to submit for grading.
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Project keys: Starting on page SG399 of this Study Guide # is a section that contains
the keys for the projects. As you complete each assignment, look at the key to see
if your computer output matches the one in the key. If so, great. If not, figure out
what you did wrong and fix it. Note that since all computers and printers are set up
differently, some of your output may not look exactly like the output shown. This is
especially true for line breaks, which are the points where the text on one line stops
and continues on the next line, and page breaks, which are the points where the
text on one page stops and continues on the next page. Don’t worry about this.
When we grade the assignments, we look to see if you have correctly followed the
directions. In most cases, your output and the key will match.

Sample Exam Questions and Solutions: At the end of the sections on Excel,
Word, and PowerPoint, you will find practice questions that are similar to the ones
that will appear on the exams. The worked-out solutions are included after the
guestions and the keys are in the Keys section at the back of this Study Guide.

The Five Steps of Each Project
To learn the material in the most efficient way, follow the steps given below:
Step 1 Read

Before trying any activities, read the introductory material that is located at the
beginning of each textbook chapter. This will help you get the overall picture of
what you are going to do when you work on the computer. This will only take a
minute or two, but it is time well spent.

Step 2 Activities

The hands-on step-by-step exercises in the textbook are called Activities.
Carefully read and follow the directions for each activity, and read and understand
the explanations. Don't just punch the keys! Note that if the resolution of your
display is not 1280 x 768 things may look a bit different from the screenshots in
the textbook or this Study Guide. Don’t worry if you need to make minor
adjustments, especially to spacing, when working on your own computer.

It is important that you do every step, except for printing, of every activity
assigned. You will need some of the workbooks, documents, and presentations
you create for later homework projects. If you skip something you will eventually
have to go back and do it later, and this will be confusing.

4 Page numbers with SG in front of them refer to pages in this Study Guide.
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Step 3 Homework Projects

When you finish all the assigned textbook activities for a chapter, return to this
Study Guide and begin work on the homework. The problems are designed to get
you to think about what you have learned in the chapter and to show that you
have mastered the concepts and skills described in the textbook and this Study
Guide. If you get stuck, refer back to those pages in the textbook that cover
relevant material. In the eText, you can search for specific words or phrases. In
the print text the Index at the end of the textbook will be a big help.

You may have to go back through a chapter to see how to do something if you did
not learn it well enough through your reading and doing the activities.

When you complete an assigned problem, compare your output with the key at
the end of this Study Guide and make changes as needed.

Rather than produce printed copy, you will save your output as pdf files and
submit those to Canvas. PDF (Portable Document Format) was developed in
1991 by Adobe Systems. It is designed to represent documents in a manner
independent of application software, hardware, and operating systems.

Step 4 Submit

When you complete all the assigned problems for a project, place the pdf files in a
folder, compress it (see page SG13) and submit it to Canvas for grading.

Step 5 Backup

It is good practice to backup your files every so often,
especially if they are stored on a USB drive (also known as
Thumb drive, Memory stick, and Flash drive) °. These can be
lost or broken. To backup, drag your Cl 1871 folder from one
device to the other, e.g., from your USB drive to your computer’s hard drive or to
Google Drive (a cloud storage facility described on page SG28).

The more important the file the more often you should back it up. For example, if
you are writing a paper saving drafts with different names every hour is a good
idea. Use names like SocPaper-1, SocPaper-2, SocPaper-3, etc. as you
progress. That way you can always go back to a previous draft if you need to.
When you have completed the paper, you can delete all drafts but the final one,
and then copy that one to another device as a backup.

5 USB stands for Universal Serial Bus. It is a specification to establish communication between
devices, such as a USB flash drive, mouse, keyboard, or printer and a host controller, usually a
personal computer. USB connectors also supply electric power, so many devices connected by
USB do not need a power source of their own.
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What If Something Doesn’t Work?

The textbook gives step-by-step instructions on how to do many spreadsheet, word
processing, and presentation operations. If you follow the directions as described
your results will be as shown. Sounds simple, doesn’t it? However, sometimes what
you think you are doing may not be what you are really doing. You can get into
trouble if you try to rush through the material or because you simply miss a step.

So, pay attention to what you are doing. If it doesn’t work, carefully read the
directions and try it again.

For computer operations problems, restarting the computer usually helps. For
Windows, restarting usually is better than shutting down. This is because when
Windows shuts down it may be set to save some temporary files so it starts up faster
from a cold boot. ® Those files may cause problems so restarting usually is better
than shutting down and then starting up again. But, both may help.

Schedule Your Time

For the textbook chapters, you should set aside a two- to four-hour block of time to
go through the activities and complete the reading (there are two guided textbook
projects for each chapter). Then, when you begin the homework projects, set aside
several more hours. The projects vary quite a bit in the time needed to complete
them so be prepared to be flexible. Don’t hesitate to go back to the textbook to redo
some of the activities—there is a lot to learn and sometimes you need to do it more
than once before it sinks in.

Now, let's get started with the coursework.

6 Booting a computer means turning it on (an old term from the expression “picking up oneself by
one’s bootstraps”). A cold boot means the computer starts from a power off state. A warm boot
(restart) means the startup process begins without turning off the power.






Project 1
Getting Started

Step 1 Read For this project, there are no pages to read in your textbook.
However, if you have never used Windows or any Microsoft Office apps (e.g.,
Excel, Word, PowerPoint) you will find it useful to work through the activities at
the beginning of the textbook. These activities contain basic information that
will make the rest of the course go more smoothly for you.

Step 2 Activities For this project, there are no textbook activities. To complete
this project, do the following:

Set Up Your Computer Filing System

To reduce the typing that you will need to do, the textbook authors and | have
created a set of files for you to get started on for most of the assignments. The files
are located on Google Drive. This is a cloud storage service that allows you to store
files online. Since the U of M is a Google campus, we all have access to unlimited
free storage. Google Drive has lots of features that you might find useful. You can
get more information at https://it.umn.edu/technology/google-drive?km

a. To download the files, follow the steps given below. Most of the screenshots
are from my computer running Windows 10. If you are using a different version,
or a Mac, things may look a bit different, but you should be able to follow the
instructions without too much difficulty.

1. On the desktop, right-click and select New and then Folder.

2. Right-click the folder and select Rename. Type CI 1871 as the new name
and then tap Enter.

3. Open a web browser such as FireFox % or Safari

4. Type the following in the address bar near the top of the screen

http://z.umn.edu/1871f22 7 This is a “shortened” URL that actually points to

https://drive.google.com/file/d/1txOSNb3XGWmY-40Ny-BL6XWADbOYnVGkV/view?usp=sharing

At the U, shortened URL's all have the same first part, z.umn.edu/, which is
easy to remember, and a unique second part, in this case 1871F22, which is
easy to remember within the context of this course. There is a short
introduction to this service, which anyone can use, at z.umn.edu/zhelp

7 HTTP stands for HyperText Transfer Protocol. It is an application-layer protocol for transmitting
hypermedia documents, such as HTML. It was developed in 1989 by Tim Berners-Lee at CERN to
facilitate communication between web browsers and web servers. HTTPS is an extension of
HTTP. It is used for Secure (encrypted) communication over a computer network.
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5. Tap Enter. Depending on your setup, you may have to sign into your U of M
account. Google Drive will open and show the file. If you get this message

Whoops!
There was a problem with the preview.

Retrying...

¥  Download

click Download. Otherwise, move the cursor to the icon in the upper right
and click the download arrow.

File Edit View History Bookmarks Tools Help
A C11871F220riginalFileszip - Go X +

&« C @ O B & nhitps//drivegoogle.com/file/d/TtxOSN .
D Buy O Financial (JFind (O Misc [ Weather EMyU Canvas ) Doug BAmz & Zoom EZ

Cl1871F220riginalFiles.zip Openwith

CI1871F22C0riginalFiles.zip 1item

Name

B C11871F220riginalFiles

6. Google Drive may give you a warning that the file is too large to scan for
viruses. In that case, click Download anyway. Depending on how your
browser is set up, the CI1871F220riginalFiles file may automatically go to
your computer’'s Downloads folder or you might get a message like this:

You have chosen to open:

B c118715220riginalFiles.zip

which is: Compressed (zipped) Folder (17.7 MB)
from: https://doc-00-0g-docs.googleusercontent.com

What should Firefox do with this file?

O Open with | Windows Explorer (default)

Save File

Do this automatically for files like this from now on.

If you get the above message, click the button next to Save File.

7. Click OK.
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8. Close your browser. On your Desktop or in your Downloads
folder, you should see the folder you just downloaded. Notice :
the zipper on the icon. To save time and space, the folderis |CI1871F220r
compressed in ZIP & format. If you do not see the zipper, your iginalFiles-1
system may be set up to automatically UNZIP folders.

If you do not see the folder on your desktop, check
your downloads folder by taping the Windows
key, typing downloads and clicking s T e s

Mac: Click the Spotlight icon, (the magnifying glass on the menu bar),
=) Tue 9:41 AM m Type downloads folder. Under Folders, click Downloads

b. If the folder has the zipper, UNZIP the folder by doing the following.
1. Point to the folder, right-click, and click Extract All.

Mac: Double-click the zipped folder to extract the files. Go to step 3.

The Extract dialog will appear. The box Select a Destination and Extract Files
shows the location where the folder will be
saved. Here is the location as it looks like
on my computer:

Files will be extracted to this folder:

‘ C:\Users\droberts\Desktop\CI1871F22OriginalFiles

C:\Users\droberts\Desktop\CI1871F220riginalFiles

C: represents the hard drive of my computer.
\ is a subdirectory delimiter (folder separator).
Users means my computer is set up for multiple users.
droberts is the part of the computer’s hard drive | am using.
Desktop means the folder will be put on my desktop.
CI1871F220riginalFiles is the name of the folder.

If the shown location is not what you want, click Browse and then navigate
to your preferred location.

2. Once you have the proper location displayed, click Extract. In a few
seconds you will see a new folder called CI1871F220riginalFiles. The new
folder contains folders for each section of the course (Excel, Word,
PowerPoint, and Access, which is extra credit). Each folder contains the
UNZIPPED files you will need. Notice that this folder has no zipper.

3. Open the folder and drag the four folders (Access Files — EXTRA CREDIT,
Excel Files, PowerPoint Files, and Word Files) to your Cl 1871 folder.

4. You will not need the ZIPPED folder or the CI1871F220riginalFiles folder
any more so drag them to the Recycle bin.

5. Close any open windows. If you will be using your own computer, you can
drag the CI 1871 folder to any location you wish.

8 ZIP is an archive file format that may contain one or more files or folders that have been
compressed. ZIP was created in 1989 by Phil Katz, who named it ZIP as in "move at high speed".
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c. Skip this part c and go to part d if you will not be storing your work on a
USB drive. If you are not working on your own computer, you should store your
files on a USB drive. To do so, insert it into one of the computer's USB ports. It
should go in easily. There is a right side up so if it does not fit one way turn it
over and try again, but gently.

To see the contents of your drive, click File Explorer on the

taskbar (or, hold down the Windows key [ and tap the letter e, which stands
for Explorer). Click your USB drive. It probably has a drive designator D: or E:

Mac: The USB drive will automatically appear on your desktop.

My screen looks like this:

€« v 4 <. > ROBERTSON (D) »
) Name
7 Quick access
Cl 1806
« Creative Cloud Files EDHD 1525W
@ OneDrive FSOS 1211

Non-School Stuff
W This PC

-~ ROBERTSON (D)

The name of my USB drive is ROBERTSON. Several drive designators may be shown:

. is for a floppy diskette drive (no longer used).

. is for a second floppy diskette drive (no longer used).

. is for the hard drive.

. is for the DVD/CD drive. My computer has none, so D: is for my USB drive.
is for a USB drive.

moow>

Click the Manage View tab and, in the Layout group, click Details.

ROBERTSON (I,

Manage

Home Share View Drive Tools

E [TH Preview pane &f Extra large icons B=/ Large icons

I

o == Mediumicons =55 Small icorfl
Navigation [Tl Details pane | £8: i =~ Details R
pane ~ e by~
Panes Layout
« v " <. > ROBERTSON (D;) v L P Search ROH
e
Name Date modified

3+ Quick access

C1 1806 6/27/2021 11:13 AM
o Creative Cloud Files EDHD 1525W 6/27/2021 11:13 AM
@ OneDrive FSOS 1211 6/27/2021 11:13 AM
Non-School Stuff 6/27/2021 11:13 AM

W This PC

~ - ROBERTSON (D)

Drag the CI 1871 folder to the USB drive window. This will copy the folder.
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d. When the textbook or this Study Guide asks you to save a file, save it to one of
the folders in the Cl 1871 folder. To see how this works, do the following (this is
part of your first homework project that you will submit for grading). Note that:

Word files are called documents

Excel files are called workbooks
PowerPoint files are called presentations
Access files are called databases

1.

w]

ILHF’:E

Word Shortcut

Start Word by doing one of the following:

Option 1 If your computer has a tiny Word icon on the taskbar, click it once.
Option 2 If your computer has a Word icon on the desktop, click it twice.
Option 3 Tap the Windows key E type word and select Word.

Mac: Click the Spotlight icon (the magnifying glass), type word, and tap Enter.

After Word starts, click Blank document.

Type the following: This file belongs to FirstName
LastName HWID, where HWID is the four-character
homework ID | emailed you. Use your own names. Blank document

Tap the Enter key. The usual default line spacing in Word is 1.08 inch. The
spacing on your computer may be different. It does not matter.

Type your U of M email address.

Tap the Enter key. Word may automatically underline the text, change its
color to blue, and attach a hyperlink to it. Word does this because it
recognizes the text as an email address and so applies its hyperlink style. If
this happens, leave it as is. You will learn about inserting hyperlinks on
page SG148 and more on page SG230.

S A i P R R R - I SR S, - -

This file belongs to FirstName LastName HWID spaCing may be diﬁerent
abcd1234@umn.edu on your computel".

Tap Ctrl + s (that is, hold down the Ctrl key and, while keeping that key
held down, tap the s key). This will open the Save As dialog box. This
allows you to specify where you want your file saved and what name you
would like to give it. You can also get here by tapping the F12 function key.

If you are using a laptop, you may notice a key labeled fn on the bottom
row of the keyboard. Because laptops have extra features, their keyboards
typically do not have room for all the keys that are needed. The fn key
allows the function keys to do double duty. For example, on my laptop,
tapping the F12 key increases the volume of the speaker. Holding down
the fn key while tapping the F12 key opens the Save As dialog box.

Mac: Shift + Command + s opens the Save As dialog box.
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8. On the left, click Browse and navigate to the desktop.

File name; | This file belongs to FirstName LastName HWID

Save as type: Word Document

Notice that Word is suggesting the first line of text in the file for the File name.
Click Save. The title bar shows the file name and that it was saved.

This file belongs to FirstName LastName HWID - Saved to this PC

Your computer may show the file name as This file belongs to HWID
FirstName LastName.docx The .docx is called a file name extension. It
tells the computer what app to use when opening the file. Depending on
how your computer is set up, it may or may not display the file name
extension (mine does not). Here are some common extensions:

.docx Word Xlsx Excel .pptx PowerPoint .accdb Access
.html Web page source text .mov QuickTime Audio/Video

.pdf Portable Document Format .rtf Rich Text Format

.wav Windows sound .zip Compressed Archive

.gif Graphic Interchange Format — for computer generated images with limited colors
Jpg Joint Photographic Experts Group — good for photographs

.png Portable Network Graphics — better than .gif for most purposes

tif Tagged Image File format — good for output from a digital camera

.mp4 — good for storing video and audio

Now, you are going to save the document using a different name.

10.

11.

12.

13.

14.

Tap the F12 key (Shift + Command + s on the Mac) or, click the File tab
and select Save As. This will open the Save As dialog box. This allows you
to save a copy of the file using a different name and/or in a different location.

Navigate to your Cl 1871 folder, double-click it, and double-click the Word
Files folder to open it. You will see a list of all the Word files in that folder.
If you do not see any files listed, check to see if the Save as type: box is

set to | 5ave as type: |Word Document

In the File name: box, delete the suggested file name and type:
HWO01-1 HWID Practice Save Done

where HWID is the four-character homework ID | emailed to you. If your
HWID were 100A, you would type this:

File name: | HW01-1 100A Practice Save Done | <G Type this.
Save as type: | Word Document h— Be sure the file type is this.

Click Save. The file will be saved in the Word Files folder with the name
HWO01-1 HWID Practice Save Done

Quit Word by clicking the X in the upper right corner of the window.

Mac: Click the Word menu and select Quit Word, or tap Command + q.
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Dictating Documents

If you have to type a large document and you are not a good typist, you lL]:J
might try Word'’s Dictate feature. You will need a microphone and Word Dictate
365 installed on your computer. The dictate icon is in the upper right -
corner of the Word window.

Voice

Click the icon and a red dot will appear in the icon showing you are being

recorded. As you speak, the words will be typed on your screen. The transcription is
good but not perfect so you will have to go back and do some editing. The process is
a bit slow and in fact a good typist can go faster than the word recognition, but you
might want to give this a try just to see how it works. Here's a web reference if you'd
like more information https://support.office.com/en-us/article/dictate-your-
documents-d4fd296e-8f15-4168-afec-1f95b13a6408

Finding Files

Windows has a powerful search engine that will help you find files without having to
sift through layers of folders. You can search for files with particular names,
contents, modification dates, and many other characteristics.

Mac: To search on a Mac, click the Spotlight icon, the little magnifying glass in the
right corner of the menu bar. A nice video on Mac searching is at
https://www.youtube.com/watch?v=pXIFPtBNt5g

a. To see how this works, read the following (you don’t have to actually do it). If you
try this yourself, your results will be different from mine because we are using
different computers that contain different files and folders. In the illustration that
follows, | searched my USB drive rather than my hard drive.

1. To open the USB drive, | clicked File Explorer on the taskbar
Tapping the Windows key + e also works (e for Explorer).

Then, I clicked my USB drive ROBERTSON (D:)


https://support.office.com/en-us/article/dictate-your-documents-d4fd296e-8f15-4168-afec-1f95b13a6408
https://support.office.com/en-us/article/dictate-your-documents-d4fd296e-8f15-4168-afec-1f95b13a6408
https://www.youtube.com/watch?v=pXIFPtBNt5g
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2. In the upper right corner of the window, | clicked inside the box that says
Search ROBERTSON (D:), typed excel, and tapped Enter. This searched
the USB drive for files and folders whose name contains the letters excel.
Capitalization of words does not matter so Excel or EXCEL will give the
same result as excel.

e el excel - Search Results in ROBERTSON (D)

File Home Share View Search e
. Current folder .T B Kind ~ & Recent searches ~ X
= All subfolders L] Size ™ |j Advanced options ~
This Date Open file Close
pc = Searchagainin~ .o 4ified~ _ Other properties ~ H Save search location  search
Location Refine Options
&~ v 4~ "l » Search Results in ROBERTSON (D) v | D 2 excel X
~
7 Quick access ki Excel Exam

Date modified: 6/27/2021 11:02 AM
& Creative Cloud Files

w  Excel Files
@ OneDrive ¥ [ modified: 6/27/2021 11:02 AM
= This PC E% HWO06-1a Excel Practice Questions Original Size: 183 KB
5 __ ROBERTSON (D) Date modified: 6/27/2021 11:02 AM Authors: Douglas Robertson
@ Network Ew HWO06-1b HWID Excel Practice Questions - ...  Size: 42.8 KB
Date modified: 6/27/2021 11:02 AM Authors: Douglas Robertson
v
8 itemsﬁ =
- I - . -
This found 8 items that have the word excel in their names (two folders
and six files).

To open a file or folder, double-click its name.
To open the location of the file, right-click its name and select Open file location.

A new tab called Search Tools Search appears. On the Search Tools
Search tab, in the Location group, be sure All subfolders is highlighted.
Under Advanced options, be sure the three choices are NOT checked.

(i e excel - Search Results in ROBERTSON (D

File Home Share View Search
. Current folder m— Bkind - € Recent sefprches ~
- B ~ "
o All subfolders __ Size~ =] Advance’ options ~
This Date _ e
pc = Searchagainin™ qodified~ _ Other properties = Changp indexed locations
Location Refine In non-i ed locations
& = v 4 W > Search Results in ROBERTSON (D) A2z s
System files
. Zipped (compressed) folders
2 Quick access L Excel Exam PP i
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3. Inthe Search Tools Search tab, in the Options group, click Advanced
options and check File contents. Now the search will include files that contain
the word excel (or Excel or EXCEL) in their names OR in their contents.

I v = Search Tools
Home Share View Search e
Current folder : B Kind ~ & Recent searches ~ X
= All subfolders _ Size ™ |*=] Advanced options ~ 1
This Date Openfile  Close
pc = Searchagainin™ | odifiad~ _ Other properties ~ H Save search location search
Location Refine Options
&« = ~ 1 » Search Results in ROBERTSON (D) v | D 2 excel X
~
7 Quick access ki Excel Exam
Date modified: 6/27/2021 11:02 AM
& Creative Cloud Files
. Excel Files
@ OneDrive B Lie modified: 6/27/2021 11:02 AM
' This PC HW08-1 Resume Extra Text Original Size: 13.5 KB
— ROBERTSON (D3) Authors: Douglas Robertson
& Network Size: 9.12 KB
Authors: Douglas F Robertson
v
36 items jtern selected ==

This returns 36 items. It lists folders and files that have excel in their
names and also files that contain excel somewhere inside them.

b. In searches, you can use Boolean operators ° such as AND, OR, and NOT. For
example, typing excel OR original shows all files that contain either word.
Typing exc OR ori lists the same files plus others that start with the letters exc
(e.g., exciting) or ori (e.g., origami). You must use UPPERCASE LETTERS for

the operators. Here, | got 77 hits.

(il excel OR original - Search Results in ROBERTSON (D:)

File Home Share View Search o
! Current folder .T B Kind - € Recent searches © ><
= All subfolders __ Size~ |*=] Advanced options ~ 1+
This Date Openfile  Close
pC % Searchagainin ™  odified~ ~ Other properties ~ H Save search location search
Location Refine Options
& = ~ /7 [l » Search Results in ROBERTSON (D:) » v (3] 2 excel OR original X
~
# Quick access k: Excel Exam

Date modified: 6/27/2021 11:02 AM

& Creative Cloud Files

. Excel Files
@ OneDrive B Dote modified: /2772021 1102 AM
> = This PC Eﬂ HWO07-3 Agenda Original Size: 12.5 KB
. ROBERTSON (D) Date modified: 6/27/2021 11:02 AM Authors: Douglas Robertson
@ Network £ HWO07-4 Brochures Logo Original
Size: 5.83 KB
v
77 items 1 item selected =

9

is considered one of the founders of the field of computer science.

Named after the 19t century English mathematician, philosopher, and logician George Boole, who
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c. You can search for items that were modified on specific dates. To show how this
works, | deleted the text that was in the search box and then, on the Search
Tools Search tab, in the Refine group, | clicked the Date modified arrow and
selected Today. Notice the search box says datemodified:today.

el datemodified:today - Search Results in ROBERTSON (D:)

File Home Share View Search e
! Current folder .T B Kind ~ 4 Recent searches ~ X
== All subfolders L] size = |*=] Advanced options ~
This Date Open file Close
pc = Searchagainin ™ | dified~ _ Other properties ~ g Save search location search
Location Refine Options
« v 4~ [ » Search Results in ROBERTSON (D) v | D 2 datemodified:today X
~
3 Quick access Cl1806

Date modified: 6/27/2021 11:13 AM
& Creative Cloud Files

EDHD 1525W
@ OneDrive Date modified: 6/27/2021 11:13 AM
= This PC FSOS 1211

_ ROBERTSON (D) Date modified: 6/27/2021 11:13 AM

Non-School Stuff
Date modified: 6/27/2021 11:13 AM

¥ Network

120 items RE —

Today is 27 June 2021. So far, | have modified 120 files and folders.

To find files or folders modified on a specific date, type the date (e.g., 7/28/18).

To find files or folders modified within a range of dates, type the dates with
two dots between them. For example, to find the names of files that were
modified between April and August 2016, inclusive, in the search box type
datemodified:4/1/16..8/31/16

Close all open windows. A nice YouTube video on advanced searching in
Windows is at https://www.youtube.com/watch?v=E37h8iyip|8

Keyboard Shortcuts in Windows 10

An extensive list of Windows 10 keyboard shortcuts can be found at:
https://support.microsoft.com/en-us/help/12445/windows-keyboard-shortcuts

Mac: See https://support.apple.com/en-us/HT201236 for a list of keyboard
shortcuts. You can also see shortcuts by going to the Apple menu, clicking
System Preferences, then Keyboard, then Shortcuts. Here, you can
change a keyboard shortcut to a different key combination if you wish.



https://www.youtube.com/watch?v=E37h8iyipl8
https://support.microsoft.com/en-us/help/12445/windows-keyboard-shortcuts
https://support.apple.com/en-us/HT201236

PROJECT 1: GETTING STARTED SG21

Below are some keyboard shortcuts that may save you time. The @ symbol refers
to the Windows Key, which is in the bottom row of the keyboard, second from the
left and also to the right of the Spacebar and Alt keys.

@ Open the Start Menu.

@ +d Minimize all windows and show the desktop. Tapping this again restores
all the minimized windows.

@) + e Open the File Explorer (to show drives C:, D:, E:, etc.).
Ctrl +y Redo the last action.
Esc Cancel the current task.

Ctrl + F1 Show or hide the Ribbon. When you open a Word, Excel, or PowerPoint
file, the top four lines of the window are called the Ribbon. If your
computer has a small screen you may want to hide this so you can see
more of your work. You can also do this by clicking the Ribbon Display
Options button in the upper right corner of the window.

Douglas F Robertson  DF

5 S Ribbon Display Options '

Mac: To show or hide the Ribbon, tap Option + Command +r.

Using symbols, this writenas "\ 38 r

Shutting Down the Computer

Before you shut down the computer or remove a USB drive, be sure to close all
open windows (don’t minimize them with this button [, but click the close box
close them). Otherwise, you may lose some of your work. -

If you are using a USB drive, to be doubly sure, right-click the name Format..
of the USB drive and click Eject. The message Safe To Remove Eject
Hardware will show in the lower right corner of the screen. Cut

Mac: To eject a USB drive, drag it to the Trash. This will NOT erase it but simply
unmount it from the operating system.

Pull out your USB drive. Don’t wiggle it, just pull it straight out.
You now can safely shut down the computer.

To sign out of a computer in a campus computer lab or classroom, tap the Windows
key, click your account icon and select Sign out.

If you are using a campus computer anything you save to the hard drive will be
deleted when the computer restarts so be sure to save all your work to a USB drive.
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Step 3 Homework Projects

Do the following four homework projects and submit them for grading. Each begins
with the statement of a Problem and then the activity guides you through the solution.

HW means || O
HomeWork || Pro

1 means 1 means
Ject 1/ Problem #1

HWO01-1 Practlce Save

Problem: How can you open and save Word documents, make videos, and take

screenshots?

a. Do the following:

1.
2.
3.

—3h

—The insertion point is the vertical line in the lower left corner. The | 1

Navigate to the Cl 1871 folder and double-click it.
Double-click the folder Word Files.

Double-click the file name HWO01-1 HWID Practice Save Done, which you
created while following the directions on page SG16 of this Study Guide.
This will open the file.

Move the insertion point to the end of the text in the document by pressing
Ctrl + End. On a laptop, you may have to hold down the Fn key as well as
the Ctrl key as you tap the End key. If neither work, use the Down Arrow
key on the keyboard. The insertion point should be just to the right of your
email address.

Tap Enter twice to insert a blank line.

So you can see where the Enter key was tapped, on the Home
tab, in the Paragraph group, click the show/hide button. | q

This-file-belongs-to-FirstName-LastName-HWIDY|
abcd1234@umn.edu-q

|

are where the Enter key was tapped.

Type | am using a XXX computer. Here, XXX is either Windows or
Macintosh.

Tap Enter and then type | am using the YYY textbook. Here YYY is
either Print or Electronic.

Tap Enter twice to insert a blank line.
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10. Type the following on separate lines but replace DATE and TIME with the
proper date and time each exam is to be submitted to Canvas:

1871 Excel exam is due on DATE at or before TIME.

1871 Word exam is due on DATE at or before TIME.

1871 PowerPoint exam is due on DATE at or before TIME.

Mark on your calendar the dates and times for each exam.
11. Tap Enter twice to insert a blank line.
12. Type Below is the screenshot of the name of the video | just made:
13. Tap Enter twice to insert a blank line.

14. Save the file but do not close it.

Both Windows and Mac have screen recording capabilities that come free with the
operating systems. Recording is useful if you want to create a tutorial for
someone, such as using an app like Excel, or to capture game play.

b-Win. The following directions are for Windows. If you are a Mac user, skip to
page SG25.

The Windows screen recording utility is called Xbox Game Bar. You do NOT
need Xbox to use this. The app comes free with Windows 10. Note that the
screen recorder cannot capture some programs, such as File Manager or the
entire Desktop. A nice YouTube tutorial on how to do screen recording in
Windows is at https://www.youtube.com/watch?v=mVJsm_000c0

To see how it works, do the following. Begin with your HW01-1 HWID Practice
Save Done open and the insertion point at the top of the file.

1. To open the Xbox Game Bar, tap Win + Alt + g T
(that is, hold down the Windows key E and the
Alt key and tap the g key). The Capture window
is the one you are interested in.

2. To start recording, tap Win + Alt + r or click the record button. In a couple
of seconds, you will see a small window showing the recording time:

3. Select the first line, This file belongs to..., and tap Ctrl + b to make it bold.

4. To see how the sound recording works, say something like
| just bolded the first line

5. Select the third and fourth lines of text. On the Home tab, in the A
Font group, click the font icon arrow and select red. Font



https://www.youtube.com/watch?v=mVJsm_000c0
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6. Stop the recording by tapping Win + Alt + r again or click the record button -

again. You should see a confirmation of success of the recording.

The recording is in your Videos folder. [=ScEL EREREL LD

7. Tap Win + e and under This PC, double-click your v = This PC
Videos folder. Then, double-click the Captures folder. , 3D Objects
@ > ThisPC > Videos > m Desktop
N 4 Documents
| Name 3 Downloads
[ Captures J Music
) ] ) = Pictures
There you will see the MP4 file you just created. [8vides ]
This PC » Videos > Captures v U O Search Captures
~  Name - Date Type Size Length
G HWO1-1 HWID Practice Save Done - Word 2021-06-29 12-19-14  6/29/2021 12:19 PM  MP4 File 23,284 KB 00:00:19

8. Right-click the file name, click Open with, and select Windows Media Player.

Open with > ﬁ Movies & TV
Give access to > B Photos
Restore previous versions & Windows Media Player

The video should start automatically. If not, click the Play button. o

When the video stops, close the Media Player window by clicking the X in
the upper right corner of its window, or by tapping Alt + F4 (that is the F4
key, not the letter f and the numeral 4).

c-Win. Take a screenshot of the properties of the MP4 video file in the Captures folder
and paste it into your HW01-1 HWID Practice Save Done file by doing the following:

1. With the Captures folder open, right-click the MP4 file name and select Properties.

2. Tap the Windows key El and type snip. Windows will list files on your computer
that contain the word snip. Windows puts the names of apps at the top of the list.

, . ER—
3. Click Snipping Tool to open the app. A;l:)ppmg 00
= Snipping Tool _ %
C¢New [ Mode ~ (2 Delay ~ X * Options

Select the snip mode using the Mode button or click the New IZIEIZ-
button.
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4.

10.

11.

12.

Click Options and be sure Always copy snips <R Snipping Tool
to the Clipboard is checked.

A2 N Mode -
Click OK. e New [ Mode

. . Free-form Snip
Click Mode and select Rectangular Snip. The
screen will look washed out and a white cross
will appear.

®  Rectangular Snip

Window Snip

Drag the white cross around the Properties dialog box. When you let up
the mouse button a picture will be placed on the clipboard and a sample of
what you have captured will be shown.

Close the Snipping Tool by clicking the X in the upper right corner of its
window. If asked to save changes, click No.

Move the cursor to the bottom of your HWO01-1 HWID Practice Save Done
window, tap Enter, and then tap Ctrl + v to paste the screenshot.

Double-click the image. On the Picture Format tab,

in the Picture Styles group, click Picture Border. Z ~

On the Picture Format tab, in the Size group, type 3 in the
width box. [z :

Save the file and close all windows.

If you are a Windows user, skip the next two sections, b-Mac and c-Mac and
continue your work on section d on page SG26.

d-Mac. The following directions are for Mac users.

The Mac screen recording utility is done through the QuickTime app.
A nice YouTube tutorial on how to do screen recording on the Mac is at
https://www.youtube.com/watch?v=RttodbaTXGA

To see how it works, do the following. Begin with your HW01-1 HWID Practice
Save Done open and the insertion point at the top of the file.

1.

Click the Spotlight icon (little magnifying glass on menu bar), type
QuickTime, and tap Enter.

From the File menu, click New Screen Recording.

At the bottom of the screen, click the Options arrow and be sure Save to is
set to QuickTime Player, Timer is set to None, and Microphone is set to
Built-in Microphone.

Click the Options menu once more to close it and then click Record.

Select the first line, This file belongs to..., and tap Command + b to
make it bold.

To see how the sound recording works, say something like
| just bolded the first line



https://www.youtube.com/watch?v=RttodbaTXGA
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7. Select the third and fourth lines of text. On the Home tab, in the A o
Font group, click the font icon arrow and select red.

Font

8. To stop the recording, on the Menu bar, click the stop button E]
9. Quit the QuickTime player. The file with the video should be e

Screen
on your Desktop.

10. Right-click the file name, click Open with, select QuickTime, and click the
Play button. When the video stops, quit QuickTime.

e-Mac. Take a screenshot of the properties of the video file and paste the screenshot
into your HWO01-1 HWID Practice Save Done file by doing the following:

1. Right-click the video’s icon and select Get Info.
2. Tap Shift + Ctrl + Command + 4. A black cross will appear.

3. Drag the black cross over the screen recording info window from the top to
just above Comments.

4. Move the cursor to the bottom of your HW01-1 HWID Practice Save Done
window, tap Enter, and then tap Command + v to paste the screenshot.

5. Double-click the image and, on the Picture Format tab, in the Picture
Styles group, click Picture Border. |z .

6. On the Picture Format tab, in the Size group,
type 3 in the width box. [z =

w

7. Save the file and close all windows.

f. For this course, you will submit to Canvas electronic copies of your files.
However, for other purposes you may want to print your documents on
paper. To be sure you know how to do this, make a hard copy of HW01-1
HWID Practice Save Done by doing the following:

1. Tap Ctrl + p to display the Print dialog box.

Print

o | e

This file belongs to FirstName LastName HWID

abcd1234@umn.edu
Printer

Hewlett-Packard HP Laser...
!:r*_’“ Ready i

| am using a XXX computer.
| am using the YYY textbook.
Printer Properties

1871 Excel exam is due on DATE at or before TIME.

1871 Word exam is due on DATE at or before TIME.

Settings
’7 Print All Pages .
D The whole thing

1871 PowerPoint exam is due on DATE at or before TIME.

Below is a screenshot of the video | made:
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2. Compare the preview with the key on page SG399 of this Study Guide.
If you need to make corrections, tap the Esc key (upper left corner of
the keyboard) to get back to edit mode and then make your changes.
Don’t print at this time. Tap the Esc key to cancel printing.

g. Do the following to locate the folder where HWO01-1 HWID Practice Save Done
is saved. This is useful when you are working with several files and drives.

Mac: On the menu bar, click File, click Properties, and then click the General tab.
To the right of the word Location you will see the path of the file location. If
you want to open that folder, copy the path, click the Finder icon (smiley face
at the bottom of the screen), click Go from the menu bar, and select Go to
Folder. Paste the location in the box and click Go. Skip to step 2 below.

1. Click the File tab to open Backstage view. On the left, click Info. This
provides information about the file. Y R——

In the lower right corner, click Open File Location. |=_—|open File Location
This opens the folder that contains the file.

[ | Word Files

File Home Share View
Cut B New item ~
» - X 'I ; v
W..| Copy path T | Easy access ~
Pinto Quick Copy  Paste Move  Copy Delete Rename New Prope
access #| Paste shortcut to~ to~ - folder -
Clipboard Organize New
&« v A » ROBERTSON (D) » ClI1871 » Word Files
Name Date modified
7 Quick access
Word Exam 1/1/2021 10:38 AM
© Creative Cloud Files @ HWO1-1 HWID Practice Save Done 12/31/2020 1:53 PM

Check to be sure your file is in the correct place it (should be in the Word
Files folder).

2. Close the folder you just opened.

3. Tap the Esc key to close Backstage view and return to normal view.

h. Save HWO01-1 HWID Practice Save Done, quit Word, and close all windows.
Rather than paper copy, you are going to submit your output to Canvas for
grading. Instructions showing how to do this are on page SG33. Don'’t do it now.
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HWO01-2 Saving Files to Google Drive

Problem: How can you save files so they can be accessed from any computer that

has an internet connection?

When you set up your computer filing system on page SG11 you accessed files that
| had put on Google Drive. In this project, you will experience uploading your own
file to Google Drive.

a. Create a new Word document by doing the following:
1.

Start Word and open a new blank document.

Tap Enter.

2. Type HWO01-2 HWID, where HWID is your four-character homework ID.
3.
4

. Tap Ctrl + s, navigate to your Word Files folder, and save the document

using the name HWO01-2 HWID Google Drive Done. Do NOT close Word.

b. You can access Google Drive by typing google.com/drive in the address bar
of your internet browser or by selecting Google Drive from the Google apps

button if your U of M email is open. Do the following:
1.
2.

Start a web browser, type mail.umn.edu in the address bar, and tap Enter.

Type your Internet ID (the characters in your U of M email address to the
left of the @ symbol), type your email password, and click Sign In.

Click the Google apps button,

(the nine tiny squares in the upper right

> 0 M @

corner of the window), and click Drive.

At the left of the window, click I‘ T

and then click File upload.

e MYe

Account Gmail Drive
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5. Navigate to your file HW01-1 HWID Practice Save Done and double-click.
In a few seconds, you will see the confirmation 1 upload complete message.

1 upload complete

m HWO01-1 HWID Practice Save Done.docx o

Under My Drive, you will see the file name.

File Edit View History Bookmarks Tools Help

DAL ST VUl £ My Drive - Google Drive

G © @& https://drive.google.com/drive/my-drive
5 Buy 3 Financial B Find B3 Lib B Math £ Misc £ More [ Weather B U of M

L Drive Q

My Drive ~

l— New

Priority

Name

[@ HWO1-1 HWID Practice Save Done.docx
» @ My Drive

6. In the upper right corner of the confirmation window, click the X to close the
1 upload complete window.

Now, you need to specify who can access your uploaded file.

7. Right-click the file name and select Get link.

Share with people and groups

No one has been added yet

© ocetiink

https://drive.google.com/file/d/1Ipuzck6lc4lvQ0IBgKemOyogLCpvfWsE/vie ... Copy link

—> o Restricted ~
=
* Only people added can open with this link

Send feedback to Google m

It will show one of the following under Get link:

= ¢ Restricted: If this is selected, you may choose who can access the file
by clicking under Share with people and groups and then entering the
email addresses of those with whom you would like to share the file.
Nobody else will be able to access the file.
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e University of Minnesota Twin Cities: If this is selected, only those at
the U of M Twin Cities campus with this link will be able to view the file.

e Anyone with the link: If this is selected, anyone on the internet who has
the link can view the file.

8. Click the down-arrow and choose Anyone with the link.

9. On the right, you will see one of the following:
e Viewer: People can see the contents and download it.
e Commenter: People can post comments on your document.

e Editor: People can edit your document.

To not allow others to change the file, be sure Viewer is selected.

Anyone with the link ~ .
y Viewer ~

Anyone on the internet with this link can view

10. Click Copy link. The link is now on the clipboard. You can send it to
anyone you want to be able to view your file.

c. Do the following to paste an image of the Google Drive Share window into
your HWO01-2 HWID Google Drive Done file.

1. Take a screenshot of the Google Drive Share window:

Share with people and groups

No one has been added yet

—
® Getlink

https://drive.google.com/file/d/1dcFpAjJlIHbB2400gbvhk.. Copy link

Anyone with the link ~
Anyone on the internet with this link can view

Viewer ~

Viewers of this file can see comments and suggestions.

2. Click Done in the Google Drive Share window to close it and then close
your web browser.

3. Switch to HW01-2 HWID Google Drive Done file and tap Ctrl + v to paste
the screenshot.

d. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save HWO01-2 HWID Google Drive Done, and close it.
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HWO01-3 PDF and Compressed Files

Problem: How can you send files to others so that they will be able to view them as
they would appear on your computer?

If you want someone to have access to one of your files you could put it up on
Google Drive or email it as an attachment. Emailing files to yourself or others may
require special handling. Email clients, like Gmail, usually have a size limitation. The
file size limit for Gmail is 25 megabytes which means that you can send up to 25 MB
in attachments. If you have more than one attachment, they can't add up to more
than 25 MB. If your file is greater than 25 MB, Gmail automatically adds a Google
Drive link in the email instead of including the file as an attachment.

Also, because different printers require different setup parameters, if you email a file
to someone the formatting on that person's computer may not look exactly like it did
on your computer. Or, that person may not have Word or Excel or PowerPoint and
so could not open the file. You can get around some of these limitations by saving
files in Portable Document Format (pdf). It is designed to represent documents in a
manner independent of application software, hardware, and operating systems. Let's
see how this works.

a. Convert a Word file to a pdf file by doing the following:

1. Navigate to your Word Files folder and open the document HW10-1
Character Styles and Declaration Original, which is one of the files you
downloaded at the start of the term. You will use this file again in Project 10.

2. Tap the F12 key (Shift + Command + s on the Mac) to open the Save As
dialog box. Remember, on a laptop, you may have to use the fn key also.

In the File name box type HW01-3 HWID-a Pdf Done

Just below this, on the right, click the Save as type arrow (File Format on
the Mac) and select PDF.

File name: \ HWO1-4 HWID-a Pdf Done

Save as type: |PDF

3. Click Save (Export on the Mac). An accurate copy of this file now can be
opened by any computer with the aid of Adobe Acrobat Reader, an app
that is available free from http://get.adobe.com/reader/?promoid=JZEFU

4. If necessary, close the newly created pdf file. Also, close HW10-1
Character Styles and Declaration Original without saving changes to it.

b. Do the following to email to yourself (NOT me!) a compressed folder that
contains some files:

1. Navigate to the Word Files folder.

2. Click ONCE the icon just to the left of file name m -
HWO01-1 HWID Practice Save Done.


http://get.adobe.com/reader/?promoid=JZEFU
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3. Hold down the Ctrl key (Command key on the Mac) and click the icon for

HWO01-3 HWID-a Pdf Done.

Name

Word Exam
ﬁ @ HWO01-1 HWID Practice Save Done
@ HWO01-2 HWID Google Drive Done

— HWO01-3 HWID-a Pdf Done

At the bottom of the window, the status bar will show 2 items selected.

4. With the arrow pointing at the icon next to file HW01-3 HWID-a Pdf Done,
right-click, select Send to, and then select Compressed (zipped) folder.

Word Exam 4/29/2022 1:16
12/30/2021 9:54 AM
9/14/2020 9:17§AM |
8/7/2020 4:17 gV A
6/29/2020 12:3§ PM d
|
A
|
A

7/7/2020 10:57jAM

7/26/2020 2:324PM
& s | 772612020 3:29PM
@ 7/27/2020 7:058AM
@ Send to > € Bluetooth adyice
@ Cut i Compressed (zipped) folder

Mac: Right-click and select Compress.

A new zipped file is created. Its icon is a folder
with a zipper.

HWO01-3 HWID-a Pdf Done

HlHW01-3 HWID-a Pdf Done

5. Right-click the name on the zipped folder, select
HWO01-3 HWID-b ZIPPED Done, and tap Enter.

Rename, type

6. Open your email app and compose an email with the

message: Attached is the compressed file.

7. Type your own email address in the To box and
HWO1-3 in the Subject box.

To YOUR EMAIL ADDRESS|

HWO1-3

Attached is the compressed file.

8. If you are using Gmail, click the paperclip icon

0

near the bottom of the

window to attach the file to the email. If you are using a different email app
it will look a bit different. Navigate to your Word Files folder and double-

click HWO01-3 HWID-b ZIPPED Done. The file wi

Il be attached to the email.

HWO01-4 HWID-b ZIPPED Done.zip (113K)

9. Send the email to yourself (NOT to me).
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c. Do the following to create your homework file:
1. Start Word and open a new blank document.
2. Type HWO01-3 HWID (use your own HWID), and then tap Enter.
3. Open your email app and then open the email you just sent to yourself.
4

. Take a screenshot of the email. It should look something like this:

HWO1-3 nbox x

Douglas Robertson <droberts@umn.edu> & 1:12 PM (1 minute ago)
tome -

Attached is the compressed file.

B Hwo1-3 HWID-b ZI...

5. Click at the end of the new Word document and then tap Ctrl + v to paste
the screenshot into the document.

6. Place a black border around the screenshot (Picture Format, Picture
Styles, Picture Border).

d. Tap Ctrl + p and compare the preview with the key. Obviously, your screenshot
will be different from mine but that is fine. Make needed corrections and then
save the document using the name HW01-3 HWID-c Compressed Files Done,
close it, and exit Word.

Step 4 Submit Now you are ready to submit your first homework project for
grading. Rather than submitting paper copy, you will upload to Canvas a ZIPPED
folder that contains pdf versions of the following files:

HWO01-1 HWID Practice Save Done — Saved on page SG27
HWO01-2 HWID Google Drive Done — Saved on page SG30
HWO01-3 HWID-c Compressed Files Done — Saved on page SG33

Follow the steps below to submit your homework to Canvas:

a. Create a pdf version of HW01-1 HWID Practice Save Done by doing the following:
1. Open HWO01-1 HWID Practice Save Done.

2. Tap Ctrl + p to open the Print dialog box. Check the print preview to be
sure the output is what you want. If necessary, close the Print dialog box
and fix things.
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3. If necessary, tap Ctrl + p to open the Print
dialog box again. Click the arrow under =
Adobe PDF

Printer and select Adobe PDF. = e -
eady

4. Click Print.

Mac: In the lower left corner, click the PDF arrow and select Save as PDF.

5. Inthe File name box, enter HW01-1 HWID File name: | HW01-1 HWID Practice Save Done

Practice Save Done (use your HWID).

Save as type: PDF files (*.PDF)

6. Navigate to the Desktop and click Save.

7. Close HW01-1 HWID Practice Save Done.

HWO01-1 HWO01-2
HWID Prac... HWID Goo...

b. Repeat the process for the other two homework problems
for project HWO1 so that all three pdf files are on your
Desktop. The pdf file names should be:

HWO01-1 HWID Practice Save Done
HWO01-2 HWID Google Drive Done HWO1-3
HWO01-3 HWID-c Compressed Files Done AWIDSEC..

c. Do the following to create a ZIPPED folder that contains your pdf files:

1. On your desktop, right-click and select New, Folder. Name the folder
HWO01 HWID LastName, FirstName. For this example, | will use
HWO1 100A Smith, Joe.

Drag the three pdf files for HWO1 into this folder.
Right-click the folder, select Send to, and then Compressed (zipped) folder.

Mac: Click Compress “HW01 100A Smith, Joe”

A new zipped file will be created. Its icon is a folder with a zipper. mec-,mA
Smith, Joe

d. By the due date, upload this folder to Canvas by doing the following:

1. Open your Web Browser, type https://canvas.umn.edu/ in the address bar,
and tap Enter. You will be asked to log in using your U of M internet ID.

2. On the menu on the left, click Courses and click CI 1871 (00n) Computer
Literacy and Problem Solving (Fall 2021). In 00n, the n is your section
number (1, 2, 3, or 4).

3. Onthe menu on the left, click Assignments.

Dashboard @ i v Assignments
Assignments
.
= . . 0 assignme
Courses Discussions
Grades
it v Assignments
People *
Pages < . HWO01 Getting Started

Not available until Aug 27 at 12:00am | Due Sep 12 at 11:59pm | 30 pts

Cilac



https://canvas.umn.edu/
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4. Click HWO01 Getting Started.

HWO1 Getting Started Submit Assignment

Submitting a file upload

5. On the right, click Submit Assignment.

6. Click Browse, navigate to your ZIPPED HWO01 100A Smith, Joe folder,
and double-click it.

File Upload Google Drive

Upload afile, or choose a file you've already uploaded.

File: Browse... HWO1 100A Smith, Joe.zip

-+ Add Another File

Comments...

Cancel SubmitAssignment

7. Click Submit Assignment.

Submission

~ Submitted!

8. On the right, you will see a confirmation.
Submission Details
9. Close your browser. Download HWO01 100A Smith,

Joe.zip

Step 5 Backup Now would be a good time to backup your files. It will take only a
minute or two to copy your files from their current location to your computer’s hard
drive, or to another USB drive, or to upload them to Google Drive.






Project 2
Excel Chapter 1: Creating Worksheets and Charts
This is the first project from the textbook. Some students will be using the printed

textbook while others will be using the eText. Both versions have the same content
but look a bit different.

To access the eText, go to your Canvas page and click Modules. @? Quizzes

. . Hel
Then, click the textbook link. P Modules
£ Announcements
Dashboard @&
Assignments » VitalSource Bookshelf
Courses  Discussions i £ Gol With Microsoft Office 365, 2019Access-UMN Twin Cities

Then, click Load Go! With Microsoft Office...

Load Go! With Microsoft Office 365, 2019Access-UMN Twin Cities in a new window

To see or hide the Table of Contents, click the Menu icon = in the upper left corner.

Table of Contents

= @Ol1:==  GO! with Microsoft Office
& 365, 2019 Edition
W;;-,

-5 Introductory (Subscription)
K Shelley Gaskin; Alicia Vargas...

S

To adjust font, size, and margins, click the Reader Preferences button As
in the upper right corner.

To search for something, click the Search icon Q. in the upper right corner.

This allows you to search for text. For example, Search

if you type formula bar and tap Enter, you will

get 263 hits. formula bar Q

If you are using the print text, lookup formula bar |, . (263) Figures (0) Workbook (0]

in the Index at the back of the book.

Clicking one of the entries will take you to that spot in the text. For example, clicking

Formula Bar 318

will take you to page 318 where you will see:

Formula Bar (® Displays the value or [SIgME contained in the active cell;

— SG37 —
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When this Study Guide tells you to go to a specific page, type the
number in the box in the lower right corner of the window. For
example, to go to page 315, type it in the box and tap Enter.

< [#5 oo >

+z

1 Creating a Worksheet and Charting Data

Search * @

formula bar Q

Content (263) Figures (0) Workbook (0

Expand | Collapse
Formula Bar ~

Expand Formula Bar button
Expand Formula Bar button

Increases the height of the Formula Bar
to display lengthy cell content.

Increases the height of the Formula Bar
to display lengthy cell content

~ Objective 2 Enter Dataina
Worksheet

notice that when you begin to type in
a cell, on the Formula Bar, the Cancel

and Enter buttons become active,.

when you begin to type in a cell, on
the Formula Bar. the Cancel and Enter o

o 315 /976 >

by one page.
m— Click the menu icon E| to open or close the Table of Contents.

Click the left or right arrows next to the page numbers to move forward or backward

Click the X to the right of Search to close its window.
Now, let’s get started.

Step 1 Read Read the introductory material on page 315.

Step 2 Activities Click the arrow on the right to go to the next page, 316.

‘ 316 :‘;’976 >

Figure 1.1 is a picture of how your output will look after you finish the textbook
activities for Project 1A. This is not the final result for Project 1A that you will
submit because you will add to it by following the instructions in this Study Guide

starting on page SG40.

We will not use MyLab IT so SKIP Project Files for MyLab IT Grader.

=) Prolect Files for MyLab IT Grader

1. In your storage location, create a folder named Excel Chapter 1.

In the 2. In your MyLab IT course, locate and click Excel 1A Quarterly Sales, Download Materials, and then
Print Text Download All Files.
do NOT 3. Extract the zipped folder to your Excel Chapter 1 folder. Close the Grader download screens.

o~

do this.

| updates to the book.

. Take a moment to open the downloaded Excel_1A_Quarterly_Sales_Instructions; note any recent

‘Yi Project Files for MylLab IT Grader

In the
eText 1. Inyour storage location, create a folder named Excel Chapter 1.
do NOT 2. Inyour MyLab IT course, locate and click Excel 1A Quarterly Sales, Download Materials, and then Download All Files.
do this. 3. Extract the zipped folder to your Excel Chapter 1 folder. Close the Grader download screens.
4. Take a moment to open the downloaded Excel_1A_Quarterly_Sales_Instructions; note any recent updates to the book.
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Below this, you will see Project Results which has directions for those NOT
using MyLab IT. That is us.

s===: [ For Non-MyLab Submissions in your storage location, create a folder named Excel Chapter 1
‘ For Project 1A, you will need: P ri nt in your Excel Chapter 1 folder, save your workbook as:
=== { New blank Excel workbook Lastname_Firstname_1A_Quarterly_Sales
T ext If your instructor requires a workbook with formulas, saye as:
Lastname_Firstname_1A_Quarterly_Sales_formulas
After you have named gnd saved your warkbaok, on the next page begin with Step 2. 4

This lists the files you will need for Project 1A. For this first project,
you will need a New blank Excel workbook and nothing else.

Do NOT follow these directions.
Below, I will give you alternate directions.

You are not going to use sub folders (e.g., Excel Chapter 1).
Instead, so you can see them all at once, save all your Excel files
in the Excel Files folder you downloaded on page SG11.

If the resolution of your display is not 1280 x 768 things may look a bit different
from the screenshots in the textbook. Don’t worry, especially if you need to
increase or decrease the widths of cells to make things look right on your computer.

Keep this in mind:

Do NOT print when the textbook instructs you to print.

Do NOT do GO! With Google Sheets (pages 345-346).

When you have completed Project 1A, do Project 1B (pages 348-362).
Do NOT do GO! With Google Sheets (pages 363-364).

Do NOT do GO! To Work (page 365).

Project 1A: Start reading on page 317. Instead of step 1 of Activity 1.01

Activity 1.01: Starting Excel, Navigating Excel, and
Naming and Saving a Workbook

avigate to your Excel Chapter 1 folder, and then double-click the Excel file you downloaded from
MyLab IT that displays your name—Student_Excel 1A_Quarterly_Sales. In your blank workbook, if

necessary, at the top click Enable Editing.

do the following. —
: ]
1. Start Excel and click Blank workbook to opena | :
new blank workbook. 4

2. Tap the F12 key to open the Save As dialog box.

Blank workbook

Mac: Shift + Command + s. Or, you can click the File tab, and then Save As.

3. Navigate to your Excel Files folder.
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4. In the File name box, replace Book1 with
LastName_FirstName_ 1A Quarterly_Sales where LastName is YOUR
last name and FirstName is YOUR first name.

5. Click Save.
6. Complete the rest of the Activities for this Project through step 10 on page 344.

10.  In the upper right corner of your screen, click Close H to close Excel.

Do NOT do steps 11 and 12 in Activity 1.17 on page 344.

7. Return here when you have completed Project 1A on page 344.

Do NOT do GO! With Google Sheets.

Project 1B: When you have completed Project 1A, start at the top of page 348.

Instead of Activity 1.18 step 1 do the following:

1. Open a blank Excel workbook and save it to your Excel Files folder using
the name Lastname_Firstname_1B_Plyo Products

2. Complete the rest of the Activities for this Project EXCEPT do NOT do
steps 12 and 13 on page 362.

3. Return here when you have completed step 11 of Project 1B on page 361.

Do NOT do GO! With Google Sheets or GO! To Work.

Step 3 Homework After you have completed Projects A and B return here and
complete the following additional activities, which you will submit for grading. A list
of what to submit is on page SG52. The output keys begin on page SG400.

Mac: The menus at the top of your screen will be a big help in locating features and
will allow you to do many of the same things as the tabs on the Ribbon. m——

@ Excel File Edit View Insert Format Tools Data Window Help W = = Sat114PM Q=
Q ©
Home Insert Draw Page Layout Formulas Data Review View < Tellme ¥ Share [J Comments
& calibri (Body) e KK =, 9. [E Conduomalfomuing v L O &
EB - o @ Format as Table v
it £ w v v I
g B I U~ 28] Iy A Alignment Number ﬁ T O Cells Editing Ideas

Clipboard Font Styles Ideas Sensitivity

If you are in full screen mode, the top menus will not show unless you use
your mouse to point to the very top of the window.

If you want to display the group titles in the Ribbon, as in i Ribbon, Shous

the Windows version, click Excel, Preferences, View and, Developer tab
at the bottom, check Group Titles. Group Titles
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HWO02-1 Quarterly Sales (Based on Project 1A)

Problem: How can you organize, summarize, and change the way data and
formulas are displayed?

a. Open the workbook LastName_ FirstName 1A Quarterly Sales, which you
created while following the directions in the textbook and saved in step 3 on
page 342.

If necessary, switch to normal view: View tab, Workbook Views group, Normal.

If you see a bunch of hash symbols (also known as pound signs or number
signs), #####, it means the column is too narrow. To fix this, move the mouse
pointer so that it is between two column heading letters. It will change to a
double-headed arrow.

A B\§+D E

1 Pro Fit Marietta
2 Second Quarter Cardio Sales
3 April May | June Total

4 |Exercise Bi H#H#H  HHHHE  HEE S

Click and drag to the right to show the cell values.

b. Save the workbook in your Excel Files folder using the name
HWO02-1 HWID 1A Quarterly Sales Done, where HWID is the
four-character homework ID | emailed you.

c. Create a bar chart of the total sales by doing the following:

1. Select E4:E7.

3-D Bar
2. Onthe Insert tab, in the Charts group, click the Insert
Column or Bar Chart arrow and select 3-D Clustered % g
Bar. Notice that a column chart is vertical, like the
columns on a building, while a bar chart is horizontal.

3-D Clustered Bar

3. Onthe Chart Design tab, in the Location group, click Move Chart.

4. Click New sheet and type the new chart name Sales Bar Chart.

|_J M (® New sheet: | Sales Bar Chart

Click OK. This puts the chart on a separate chartsheet where only the chart
is shown (versus a worksheet where both a chart and data cells may be
shown). This will make it easier to work on.

5. To put names on the bars, on the Chart Design tab, in the Data group,
click Select Data to open its dialog box.

Horizontal (Category) Axis Labels

6. Under Horizontal (Category) Axis Labels click Edit. | I Edit ‘
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7. You could type the range for the labels but there is an easier way. Click the
collapse dialog button | # [then click the Sheetl tab and select A4:A7.

Click the collapse dialog button again.

A B C

D E

Pro Fit Manje

Second Quarter Cadio Sales

tta

April May ‘

June Tof

Exercise Bikes

Elliptical Machines
Treadmills

W00~ U s W N

-
Auxis Labels ? X
Axis label range:

_______________ | | =Sheet115A$4:5457 (2] - Exercise Bikes..

Total

This puts in the reference for you. It says to go

to Sheetl and select the

names in cells A4:A7. Excel puts a green dotted line around that range so
you can clearly see what you have selected. The $ indicate that these are
absolute references. Here, they are optional. Later, you will use absolute

references in some formulas.

8. Click OK. Now, the machine names show up u
the Horizontal (Category) Axis Labels.

9. Click OK.

Horizontal (Category) Axis Labels
l EZ Edit ]

Exercise Bikes

nder

Elliptical Machines

Treadmills

RERE

Rowing Machines

10. Click anywhere in the chart and a green cross

“|_ appears in the chart’s

upper right corner. This is one of the Chart Elements buttons. Click that

and put a check next to Data Labels.

Mac: There is no green cross. On the Chart Design tab, in the Chart |:|;h B
Layouts group (on the left), click the Add Chart Element arrow, o

select Data Labels, and select More Data Label

Format Data Labels pane does not automatically open, on the

Options. If the |Add Chart
Element

Format tab, in the Format group, click Format Pane. If you have a small

screen, you may have to click the double chevron
to the right of the Chart Design tab to see the
Format tab.

Chart Design rr

7 S

Chart Title

Chart Elements
Axes

[ Axis Titles
Chart Title

<IN

Rowing Machi —60,804.65
OWINg Viachines D D
r ata Table

Gridlines

This puts the values (labels) at the ends of the

bars.
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11.

On the Chart Format tab, in the Current Selection group
(on the left), click the Chart Elements arrow and select
Series 1 Data Labels. Just under that, click Format
Selection.

Series 1 Data Labels ~

d‘;ﬂ Format Selection
2] Reset to Match Style

Current Selection

Mac: There is no Format Selection choice.

This selects the data labels and opens the Format Data Labels pane.

Mac: Over on the right, click Format Pane to open the Format Data Labels pane.

12.
13.

14.
15.

16.

17.

18.

19.

You can also select the data labels by clicking one of them.

them would be selected.

In that case, all of

On the Home tab, in the Font group, select Arial Black and make the size 9.

On the Chart Format tab, in the Current Selection group,
click the arrow and select Vertical (Category) Axis.

Just under that, click Format Selection (not on the Mac).
Change the font to 9 pt Arial Black.

On the Chart Format tab, in the Current Selection group,

Vertical (Category) Axis ~
<y Format Selection
<|'2_—C| Reset to Match Style

Current Selection

click the Chart

Elements arrow and select Horizontal (Value) Axis. Just under that, click

Format Selection. Tap the Del key to remove this axis.

On the Chart Format tab, in the Current Selection group,

click the

Chart Elements arrow and select Chart Title. Just under that, click
Format Selection. Click inside the formula bar and type Total Sales for

Each Type of Machine.

X « fx | Total Sales for Each Type of Machine

Chart Title

Tap Enter. Make the font 12 pt Arial Black.

Click the bar for Rowing Machines once, wait a second, and click it again.

This will select that single bar. This is not a

“double-click” but a click, a pause, and then
another click. Double-clicking will select all the I ’
bars and open the Format Data Series pane Automatic
(nOt what you Want). Theme Colors

H EEEEN

Click the paint bucket and select blue.

Follow the same procedure to change the color of o I '1; EU;B;G;r;JrEH Darker 25%

= L7 -

the Treadmills bar to pink and the color of the
Elliptical Machines bar to green.

On the Chart Design tab, in the Location group, click Move Chart. Click the
button next to Object in, select Sheetl (if necessary), and click OK.
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20. Position the new bar chart under the column chart.

$40,000.00

$20,000.00

April lune

M Exercise Bikes W Elliptical Machines B Treadmills B Rowing Machines

Total Sales for Each Type of Machine

Rowing Machines [N 30,5065

21. Click one of the labels to select them all. Format Data Labels
The Format Data Labels pane will open. Label Options | Text Options

22. Click the Label Options button. DDD— O QO

> Label Options

23. Click the Number triangle.

4 Number

Label Options

Category

24. Click the Category arrow and select Currency.
25. Change the number of decimal places to 0. Dol [0 |

Symbol:

The $ should show under Symbol.

d. Change the bar shape and spacing between bars by doing the following:

1. With the bar chart selected, on the Chart Format tab, in the Current
Selection group, click the Chart Elements arrow and select Series 1.

Series 1 v

2. Click Format Selection
Series pane.

3. Click the Series Options icon m

4. Under Column shape, click Cylinder to change the shape of the bars from
rectangular pyramids to cylinders.

to open the Format Data

% Format Selection

Mac: You cannot change the column shape so leave it as is.

5. Change the Gap Width to 30% Gap e e

-

e. Depending on your screen resolution, the bar labels may be difficult to read
and/or the digits may wrap. Do the following to make the labels more readable:

1. Click the Rowing Machines label value once. This will select all four labels.

2. Onthe Chart Format tab, in the Shape Styles group, click the Shape Fill
arrow and select Yellow. Now the numbers are easier to read.
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3. Click in the Chart Area to deselect the data labels. Then, click the

Rowing Machines data label once, wait a second, and click it again.
This will select only that label. Grab the edge of the data label box and
position it as shown below. Repeat this process for the Treadmills,
Elliptical Machines, and Exercise Bikes data labels.

Total Sales for Each Type of Machine

Rowing Machines
$241,682 '
Treadmills
o ) $74,299 '
Elliptical Machines
Exercise Bikes

f. Add a callout by doing the following:

1.

On the Insert tab, in the lllustrations group, click Shapes, and way down
at the bottom, click Cloud Callout. If you do not have that callout, use any
other. A small cross will appear.

Move the cross to about the middle of cell F30, hold down the left mouse
button, and drag down and to the left to insert the callout.

Right-click the cloud and select Edit Text.
Type Too low! Change the font to black Arial Black.

Point to the little orange tip and a white arrow will appear
Drag so the cloud points to the Elliptical Machines bar.

Adjust the cloud size and position to it look like the following:

_ i s74,299' °® ‘
Elliptical Machines

As you can see, when working with graphs, you sometimes have to fiddle
around with the parts to get it to look the way you want it.

g. Double-click the Sheetl tab name to select the word Sheetl, type Data as the
new name, and then tap Enter.
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h. Set up the Quarterly Sales Data worksheet for printing by doing the following:

1. Click cell A1. On the Page Layout tab, in the Page Setup group, in the

lower right corner, click the dialog box launcher m and click Page Setup.

Mac:

There are no dialog box launchers on the Mac. For features not expressly
included on the Ribbon you can use the main menu bar. In that case, click
the File menu, and then Page Setup. Or, on the Page Layout tab, in the
Page Setup group, click the Page Setup button.

Click the Page tab and confirm that the orientation is Portrait.
Click the Margins tab and put a check in the box next to Horizontally.

Click the Header/Footer tab and click Custom Footer.

Click inside the Left section box and click the Insert File Name icon ﬁ:

o g kA WD

Click inside the Right section box and click the Insert Sheet Name icon

B8

Mac:

Skip steps 7, 8, and 9. While Mac allows you to insert a picture there is no
Format Picture icon so you cannot change its size to fit in the footer.

7. Click inside the Center section box and click Insert Picture icon E

8. Navigate to your Word Files folder. Double-click HWO07-2 Goldy Original.

Notice the codes inserted by Excel. Other icons allow you to modify the
font, display the page number, date and time.

A & O &) 8| B8] )|

Left section: Center section: Right section:

&[File] | &[Picture] | &[Tab]|
9. Select the code &[Picture], click the Format Picture icon
Change the Height to 0.3 inch.
10. Click OK three times. Tap Ctrl + p to open the Print dialog box and compare

the preview with the key on page SG400. Make corrections and save the
workbook but DO NOT close it.

i. Copy the DATA worksheet and display the formulas by doing the following:

1. Near the bottom left of the screen, right-click the Data tab Insert...
and select Move or Copy from the menu. EX Delete
Ri
2. Click the Create a copy check box. e
Move or Copy...
3. Click OK. This makes a duplicate of the worksheet and GF View Code
names it Data (2) EX Protect Sheet..
4. Double-click the tab name, Data (2), to select it. Ifb coter
Type the new name, Formulas, and tap Enter. Hide
5. If necessary, delete the two charts by clicking an edge to ;lecmn hoets
select them, and then tapping the Del key. Dt e
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6. Tap Ctrl + " to display the formulas. The " key is located at the upper left
corner of the keyboard. You can also display the formulas by going to the
Formulas tab and, in the Formula Auditing group, clicking Show Formulas.

7. Click the Select All box in the upper left corner of the worksheet.

This selects all the cells of the worksheet.

8. Move the pointer to the column heading boundary between any
two columns so the pointer becomes a double-headed arrow.

y |

A1 M

A

£
+

PrgAt Marietta

B

Cl

N

1

2

Double-click. This process, called AutoFit, will adjust the column widths to
fit the formulas displayed. Don’t worry if the formatting looks different
because displaying the formulas sometimes messes it up.

Second Quarter Cardio Sales

Pro Fit Marietta

Exercise Bikes

Treadmills
Rowing Machines
Total

2
3
4
W Elliptical Machines
6
7
8

April May
68991.12 86894.82
28836 22634.23
59519.78 82337.98
81267.17 87867.5

June
99650.58
22828.78
99823.87
91669.98

Total
=SUM(B4:D4)
=SUM(B5:D5)
=SUM(B6:D6)
=SUM(B7:D7)

=B4+B5+B6+B7 =C4+C5+C6+C7 =SUM(D4:D7) =SUM(BS:DS)

[=

Tren

P
N
P
o

9. Click cell Al to deselect all the cells.

j. Set up the Quarterly Sales Formulas worksheet for printing. The initial
setup should be the same as for the Data worksheet, but check to be sure.
In addition, do the following:

1. Tap Ctrl + p. Be sure it shows Print Active Sheets:

PC | Settings

ﬁ Print Active Sheets
Only print the active sheets

Mac

Click Page Setup.

- Excel
Collate pages
Print: [ Active Sheets

Mac: On the Page Layout tab, in the Page Setup group, click Page Setup.

2. Onthe Page tab, look at the Scaling section. Here, you can adjust the
scale to any percent of normal size, larger or smaller, or have Excel fit the
output to a specific number of pages wide and tall.

Click the button to the left of Fit to: and confirm that 1 is in the box.

Scaling
'S' Adjust to:

'@' Fit to: 1

4 A
U

-

% normal size

= | page(s) wide by

Y
-

tall
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3. Click the Sheet tab. In the Print section, Print

check the boxes next to Gridlines and Row Gridlines

and column headings. Printing these makes |:|_I .

it easier to see if the formulas are correct. Black and white

_ |:| Draft quality

4. Click OK. Row and column headings
5. Compare the preview with the key. Make

needed corrections, save the workbook, and then close it.

HWO02-2 Plyometric Products Inventory (Based on Project 1B)

Problem: How can you summarize data and construct and format graphs so that

they are informative, visually appealing, and clearly display relationships
between data?

a. Open the workbook Lastname_Firstname 1B Plyo Products, which you
created while following the directions in the textbook and saved in step 10 on
page 361.

b. Save the workbook in the Excel Files folder using the name HW02-2 HWID 1B
Plyo Products Done, where HWID is your four-character homework ID.

c. Insert some extra text, an arrow, and a photo by doing the following:

d. Double-click the Sheetl tab name to select it. Type the new sheet name Data.

1.

In cell A14, type University Recreation and Wellness Center is a great
place to work out.

In cell A15 type For more information see https://recwell.umn.edu/
Make the text red and bold.

Click cell A16. On the Insert tab, in the Illustrations group, click Pictures
and then Insert Picture From This Device. Navigate to your Excel Files
folder and double-click HW02-2 U of M Rec Center Photo Original.

Double-click the photo. On the Picture format tab, in | 145 7|
the Size group, change the height to 4.5 inches and the

width to 7 inches. Sr

Click cell C15. On the Insert tab, in the Illustrations Lines
group, click Shapes and click Line Arrow. NN\ LT
This will display a cross. Drag the cross to make a Line Arrow

horizontal arrow that is about 1 inch long. O+

With the arrow selected, on the Shape Format tab, in the Shape Styles
group, click Shape Outline, and select red.

With the arrow selected, on the Shape Format tab, in the Shape Styles
group, click Shape Outline, and select Weight and 3 pt.

. With the arrow selected, on the Shape Format tab, in the Shape Styles

group, click Shape Outline, select Arrows and change the arrowhead to

this: <=
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10. Adjust the text, arrow, and photo to look like this:

University Recreation and Wellness Center is a great place to work out

For more information see https://recwell.umn.edu/ b

N ol

e. Set up the Plyometric Products worksheet to print in Landscape orientation,
all on one page, centered horizontally but not vertically, and include a footer
that contains the file name on the left and the sheet name on the right.
Compare the preview with the key. Make needed corrections, save the
workbook, and close it.

HWO02-3 Vehicle Sales Charts

Problem: How can you create detailed three-D column charts to visually display

relationships between data?

a. Open the workbook HW02-3 Vehicle Sales Original, which is one of the files
you downloaded at the start of the term.

b. Save the workbook to the Excel Files folder using the name
HWO02-3 HWID Vehicle Sales Done

c. Set up the worksheet as follows:

1.
2.

Merge and center A1:E1. Merge and center A2:E2.

In row 7, enter formulas that will calculate the sum for Cars for each year. Do the
same for row 12 for Vans, for row 16 for SUVs, and for row 17 for Grand Total.

Click F17 and type ="Average is "& AVERAGE(B17:E17) The ampersand,
&, allows you to display more than one item in a cell. It has the effect of
concatenating (sticking together) the items so the text inside the quotation
marks will be displayed followed by the calculated average.

Click the Enter checkboxand the cell will display Average is 84.25.

Sometimes, it is useful to display the entire location (path) of your file right
on the printout. To do that, click cell A19, type =cell("filename") and tap
enter. Here is what mine shows: C:\Users\droberts\Desktop\Excel
Files\[HW02-3 HWID Vehicle Sales Done.xIsx]Data

d. Insert Sparklines as follows:

1.

In cell F5, insert a Line Sparkline for the Sedans data. —
Use the options in the Sparkline Design tab to make the color red and
mark the High Point and Low Point in dark blue.

Do the same for the Coupes in F6.

In F9, insert a column Sparkline for the Full Sized Vans data. Do the same
for the Mini Vans and the Four Wheel Drive Vans. Make the Sparkline for
Full Sized red, for Mini green, and for Four Wheel Drive blue.
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e. Set up the Data worksheet to print in Portrait orientation, all on one page,
centered horizontally but not vertically, and include a footer that contains the
file name on the left and the sheet name on the right. Note that you can have
the full file location displayed in the footer by clicking the Insert File Path button
instead of the Insert File Name button. | Compare the preview with the key.
Make needed corrections, save the workbook but do NOT close it.

\F,

f. Create a line chart of the Total Cars and Total Vans and Total SUVs for the
years 2005 through 2020 by doing the following:

1. Click A3 and drag across to E3. This will set the scale at the bottom of the
line chart. Note that even though A3 is empty you still need to select it so
that there is consistency in the selection of the rest of the data.

2. Hold down the Ctrl key (Command key on Mac) and select A7:E7. Now
both A3:E3 and A7:E7 ranges are selected.

1 Vehicle Sales
(in thousands of vehicles)

2005 2010 2015 2020

Sedans 23 31 35 29
Coupes 14 12 16 15
| Total Cars | 37 43 51 44

3. Hold down the Ctrl key and select A12:E12.
4. Hold down the Ctrl key and select A16:E16.

5. Onthe Insert tab, in the Charts group, click Line,
and select Line with Markers. k k)

6. On the graph, click Chart Title, click the formula bar, type Vehicle Sales,
and tap Enter.

Chart Elements
7. Click the Chart Elements button, the green cross in the upper Axes
right corner of the chart, and put a check next to Axis Titles. Axis Titles

Mac: Chart Design, Add Chart Element, Axis Titles, Primary Horizontal,
Primary Vertical. If the Format Axis Title pane does not automatically open,
click the Format tab, and click the Format Pane button.

8. Click the horizontal Axis Title and, in the formula bar type, Year, and tap Enter.
9. Enter Thousands of Vehicles for the vertical Axis Title.
10. Change the font of the Title, the Axis Titles, and the Axis Numbers to Arial Black.

11. Onthe Chart Design tab, in the Location group, click Move Chart to open
the Move Chart dialog box.

12. Next to New sheet, replace the word Chartl |JJ (@) New sheet:  Line Chart
with Line Chart.
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13. Click OK. The chart now is in its own chartsheet. Do NOT print this chart.

Vehicle Sales
60

Thousands of Vehicles
W
-1

g. Do the following to create a 3-D Column chart for 2005, 2015, and 2020 using
the data for Sedans, Coupes, Full Sized, Mini, and Regular.

1. Click the Data worksheet tab. Since you are skipping the 2010 column you
cannot select the data like you did for the line chart. That is, you cannot
drag across the rows of data; you must click each cell individually, left to
right, top to bottom.

2. Start by clicking A3 even though it is blank. Then, hold down the Ctrl key
and click (do NOT drag) B3, then click D3, then click E3.

3. Move to row 5 and, with the Ctrl key still held down, click the cells you
want, working left to right.

Continue in this left to right and top to bottom manner, as if you were
reading a book.

1 Vehicle Sales

2 (in thousands of vehicles)

3 2005 2010 2015 2020
- Cars

Il Sedans 23 31 329
Ml Coupes 14 12 16 15
[ Total Cars 37 43 51 44
=M Vans

Bl Full Sized 12 10 8 12
RLE Mini 8 12 14 23
(i Four Wheel Drive 0 2 3 16
{#’J] Total Vans 20 24 25 51

Akl SUVs

MEA Regular 0 4 12 18
{8 Towing Package 0 0 2 6
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4. Once the data are selected for rows 3, 5, 6, 9, 10, and 14,
on the Insert tab, in the Charts group, click 3-D Column.

Set up the chart so it has these characteristics: Format Chart Area

+ Type: 3-D Column Chart Options | Text Option

» Location: New chartsheet called 3-D Column Chart o Q —

* Chart title (above chart): : F
Selected Vehicle Sales for 2005, 2015, 2020

» Horizontal axis title: Type of Vehicle

» Vertical axis title: Thousands of Vehicles

+ Depth axis title: Year

« Make the Title and Axis Titles 14 pt Arial Black © 3D Format

« Make the Axes Labels 9 pt Arial Black 4 3-D Rotation

* Legend: None

- Set the X Rotation to 50° and the Y Rotation to 30° :
« Vertical Axis Gridlines: 3 pt red I i
* Floor: Gray > gl Y Rotation

h. Set up the 3-D Column chartsheet to print in Landscape orientation. Include a
footer that contains the file name on the left and the sheet name on the right.
Compare the preview with the key. Make needed corrections, save the
workbook and close it.

' Shadow

P Glow

I Soft Edges

Presets

Step 4 Submit Now, do the following to create your pdf files. Each file should
contain only one worksheet or chartsheet on a single page. Do
NOT submit multiple worksheets or pages in a single pdf. Check
the key on page SG400.

Use these names for the pdf files:

HWO02-1 HWID 1A Quarterly Sales Done (Data) — This is the Data worksheet

HWO02-1 HWID 1A Quarterly Sales Done (Formulas) — This is the Formulas worksheet
HWO02-2 HWID 1B Plyo Products Done

HWO02-3 HWID Vehicle Sales Done (Data) — This is the Data worksheet

HWO02-3 HWID Vehicle Sales Done (3-D Column Chart) — This is the 3-D Column chartsheet

See the next page for the steps for creating your pdf files.
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1. Open one of the files, click the appropriate worksheet tab, and tap Ctrl + p

to open Print Preview.

Mac: Tap Command + p to open the Print dialog box

Print
[<«<1< | 1of1 [ > 12> Printer: | @ Peik 125 Toshiba
Presets: [ Default Settings
Copies: D@ Two-Sided
T Pages: © All
O From: [1 | to: 1 |
'lil IIHI Ilil
e - Paper Size: [ US Letter 8.50 by 11.00 inches
[T |
- z——-wl' 4[ Excel
,,,,,:_:,
Collate pages
int: | Active Sheet: ]
. Print: | Active Sheets !J
| Margins: | Normal Margins ‘
Orientation: | Portrait
(] Scale to fit:
1 0
?;: [ Hide Details J sf PDF Cancel

2. Check the key on page SG400 to be sure your output is correct.
3. Click the Printer arrow and select Adobe PDF.

[#]

Open in Preview

Mac: Click the PDF button at the bottom and select Save as PDF.-}

Save as PDF

Save as PostScript

Send in Mail
Save to iCloud Drive

Save to Web Receipts

Edit Menu...

Save as Adobe PDF ||

0]
1

T T =T T=7

Click Print.

} POF @

Navigate to the desktop, enter the file name, such as HW02-1 HWID 1A

Quarterly Sales Done (Data) and then click Save.

When you have created all five pdfs, create a new folder

called HW02 HWID LastName, FirstName using your own

HWID and names.
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7. Drag your pdf files into the new folder.

> HWO02 HWID LastName, FirstName v ($] S Search HW02 HWID LastName, FirstName
~ Name Date modified Type
HWO02-1 HWID 1A Quarterly Sales Done (Data) 6/19/2022 2:12 PM  Adobe Acrobat Document
HWO02-1 HWID 1A Quarterly Sales Done (Formulas) 6/19/2022 2:13 PM  Adobe Acrobat Document
HWO02-2 HWID 1B Plyo Products Done 6/19/2022 2:14 PM  Adobe Acrobat Document
HW02-3 HWID Vehicle Sales Done (3-D Column Chart) 6/19/2022 2:15 PM  Adobe Acrobat Document
HW02-3 HWID Vehicle Sales Done (Data) 6/19/2022 2:14 PM  Adobe Acrobat Document

8. Compress the folder to form a new zipped file as you did on page SG32.

HWO02 HWID

LastName,
FirstName

9. By the due date, upload the zipped file to the HW02 Excel Cpt 1 Creating
Worksheets and Charts folder in Canvas.

Step 5 Backup Now would be a good time to backup your files.



Project 3
Excel Chapter 2: Functions, Tables, and Large
Workbooks

Step 1 Read Read the introductory material on page 385 in the textbook.

Step 2 Activities Turn on the computer and do the following:

Project 2A: Start at the top of page 387.

Instead of Activity 2.01 step 1 do the following:

1.

Navigate to your Excel Files folder and open e02A_Tree Inventory,
which is one of the files you downloaded at the start of the term.

Save the file in your Excel Files folder using the name
Lastname_Firstname_2A_Tree_Inventory

Complete the rest of the Activities through step 11 on page 408. Do NOT
do steps 12 and 13 in Activity 2.20 on page 409.

Return here when you have completed Project 2A on page 408.

Do NOT do GO! With Google Sheets

Project 2B: When you have completed Project 2A, start at the top of page 413.

Instead of Activity 2.21 step 1 do the following:

1.

Navigate to your Excel Files folder and open e02B_Weekly Sales, which
is one of the files you downloaded at the start of the term.

Save the file in your Excel Files folder using the name
Lastname_Firstname_2B_Weekly Sales.

Complete the rest of the Activities through step 4 on page 432. Do NOT do
steps 5 and 6 in Activity 2.36 on page 432.

Return here when you have completed Project 2B on page 432.

Do NOT do GO! With Google Sheets or GO! To Work

Step 3 Homework After you have completed Projects A and B return here, do
the following additional activities, and turn them in for grading.

— SG55 —
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HWO03-1 Tree Inventory (Based on Project 2A)
Problem: How can you use statistics to analyze data?

a. Open the workbook Lastname_Firstname_2A_Tree_Inventory, which you
created while following the directions in the textbook and saved on page 408.

b. Save the workbook to the Excel Files folder using the name
HWO03-1 HWID 2A Tree Inventory Done

c. When a worksheet has many rows or columns it is often useful to be able to
see non-adjacent parts of the worksheet at the same time. The textbook
showed you how to do this in a couple of ways:

e freeze parts of the screen so specific rows or columns are always in view
(textbook page 401).

e split the screen horizontally so you can scroll the upper and lower parts
independently, or split the screen vertically so you can scroll the left and right
parts independently (textbook page 406).

A third way is to hide rows or columns. To see how this works, do the following:

1. Select rows 17:41 by clicking on row number 17 and dragging to row 41.

2. While pointing to any selected row number,

: : . I Oak T 13
right-click and select Hide from the menu. 1 M%pléeﬁzes 6 (571 totd
Now it appears that row 16 is followed by row ¥ -
42. The other rows are still there but they are }i Quantity in Stock — ”e’]‘;fg;
hidden from view. Notice that the count in B10 & 35| 13358
has not changed. Even though you cannot 16 60 15688
see the hidden rows the values are taken into [ 201 16955
. ) 18 75 21683
account in the formulas. When you print, those g o 22189
hidden rows will not print. 20 68| 23677
42 350 43153
Do NOT go to the View tab, hid 43 7/5/2020 9:53
Window group and click Hide. e

This will hide the entire workbook! If you do that, click Unhide | [_]Unhide
to get the window back.

3. Select rows 16 to 42, right-click, and select Unhide.
d. Hide rows 21 to 41.

e. Set up the Tree Inventory worksheet to print in Landscape orientation, all on
one page, centered horizontally but not vertically, and include a footer that
contains the file name on the left and the sheet name on the right. Click the
Sheet tab and click Row and column headings. Click OK. Compare the
preview with the key. Make needed corrections, save the workbook, and close it.
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HWO03-2 Weekly Sales Summary (Based on Project 2B)
Problem: How can you organize and summarize data from different sources?

a. Open the workbook Lastname_Firstname_2B_Weekly Sales, which you
created while following the directions in the textbook and saved on page 432.

b. Save the workbook to the Excel Files folder using the name
HWO03-2 HWID 2B Weekly Sales Done

c. Set up the Summary worksheet to print in Portrait orientation, all on one
page, centered horizontally but not vertically, and include a footer that
contains the file name on the left and the sheet name on the right. Compare
the preview with the key. Make needed corrections, save the workbook but do
NOT close it.

d. The IF function introduced on textbook page 396 allows you to choose
between two alternatives based on the truthfulness of a condition called a
logical test. The IF function evaluates the logical test and, if the logical test
result is true, the first alternative is displayed; otherwise the second alternative
is displayed.

The IFS function, described on pages 427-429, allows the user to display
different things based on more than one condition (hence the S in IFS).
However, the conditions must be placed in the correct order for the function to
work properly. Here is the formula the authors provided:

=IFS(B4>4999,500,B4>3999,350,B4>2999,250,B4>0,0)

Notice that this starts with the highest cutoff, 4999.
IF that is exceeded, THEN 500 is displayed.
IF it is not, THEN the next highest cutoff, 3999, is checked.

And so on.
THEN Else THEN Else THEN Else THEN
=IFS| B4>4999 , 500 y B4>3999 , 350 , B4>2999 , 250 ’ B4>0 ’ 0
—_— —_—— [ ———— —
Condition 1 Display Condition 2 Display Condition 3 Display Condition 4 Display
if true if true if true if true

Some people find using “nested” IF statements easier to understand.
“Nested” means putting one IF statement inside another. You are choosing
between four different bonus values, so you need three IF statements.
For this problem, it would look like this:

THEN Else THEN Else THEN Else
=IF| B4>4999 , 500 » IF| B4>3999 ’ 350 ,» IF| B4>2999 ’ 250 ’ 0
e R S E— —
Condition 1 Display Condition 2 Display Condition 3 Display Display

if true if true if true if false
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What happens if you reverse the order in the IFS formula, like this?

=IFS(B4>0,0,B4>2999,250,B4>3999,350,B4>4999,500)

In this case, the first condition, B4>0, is true for everyone and so the
result is a bonus of 0 for everyone! Be sure to always check your
formula results by hand because it is really easy to get things backwards.

To see how this works, do the following:

1.

2
3.
4

Click the Bonus worksheet tab. In cell C3 replace Bonus with Bonus using IFS.
In cell D3 type Bonus using nested IF.

Select B4:D7, right-click and select Format Cells.

. On the Number tab, click Accounting and set the Decimal places to 0

and display the $.

Select A1:D1 and, on the Home tab, in the Alignment group, click
Merge & Center to deselect it and click it a second time to select it again.

1 Weekly Online Sales Bonus

=8 Salesperson Weekly Sales Bonus using IFS Bonus using nested IF

AutoFit columns A:D.
In cell D4 type =if(b4>4999,500,if(b4>3999,350,if(b4>2999,250,0)))

Fill D4 down to D7. Notice the values in columns C and D are the same.

There is nothing to print here. You will learn more about nested IF functions on
page SG143.

HWO03-3 Inventory (Based on Project 2G)

Problem: How can you summarize data based on certain conditions?

a. Start at the top of textbook page 453. Instead of step 1 do the following:

1.

Open the file e02G_Inventory, which is one of the files you downloaded at
the start of the term.

Save the file in your Excel Files folder using the name
Lastname_Firstname_2G_Inventory

b. Follow the directions for steps 2 through 23 for Project 2G Inventory on pages 453-454.

c. After completing step 23, save your file to the Excel Files folder using the
name HWO03-3 HWID 2G Inventory Done

d. The Tables may still be defined for the Bulbs and Trees worksheets.
If necessary, do the following to remove the Table designation:

1.

Click the Trees worksheet tab.
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2. Click A15. If the Table Design tab appears then this range is still designated
as a table. To remove the table designation, on the Table Design tab, in the
Tools group, click Convert to Range. Click Yes to confirm the conversion.
The Table Design tab will no longer be present and there will be no arrows in
the header row (row 14).

3. Click the Bulbs worksheet and, if necessary, convert the table into a range.

4. Click cell B5S and make the number bold red and the fill yellow so it stands out.

If the Gridlines are showing, remove them (View tab, Show group, Gridlines).

e. Change the worksheet tab colors by doing the following:
1. Right-click the Bulbs worksheet tab, point to Tab Color, and click orange.

2. Repeat the process to make the Trees worksheet tab color green.

f. On page 405, step 8, the book showed you one way of determining the quantity
in stock of Tulips on the Bulbs worksheet by using filtering. Below is an easier
way of doing that, and one that will automatically update as the data change.

1. Click the Bulbs worksheet tab to make it active.
2. In C10, type Tulip Total using SUMIFS.

3. In C11, type =sumifs(al5:a42,f15:f42," Tulips") and then click the Enter
checkbox to keep C11 active. Notice the number, 433, is the same as the
one you typed in B11. If the Quantity in Stock in column A changes, this
value in C11 will automatically be updated but the value in B11 will not.

The SUMIFS function works like the COUNTIF function you learned about
in Project 2A, except SUMIFS finds the sum of selected values rather than
counts how many there are. Here is the form of the function:

where to look where to look
what to sum ————  what to look for ———— what to look for
— criteria1 — criteria 2 —

=SUMIFS( sum range , y criteria1 |, y criteria2 |,...
-— range N range -
Quan in Stock —_— Tulips —_— not needed
range that not needed
has Category

sum range: Which cells do you want to sum? Quantity in Stock (A15:A42).

criteria 1 range: Whose Quantity in Stock do you want to include?
Those of Tulips, so use the Category in F15:F42

criteria 1: What should the Category be? Tulips, so use "Tulips"
criteria 2 range: You can include many more conditions but it is not needed here.

criteria 2: Not needed here.

what to sum where to look what to look for

=SUMIFS( A15:A42 ,| F15:F42 , T"Tulips” )
%,—/ %,—J

Quan in Stock range that Tulips
has Category
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Click the Trees worksheet tab to make it active.
In C10, type Evergreen Total using SUMIFS.

Click C11 and enter a formula that will sum the quantity in stock for
Evergreens in the range F15:F42. You should get the same number, 583,
asisin B11.

g. The AVERAGEIFS function is like SUMIFS but it finds averages rather than
sums. For example, do the following to find the average price for the tulips:

1.
2.
3.

Click the Bulbs sheet tab to make that sheet active.
In A12 type Tulip Average Price.

In B12, type =averageifs( After you type the left parenthesis, (, Excel
provides a screen tip that shows the structure of the AVERAGEIFS formula.

=averageifs(

AVERAGEIFS(average_range, criteria_rangel, criterial, ...)

The average_range is the location of the numbers you wish to average. This is
the Retail Price in D15:D42. Type that range followed by a comma.

=averageifs(d15:d42,

AVERAGEIFS(average_range, criteria_range], criterial, [criteria_range?2, ...)

The criteria_rangel is the range where the criteria are located. That is,
Category in F15:F42. Type that range followed by a comma.

=averageifs(d15:d42,f15:f42,

AVERAGEIFS(average _range, criteria_range, criterial, [criteria_range2, criteria2], ...)

The criterial is what you are looking for. That is Tulips. Type “Tulips”)
(note the right parenthesis). The quotation marks around Tulips are
needed. The square brackets around [criteria_range2, criteria2] mean
the items inside are optional. In this case, we have only one criterion so
there is no criteria_range2.

Click the Enter checkbox to keep B12 active. The value 11.426 should
show.

10 Tulip Types 5 Tulip Total using SUMIFS
IBN Tulip Total Quantity 433 433

WM Tulip Average Price [ § 11.426 |

Format the average price in B12 to match the average price in B5. A quick
way to do that is to use the Format Painter. Its icon is the paintbrush on <
the Home tab, in the Clipboard group. To use it, click cell B5, which has
the format you want, click the paintbrush, and click B12. All the formatting
in B5 is “painted” onto B12.
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5. If you need to remind yourself of something about the contents of a cell you
can use an Excel Note. These are like Post-It notes that you can tack on to
any cell. For example, click C11, right-click, and select New Note, or tap
Shift + F2. In the box, type Used SUMIFS.

10 Tulip Types 5 Tulip Total using SUNALES U —
I Tulip Total Quantity 433 ] e
WA Tulip Average Price §  11.43 . -

Notice that Excel inserts the name of the user automatically so if more than
one person makes a Note you can see who did it. Notes do not
automatically appear when the worksheet is printed. If you want to print
them, go to Page Layout, Page Setup, Sheet, click the Comments and
notes down-arrow, and select As displayed on sheet. For more options
on Notes, click the Review tab and click the Notes down-arrow.

Click C11. Depending on how your version of Excel is set up, the Note may
disappear, leaving only a small red triangle in the upper right corner of the
cell. If you click the cell the Note textbox will appear. To have the Note stay
on the screen, right-click the cell and select Show/Hide Note. To hide a
Note, right-click and select Show/Hide Note again. To delete a Note, click
the cell, right-click, and select Delete Note (do not do that).

6. To add a cute image to the Bulbs worksheet, on the Insert tab, in the
lllustrations group, click Icons. In the search box, type tulip. Click the
tulip icon, and click Insert.

7. Drag the tulip icon so it is in column C, just under As of December 31.

8. Onthe Graphics Format tab, in the Graphics Styles group, click the
Graphics Fill arrow and select orange.

Mac: Right-click the icon. Select Format Graphic. Click the paint bucket and Fill.

9. Onthe Graphics Format tab, in the Graphics Styles group, click the
Graphics Outline arrow and select black.

Mac: Click the paint bucket and Line.

Pasadena Facility: Iny
As of Dec

1

2

3

“M Total Items in Stock 2,847
S8 Average Price
6
7
8

S 8.99
Median Price $ 8.42
Lowest Price $ 475
Highest Price $ 16.58




SG62 PROJECT 3 EXCEL CHAPTER 2: FUNCTIONS, TABLES AND LARGE WORKBOOKS

h. Set up the Bulbs worksheet to print in Portrait orientation, all on one page,
centered horizontally but not vertically, and include a footer that contains the
file name on the left and the sheet name on the right. Make the Note in cell
C11 appear on the output. Compare the preview with the key. Make needed
corrections, save the workbook, but do not close it.

i. Use the COUNTIF, SUMIFS, and AVERAGEIFS functions to collect Bulbs and
|

Trees summary data by doing the following:

1. Click the Summary worksheet tab.
2. Select columns B:D. Right-click and select | colmnwidn: 24 =
Column width. Type 24. Cancel

A8 Bulbs Category Number in Stock Number of Categories Average Price
|8 Begonias

|58 Callas

&8 Daffodils

|8 Dahlias

[FN Gladiolus

VA Tulips

VAl Trees Category Number in Stock Number of Categories Average Price
PN Evergreens

A8 Flowering Trees

2 Fruit Trees

AN NUT Trees

LN Shade Trees

4. Use the Format Painter to match the formatting of the new column and row
headings to those in cell A7. To do that, click A7 and, on the Home tab, in
the Clipboard group, double-click the Format Painter. |5

Then, drag across the cells where you want the format to be applied
(A11:D11, A11:Al17, A19:D19, A19:A24). Now, click the Format Painter
icon to turn it off.

5. Select row 11, right-click, select Row height, and type 28.

6. Do the same for row 19.

7. The formula bar is set to show only one line. Click the arrow on the right, | ¥

and three lines of the formula bar will appear.

8. Click B11. In the formula bar, place the insertion point just to the left of the i
and tap Alt + Enter. Tap Enter. This will putin Stock below Number.

Number

(Bl Bulbs Category in Stock
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9.

Repeat for C11, D11 and center all three titles so they look like this:

ulbs Category in Stock Categories Price
egonias

Number
in Stock

Number Number of Average

10.
11.
12.

13.
14.

Copy B11:D11 and paste in B19:D109.
Change the widths of columns B, C, and D to 13 pt.

Place a light border around A11:D17 (select A11:D17, right-click, select
Format cells, click Border, click the light border (just under None), click
Outline, click Inside, and click OK.

Repeat for A19:D24.

In B12, display the sum of the quantities of the different types of Begonias
in stock on the Bulbs worksheet. To do that, click B12 and type =sumifs(

SUMIFS(sum_range, criteria_range, criterial, ...)

The screen tip appears showing the structure of the SUMIFS formula:

e sum_range, which means “Which numbers are you going to sum?” (on
the Bulbs sheet, Quantity in Stock range A15:A42).

e criteria_rangel, which means “Where are you going to look?” (on the
Bulbs sheet, in the Category range F15:F42).

e criterial, which means “What are you looking for?” (the word Begonias).
Now, click the Bulbs worksheet and select A15:A42

then type a comma
then click the Bulbs worksheet and select F15:F42
then type a comma
then click the Summary worksheet and click A12,
then type a right parenthesis )
finally, click the Enter checkbox to keep B12 active.

B12 should display the number 314 and the formula bar will show
=SUMIFS(Bulbs!A15:A42,Bulbs!F15:F42,Summary!Al12)

This is similar to the previous SUMIFS. The only difference is that the first
two cell ranges are on the Bulbs worksheet and the criteria is not a word in
guotes (like "Tulips") but a cell reference that has the criteria word in it; that
is, A12, which contains the word Begonias, acts as the criteria.

what to look for
what to sum where to look

Word in A12
=SUMIFS(Bulbs!A15:A42, F15:F42 ,. on

range that has range that Summary Sheet
Quan in Stock has criterion Begonias
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15.

Before copying the formula to B13:B17, you need to convert the ranges for
the Bulbs worksheet to absolute references so when you fill the formula
down the ranges on the Bulbs worksheet will not change (similar to what
you did on page 355 of the textbook). To do that quickly, in the formula bar
click the cell reference A15 and then tap the F4 key. Remember, on a
laptop, you may have to hold down the fn key when you tap F4.

The cell reference changes to $A$15. If you forget about this keyboard
shortcut, you can always type the $ manually.

Do the same for cell references A42, F15, and F42 and then tap the
Enter check box on the formula bar.

Do NOT put in the $ for A12 because you want that to change to A13,
then Al14, etc. when you fill down.

Now the formula looks like this:

=SUMIFS(Bulbs!$A$15:$A$42,Bulbs!$F$15:$F$42,Summary!Al2)

Point to the lower right corner of B12 and the fill handle (little black cross)
will appear. Drag down to B17 and let up the mouse button. This copies
(fills) the formulas. Note that if you double-click the fill handle the formula
will be filled down automatically, without having to drag.

Number Number of Average
1N Bulbs Category in Stock Categories Price
|’} Begonias 314

101

[F:8 Daffodils 755
[IB} Dahlias 473
Gladiolus 771
IPA Tulips 433

If you see any zeros, check your spelling in A12:A17. Be sure there are no
blank spaces, which you cannot see but which Excel knows are there.

Note that when you point to a cell you will see one of three icons:

| op | White Cross shows where the mouse is pointing.

|:| Black Cross in lower right corner is the fill handle. To copy
+ a formula down, drag this cross or double-click it.

| 1, Four-headed Arrow allows you to drag the contents of the
cell in any direction. When you drag a cell onto another cell
the contents of that other cell will be replaced.




PROJECT 3 EXCEL CHAPTER 2: FUNCTIONS, TABLES AND LARGE WORKBOOKS SG65

16. Enter similar formulas in cells B20:B24. A quick way to do that is to copy
the formula in B12 and paste it into B20. Then, in B20 change Bulbs! to
Trees! and change A12 to A20. So, the formula in B20 would be

=SUMIFS(Trees!$A$15:$A$42, Trees!$F$15:$F$42,Summary!A20)
17. Fill the formula in B20 down to B24.

j. In C12:C17, enter formulas that display the Number of Categories (that is, the
number of different types of Begonias, Callas, etc.). Here, you are counting
the different types of bulbs so you will use the COUNTIF function.1°

k. In C20:C24 do the same for Trees.

[. In D12:D17, enter formulas that display the Average Price for the bulbs. Here,
you are finding an average so you will use the AVERAGEIFS function.*!

m. In D20:D24 do the same for Trees.
n. Format the cells in D12:D17 and D20:D24 to the accounting style.

0. The Sparklines in D5:D9 are not informative because all the tree prices are so
much larger than the bulb prices. Do the following to remove them:
1. Select D5:D9.

2. Tapping the Del key does not delete the Sparklines. Instead, on the
Sparkline tab, in the Group group, click the Clear arrow, and select Clear
Selected Sparklines.

Click D4 and use the Del key to delete Bulbs/Trees title.

4. While still in D4, right-click and select Format Cells. Click the Border tab
and click the bottom border to delete it.

Text

Color:

N

5. Click OK.

p. Make the worksheet easier to read by doing the following:
1. Rightalign cells A5:A24.
2. Center align cells B12:C24.

g. Set up the Summary worksheet to print in Portrait orientation, all on one
page, centered horizontally but not vertically, and include a footer that
contains the file name on the left and the sheet name on the right. Compare
the preview with the key. Make needed corrections, save the workbook, and
close it.

10 =COUNTIF(Bulbs!$F$15:$F$42,Summary!A12)
11 =AVERAGEIFS(Bulbs!$D$15:3D$42,Bulbs!$F$15:$F$42,Summary!Al12)
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HWO03-4 Payroll IF

Problem: How can you set up a payroll worksheet that automatically calculates
regular pay, overtime pay, total pay, and summary statistics?

a. Open the workbook HWO03-4 Payroll IF Original, which is one of the files you
downloaded at the start of the term.

b. Save the workbook to your Excel Files folder using the name
HWO03-4 HWID Payroll IF Done

c. Sort the data alphabetically by name by doing the following:

1. Select rows 8 through 28. Be sure to select entire rows and not just the
Name column or the data will be scrambled. To select an entire row, point
to the row 8 number. The cursor will change to a right-pointing arrow. [.g
Click to select the entire row 8. Then, drag down to row 28.

2. Onthe Home tab, in the Editing group, click the Sort & Filter arrow, and
select Custom Sort from the menu.

Mac: The Editing group might look like a magnifying glass: -

Editing

3. Be sure there is a check next to My data has headers so the titles in row 8
will not be sorted with the rest of the data.

4. Select Name from the Column Sort by drop-down menu.

~+ Add Level = XX Delete Level [Bgopy Level ‘ Options... My data has headers
Column Sort On Order
Sortby  Name Cell values v | |AtozZ v
|D ..........
Name

You want the names in alphabetical order so leave the Order as A to Z.

5. Click OK.

d. Break-up the names in column B so that the last names and first names are
shown in separate cells by doing the following:

1. Select columns C and D, right-click, and choose Insert. This will move
column C (Sex) right to become a new column E and leave two blank
columns, now called C and D, that will hold the last and first names.

Payroll

Date Modified:
Time Modified:
Current Date:
Current Time:

ID Name Sex
4470881 Anderson, Amanda R F

2. Type Last Name in C8 and First Name in D8.
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3. In C9, type Anderson. This is the last name of the first person on the list.
Click the Enter checkbox to accept the typing and remain in cell C9.

4. With C9 still selected, on the Home tab, in the Editing group, [ '« |
click Fill, and select Flash Fill. The last names are filled in € Undo Flash Fil
column C. If a small icon appears, click its arrow and click Accept suggestions
Accept suggestions.

5. In D9, type Amanda. This is the first name of the first person on the list.
Click the Enter checkbox to accept the typing and remain in cell D9.

6. With D9 still selected, on the Home tab, in the Editing group, click Fill, and
select Flash Fill. The first names are filled in column D. Click Accept
suggestions, if necessary.

7. You no longer need the Name column so select the entire column (click the
column letter B), right-click, and select Delete. The columns to the right are
shifted left so now Sex is in column D, Pay Rate is in column E and so on. *?

8. AutoFit columns A:E.

e. In G9, enter a formula to calculate the regular pay for Anderson. You can use
the IF function to do that. The IF function chooses between two alternatives. In
this case, the alternatives are two different ways of calculating regular pay,
depending on the hours worked.

Here is the logic you need to use:

¢ |If she worked 40 hours or less (F9<=40) then the regular pay is computed by
multiplying rate and hours (E9*F9).

¢ |f she worked over 40 hours, then she worked 40 regular hours. In that case,
the regular pay is the product of rate and 40 (E9*40).

1. Type your formula in G9.

display if display if
logical test condition condition
(condition) TRUE FALSE

=IF( F9<=40 , E9*F9 , E9*40 )
are hours pay rate pay rate

40 or less? times times
hours 40

So, the formula is =IF(F9<=40,E9*F9,E9*40)

2. Tap Enter and check the result. Since Anderson worked 21 hours her
regular pay will be her Pay Rate times her Total Hours, 6*21 = 126.

3. Fill the formula in G9 down to row 28 and preserve the format.

12 Flash Fill can also work in reverse. For example, if you were to click cell L9, type Amanda
Anderson, tap Enter, and then select Flash Fill, the rest of the names would be filled in
(Christopher Bastian-Smith Ill, EImer Gary Bell, and so on. Don’t do this!
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4. Check the result for Bell, in G11. He worked 50 hours, which is 40
regular hours and 10 overtime hours. So, his regular pay will be his
Pay Rate times 40, 3*40 = 120.

f. In H9, enter a formula to calculate the overtime pay for Anderson.

+ If Anderson worked 40 hours or less (F9<=40) then her overtime pay is 0
(she has not worked overtime so her overtime pay is 0).

+ If Anderson worked over 40 hours, then her overtime pay is computed by
multiplying the rate times 1.5 (for time and a half) times the number of
overtime hours worked. Here, the overtime hours will be the total hours minus
40. Remember to use parentheses where appropriate because you want the
computer to do the subtraction of the hours before it multiplies by the rate.

1. Type your formula in H9.

display if display if
logical test condition condition
(condition) TRUE FALSE
=IF( F9<=40 , 0 , E9*1.5*(F9 - 40))
are hours no pay rate times 1.5

40 or less? overtime times hours over 40

So, the formula is =IF(F9<=40,0,E9*1.5*(F9-40))

2. Tap Enter and check the result. Anderson worked 21 hours so her
overtime pay will be 0.

3. Fill the formula in H9 down to row 28 and preserve the format.

4. Check the result for Bell, in H11. He worked 50 hours, which is 40 regular
hours and 10 overtime hours. So, his overtime pay will be his Pay Rate
times 1.5 times 10, 3*1.5*10 = 45.

g. In 19 (that is eye nine not 19) enter a formula that will add the regular and
overtime pay for Anderson. Enter the same formula in J9. You will see why
later. Fill the formulas in 19:J9 down to row 28 and preserve the format.

h. Improve the “look” of the numbers in G9:J28 by doing the following:

1. Select G9:J28 and, on the Home tab, in the Number group. click the
Increase Decimal button | 3 | twice to show cents.

2. Select G9:J28, right-click any cell, and Text alignment
choose Format cells. On the Alignment Horizontak
tab, under Text alignment, Horizontal, —
change Indent from 0 to 2. Right (Indent) | Indent:
3. Click OK. This looks nicer. Vertical: 2
& H | J
Regular Pay | Overtime Pay Total Pay Total Pay
$126.00 $0.00 $126.00 $126.00
$140.00 $0.00 $140.00 $140.00
$120.00 $45.00 $165.00 $165.00
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I. Insert a rank indicator to show the rankings for Total Pay.

1.

In K9 type =rank($i9,$i$9:$i$28) and tap Enter. This calculates
Anderson’s rank in terms of total pay. The RANK function compares the
value in 19 (Anderson’s Total Pay) with the values in 19:128 and displays
her rank (1, 2, 3, etc.).

Note the use of dollar signs, which indicate absolute references:

e The $ to the left of i says to NOT change the column indicator, i, when
the formula is copied left or right. This is an absolute reference.

e There is no $ to the left of the first 9 because when you fill the formula
down you want this 9 to change to 10, and then to 11, and then to 12, so
on. This is a relative reference.

e The $ to the left of the second 9 and the 28 (in the range $i$9:$i$28)
says to keep those row numbers the same when the formula is filled
down. That will keep the range the same for all rows.

Fill the formula in K9 down to K28 and preserve the format. The ranks
range from 1, highest pay (in 124), to 20, lowest pay (in 126).

Use a conditional format to highlight duplicate Pay Ranks. Since you want
to format the ranks, select the range K9:K28. On the Home tab, in the
Styles group, click Conditional Formatting, select Highlight Cells Rules,
and select Duplicate Values. Click OK. Notice that Bostrom and Francis
both made $80 so they are tied for 17t" place. Hence, there is no rank 18.

Use a conditional format to make a bar graph of the Total Pay. Since you
want the format to be on the Total Pay cells, select the range J9:J28. Then,
on the Home tab, in the Styles group, click Conditional Formatting, select
Data Bars, and select the green Gradient Fill icon.

I Gradient Fill Total Pay
[ Data Bars > $126.00

$140.00

$165.00
This provides a visual representation of the relation between the
Total Pay values of the employees.

Having the numbers and the data bars in the same cell sometimes makes the
numbers difficult to read. To have only the data bars show in column J do the
following:

5.

Select the range J9:J28 again. On the Home tab, in the Styles group, click
Conditional Formatting, Manage Rules.

Double-click the Data Bar rule to open its dialog box.

Under Edit the Rule Description, click the box next to Show Bar Only.

Edit the Rule Description:

Format all cells based on their values:
Format Style: pata Bar v iShow Bar Only




SG70 PROJECT 3 EXCEL CHAPTER 2: FUNCTIONS, TABLES AND LARGE WORKBOOKS
8. Under Bar Appearance, choose Solid | | J
Border and black for the Color. Total Pay Total Pay
, ) , $126.00 |
9. Click OK. Then, click OK again. Now, the $140.00 |
Total Pay numbers are in column | and $165.00 |
the Data Bars are in column J. $92.00 | |

J- In order to make some formulas easier to read and understand, Excel allows
users to create what are called named ranges. To see how helpful this can be,
do the following:

1. Select cells D9:D28. In the name box, type Sex. h‘”‘ I x vk |

Tap Enter. Now, anytime you want to use that range in a formula, you can
use its name rather than the cell references.

Names must begin with a letter. They cannot contain spaces but can
contain the underscore.

In the same way, create the following named ranges:

E9:E28 PayRate
F9:F28 TotalHours
H9:H28 OvertimePay
19:128  TotalPay

To see a list of your named ranges, on the Formulas tab, in the Defined
Names group, click Name Manager.

Mac: Formulas, Defined Names, Define Name arrow, Define Name...

Mame Manager

MNew... Edit... Delete
Mame Value Refers To Scope
::EéDvertimePa}' {"$0.00""$75.00":"$0.0... ='Payroll Data'!$H$2:%... Workbook
@PayRa‘ce {"g""g" 4" 34 .. ='Payroll Data''$E§3:%... Workbook
@Sex PRSI L, ='Payroll Data'l $D$9:5..  Workbook
@TotalHours 21"rs0n35" 50" 2., ='Payroll Data"! $F$9:5... Workbook
@Totalpay {"$126.00""$275.00""... ='Payroll Data" $139:51.. Workbook

If you want to change a name, select it and click Edit.
If you want to delete a name, select it and click Delete.

Mac: To delete a name, select it and click the minus sign inside a box.| -
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4. Click Close. You can also see your named ranges by clicking the arrow in

the name box.
Al
OvertimePay
PayRate

Sex
TotalHours
TotalPay

Selecting a name will select the cells in that range.

k. In J3, insert a function that will display the number of people who earned

overtime pay. Since you are looking for a number of things, use COUNTIF.

The form for COUNTIF is =COUNTIF(range, criteria) The range is “where to
look” and the criteria is “what to look for”. Be sure to put the criteria inside
quotation marks: You can write the formula in two different ways:

=COUNTIF(H9:H28,">0") Uses cell references

=COUNTIF(OvertimePay,">0") Uses the named range for Overtime Pay.

As you can see, using a named range makes the formula easier to read and

understand.

[. In J4, insert a function that will display the number of women who earned
overtime pay. To count cells based on multiple criteria (here, sex and overtime
pay), use the COUNTIFS function. It has the form:

where to look where to look
—_— what to look for —_— what to look for
criteria1 — criteria 2 —
=COUNTIFS( , criteria1 , criteria2 |,...)
range — range —_—
—_— Women —_— over 40
range that range that
has sex has hours

It is basically the COUNTIF function with two or more ranges and corresponding
criteria (hence the S in COUNTIFS). Again, remember to put the criteria inside
quotation marks, as in "=F".13

. In J5, insert a SUMIFS function that will display the sum of the Total Pay for
people who worked overtime. Remember, the form for SUMIFS is
SUMIFS(sum_range, criteria_range1, criteria1, ...) Here, there is only 1
criterion. Be sure to put the criteria inside quotation marks. 14

13 =COUNTIFS(D9:D28,"=F",F9:F28,">40") or =COUNTIFS(Sex,"=F",TotalHours,">40")
14 =SUMIFS(19:128,H9:H28,">0") or =SUMIFS(TotalPay,OvertimePay,">0")



SG72

PROJECT 3 EXCEL CHAPTER 2: FUNCTIONS, TABLES AND LARGE WORKBOOKS

n. In J6, insert a function that will display the total hours for men whose pay rate is
under 5 dollars. To sum cells based on multiple criteria (here, sex and pay rate),
use the SUMIFS function again. It has the form:

where to look where to look
what to sum —_—— what to look for ~———— what to look for
—_—— criteria1 — criteria 2 —
=SUMIFS(sum range , y criteria1 y criteria2
total hours —_ Men _— under 5
range that range that

has sex has pay rate

sum range: Which cells do you want to sum? Total Hours (F9:F28).

criteria 1 range:

criteria 1:
criteria 2 range:

criteria 2:

Whose Total Hours do you want to include?
Those of Men, so use the Sex in D9:D28

What should the Sex be? M, so use "=M"

What kind of men do you want to include?
Those who have a certain Pay Rate, which is in E9:E28

What should the Pay Rate be? Under 5, so use "<5" 15

0. Create a conditional format so that the data of the people who worked overtime
has Bold Red text and a Yellow cell fill by doing the following:

1. You want to apply the formatting to the data, so select A9:K28.

2. Onthe Home tab, in the Styles group, click Conditional Formatting and
select Manage Rules.

3. Click

2| New Rule...

Mac: Click the plus sign inside a box| +

in lower left corner. From Style select Classic.

4. Click the last bullet, Use a formula...

5. Type this into the formula box: =$f9>40 This says to see if the value in F9
(Total Hours for Anderson) is greater than 40. If it is, apply a special
format to the selected cells (A9:K28); otherwise, leave the cells alone.

6. Click Format. Set the font to Bold Red and the fill to Yellow.

7. Click OK twice.

Rule (applied in order shown)

Formula: =$F9>40

Format

AaBbCcYyZz

Applies to

=$A39:5K528

Notice that the formula =F9>40 looks like it will only evaluate Anderson's
pay. However, under Applies to the range for this conditional format is
$A$9: 3K $28 so Excel will use =F10>40 for Bastian-Smith, and =F11>40
for Bell, and so on. That is because you selected $A$9:$K$28 before you
created the conditional format.

8. Click OK to return to edit mode. The format is applied to the data of the
seven people who have worked overtime (this matches the value in J3).

15 =SUMIFS(F9:F28,D09:D28,"M" ,E9:E28,"<5") or =SUMIFS(TotalHours,Sex,"=M" ,PayRate,"<5")
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p. Excel stores dates and times as whole numbers representing the number of
days since 1900-Jan-0, plus a fractional portion of a 24-hour day. This is called
a serial date, or serial date-time. For example, 18 June 2021 at 8:35 am is
stored as 44365.3576388889.

Be careful if you switch between Windows and Mac because, for historical
reasons, older Macs use 1904 for its starting year rather than 1900. If you
change the date system for a workbook that already contains dates, the dates
will shift by four years and one day (1462 days taking Leap Years into account).
So, if you switch from one computer to another be sure to check that the dates
are correct.

In Windows, if you want to change your dates to the 1904 version use File,
Options, Advanced, When calculating this workbook and check the box
next to Use 1904 date system. This is NOT recommended. 6

Mac: Excel menu, Preferences, Formulas and Lists, Calculation.

Enter the date and time and apply custom formatting by doing the following:

1. Click B3 and enter the current date. You can either type the date or tap
Ctrl +; (that is, hold down the Ctrl key and tap the semicolon key) and
then tap Enter. This is a static date, which means that it will stay at that
value until you enter in a new one.

2. Click B4 and enter the current time. You can either type the time or tap
Shift + Ctrl + : (that is, hold down both the Shift key and the Ctrl key and
tap the colon key) and then tap Enter. This is a static time, which means
that it will stay at that value until you type in a new one.

3. Click B5, type =now/() and tap Enter. Note the parentheses () with nothing
inside them! This enters the current date and time and it will automatically
change each time Excel recalculates any formula. Excel also has a DATE
function, but that does not display the date! DATE displays a number that
Excel uses to internally keep track of time. It is not very useful unless you
are a programmer.

4. Click B6, type =now() and tap Enter again. You get the same result as in B5.

5. Select cells B3 and B5. To select non-adjacent cells, click the first cell,
then hold down the Ctrl key and click the second cell. With the two cells
selected, right-click, and select Format Cells.

6. Click the Number tab and click Custom. 17

7. Replace the text in the Type: box with ddd d mmm yyyy. This tells
Excel to display the date using the day of the week (ddd), the date (d),
the month (mmm), and the four-digit year (yyyy).

16 For more information see https://support.microsoft.com/en-us/help/214330/differences-between-
the-1900-and-the-1904-date-system-in-excel
17 For more information on custom formatting, see https://www.youtube.com/watch?v=tGY70sdpalc



https://support.microsoft.com/en-us/help/214330/differences-between-the-1900-and-the-1904-date-system-in-excel
https://support.microsoft.com/en-us/help/214330/differences-between-the-1900-and-the-1904-date-system-in-excel
https://www.youtube.com/watch?v=tGY70sdpaLc
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10.

11.

12.

13.

14.

Click OK. If you see ####### in the cell it means the column is too narrow.
Make the column wider if necessary.

Select cells B4 and B6 and follow the same procedure except replace the
text in the Type: box with h:mm am/pm and tap Enter. The h tells Excel to
display the hour, mm tells Excel to display the minutes, and am/pm tells
Excel to display either AM or PM, depending on whether the current time is
before noon or after noon. Notice that the times in
the two cells are different. Cell B4 displays the time
when you tapped Shift + Ctrl + : while B6 displays
the current time (it was just updated when you
tapped Enter).

Select A3:B6. Place a heavy border
around the outside and a light border
between the rows.

Time Modified: 2:01 PM
Current Date: Fri 18 Jun 2021
B Current Time: 6:08 PM

2
<™ Date Modified: Fri 18 Jun 2021
4
5

Now, create some other custom formats.
Click J3, right-click, and select Format
Cells. On the Number tab, click Custom. Replace the text in the Type:
box with #* people" )

# tells Excel to display the number without decimal places,
" people" says to display the word people,

_) says to leave one blank space on the right (so this will line up nicely
with the accounting format that will be in J5).

Click OK.

Click J4 and follow the same procedure except replace the text in the
Type: box with #' women" )

Click J5, right-click, and select Format Cells. On the Number tab, click
Accounting. Be sure two decimal places and the $ show. Click OK.

For historical reasons, the Accounting style places the $ on the left edge
of the cell whereas the Currency style places it against the number. Also,
the Accounting style places a blank space to the right of the number.

Accounting:|$  1,597.50|  Currency:| $1,597.50)

Click J6 and follow the same procedure except replace the text in the
Type: box with #" hours" )

£} Date Modified: Fri 18 Jun 2021 Number of people who earned overtime pay = 7 people
L3 Time Modified: 2:01 PM Number of women who earned overtime pay = 8
=8 Current Date: Fri 18 Jun 2021 Sum of Total Pay for people who worked overtime = § 1,5697.50
el Current Time: 2:22 PM Total hours for men whose pay rate is under $5 = | 130 hours
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g. Excel allows you to change the font characteristics of text within a cell. Try this:
1. Double-click Al to enter edit mode.

2. Select the four letters roll in the word Payroll.

3. On the Home tab, in the Font group, click the launch dialog button |[x
(lower right corner of the Font group).

Mac: Tap Command + 1 to open Format Cells, Font.

4. Put a check in the box next to Subscript,

make the color red, and the font Arial Black. 1

5. Click OK and then tap Enter.

r. Follow a similar procedure make the following changes:
In 13, make the word people bold and purple.
In 14, make the word women bold and red.
In 16, make the word men bold and blue.

s. Note that the time in B4 is the same as it was when you tapped Shift + Ctrl +:
but the time in B6 is the current time because you just made a change to 16 and
so Excel did a recalculation of all cells. If you open this file tomorrow, the date
in B3 will be today’s but the date in B5 will be tomorrow’s.

t. Set it up the Payroll Data worksheet to print in Landscape orientation, all on one
page, centered horizontally but not vertically, and include a footer that contains
the file name on the left and the sheet name on the right. Compare the preview
with the key. Make needed corrections, save the workbook and close it.

u. Copy the Payroll Data worksheet and name the new worksheet Payroll Formulas.

v. Display the formulas (Formulas, Formula Auditing, Show Formulas) and
Autofit the columns. Then, change the width of column | to 6.

Note that cell B3 has the number Excel
uses for dates (in my case, 44365) and
cell B4 has the number Excel uses for
time (in my case, 0.584027777777778).
However, cells B5 and B6 show the
NOW formula, which calculates the
current date and time.

Payroll

1
2
53 Date Modified: 44365

3 Time Modified: 0.584027777777778
5

6

7

Current Date: =NOW()
Current Time: =NOW()

w. Set up the Payroll IF Payroll Formulas worksheet to print in Landscape
orientation, all on one page, centered horizontally but not vertically, and with
left and right margins set to 0.5. Include a footer that contains the file name
on the left and the sheet name on the right, and without gridlines but with row
and column headings showing. Compare the preview with the key. Make
needed corrections, save the workbook, and close it.
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Step 4 Submit Now, do the following to create your pdf files. Each file should
contain only one worksheet on a single page. Do NOT submit
multiple worksheets or pages in a single pdf. Check the key on
page SG402.

Use these names for the pdf files:

HWO03-1 HWID 2A Tree Inventory Done

HWO03-2 HWID 2B Weekly Sales Done (Summary) — This is the Summary worksheet
HWO03-3 HWID 2G Inventory Done (Bulbs) — This is the Bulbs worksheet

HWO03-3 HWID 2G Inventory Done (Summary) — This is the Summary worksheet
HWO03-4 HWID Payroll IF Done

Create a pdf file of the output for each of the above, place them in a folder
called HWO03 HWID LastName, FirstName, zip the folder and, by the due date,
submit it to the Canvas folder HWO03 Excel Chapter 2: Functions, Tables, and

Large Workbooks.

Step 5 Backup Now would be a good time to backup your files.



Project 4
Excel Chapter 3: Analyzing Data with Charts and

What-If Tools

Step 1 Read Read the introductory material on page 459 in the textbook.

Step 2 Activities Turn on the computer and do the following:

Project 3A: Start at the top of page 461.

Instead of Activity 3.01 step 1 do the following:

1.

Navigate to your Excel Files folder and open eO3A_Enterprise_Fund,
which is one of the files you downloaded at the start of the term.

Save the file in your Excel Files folder using the name
Lastname_Firstname_3A_Enterprise_Fund

Complete the rest of the Activities through step 8 on page 473. Do NOT do
steps 9 and 10 in Activity 3.11 on page 473.

Return here when you have completed Project 3A on page 473.

|‘ Do NOT do GO! With Google Sheets

Project 3B: When you have completed Project 3A, start at the top of page 476.

Instead of Activity 3.13 step 1 do the following:

1.

Navigate to your Excel Files folder and open e03B_Tourism, which is one
of the files you downloaded at the start of the term.

Save the file in your Excel Files folder using the name
Lastname_Firstname_3B_Tourism.

Complete the rest of the Activities through step 10 on page 494. Do NOT
do steps 11 and 12 in Activity 3.22 on page 494.

Return here when you have completed Project 3B on page 494.

|‘ Do NOT do GO! With Google Sheets or GO! To Work

Step 3 Homework After you have completed Projects A and B return here, do
the following additional activities, and turn them in for grading.

— SG77 —
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HWO04-1 Enterprise Fund (Based on Project 3A)

Problem: How can you visually display the relationship between expenditures for
an enterprise?

a. Open the workbook Lastname_Firstname_3A_ Enterprise_Fund, which you
created while following the directions in the textbook and saved on page 473.

b. Save the workbook to the Excel Files folder using the name
HWO04-1 HWID 3A Enterprise Fund Done

c. Set up the Expenditures Chart to print in Landscape orientation and include a
footer that contains the file name on the left and the sheet name on the right.
Compare the preview with the key. Make needed corrections, save the
workbook and close it.

HWO04-2 Tourism Spending Projection (Based on Project 3B)

Problem: How can you make data-based predictions concerning tourism at a
resort?

a. Open the workbook Lastname_Firstname_3B_Tourism, which you created
while following the directions in the text and saved on page 494.

b. Save the workbook to the Excel Files folder using the name
HWO04-2 HWID 3B Tourism Done

c. Click the Expenditures tab. The background picture makes the chart more
interesting and visually pleasing, but it may detract from clearly seeing the data.
That is a problem with being cute; it sometimes makes it more difficult to see
that which is important. Adjust the transparency of the chart by doing the
following:

1. Click anywhere in the chart.

2. On the Chart Format tab, in the Current Selection group, click the arrow
and select Chart Area.

3. Click Format Selection to open the Format Chart Area pane.

Mac: On the Format tab, in the Format group, click Format Pane. If you have a

small screen, you may have to click the double chevron |chart Design > O Tell m

to the right of the Chart Design tab to see the

Format tab. Click Format Pane.

4. Click the paint bucket to show the Fill & Line choices.
5. Click the Fill arrow to show its options.

6. Make the Transparency 30%. Now you can better see the information
on the chart. You still can see the picture, but it is not so overpowering.
Depending your printer, the transparency may not work correctly. If it
does not, don’t worry about it.
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d. On the Expenditures worksheet, click cell Al to be sure the chart is not
selected. Set up the worksheet to print in Portrait, all on one page, centered
horizontally but not vertically and include a footer that contains the file name
on the left and the sheet name on the right. Compare the preview with the key.
Make needed corrections, save the workbook, but do NOT close it.

e. On the Advertising worksheet, click cell Al to be sure no chart is not selected.
Set up the worksheet to print in Portrait orientation, all on one page, centered
horizontally but not vertically, and include a footer that contains the file name
on the left and the sheet name on the right. Compare the preview with the key.
Make needed corrections, save the workbook, and close it.

HWO04-3 HLOOKUP Gradebook

Problem: Given the total points earned by students in a course, how can you
assign the corresponding letter grades?

a. Open the workbook HW04-3 HLOOKUP Gradebook Original, which is one of
the files you downloaded at the start of the term.

b. Save the workbook to your Excel Files folder using the name
HWO04-3 HWID HLOOKUP Gradebook Done.

At the end of each semester, | assign letter grades based on the total number
of points students earned on homework and exams. Here is the table | use:

5 Total Points. [} 65 68 70 73 7 | 80 82 8 20 95
| Comment  Ouch! | Studylots! | Study! Fair Ok Not bad Fine Good | Pretty good | Very good | Great!

7 Grade F D D+ C- c | o+ s | B | B+ A- A

To assign a specific letter grade, | have Excel “look up” the total points in the
above table and then display the corresponding letter grade. For this, | use one
of Excel's LOOKUP functions.

The above table is horizontal, so | use the HLOOKUP function. If the table were
vertical, | would use VLOOKUP (see page SG85). The HLOOKUP function has
the following form:

need exact or
what to look for where to look row to display approximate match?

=HLOOKUP( lookup value , table array , row index num , range lookup )

total points range with number of row approximate
total points with letter grades match
and grades

* lookup value is the value to be found in the first row of the table. It can be a
value, a reference, or a text string. In this example it is the Total Points
earned. For example, Aanon’s total points is located in J12.

» table array is the range where the lookup value is to be looked up.
In this case, it is C5:M7.
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* row index number is the number of the row in the table | want displayed. In
this example, it is row 3. Note that this is NOT the worksheet row number,
which is 7. It is the row number within the range C5:M7.

* range lookup is an optional parameter that is either TRUE or FALSE.
It specifies whether you want Excel to find an exact (FALSE) match or an
approximate match (TRUE).

If you type TRUE or omit this parameter, then the values in the first row of the
table must be placed in ascending sort order. In that case, Excel will find an
approximate match. For example, if the lookup value (total points) is 79,
Excel will scan the first row of the table for 79. Since 79 is not listed, Excel will
use the next lowest number in the table (76) and display the corresponding
letter grade (C+). If the lookup value were 80, Excel would display B-.

If you type FALSE, then the values in the first row of the table may be in any
order. In that case, Excel will look for an exact match. If no exact match exists
Excel will display #N/A. In this example, Aaron’s total of 79 is not in the table so
Excel would display the error message.

1. Click K12 and type =hlookup(

A ScreenTip will appear to remind you of the form of the function.

Total Grade Comment
79 _\_| =hlookup(

HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup])

2. Finish by typing j12,$c$5:$m$7,3)

Your complete formula should be =hlookup(j12,$c$5:$m$7,3) Note the
absolute references (the dollar signs) in $c$5:$m$7. You need the dollar
signs so that when you copy the formula for the other students the location
of the table will remain constant.

3. Click the Enter checkbox. The grade C+ appears in K12 and the formula
appears in the Formula Bar.

A

1

2 Course: Math 1051 Cutoff on Diagnostic Test -> 65

3 Instructor: Robertson Cutoff on Total Points Earned -> 65

4 Num Stu with Diag Below Cutoff and Total At Least Cutoff ->

5 Total Points 0 65 ! 68 70 | 73 | 76 i 80 82 i 86 b0 i 95

6 Comment Ouch!  Studylots!  Study! | Farr Ok | Notbad Fine | Good Pretty good | Verjgood |  Great!

7 | Grade F oD or c- c | cr | B- | BB+ k. A

8 Num Stu |

9

) VLOOKUR XLOOKUP
AN |Name ) ) . Attend HW  Diagnostic|  Ex1 Ex2 ~ Ex3 | Final Ex _Total Grade Comgment | Grade |
il |Aanon, Natalie 80 90 99 56 94 74 74 79 C+

c. To make the worksheet easier to work with, split the screen by doing the
following:

1. Select row 17 (click the 17 row number).

2. Onthe View tab, in the Window group, click Split. This splits the screen
into two parts. The top shows rows 1 through 16. The bottom shows the
rest of the rows.
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3. Click B17. Tap Ctrl + Down Arrow. This will move the active cell to the last
non-blank cell in column B (Williams in B121). This same technique works
moving to the last non-blank cell on the right (Ctrl + Right Arrow) or on the
left (Ctrl + Left Arrow).

d. Copy the formula in K12 by doing the following:
1. Click K12 and tap Ctrl + C to copy the cell.

2. With K12 still active, hold down the Shift key and click cell K121.
This selects the range K12:K121.

3. Point to K12 again, right-click, and select Paste Options: Formulas (F)
(Mac: Paste Special, Formulas).

1 Cut

Em Copy
T}, Faste OptiNgis:

Duaffﬁ:ﬂ'

Paste Speci=!
Formulas (F)

L b

A second way of duplicating the formula is to use the Fill Handle. To do this,
you would point to the lower right corner of K12 and the fill handle (little black
cross) would appear. Click the little black cross and drag down to K121. If you
copy the formulas this way be sure to select Fill Without formatting from the
Auto Fill Options menu to preserve the heavy black border at the bottom
of K121.

= <€
@ Copy Cells

2 Fill Formatting COnly

& Fill Withgut Formatting (
2 Flash Fill

4. With K12:K121 still selected,
right-click and select Format
Cells. Click the Alignment tab. Text alignment
Under Horizontal, select Left
(Indent) and in the Indent box
enter 3. Click OK. The effect is to Left (Indent) ~ | Indent:
line up the letters on the left and
center the grade in each cell.

Number Mlgnment Font Bords
Horizontal:

Vertical: 3 =

e. For cell L12, create an HLOOKUP formula that will display the appropriate
comment from the table in cells C5:M7. The comment should be based on the
Total in column J. It will look very similar to the formulas in column K. In fact,
the only difference will be that the row index number will be 2 rather than 3.
Then, fill the formula down to cell L121, preserving the format.
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f. Microsoft has introduced a new function called XLOOKUP that is designed to
replace VLOOKUP, HLOOKUP, and LOOKUP. Unfortunately, older versions of
Excel do not have this function. That is why | used the HLOOKUP function
above. If your version of Excel has XLOOKUP, then do the following; otherwise
skip this part, f, and leave M12:M121 blank.

The XLOOKUP function has the following form:
=XLOOKUP(lookup_value, lookup_array, return_array, [if_not_found],

[match _mode], [search_mode])

* lookup value is the value to search for. In this example it is the Total Points
earned. For example, Aanon’s total points is located in J12.

* lookup array is the range where the lookup value is to be found. In this
case, it is the total points in C5:M7.

+ return array is the range that contains the values you want to return. In this
case it is the comment in C6:M6.

The following three parameters are enclosed in square brackets, which means
they are optional:

« [if not found] is what to display if the lookup value is not found. If it is not
included and the lookup value is not found the #N/A error is displayed.

« [match mode] specifies how to do the match. It can have one of four values:

0 means Excel will look for an exact match. This is the default.

-1 means if there is no exact match; Excel will return the next smaller item.

1 means if there is no exact match; Excel will return the next larger item.

2 means the lookup value contains the *, ?, or ~ wildcard. See page SG140
for an example that uses wildcards.

» [search mode] specifies how to do the match.
1 means to start the search at the first item. This is the default.
-1 means to do a reverse search starting at the last item.

So, the formula should look like this:

what where what text to display exact or
to look for to look to display if not found approximate
match? order
looku looku return range
=XLOOKUP( P, P, , g » 01,12 , 1,1 )
value array array lookup — —_
— — return next start at
total points range with range with Not found smaller item firstitem
J12 total points letter grades -1 1

$CH5:5M$5 $CH6:5M$6
Two of the last three parameters are optional. If you leave them off the default
values will be used. So, both of these formulas work:
=XLOOKUP(J12,$C$5:3M$5,$C$6:$M$6," Not found",-1,1)
=XLOOKUP(J12,$C$5:3M$5,$C$6:$M$6,,-1)

Enter either formula and then fill down, preserving the format. The text in
column M should match the text in column L.
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g. In C8, enter a formula that will display the number of students that earned the
grade in C7. Give it a try. You want to count the number of students who
earned the grade so you will use COUNTIF, which has the form:

where to look what to look for

=COUNTIF(criteria range, criteria )
%’_/

range that grade in C7

has grades

The criteria (letter grades) are located in row 7 so use a cell reference rather
than typing the criteria inside quotation marks. Be sure to use absolute
referencing where appropriate so you can duplicate the formula in D8:M8.18

Fill the C8 formula to M8.

h. At the start of my precalculus course, students take a diagnostic pretest to see
if they have the necessary high school algebra background. | want to know how
many students who scored below a certain cutoff on the diagnostic test also
scored above a certain cutoff in their final total points. In other words, | want to
know how badly a student can do on the pretest and still pass the course.

To do this, create a formula for J4 that will display the number of students with
diagnostic test scores below the diagnostic test cutoff score in J2 AND above
the total points cutoff score in J3.

You want to count the number of students who meet two criteria at the same
time so use the COUNTIFS function, which has the form:

where to look where to look

what to look for ———  what to look for

criteria1 criteria 2 —
=COUNTIFS( y, criteria1 |, y criteria2 )
range —_— range —_—
under diag test —_— over total pts
range that has cutoff score range that cutoff score
diag test scores inJ2 has total pts inJ3

criteria 1 range is the location of the diagnostic test scores, E12:E121
criteria 1 is under the value in J2

criteria 2 range is the location of the total points, J12:J121
criteria 2 is at least the value in J3

18 =COUNTIF($K$12:$K$121,C7)
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To use > or < with cell references for criteria you must put > or < inside quotation
marks and you must put an ampersand & to the left of the cell reference. Here is
the formula:

where to look what to look for| |(where tolook what to look for

=COUNTIFS( E12:E121 , "<"&J2 y| 912:d121 , ">="&J3 )

range that has under diag test range that over total pts
diag test scores cutoff score has total pts cutoff score
inJ2 inJ3
J4 = > v Jo | =COUNTIFS(E12:E121,"<"&J2,J12:J121,">="8&J3)

Cutoff on Diagnhostic Test -> 65
Cutoff on Total Points Earned -> 65
Num Stu with Diag Below Cutoff and Total At Least Cutoff ->| 1

You can see that out of 110 students only 1 who scored under 65 on the
diagnostic test was able to earn at least 65 for a total and pass the course. | have
to make a decision: Should | force students who score under 65 on the test to
drop to a lower course or should | only suggest that they do it, knowing that not
dropping would almost certainly be a time-wasting and money-wasting mistake.

On the Excel exam, | will not ask you to do something this complicated. | show it
here so you can see what Excel is capable of doing and maybe use it on the job.

i. Use Conditional Formatting to identify which students failed the diagnostic
test and still passed the course:

1. Select B12:B121 because that is where you want the formatting to display.

2. On the Home tab, in the Styles group, click Conditional Formatting, and
select New Rule.

Mac: From Style: select Classic.

3. Select Use a formula to determine which cells to format.

4. Because two criteria must be met, use the Boolean operator AND.
This returns true if BOTH criteria are met. In the Formula box, type
=and($e12<$j$2,$j12>=$j$3)

5. Click Format, Fill, and select purple. Click OK two times.

6. Select E12:E121 and repeat the process. You can save typing by copying
the formula you just entered and pasting it into the new Formula box.

7. Select J12:J121 and repeat the process.

8. Scroll down and you can see that Beth Earlywine just missed the
diagnostic cutoff by one point.

"7l |Earlywine, Beth 73 100 | 64 | 63 73 62 62 68 | D+

Looking at this result, should | change the cutoff or is it working OK?
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J. Remove the split screen (View, Split). Set the print area to A1:M21 (select
A1:M21, Page Layout, Print Area, Set Print Area).

Set up the Gradebook worksheet to print in Landscape orientation, all on one
page, centered horizontally but not vertically, and include a footer that
contains the file name on the left and the sheet name on the right. Compare
the preview with the key. Make needed corrections, save the workbook, and
close it.

HWO04-4 VLOOKUP Shipping

Problem: Given the item number or the weight of a product, how can you look up
the corresponding shipping cost?

The VLOOKUP function works the same way as the HLOOKUP function except the
table array is a vertical table rather than a horizontal table.

a. Open the workbook HW04-4 VLOOKUP Shipping Original, which is one of the
files you downloaded at the start of the term.

b. Save the workbook to your Excel Files folder using the name
HWO04-4 HWID VLOOKUP Shipping Done

c. For cells D11:D70, you want Excel to display the Shipping Cost for each Item
Number. The cost depends on the weight of the item. To do the calculation, you
can use the VLOOKUP function. It has the same form as HLOOKUP except H
is replaced by V and row is replaced by column.

need exact or
what to look for where to look column to display approximate match?

=VLOOKUP( lookup value , table array , columnindex num, range lookup )

weight range with number of column approximate
weights and with shipping costs match
shipping costs

1. Click D11 and type =vlookup( and a screen tip will appear:

|:vlunkup{ .I

VYLOOKUP(lookup_value, table_array, col_index_num, [range_lookup])
* lookup_value is what you want to find, which is the weight.
Type cl1, (be sure to type the comma).

» table_array is the vertical range where you want to look. It is the range
that contains the Weights and Shipping costs.

Type h11:i20, (be sure to type the comma).

* col_index_num is the number of the column in the table whose value
you want displayed.

Column H, which is Column 1 in the table, contains the Weights.

Column 1, which is Column 2 in the table, contains the corresponding
Shipping costs. This is what you want to display.
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Type 2, (be sure to type the comma). When you type the comma after 2
a screen tip provides the definition of TRUE and FALSE for the
[range_lookup].

=vlookup(c11,h11:120,2,

VLOOKUP(lookup_value, table =

(-.-) FALSE - Exact match

+ [range_lookup] tells Excel if you want an exact match or an
approximate match.

FALSE says to look for an exact match. If there is no exact match the
error message #N/A will be displayed. This is not what you want
because the weights in column C are in tenths of a pound and the
weights in column H are in whole pounds.

TRUE says that data in the first column of table_array (column H) are in
ascending order, which they are, and you want either an exact
match or an approximate match. If an exact match is found, great; if
not then Excel settles for the next lowest value. The weight in C11 is
7.5 so Excel would choose the Shipping Cost for 7.0 (the next value
below 7.5). This is what you want.

Type true) The formula is =vlookup(c11,h11:i20,2)
Click the Enter checkbox. The cost is $30.60.

2. You are going to fill this formula down to row 70 so you must figure out if
you need absolute referencing (the $) and, if so, where to put them.

Put the $ in the proper places, click the Enter checkbox, and then fill the
D11 formula down to D70, preserving the formatting. If you get an #N/A
error then go back and check your $. The range H11:120 must be the same
for all rows so that needs the $.

D11 © > « fk | =VLOOKUP(C11,$H$11:$1$20,2, TRUE)
. B D
9 VLOOKUP XLOOKUP : Round up
0 Item Number Weight (Ibs) Cost Cost Cost
44537 7.5 $30.60 If you do If you do

For this example, if a weight is between two whole numbers, then the
Shipping Cost for the lower weight is used. Thus, a weight of 7.9 would
use the Shipping Cost for 7.0. However, the shipper might want to charge
the higher weight in order to fully cover the cost of shipping. To do that, you
need to use XLOOKUP, which you will do in the next section.
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d. Use XLOOKUP instead of VLOOKUP to find the Shipping Costs. If your version
of Excel does not have XLOOKUP then leave E11:F70 blank. Otherwise,
construct an XLOOKUP function to calculate the shipping cost in E11.

1. Construct your formula:

what where what text to display exact or
to look for to look to display if not found approximate
match? order
looku looku return range
=XL°°KUP( P ’ d ’ ’ 9 » 051,12 , 1,1 )
value array array lookup —_— —
— —_— [ — N approx match start at
Weight range with range with Not found return next firstitem
C11 weights shipping costs smaller item
$HS$11:5H$20 S$I$11:51$20 -1

2. Enter the formula in E11. Remember, as you type Excel will show a screen
tip to remind you of the values of the match_mode and the search_mode.
For example,

=XLOOKUP(C11,$H$11:$H$20,$1$11:51$20,"Not found",)

XLOOKUP({lookup_value, lookup_array, return_array, [if not_found], [match madal Icoz
B O - Exact match

(
(++-)-1 - Exact match or next smaller item
(++:)1 - Exact match or next larger item
(-+.)2 - Wildcard character match

3. Fill down to E70, preserving the format. The costs in columns D and E
should match.

e. In F11:F70, use XLOOKUP to find the shipping costs but this time return the next
larger cost. The only difference between this formula and the previous one is
that the match_mode should be 1 rather than -1.

Enter your formula and then fill down, preserving the format. Notice F12 shows
Not found. That is because the weight, 9.9 Ibs, is higher than the highest entry in
the Weight/Cost Table and so Excel cannot return the next larger cost because
there is none. The shipper will have to make some adjustments to fix this
problem.

f. In H4, insert a function that will display the total weight and total shipping cost
of all the items, as well as text that gives meaning to the numbers. It should
look like this:

Total weight is 329.5 Ibs and total shipping cost is $1,555.60

To display this, you need a formula that contains four separate parts that are
joined together end to end. Computer programmers refer to this type of joining
as CONCATENATION. Here are the four parts:
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Total weight is 329.5 Ibs and total shipping costis $1,555.60

Text1 Calculation 1 Text 2 Calculation 2

Text 1 will go inside quotation marks: "Total weight is "
Calculation 1 finds the sum of all the weights: SUM(C11:C70)

Text 2 will go inside quotation marks: " Ibs and total shipping costis "
Calculation 2 finds the sum of all the shipping costs: SUM(D11:D70)

To join these four pieces into one formula you can use the ampersand, &,
between the pieces as follows:

1. Type the following formula into H4 and click the Enter checkbox.

="Total weight is "&SUM(C11:C70)&" Ibs and total shipping cost is "&SUM(D11:D70)

This displays the text between quotation marks Total weight is
then it displays the SUM of C11 through C70
then it displays the text between quotation marks |bs and total shipping cost is
then it displays the SUM of D11 through D70

|

EE

2

3 Calculate Shipping Cost | Calculate Shipping Cost Summary

4 Given Item Number Given Item Weight Total weight is 329.5 Ibs and total shipping cost is 1555.6

2. The formula in H4 displays the cost as 1555.6. This is the correct value, but
it should be in currency style as in $1,555.60. To do that you can use the
TEXT function. It has the form:

=TEXT(value, format)
* value is a number or cell reference.

« format is the way you want the value to be displayed. This part must go
inside quotes. For example, use

"m/d/yyyy" to display 12/31/2021
"ddd d mmm yyyy" to display Tue 31 Dec 2021
"$# ###.00" to display $1,555.60

* The number you want to display is calculated by SUM(D11:D70) so that
will be the value in the TEXT function. The format you want is currency
so "$# ###.00" will be the format.

* Modify the formula in H4 by putting SUM(D11:D70) inside the TEXT
function. Click the Enter check to see the result:

Calculate Shipping Cost | Calculate Shipping Cost Summary
Given Item Number Given Item Weight Total weight is 329.5 Ibs and total shipping cost is $1,555.60
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g. Enter a function in H5 that will display the ltem Number of the item with the
highest weight. The MAX function can be used to find the highest weight in
C11:C70. To find the Item Number you can use the VLOOKUP function.
Unfortunately, Item Number is to the left of Weight in the table so VLOOKUP
cannot be used directly. To get around this, create a “scratch area” where
Weight is to the left of tem Number. Do the following:

1. In K9, type Scratch Area and merge and center it across K9:M9.

2. In K10 type Weight, in L10 type Item Number, and in M10 type Shipping Cost
3. In K11, type =c11, in L11, type =b11l and in M11 type =d11
4. Fill the formulas in K11:M11 down to K70:M70. This creates a new table
where the Weight is to the left of the Item Number.
5. Format K11:K70 as numbers with one decimal point.
6. Format M11:M70 as currency with the dollar sign and two decimal places.
7. Center align columns K, L, and M.
8. To make the table easier to read, format it as shown below. To put in

borders, select the table, right-click, select Format cells, click the Boarders
tab, and apply the borders. There is a heavy border around the outside, a
light border on the inside, the table has a gray fill, and the titles are bold.

Scratch Area

Weight Item Number Shipping Cost
7.5 44537 $30.60
9.9 80680 $33.00
8.7 43913 $31.80

9. In H5, enter a VLOOKUP function that will display the Item Number of the
item with the highest Weight. Here is the structure:

need exact or
what to look for where to look column to display approximate match?

=VLOOKUP( lookup value , table array , column index num, range lookup )

highest weight range with number of column exact match
weights and with item numbers
item numbers

* lookup value is the highest Weight in K11:K70. Use MAX(k11:k70)

» table array is the range that contains Weights and Item Numbers in
the scratch area.

* column index num is the number of the column in the table whose
value you want displayed.

Column K, which is column 1 in the table, contains Weights
Column L, which is column 2 in the table, contains Item Numbers
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* range lookup is TRUE or FALSE. Make your choice by noting that the
Weights are not in ascending sort order and you want an exact match.

TRUE for approximate match
FALSE for exact match

10. Enter your formula and click the Enter checkbox.

=VLOOKUP(MAX(K11:K70),K11:L70,2, FALSE)

Total weight is 329.5 Ibs and total shipping cost is $1,555.60
80680 |

11. Use the Ampersand, &, to display the following text to the left of 80680:
Highest weight is for item number

When you tap Enter you may see #####H###, which indicates the value to
display will not fit entirely in H5. To fix that, select H5:M5 and, on the Home
tab, in the Alignment group, click Merge & Center, and then click the
Align Left button.

8 Total weight is 329.5 Ibs and total shipping cost is $1,555.60

;1 Highest weight is for item number 80680

h. If your version of Excel has XLOOKUP, enter the formula for highest weight in
H6. With XLOOKUP, you do not need the Scratch Area because XLOOKUP
can look either left or right.

="Highest weight is for item number "&
XLOOKUP(MAX(C11:C70),C11:C70,B11:B70,"Not found",0,1)

i. Enter a function in C7 that will display the Shipping Cost for an item whose
Item Number is entered in B7. You want to find (lookup) a number in a vertical
list, so VLOOKUP is a good choice. Excel does have a FIND function (see
page SG153) but that does not “find” items in a list, so do not use that.

Do the following:

1. Enter 43913 in B7. This is the Item Number whose Shipping Cost you seek.
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2. In C7, enter a formula that will display the Shipping Cost for the item
whose Item Number is in B7.

need exact or
what to look for where to look column to display approximate match?

=VLOOKUP( lookup value , table array , columnindex num, range lookup )

item number range with number of column exact match
item nums and with shipping costs
shipping costs

* lookup value is the Item Number in B7.

+ table array is the range that contains Item Numbers and Shipping
Costs. This is B11:D70.

e column index num is the number of the column in the table whose
value you want displayed.

Column B, which is Column 1 in the table, contains Item Numbers
Column C, which is Column 2 in the table, contains Weights
Column D, which is Column 3 in the table, contains Shipping Costs

* range lookup is TRUE or FALSE. The Item Numbers are not in
ascending sort order and you want an exact match.

TRUE for approximate match
FALSE for exact match

Since this formula will not be filled to other cells, you do not need the
absolute referencing $.

1 Shipping Cost Calculations

2

3 Calculate Shipping Cost | Calculate Shipping Cost

4 Given Item Number Given Iltem Weight

5 Choose Shipping Enter Shipping VL{
6 Item Number Cost Weight Cost XL{
7 43913 $31.80

Here is the XLOOKUP formula:

what where what text to display exact or
to look for to look to display if not found approximate
match? order
looku looku return range
=XLOOKUP( P P , %€ 01,12 , 1,1 )
value array array lookup —_— —_
e — exact match start at
Item Num range with range with Not found return next first item
B7 item nums ship costs smaller item 1

B11:B70 D11:D70 -1
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. Enter a function in E7 that will display the Shipping Cost for an item whose
Weight is entered in D7. Type 1.1 in D7 as a test value. Give it a try by
following the same process you did for the formula in C7.

need exact or
what to look for where to look column to display approximate match?

=VLOOKUP( lookup value , table array , columnindex num, range lookup )

weight range with number of column approximate match
D7 weights and with shipping costs True
shipping costs 2
H11:170

1 Shipping Cost Calculations

2

3 Calculate Shipping Cost | Calculate Shipping Cost

4 Given Item Number Given Item Weight

5 Choose Shipping Enter Shipping

6 Item Number Cost Weight Cost :j
7 43913 $31.80 1.1 $15.75

The weight in D7 is 1.1, which is between 1.0 (Shipping Cost is $15.75)
and 2.0 (Shipping Cost is $18.50). Excel chooses the lower weight so the
cost is $15.75.

Here is the XLOOKUP formula:

what where what text to display exact or
to look for to look to display if not found approximate
—_—— match? order
looku looku return range
=XLOOKUP( P P . %€ 0,112 , 1,1 )
value array array lookup —_— —_—
e — —_— — (R exact match start at
Item Num range with range with Not found return next firstitem
D7 item nums ship costs smaller item 1
H11:H70 111:170 -1

k. Misspelled words can be embarrassing. ° For example, a news headline read
“Floods from the Mississippi may be prevented by putting big dames in the
river.” Here is a road sign from South Bend Indiana:

3 =
5pubic: schog.ls.

19 Adapted from http://www.dummies.com/how-to/content/limit-data-entry-with-data-validation-in-
excel-201.html



http://www.dummies.com/how-to/content/limit-data-entry-with-data-validation-in-excel-201.html
http://www.dummies.com/how-to/content/limit-data-entry-with-data-validation-in-excel-201.html

PROJECT 4 EXCEL CHAPTER 3: ANALYZING DATA WITH CHARTS & WHAT-IF TooLs SG93

When you misspell a word in an email or letter the reader often can figure out
what you are trying to say from the context. Try reading this:

| cdnuolt blveiee taht | cluod aulaclty uesdnatnrd waht | was rdanieg.
The phaonmneal pweor of the hmuan mnid. Aoccdrnig to rscheearch
it deosn't mttaer in waht oredr the Itteers in a wrod are, the olny
iprmoatnt tihng is taht the frist and Isat Itteer be in the rghit pclae. The
rset can be a taotl mses and you can sitll raed it.

Just about every word is misspelled, but your amazing brain is able to fill in
what it needs to make sense of this from the context and your facility with
English.

However, if you enter a wrong number in Excel the user probably will not be
able to tell if it is wrong by looking at the context, and any analysis which uses
that number will be wrong. While you cannot completely prevent data entry
errors, Excel allows you to check some of the characteristics of data you enter
through its Data Validation feature. To see how this works, do the following:

1. Click B7, and then, on the Data tab, in the Data Tools group, click the
Data Validation arrow and select Data Validation. There are a lot of
choices that you can explore on your own.

2. Click the Settings tab and select List from the Allow menu.

3. For this project, Item Number must be one of the Settings | Input
numbers in the range B11:B70. So, in the Source box, |
type the range where the Item Numbers are listed. Validation criteria
That is type =$b$11:$b$70 (or select that range with Allow:

your mouse). _
List

4. Click the Input Message tab and in the Input message Data:
box type Select or type item number.

Data Validation
Source:

Settings Input Message  Error Alert =$B$11:5B570

Show input message when cell is selected

When cell is selected, show this input message:

Title:

Input message:

Select or type item number.

Now, when you click B7 the message will appear to remind you of what
type of data goes in B7.
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5.

8.

Click the Error Alert tab and, in the Error message box, type Item
Number not found. Now, if you enter an Item Number that is not on the
list of numbers in B11:B70 you will get an error message.

The default under Style is Stop. That means Excel will not allow a number
outside the range. If you change the Style to Warning Excel will display
the error message as a warning, but it will allow the value to be entered if
you wish.

Leave the Style as Stop and click OK. You will see the
Input message for cell B7.

Shipping Cost

To see how data validation works, click B7, type 1, and
tap Enter.

Calculate Shipp
Given Item N

Shipping Cost Calculation Choose 4
Item Number
Calculate Shipping Cost | C; 43913 -
Given Item Number Select or type

item number.

Choose Shipping
Item Number Cost
1 -] #NIA

Select or type
item number.

Microsoft Excel

8 Item Number not found.
Cancel Help

Here, you can click Retry or Cancel. Click Cancel.

When B7 is active, there will be an upside triangle just to the right of the
cell. This is a drop-down menu that can be used to select an ltem Number
rather than type it.

To see how the drop-down menu works, click the arrow, scroll up a bit, and
select 80680. The Shipping Cost in C7 will show $33.00.

|. Here is another type of validation rule. Set up things so that the weights entered
must be between 0 and 10 pounds. Give it a try. If you need help, do the
following:

1.

a kM 0D

Click D7, and then, on the Data tab, in the Data Tools group, click the
Data Validation arrow and select Data Validation.

Click the Settings tab. In Allow box and select Decimal.
In the Data box, select between.
In the Minimum box type 0.

In the Maximum box type 10.
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6. Click the Input Message tab. In the Input message box type
Enter decimal between 0 and 10.

7. Click the Error Alert tab and, in the Error message box, type
Weight must be a decimal between 0 and 10.

8. Inthe Style box confirm that Stop is selected.
9. Click OK.

10. To see how data validation works, click D7, type 11, and tap Enter. You
should see the error message.

11. Click Cancel.

If you want to find cells to which Data Validation has been applied, tap the F5
key to open the Go To dialog box, click the Special button, click the Data
Validation button, and click OK. Every cell that has Data Validation will be
highlighted (B7 and D7).

Go To Special ?
Select
O Comments O Row differences
O Caonstants O Column differences
O Formulas O Precedents
Mumbers O Dependents
Text Direct only
Logicals All levels
Errors O Last cell
O Blanks O Visible cells only
O Current region
D Current array
D Objects

If you want to get rid of Data Validation assigned to a particular cell range, first
select the range. Then, on the Data tab, in the Data Tools group, click the Data
Validation arrow and select Data Validation. Click the Clear All button and

then click OK. Do NOT do this now.

m. Set the Print Area to B1:M35 (Page Layout, Page Setup, Print Area, Set
Print Area). Set up the Shipping Costs worksheet to print in Landscape
orientation, all on one page, centered horizontally but not vertically, and
include a footer that contains the file name on the left and the sheet name on
the right. Compare the preview with the key. Make needed corrections, save
the workbook, and close it.
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HWO04-5 PivotTables

Problem: How can raw data be organized into meaningful reports that can reveal
patterns or trends?

A PivotTable is a table of statistics that summarizes the data of an Excel worksheet
or Access database. This summary might include sums, averages, or other
statistics, which the PivotTable groups together in meaningful ways. The PivotTable
allows you to arrange and rearrange ("pivot") the data in order to draw attention to

useful information.

For example, you might have data on family expenses like this:

A B

1-Jan Mom
2-Jan Mom
3-Jan Dad
4-Jan Dad
4-Jan Kelly

C 1o A

4N O R W N

(& D
Fuel S50
Groceries $120
Cafes $10
Fuel S40
Groceries $129

~o L can

Here, the variables or fields are in columns and the individual data are in rows.

With a few mouse clicks, the data can be summarized by creating a PivotTable like
this, which summarizes the amount spent by each family member:

A B
3 Row Labels ~ Sum of Amount
4 Dad $15,444
5 Kelly $28,160
6 Mom $26,373
7 Grand Total $69,977

A couple more mouse clicks and the data can be summarized in a more detailed
report that shows how much each person spent on each type of item:

11 Restaurants
12 |Grand Total

A B C
3 |Sum of Amount Column Labels ~
4 Row Labels |~ Dad Kelly
5 |Books $108 51,574
6 |Cafes S58 5179
7 |Entertainment $609 51,923
8 |Fuel 5882 $822
9 Groceries 58,722 513,734
10 Music $202 547

54,863 59,881
$15,444 $28,160

D

Mom
$309
5219

$3,207
5488
510,213

$11,937
$26,373

E

Grand Total
$1,991

5456

$5,739
52,192
$32,669
$249
526,681
$69,977
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Two more mouse clicks and the data can be “pivoted” to show the details by person:

A B C D E F G H |
3 Sum of Amount Column Labels -
4 Row Labels -~ Books Cafes Entertainment Fuel Groceries Music Restaurants Grand Total
5 Dad 5108 S58 S609 5882 $8,722 S202 54,863 515,444
6 Kelly $1,574 5179 $1,923 5822 513,734 547 59,881 $28,160
7 Mom $309 S$219 $3,207 5488 510,213 $11,937 526,373
8 Grand Total $1,991 $456 $5,739 $2,192 532,669 5249 $26,681 $69,977

One more mouse click, and a PivotChart of the data may be created:

Family Expenses

$13,734

$14,000

$11,93
$12,000 =

$10,213
$10,000

$8,722

= Books
Cafes

$8,000

u Entertainment

m Fuel

u Groceries

$6,000
? u Music

Restaurants

$4,000

$2,000

$0
Dad Kelly Mom

To see how to create PivotTables and PivotCharts, do the following:

a. Open the workbook HWO04-5 PivotTables Original, which is one of the files
you downloaded at the start of the term.

b. Save the workbook to your Excel Files folder using the name
HWO04-5 HWID PivotTables Done

c. The worksheet shows the call data to Fire and Police Departments for three

months.2?0
A B C D E
1 Fire/Police Month Loc Class N
2 Fire Jan  Station1 Medical 924
3 Fire Jan Station1 Fire 299
4
5 Fire Jan Station2 Medical 987

20 Based on Project 7 in Gaskin & Vargas. GO! with Microsoft Excel 2016 Comprehensive. New
York: Prentice Hall, 2017.
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For example, row 2 shows that 924 Medical calls were received from Fire
Station 1 during the month of January.

Your task is to organize the data in several different ways so that staffing and
resource decisions can be made. You will do this by “pivoting” or arranging the
information in different ways in order to see it from different perspectives. To
see how this works, do the following:

1. First, you need to make sure the data have clear column headings. In row 1,
change Loc to Location and N to Num.

2. The structure of the data must be consistent. So, for example, you must
remove blank columns (there are none for this worksheet) and blank rows.

+ Option 1 By Eye: One way to remove blank rows is to find them by eye
and, when you see a blank row such as row 4, select the entire row,
right-click, and select Delete. That will be time consuming for a large
data set so you will not do that. Instead, use Option 2 below.

« Option 2 By Sorting: A second way to remove blank rows is to sort the
data. To see how this works, do the following:

3. Select all the rows and, on the Home tab, in the Editing group, click Sort
& Filter and Custom Sort. Be sure the My data has headers box is
checked. Then, add four sort levels, one each for Fire/Police, Month,
Location, and Class.

Mac: Add Level, Delete Level, and Copy Level are in the lower left corner of the
Sort dialog box. They look like this:| + - Copy]|

Except for Month, set the sort Order to A to Z. For Month, you want the
data chronologically rather than alphabetically, so click its Order arrow,
select Custom List, and select Jan, Feb, Mar, Apr, ...

Sort ? X
+ Add Level X Delete Level Dagopy Level A Options... My data has headers
Column Sort On Order

Sort by Fire/Police v || Cell Values v | |AtoZ v

Then by | Month ~ | | Cell values v | |Jan, Feb, Mar, Apr, May, Jun, Jul, A v

Then by || ocation v | cell values v | |Atoz v

Then by | Class v | Cell values v | |Atoz v

Click OK.

4. Convert the data into a Table by selecting A1:E79 and, on the Insert tab,
in the Tables group, clicking Table and then OK.

1 Mlﬂ_

2 |Fire Jan Station 1 Fire
3 |Fire Jan Station 1 Medical 924
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5. Onthe TableTools Design tab, in the Properties group, in

the Table Name box, type RawData, and then

The reason you convert the data into a table is if you were to add data to
the blank rows under the table, the data would be added to the PivotTable

when it is refreshed (updated).

click OK. RawData

Table Name:

6. Click anywhere in the data and, on the Insert tab, in the Tables group, click

PivotTable. A dialog box will appear that shows the RawData table will be
used as the basis for the PivotTable. Under Choose where you want the

PivotTable report to be placed, be sure New
7. Click OK. Excel adds a new Sheetl.

8. Rename the worksheet Pivot.

worksheet is checked.

PivotTable Tools

Two new PivotTable Contextual tabs appear on the Ribbon. _

Analyze  Design

Mac: If you have a small screen, you may have to click the double chevron to the
right of the PivotTable Analyze tab to see the Design | pivotTable Analyze
tab, like you did working with charts on page SG42. [ Design |

. | B

Also, if you are working on a small screen, you may want to show or hide the

Ribbon by tapping Ctrl + F1 (Option + Command

On the right, the top part of the PivotTable Fields
pane lists the Field (column) headings from the
RawData table. This is called the Field section.

Just below this is the Layout section. This is where
you will place the fields that will form the PivotTable.

You may change the relative sizes of the Field and
Layout sections by pointing to the border between

them. A double headed arrow will appear. Left-click

and drag to change the sizes.
More Tables...
K

Drag fields between areas be;c:w:

+ R on the Mac).

(] Fire/Police

] Month i

[ Location Fleld_

[] Class Section
] Num

PivotTable Fields ~ %
Choose fields to add to report: @} =
Search ,C

Drag fields between areas below:

Filters Columns
Layout
Section

Rows Values

If you prefer, you can make the Field and Layout
sections side-by-side by clicking the Tools icon

and clicking Fields Section and Areas Section
Side-by-Side.
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d. Set up the PivotTable by doing the following:

1. Since you are interested in the number of calls, from the Values
Field section drag the Num field to the Values box in the
Layout section.

Sum of Num

It says Sum of Num because, by default, the sums of the numbers are
displayed. Later, you will see how other statistics, such as average, may be
displayed. Notice that a check appears next to Num in the Field area.

On the left, a small PivotTable appears. Right now, it only A
contains the total number of calls for all the Stations and
Precincts.

1
2
3 Sum of Num
4 101250

2. Drag the Fire/Police field down to the Rows box. The
PivotTable is modified to show the number of calls to Fire and the number
of calls to Police, as well as the total number of calls.

A B
1
2
3 |Row Labels| ~ Sum of Num
4 |Fire 10212
5 |Police 91038
6 |Grand Total 101250

3. Drag the Location field down so it is under the Fire/Police field in the

Rows box.
Rows Values
Fire/Police ¥ ||| Sum of Num
Location v

The PivotTable is modified to include the Locations of the calls.

A B C D E F [~ . .
1 PivotTable Fields
2
3 Row Labels | - Sum of Num Choose fields to add to report:
4 | =Fire 10212 Searct
5 Station 1 3524 e
? ga?on g ?g;g Fire/Police

ation

[N

8 Station 4 1911 o
9 | =Police - 91038 Drag fields between areas below:
10 Precinct 1 11909
11 Precinct 2 16222 Filters Columns
12 Precinct 3 15643
13 Precinct 4 16077
14 Precinct 5 15250
15 Precinct 6 15937 Rows Values
16 |Grand Total 101250
17 Fire/Police - | * | Sum of Num
18 Location ¥ |
19

Pivot | Raw Data :+: p , Defer Layout Update
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4. In the Layout section, in the Rows area, point to Fire/Police, hold down
the left mouse button, and then drag the field name upward into the Filters

box.
- - A B
Filters Filters 1 Fire/Police (Al -
Fire/Police Fire/Police e 2
' — 3 Row Labels ~ | Sum of Num
a 4 Precinct 1 11909
Rows Row 5 Precinct 2 16222
Bl 6 Precinct 3 15643
Fire/Police - Location - 7 Precinct4 16077
. 8 Precinctb 15250
Location hd 9 Precinct 6 15937
10 |Station 1 3524
. . - . 11 |Station 2 3515
On the left, the Fire/Police label is inserted into cell |1, o ion s 1260
Al, and the Precinct rows are moved above the 13 |Station 4 1911
Station rows (because P comes before S). 14 |Grand Total 101250
5. On the right, drag Class down so it is under Location.
On the left, a little =/ appears next to each Precinct and Station.
A B C D E F [« ) )
1 |Fire/Police  (All) - PivotTable Fields
2
3 |Row Labels | ~ | Sum of Num Choose fields to add to report:
4 | =Precinct 1 11909 Searct
5 Accidents 731 eardh
6 Crime 499 ¥ | UL
7 Sent 10679 Class
8 | =@ Precinct 2 16222
9 Accidents 586 Drag fields between areas below:
10 Crime 699
11 Sent 14937 Filters Columns
12 | @ Precinct 3 15643 Fire/Police v
13 Accidents 558
14 Crime 634
15 Sent 14451 Rows Values
16 | =@ Precinct 4 16077 T + =<1 sum of Num
17 Accidents 617 .
18 Crime 881 BE b
19 Sent 14579
Pivot Raw Data :+: < , Defer Layout Update

In cell A4, click the = next to Precinct 1. Class for that Location
disappears, and the =/ changes to a '+, indicating that there is more
information under that label.

A B

1 |Fire/Police (All) -
2

3 Row Labels -~ Sum of Num
4 | ®Precinct 1 11909
5 | =@ Precinct 2 16222
(3] Accidents 586
7 Crime 699
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6. Point to the = or &l of any location, right-click, point to Expand/Collapse,
and select Expand Entire Field. Now, the sub-data (Class) appear for all
Precincts and Stations again.

7. You can change the order of the fields by dragging. This is called “Pivoting.”
For example, under Rows, drag Class up so it is above Location.

Rows

Rows
— Class
Location - + Class
Class ¢| v Location

-

-

Now, the PivotTable shows Location subordinate to Class.

A B (=

1 |Fire/Police (Al -
2

3 Row Labels - Sum of Num
4 | = Accidents 3917
5 Precinct 1 731
6 Precinct 2 586
7 Precinct 3 558
8 Precinct 4 617
9 Precinct 5 600
10 Precinct 6 825
11 | = Crime 4311
12 Precinct 1 499
13 Precinct 2 699
14 Precinct 3 6534
15 Precinct 4 881
16 Precinct 5 763
17 Precinct 6 835
18 | ='Fire 2409
19 Station 1 989

Pivot | Raw Data )

D E

A

-

PivotTable Fields

Choose fields to add to report:
Search

¥ ] Lucauun

Class

Drag fields between areas below:

Filters Columns
Fire/Police hd

Rows Values
Class ¥ =] Sum of Num
Location v |-

Defer Layout Update

8. Drag Class back under Location to return to the previous arrangement.

9. On the right, from the Field section, drag the Month field down to the
Columns area. This allows you to see the month by month data.

Now you can see, for example, that Precinct 2 Crime (row 11) decreased
from January (310) to February (175), but Precinct 3 Crime (row 15)
increased from 196 to 224 during that same time period.

No DL eND O R WN

13
14
15
16
17
18
19

A
Fire/Police

Sum of Num

B C D
(Al -

Column Labels | ~

Row Labels - |Jan Feb Mar
-Precinct 1 4275 3529 4105
Accidents 327 208 196
Crime 285 93 121
Sent 3663 3228 3788
- Precinct 2 5637 4563 6022
Accidents 252 163 171
Sent 5075 4225 5637
-IPrecinct 3 5540 4504 5599
Accidents 221 215 122
Sent 5123 4065 5263
- Precinct 4 5340 4959 5778
Accidents 235 197 185
Crime 308 327 246
Pivot | Raw Data @ Pl

E

Grand Total
11909
731
499
10679
16222
586
699
14937
15643
558
634
14451
16077
617
881

PivotTable Fields

Choose fields to add to report:
Search

Month

— -

Drag fields between areas below:

Filters Columns
Fire/Police hd Month

Rows Values
Location ~ %] Sum of Num
Class R

Defer Layout Update

It would be a good idea to investigate why this is so.
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10. To make the PivotTable easier to read, select columns B, C, and D, right
align them, and make the column width 9. Apply Wrap Text to cell B3.

On the Design tab, in the PivotTable Styles group, click More [Z] and
select Rose, Pivot Style Medium 10.

Medium

—
=

Now, the PivotTable looks like this:

Mac: The style may look a bit different on a Mac.

A B C D E T _
1 |Fire/Police - PivotTable Fields
2 Column Choose fields to add to report:
53 Sum of Num Labﬂ Search
L3 Row Labels i Jan Feb Mar Grand Total
5 | @ Precinct 1 4275 3529 4105 11909 Fire/Police
6 Accidents 327 208 196 731 .
7 Crime 285 93 121 499
8 Sent 3663 3228 3788 10679 Drag fields between areas below:
9 | ZPrecinct 2 5637 4563 6022 16222
10 Accidents 252 163 171 586 Filters Columns
11 Crime 310 175 214 699 Fire/Police - Month
12 Sent 5075 4225 5637 14937
13 | = Precinct 3 5540 4504 5599 15643
14 Accidents 221 215 122 558 Rows % Values
15|  Crime 196 224 214 634 T— ~ =1 sum of Num
16 Sent 5123 4065 5263 14451
17 | = Precinct 4 5340 4959 5778 16077 gl A4
18 Accidents 235 197 185 617 -

| Pivot | Raw Data | f+j < , Defer Layout Update

e. When you make a PivotTable, Excel takes a “snapshot” of the raw data by
making a copy. The result is that if you modify the data on the Raw Data tab,
the PivotTable is not automatically updated — you must do that manually. To
see how this works, do the following:

1. Click the Raw Data worksheet. Click cell E30 (Precinct 2 Crime for
January), change it from 310 to 5000, and tap Enter.

Click the Pivot worksheet and notice that cell B11 still shows 310.
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2. To update the PivotTable, right-click any cell in the PivotTable and select
Refresh. The value now is 5000 and all the values that depend on that cell

are updated.

A
1 Fire/Police
2
3
4
5 | = Precinct 1
6 Accidents
T Crime
o] Sent
9 | = Precinct 2
10 Accidents
11 Crime
12 Sent

4275 3529

327 208
285 93

3663 3228
10327 4563

252 163

| 5000_' 175
5075 4225

Mar Grand Total

4105 11909
196 731
121 499

3788 10679

6022 20912
171 586
214 5389

5637 14937

3. Now, change the data back by clicking the Raw Data worksheet,
clicking cell E30 and changing the Precinct 2 Crimes value for
January from 5000 back to 310.

Click the Pivot worksheet, right-click any cell in the table and select
Refresh. B11 is 310 again and all the cells that depend on B11 are

updated.

If you want to add new raw data, you would enter it in the row just below the
last row on the Raw Data worksheet. Then, you would refresh the PivotTable

as you just did.

4. You can focus on either Fire or Police data by using the filter arrow in B1.
Click the filter arrow and then click Fire.

Mac: Click the check next to Police to deselect it.

Click OK

Mac: There is no OK button. Click the red dot to close the dialog box.




PROJECT 4 EXCEL CHAPTER 3: ANALYZING DATA WITH CHARTS & WHAT-IF TooLsSG105

The Police data disappear leaving only the Fire data displayed.

1

\%]

A B @ D E
Fire/Police F|-T
Column

F

G

-

PivotTable Fields

Choose fields to add to report:

53 Sum of Num Labﬂ Search
S Row Labels g Jan Feb Mar Grand Total
5 | = Station 1 1223 1248 1053 3524 Fire/Police
6 Fire 209 369 321 989 i
7 Medical 924 879 732 2535
8 | = Station 2 1313 1035 1167 3515 Drag fields between areas below:
9 Fire 326 265 204 795
10 Medical 987 770 963 2720 Filters Columns
11 | = Station 3 439 424 399 1262 Fire/Police * ||| Month
12 Fire 68 92 78 238
13 Medical 371 332 321 1024
14 | - Station 4 658 601 652 1911 Rows 3 Values
15 Fire 117 123 147 387 p— ~ <1 sum of Num
16 Medical 541 478 505 1524
17 Grand Total 3633 3308 3271 10212 gl v |~
18 -
Pivot Raw Data f-i-) < , Defer Layout Update

5. Repeat the process, but this time select All so all the data appear again.

f. If you want to send a PivotTable to someone else so they can do an analysis,

make a copy of the worksheet in a new workbook. To see how this works, do
the following:

1. Right-click the Pivot worksheet tab and select Move or Copy to open its

dialog box.

Mac: Edit menu, Sheet, Move or Copy Sheet.

2
3
4.
5

6.

Click the Create a copy box.

In the box under To book, click the arrow and select (new book).

Click OK. A new workbook, titled Book1, is created.

Save the new workbook in the Excel Files folder using the name HWO04-5b
HWID Fire & Police PivotTable Done.

Close the new workbook HW04-5b HWID Fire PivotTable.

Now, you have a copy of the PivotTable. You can manipulate the data as you
see fit. However, since this is a “snapshot” of the data, the data cannot be
updated and refreshed.

. Specific data may also be displayed using Slicers (filters).

1. With the workbook HWO04-5 HWID PivotTables Done open, make a copy

of the Pivot worksheet and rename it Slicer-1.

2. Onthe PivotTable Analyze tab, in the Filter group, click Insert Slicer.

This displays the field names in a dialog box.
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3. Click the Fire/Police check box and then click OK.
A new tab called Slicer appears.
4. On the Slicer tab, in the Slicer Styles group, select Light Green.
5. Inthe Slicer box, click Fire to display only the Fire data. The filter ?
button now shows a red X. To remove the filter, click that button X
(DO NOT do that now).
6. Click any cell in the PivotTable and insert a second slicer. Click Class in
this new dialog box, and then click OK.
7. Apply the Lavender style.
8. Arrange the two slicers on the right so you can clearly see both.
9. On the Class slicer, click the Medical filtering button.
A B C D E F G H | J K
1 |Fire/Police Fl-T
2
Column Fire/Police Y= \{ | Class v= 2
53 Sum of Num Labﬂ - .
"l Row Labels EJ  Jan Feb Mar Grand Total [iikd Fire
5 | - Station 1 924 879 732 2535  police Medical
6 Medical 924 879 732 2535 -
7 | - station 2 987 770 963 2720 Accidents
8 Medical 987 770 963 2720 Crime
9 | - Station 3 3711 332 321 1024 et
10 Medical 371 332 321 1024
11 | - Station 4 541 478 505 1524
12 Medical 541 478 505 1524
13 Grand Total 2823 2459 2521 7803

The Fire/Police slicer filters out the Police data, and the Class slicer filters
out Fire calls. The three police Class buttons are grayed because the
Police data have been already filtered out by the Fire/Police slicer.

h. Set up the PivotTables Slicer-1 worksheet to print in Portrait orientation, all
on one page, centered horizontally but not vertically, and include a footer that
contains the file name on the left and the sheet name on the right. Click the
Sheet tab, click Gridlines and also Row and column headings. Compare the
preview with the key. Make needed corrections, save the workbook but do NOT
close it.

i. In this Activity, you will “pivot” the order of the fields to view the data from a
different perspective.

1.

Click the Pivot worksheet. In the Layout section of the PivotTable Fields
pane, from the Columns area, drag Month upward into the white Field
section. This removes the Month data from the PivotTable.
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2. Inthe Layout section, from the Rows area, drag the Class field into the
Columns area.
A B C D E F G NI ]
1 |Fire/Police ¢- PivotTable Fields
2
B8 Sum of Num Column Labels n Choose fields to add to report:
L Row Labels Bl Accidents Crime Fire Medical Sent Grand Total Search
5 |Precinct 1 731 499 10679 11909 S
6 |Precinct 2 586 699 14937 16222
7 Prec?nﬂ 3 998 634 14451 15643 Drag fields between areas below:
8 |Precinct 4 617 881 14579 16077
9 |Precinct 5 600 763 13887 15250 Y Filters Il Columns
10 |Precinct 6 825 835 14277 15937 e —_ . =
11 | Station 1 989 2535 3524 LCpebe 2
12 | Station 2 795 2720 3515 = Rows 3 Values
13 | Station 3 238 1024 1262 -
14 | Station 4 387 1524 1911 Location ~ ||| Sum of Num
15 |Grand Total 3917 4311 2409 7803 82810 101250 | ~
» | Slicer-1 | Pivot | Raw D ... @.} P N - S
Class now is in columns rather than rows. The column names are listed in
alphabetical order, which is not very useful since Fire data are intermixed
with Police data.

3. Right-click Medical, in cell E4, point to Move, and then click Move
“Medical” to Beginning. This moves those data to the beginning of the
columns in column B.

4. Repeat the process for Fire. The Fire data now are adjacent to each other,
as are the Police data. This makes things easier to read.

A B C D E F G - )
1 |Fire/Police - PivotTable Fields
2
% Sum of Num  Column Labels n Choose fields to add to report:
4 B Labels-Fire Medical Accidents Crime Sent Grand Total Search
5 | Precinct 1 731 499 10679 11909 A
6 |Precinct 2 586 699 14937 16222
7 Prec?ncl 3 558 634 14451 15643 Drag fields between areas below:
8 Precinct 4 617 881 14579 16077
9 |Precinct 5 600 763 13887 15250 Y Filters Il Columns
10 |Precinct 6 825 835 14277 15937 T . =
11 | Station 1 989 2535 3524 I =
12 | Station 2 795 2720 3515 = Rows 2 Values
13 | Station 3 238 1024 1262 -
14 | Station 4 387 1524 1911 Location |||l Sum of Num
15 |Grand Total 2409 7803 3917 4311 82810 101250 ~
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J. You can display select PivotTable report details in a new worksheet. For
example, do the following to make a report that shows Crimes reported each
month by Precinct:

1. On the Pivot worksheet, double-click cell E15 (Grand Total for Crimes).
This creates a new worksheet with the details of the Crimes for each
Precinct and Month.

A B % D E
1 M Month [ - M Num [
2 |Police Mar Precinct 1  Crime 121
3 |Police Feb Precinct 1 Crime 93
4 | Police Jan Precinct 1  Crime 285
5 |Police Mar Precinct 2 Crime 214
6 |Police Feb Precinct 2 Crime 175
7 |Police Jan Precinct 2 Crime 310
& Police Mar Precinct 3 Crime 214

2. Rename the worksheet Crime. At this point, you should have four
worksheets in this workbook. | Slicer-1 | Crime | Pivot | Raw Data |

k. Apply conditional formats to this Crime worksheet so that each month’s row will
have a different color. Do the following:

1. You are going to do some complex sorting and set conditional formats so
convert this table into a regular Range. To do that, on the Table Design
tab, in the Tools group, click Convert to Range and then click Yes. Notice
the filter arrows disappear.

2. With A1:E19 selected, on the Home tab, in the Styles group, click the
Conditional Formatting arrow, click New Rule and then click Use a
formula ...

Mac: Select New Rule, Style: Classic, Use a formula...

3. Inthe box, type =$b1="Jan"
4. Click the Format button.

Mac: Click Format with and select Custom Format.

5. Click the Fill tab and click light red.
6. Click OK. Click OK again.

7. Repeat the process for Feb and Mar, using different colors for those months.

A B C D
Fire/Police_|Month _|Location _|Class _|

1

2 Police Mar Precinct 1  Crime
3 Police Feb Precinct 1  Crime
4 |Police Jan Precinct 1 Crime
5 Police Mar Precinct2 Crime
6 |Police Feb Precinct 2 Crime
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|. Sort the data by Month, Jan to Mar, and then by Num, in descending order.
Here are the steps:

1.

With A1:E19 selected, on the Home tab, in the Editing group, click the
Sort & Filter arrow, and select Custom Sort. Be sure My data has
headers is checked.

Click the Sort by arrow and select Month. Click the arrow under Order
and select Custom List. Choose Jan, Feb, Mar, ... and click OK.

Click Add Level (* on Mac). Click the Then by arrow and select Num.
Click the arrow under Order, select Largest to Smallest, and click OK.

m. Insert Data Bars to graphically show the data. To do that:

1.

w

N o g A

Select column E, copy, click the column F column label, and paste. You are
going to put the data bars in column F so you can easily see both the
numbers and the data bars.

Select F2:F19 (you do not want F1 because that contains the field name).

On the Home tab, in the Styles group, click Conditional Formatting, point
to Data Bars, and select More Rules.

Check the box that says Show Bar Only (so the numbers do not show).
Click the arrow under Fill and select Gradient Fill.
Select dark gray for the color.

Click the arrow under Border and select Solid Border with the color black.

Format all cells based on their values:

Format Style: |pata Bar v Show Bar Only
Minimurm Maximum

Type: Automatic ~ | | Automatic o

Value: {Automatic) 1 [Automatic) t

Bar Appearance:

Fill Color Border Colar

Gradient Fill |~ R Solid Border | - et
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Click OK. Here you can see that Precinct 2 had the highest Num of
Crimes in January, but was in the bottom half for February and March.
This would be something to investigate.

A B C D E F
1 Fire/Police |Month Location Class Num Num

2 Police [Jan Precinct 2  Crime 310|.

3 |Police Jan Precinct4 Crime 308.

4 |Police Jan Precinct5 Crime 286-:|
5 Police Jan Precinct 1 Crime saes R ]
6 Police Jan Precinct 6 Crime s1allE |
7 |Police Jan Precinct3 Crime 196.:|

8 Police Feb Precinct4 Crime 27 |
9 Police Feb Precinct5 Crime 2430 ]
10 Police Feb Precinct 3 Crime 224 ]
11 Police Feb Precinct6 Crime 206 |
12 Police [Feb Precinct2 Crime 1751

13 Police Feb Precinct 1 Crime 93|:|

14 Police Mar Precinct6 Crime <G
15 Police Mar Precinct4 Crime 246 [ ]
16 Police Mar Precinct5 Crime 234 ]
17 Police [ Mar Precinct 2 Crime 214

18 Police Mar Precinct 3 Crime 214 |
19 Police Mar Precinct 1 Crime 121 |:|

n. Set up the PivotTables Crime worksheet to print in Portrait orientation,
Adjust to 150 % of normal size, centered horizontally but not vertically, and
include a footer that contains the file name on the left and the sheet name on
the right. Compare the preview with the key. Make needed corrections, save
the workbook but do NOT close it.

0. In order to make analysis easier, you can display data on separate worksheets.
For example, let’s do this for Fire and Police data. Doing so will make it easier
to answer questions about the calls handled by each department.

1. On the Pivot worksheet tab, click cell Al.

2. Onthe PivotTable Analyze tab, in the PivotTable group (on the left), click
the Options arrow, and then click Show Report Filter Pages.

File Home Insert

Active Field:

Fire/Police

[iZ Field Settings |

Active |

PivotTable Name:

PivotTable1
@Options @
E Options

In the dialog box, confirm that Fire/Police is selected and click OK.
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This adds two new worksheets, one for Fire and one for Police.

Fire Worksheet

Police Worksheet

A B C D A B C D E

1 |Fire/Police Flr 1 |Fire/Police Poli-T

2 2

&) Sum of Num  Column Labels [ 3 aunl HEITIT RS = .

P8l Row Labels [ Fire Medical Grand Total ‘; i B Accidents v c“ 9 Sranc 1

5 | Stafion 1 989 2535 3524) | 5 precinct 2 586 699 14937 16222

6 |Station 2 795 2720 3515 | 7 | Precinct 3 558 634 14451 15643

7 |Station 3 238 1024 1262| | 8 |Precinct 4 617 881 14579 16077

8 |Station 4 387 1524 1911 [9 |Precinct 5 600 763 13887 15250

9 |Grand Total 2409 7803 10212| |10 |Precinct 6 825 835 14277 15937
11 |Grand Total 3917 4311 82810 91038

The data are copied, not moved. That is, the data for each worksheet

remains on the original Pivot worksheet.

3. Hide the Fire worksheet by right-clicking its worksheet tab

and selecting Hide.

Hide

Select A
Fire | Fonce

4. In the same way, hide the Police worksheet. You can unhide a worksheet
by right-clicking its tab and selecting Unhide.

p. The default summary statistic is to find sums. It is also possible to calculate

other quantities. Do the following:

1. On the Pivot worksheet tab, point to cell G5 (Grand Total for Precinct 1),
right-click, and click Value Field Settings.

2. Under Summarize value field by, select Average, and click OK.
All the calculated values are changed from Sum to Average. Notice that
cell A3 changes from Sum of Num to Average of Num.

3. Right-click any numeric value and select Value Field Settings. In the lower
left corner of the dialog box, click Number Format to open its dialog box.

4. Under Category, click Number. Make the Decimal places 0 and check
the Use 1000 separator box. Click OK. Click OK again.

A B C D E F G - . .
1 |Fire/Police E PivotTable Fields ~ X%
2
&W Average of Num Column Labels Choose fields to add to report: @} 7
L3 Row Labels -Fire Medical Accidents Crime Sent Grand Total cearch /O
5 |Precinct 1 166 3,560
6 |Precinct 2 195 233 4,979
7 Prec!nct 3 186 211 4,817 1,738 Drag fields between areas below:
8 |Precinct 4 206 294 4,860 1,786
9 Precinct 5 200 254 4,629 1,694 Filters Columns
10 |Precinct 6 275 278 4,759 1,771 § -
11 | Station 1 330 845 587 FirefPolice = J}j| Class -
12 | Station 2 265 907 586 Bors = Values
13 | Station 3 79 3 210
14 | Station 4 129 508 319 Location 57 Average of Num ¥
15 |Grand Total 201 650 218 240 4,601 1,298

« » ...| Crime | Fire | Police | Pivot ... () 4
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g. You can create charts of the PivotTable. Do the following on the Pivot worksheet:

1. Onthe PivotTable Analyze tab, in the Tools group, click PivotChart. In the
Insert Chart dialog box, on the left side, if necessary, click Column, and
then click OK to accept the default chart — Clustered Column.

Mac: There is no Insert Chart dialog box.

A B = D E F G - . .
1 |Fire/Police -~ PivotTable Fields ~ X%
2
EW Average of Num Column Labels n Choose fields to add to report: @ 4
L3 Row Labels -Fire Medical Accidents Crime Sent Grand Total earch /o
5 |Precinct 1 244 166 3,560 1,323
6 Prec!nct2 195 233 4,979 1,802 Fire/Police
7 |Precinct 3 186 211 4,817 1,738 [ Month
8 |Precinct 4 206 294 4,860 1,786 _
9 |Precinct 5 200 254 4,629 1,694 ¥l Location
10 |Precinct 6 275 278 4,759 1,771 Class
11 |Station 1 330 845 587 Num
12 |Station 2 265 907 586 M
| ore Tables...

13 |Station 3 79 341 210
14 |Station 4 129 508 319
15 |Grand Total 201 650 218 240 4,601 1,298
:? Fire/Police + Drag fields between areas below:
18 Average of Num Filters Columns
;3 6,000 Fire/Police A Class A

5,000
21 Class v

4,000
22| 49 m Fire
23 | 2,000 Miedical

n ical

24 | 500
25 Accidents

1,000 )
3? 0 - " n [ n " II -I a | Crime Rows Z Values
28 -é'}‘\ -&O‘ -é';’ _é}"‘ _&CJ _Q\&“‘ & _d;" _é\"’ -d“h # sent Location ~ ||| Average of N.. ~
29 Q@o q@c Q@(} q&(} Q@(} q@c ‘-3"?;L ‘-)(} ‘-3":8— ‘-)(}
30
31 Location +
32
33
34
= Defer L Upd

» | Slicer-1 | Crime | Pivot ‘ Rav ... () 4 » efer Layout Update

This is a chart of all the Fire and Police data. It shows:

6 Police Precincts with their 3 Classes, Accidents, Crime, and Sent
4 Fire Stations with their 2 Classes, Fire, and Medical.

Notice the Filter Buttons for:

Fire/Police
Average of Num [Average of tum |
Location W

Class

Mac: There are no Filter Buttons on Mac PivotCharts.
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2. On the chart, click the Fire/Police Filter Button.

Select Fire and click OK. The Fire/Police Filter Button
now shows the filter icon with the arrow. The same is true for the filter
button in cell B1 on the PivotTable.

Mac: On the PivotTable, click the arrow in cell B1. A B
Uncheck Police so that only Fire is 1_ Fire/Police Fire
checked.

[ A B [# D E F G - ] |

1 |Fire/Police GES PivotTable Fields ~ X

2

EW Average of Num Column Labels - Choose fields to add to report: @ 57

L3 Row Labels - Fire Medical Grand Total coarch 0

5 |Station 1 330 845 587

[} Stat!on 2 265 907 586 Fire/Police 7=

I |Station 3 79 KLy 210 [ Month

8 |Station 4 129 508 319 .

9 [Grand Total 201 650 426 ¥ Location

10 Class -

11 Fire/Police + ¥ —

12 | Average of Num Drag fields between areas below:

13 1,000 §

14 300 Filters Columns

15 200 Fire/Police S Class 7

16 700

17 500 Class v

18 500 M Fire

19 | 400

bo| 300 = Medical Rows % Values

e1 ig I I Location 57 Average of N... =

P2

2l - N

ba Station 1 Station 2 Station 3 Station 4

b5 Location v

i - Defer Layout Upd

» | Slicer-1 | Crime | Pivot | Rav .. &) F » ST AR EIEE

Repeat this process to display All the data again.

3. Inthe lower left, click the Location Filter Button to open its dialog box.

Mac: In the PivotTable, click the arrow in cell A4, Row Labels.

Click the Value Filters arrow, select Top 10... and, in the dialog box,
change 10 to 4 and click OK.

Mac: Under Filter, next to By value, click the Choose one arrow and select Top
10. Under Top 10, change the 0 to 4 and close the dialog box.
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Now, the four Locations with the most calls are displayed. They are Police
Precincts 2, 3, 4, and, 6.

| A . B € [ b [ETF] 6 T . )
1 Fire/Police - PivotTable Fields ~ X
2
£ Average of Num Column Labels - Choose fields to add to report: @ 7
L3 Row Labels Fire Medical Accidents Crime Sent Grand Total F— Jo
5 Precinct 2 195 233 4,979 1,802
6 Precinct 3 186 211 4,817 1,738 Fire/Police -
7 Precinct 4 206 294 4,860 1,786 [ Month
8 Precinct 6 975 278 4,759 1,771 o
9 Grand Total 216 254 4,854 1,774 ¥ Location g
10/ 3 Class
11: Fire/Police » Num
127 Average of Num h
13— 6,000 Drag fields between areas below:
15 5,000 T Filters Il Columns
16
17| Class - Fire/Police - Class -
— 4,000
18 | H Fire
;g_ 2000 u Medical
21— m Accidents
22: 2000 B Crime = Rows 3 Values
;3— 1,000 [ Sent Location * | Average of Num *
;g— 0 -. -. =l nm
a Precinct 2 Precinct 3 Precinct 4 Precinct 6
28: Location ¥
29 -
< » .| Crime | Fire | Police | Pivot .. 3 4 » Defer Layout Update

4. On the right middle of the chart, click the Class arrow.

Mac: In the PivotTable, click the arrow in cell B3, Column Labels.

Deselect everything but Accidents and Crime. | = Selectab

[TFire
. [ Medical
Click OK. [¥] Accidents
Crime
A , B T € | D [ E | F | G- _ ,
1 |Fire/Police B PivotTable Fields
2
kM Average of Num Column Labels Choose fields to add to report:
L3 Row Labels Accidents Crime Grand Total Search
5 |Precinct 2 195 233 214 A
6 | Prec!ncl 4 206 294 250 Fire/Police
7 |Precinct 5 200 254 227 [ Month
8 |Precinct 6 275 278 277 .
9 |Grand Total 219265 242 ]l || 4 Location
10/ s - h Class
”— Fire/Police + 7 Nuen

12 | Average of Num
- Drag fields between areas below:

13 | 350
14 200 Y Filters Il Legend (Series
15
16_ 250 Fire/Police - Class
1?:) 200 Class ¥ (
18, 150 M Accidents
19 | .
o0 | 100 rime = Auxis (Categories) % Values
21| so Location A Average of Num
22

— 0
33— Precinct 2 Precinct 4 Precinct 5 Precinct 6
o5 | Location +¥

R | Slicer-1 | Crime | Pivot .. (3@ P » Defer Layout Update

5. Move the chart to its own chartsheet (PivotChart Design, Location, Move
Chart) and label it 3-D Chart.
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6.

7.

On the PivotChart Design tab, in the Type group, click Change Chart
Type, select 3-D Stacked Column, and then click OK.

Click the green cross + and place checks next to Axes (Primary
Horizontal, Primary Vertical), Chart Title (Above Chart), Data Labels
(Center), Gridlines (Primary Major Horizontal), and Legend (Right).

Mac: There is no green cross. On the Chart Design tab, in the Chart Layouts

group (on the far left), click the Add Chart Element arrow and set the Axes,
Chart Title, Data Labels, Gridlines, and Legend.

8.

10.
11.

Enter 1st Quarter Crime and Accident Calls for Top Four Precincts as
the title. Change the font to 12 pt purple Arial Black.

Change the font of the column data labels to 12 pt yellow Arial Black.
Change the font of both axes and the legend 12 pt purple Arial Black.

Make the Major Gridlines purple and Width 2 pt. (PivotChart Format, Current
Selection, Vertical (Value) Axis Major Gridlines, Format Selection (Format
Pane on Mac), Line, Solid line, Color Purple, Width 2 pt).

12. Follow a similar procedure to make the floor gray.

Fire/Police =

Average of Num

600

400

300

Location ¥

200

100

1st Quarter Crime and Accident Calls for Top Four Precincts

Class -7
H Crime

H Accidents

Precinct 4
Precinct 5
Precinct 6

The columns show the Accidents (blue) and Crime (red) calls added together.
The different colors illustrate how much each contributes to the total.
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13. Click the Pivot worksheet tab. Since the charts were based on this
PivotTable, and you changed the items displayed in the chart the
PivotTable shows only Accidents and Crime for the top four Precincts.

A B C D

1 |Fire/Police (All) -

2

53 Average of Num Column Labels

3 Row Labels Accidents Crime Grand Total
5 |Precinct 2 195 233 214
6 |Precinct 4 206 294 250
7 |Precinct 5 200 254 227
8 |Precinct 6 275 278 277
9 |Grand Total 219 265 242

If you were to change the filters on this PivotTable, the graph that is based
on this PivotTable would change also.

r. Click the 3-D Chart tab and click in the chart. On the PivotChart Analyze tab, in
the Show/Hide group, click the Field Buttons arrow and select Hide All so
those do not show on the printout. (To show them again, click that button again).

Mac: Field Buttons do not exist on Mac PivotCharts so ignore references to them.

Set up the 3-D Chart chartsheet to print in Landscape orientation. Include a
footer that contains the file name on the left and the chartsheet name on the
right. Compare the preview with the key. Make needed corrections, save the
workbook but do NOT close it.

s. Unhide the Fire and Police tabs (right-click a visible tab to open the Unhide
dialog box, click the name of the tab you wish to unhide, and click OK).

There may be too many worksheet tabs in this workbook to see them all at one
time. If you see arrows to the left of the left-most tab, it means some tabs are
not visible. To see them, click the arrow as many times as is necessary. The
arrow will change as you display worksheet tabs or hide them.

* | means there are more tabs on the right.

means there are more tabs on both the left and right.

@ means there are more tabs on the left.

You may want to adjust the space for the tab labels. To do that, move the
mouse pointer to the three vertical dots next to the horizontal —
scroll bar. The pointer becomes a double headed arrow. Click & b !
and drag left or right to make less or more room for the tab
labels. This will expand or contract the horizontal scroll bar.

Mac: The horizontal scroll bar is just above the tab names so skip this.

t. Save and close the workbook.




PROJECT 4 EXCEL CHAPTER 3: ANALYZING DATA WITH CHARTS & WHAT-IF TooLsSSG117

Step 4 Submit Now, submit the following. Use these names for the pdf files:

HWO04-1 HWID 3A Enterprise Fund Done (Expenditures Chart) — This is the
Expenditures Chart chartsheet

HWO04-2 HWID 3B Tourism Done (Expenditures)— This is the Expenditures
worksheet

HWO04-2 HWID 3B Tourism Done (Advertising) — This is the Advertising
worksheet

HWO04-3 HWID HLOOKUP Gradebook Done

HWO04-4 HWID VLOOKUP Shipping Done

HWO04-5 HWID PivotTables Done (Slicer-1) — This is the Slicer-1 worksheet
HWO04-5 HWID PivotTables Done (Crime) — This is the Crime worksheet
HWO04-5 HWID PivotTables Done (3-D Chart) — This is the 3-D Chart chartsheet

Create a pdf file of the output for each of the above, place them in a folder
called HW04 HWID LastName, FirstName, zip the folder and, by the due date,
upload it to the Canvas folder HWO04 Excel Chapter 3: Analyzing Data with
Charts and What-If Tools.

Step 5 Backup Now would be a good time to backup your files.






Project 5
Excel: Customize Charts, Make Decisions, and Sort

Step 1 Read For this project, there are no pages to read in your textbook.
Step 2 Activities For this project, there are no textbook activities.

Step 3 Homework Do the problems listed below, and turn them in for grading.

This Project will extend your knowledge of using Excel to make graphs and to help
make decisions using IF/THEN/ELSE logic.

HWO05-1 River Chart

Problem: How can you create a mathematical model (formula) based on empirical
data and put two graphs on one chart?

In this exercise you will be given measurements that show the relationship between
the depth of a river, the distance from one of its banks, and the water temperature.
Water depth measurements are routinely made to help keep rivers navigable and to
help with flood control and prevention. Your task is to graph these relationships and
to create a mathematical model that can be used to predict the expected water
depth at any distance from the shore. Where the actual depth does not match the
model might indicate that dredging is needed. On the same graph, you will also
graph bottom water temperature versus distance from the riverbank. Having these
two graphs on one grid will enable you to see the relation between water depth and
temperature.

a. Open the workbook HWO05-1 River Original, which is one of the files you
downloaded at the start of the term.

b. Save the workbook to your Excel Files folder using the name
HWO05-1 HWID River Done.

— SG119 —
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c. Graph the distance/depth data by doing the following: H:l? dil- 3~ M
K- - B
1. SEIECt Ce”S Bng Recommended a .
. Charts 'e)' |‘—'
2. Onthe Insert tab, in the Charts group, Scatter
click Scatter and then select Scatter.
® & O
A B T D E F] o®
. [ ] [ ]
Distance from | Depth of Water
the West Bank | the River | Temperature 11
1 (feet) (feet) (degrees F)
2 0 0.0 70.0
3 15 10.2 53.6
4 25 17.0 45.0
5 40 19.0 48.0
6 50 200 500 Note that a
7 70 18.0 65.0
8 90 72 69.0 Worksheet has
— 20 20 cells and may
. Chart Title contain a chart.
13 25.0
14
15 || 20.0 & .
16 . .
17 15.0
18
19
20 10.0 L]
21 [}
22 50
23
24| g0 .
25 o 1 2 3 4 5 i) 7 2 9
26

3. Be sure the chart is selected and then on the Chart Design tab in the
Location group (way over on the right), click Move Chart.

4. Click the button next to New sheet, type River Depth Chart, and click OK.
The chart appears in its own chartsheet.

Chart Title

. Note that a
Chartsheet
has no cells,
only a chart.

50

00 . .
o 1 2 3 4 5 6 7 8 9

B

Select
Data

5. Be sure the chart is selected and then on the Chart Design tab in
the Data group (way over on the right), click Select Data.
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_ _ ) ) Legend Entries [Series)
6. Under Legend Entries (Series), click Edit. 47 add 3 Edit

Mac: There is no Edit button. The boxes below automatically appear.

7. Fillin the Edit Series box as follows:

¢ In the Series name box type Depth. This gives the data a name.
In a bit, you will enter another series called Temperature.

¢ Next to the Series X values box, click the collapse dialog button:

Series name:

Depth El Sele nge

Series X values:

2| select Range

e Click the River Data worksheet and select A2: A9, which contains the
distance data. Notice how the location is inserted in the box:

='River Data'l$A52:5A%9 [«

¢ Click the collapse dialog button again.

8. The Series Y values should already show the range B2:B9 in the River
Data worksheet. Click OK.

Select Data Source ? X
Chart data range: | ='River Data'!$A$2:5B59 *
Switch Row/Column

Legend Entries (Series) Horizontal (Category) Axis Labels

E add E % Edit I P<Remove & | w E Edit

Depth 0 ~
15
25
40
50 W

Hidden and Empty Cells oK Cancel

9. Click OK again.
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_|_

1. Click anywhere in the chart so the chart elements buttons are 4
displayed in the upper right corner. ?

d. Format the chart as follows:

Mac: There are no chart elements buttons. The Add Chart Element menu is in the
upper left corner of the screen. Click its arrow to open it.

Open the Chart Elements menu by clicking the green cross.

Insert checks as shown below:

CHART ELEMENTS
y Aoces

& Axis Titles
Chart Title

Y |:| Data Labels
[ | ErrorBars
Gridlines » Prirary Major Horizontal
[ ] Legend Primary Major Vertical
[ ] Trendline Primary Minor Horizontal

Prirnary Minor Vertical
Mare Options...

2. Click the Chart Title textbox (it probably has the word Depth in it). Click
the formula bar, and type River Depth vs. Distance From West Bank

Tap Enter to update the title.

Mac: If you have trouble selecting a chart element, tap the Tab key to cycle through
the elements until the one you want is selected.

3. Using the same technique, change the Vertical Axis Title to Depth (feet).
Change the Horizontal Axis Title to Distance From West Bank (feet).

4. For each of the three titles, make the font 14 point Arial Black.
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e. Format the data points by doing the following:

1. Onthe Chart Format tab, in the Current Selection group (on the left), click
the arrow and select Series “Depth”. This selects the data points.

Series "Depth" s* S ™y

2

+ %% Format Selection Ood- [ Abe ] [ Abe ] [ Abe ] - [

3] Reset to Match Style AL LIs T o
Current Selection Insert Shapes Shape Styles

- % | =SERIES("Depth”,'Ri

River Depth vs. Dis

250

2000 3

£

2. Onthe Chart Format tab, in the Current Selection group click
= Format Selection to open the Format Data Series pane (on the right).

Mac: Click the Format Pane button on the right side of the ribbon.

Click the paint bucket|<’»| to see the Line and Format Data Series
Marker options. Series Options ¥

3. Click Marker, click the triangle next to Marker S ol
Options to open its menu, and then click the
Built-in button. ~ Line " Marker

1 .. . S H .D t' -
Click the Type arrow and be sure it is set to circle eries Uptions

(third choice from the bottom). & |||
Change the size to 10.

. . . . . -~ Line " Marker
4. Click the Fill triangle to open its menu, click

Solid fill, and then change the color to dark red. 4 Marker Options

Automatic
Mane
* Built-in

Type (# -

Size 10
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f. Change the background color of the chart by doing the following:

1. Onthe Chart Format tab, in the Current Selection group, click the arrow,
select Chart Area, and then click Format Selection to open the Format
Chart Area pane.

2. If necessary, click the Fill triangle to show its menu and then click Picture
or texture fill.

Insert picture from

3. Click the arrow to the right of Texture File.. | | Clipboard Online..

and click the Blue tissue paper texture. Texture -

g. Format the axes and gridlines as follows:

1. Onthe Chart Format tab, in the Current Selection group, click the arrow,
select Vertical (Value) Axis, and click Format Selection.

2. Click the paint bucket |<*3| change the Line color to purple and make the
width 3 pt.

3. Follow the same procedure to format the Horizontal (Value) Axis line
to 3 pt purple.

4. On the Chart Format tab, in the Current Selection group, click the arrow,
select Vertical (Value) Axis Major Gridlines, and click Format Selection.

Click the paint can and change the Color to dark gray and the Width to 2 pt.

Format Major Gridlines ~
Major Gridline Options ~

&

4 |line
Mo line
* Solid line

Gradient line

Automatic

Color &y -

Transparency | 0%

Width 2 pt
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5. Use the same procedure to make these changes:
* Make the Vertical (Value) Axis Minor Gridlines 0.5 pt dark gray.
» Make the Horizontal (Value) Axis Major Gridlines 2 pt dark gray.
+ Make the Horizontal (Value) Axis Minor Gridlines 0.5 pt dark gray.

River Depth vs. Distance From West Bank

25.0

20.0 ®

,_.
o
=}

Depth (feet)

-
o
=]
| J

5.0

00 @ @

0 20 40 60 80 100 120

Distance From West Bank (feet)

h. Have Excel calculate and insert a trend line by doing the following:

1. If necessary, click inside the chart to show the Chart Elements button
(green cross). Click the arrow next to Trendline and select More Options.

Mac: Click the Chart Design tab, click the Add Chart Element arrow, select
Trendline, and select More Options.

If it is not already selected, click ||| to open the Trendline Options
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2. Notice how most of the points of the graph look like they would fall on an
upside down parabola. So, you will try a mathematical model whose graph
Is a parabola. To do this, if necessary, click the Trendline Options triangle
to open its menu and select More options to open the Format Trendline
pane. Click the three vertical columns to open the Trendline Options.

S K" CHART ELEMENTS Format Trendline
y fxes Trendline Options
& Axis Titles _
¥ Chart Title @ 7 0
[ ] DataLabels
L] ErrorBars 4 Trendline Options
Gridlines
] Legend Exponential
[] Trendline b Linear .
| Linear

Linear Farecast

Two Period Maving Average | Logarithmic
More Options.. | ® Polynomial Order

Click the button next to Polynomial. Confirm that the Order is set to 2.

Excel uses a mathematical technique called polynomial regression to
create the second degree (quadratic) polynomial that best describes the
data. The graph of the equation is a parabola. You will study regression
when you take a statistics course.

3. Check the box next to Display Equation on chart.

4. Check the box next to Display R-squared value on chart. This value
gives an idea of how well the mathematical model describes the data. The
optimal value is R2 = 1, which indicates a perfect fit.

The actual data points are represented by the red dots and the
mathematical model calculated by Excel is represented by the trendline.
The displayed R2 value, 0.9919, indicates that the mathematical model fits
the data very well.

5. Click the Fill & Line paint bucket @ and change the trendline color to
dark red, the Width to 3 pt, and the Dash type to solid.

s -0.0082x} + 0.8209x + 0.144 b

2]
20 R*=0.9919 100

6. Save your file.
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i. Different mathematical models will fit the data more or less precisely. To see
this, do the following:

. Format Trendline
1. Make a copy of the River Depth Chart chartsheet. . .
To do this, right-click the chartsheet name, select Trendline Options ¥
Move or Copy, click Create a copy, and click OK. & |||
Double-click the new chart name, River Depth
Chart (2), type River Depth and Temp Chart, and
then tap Enter. 4 Trendline Options

2. Be sure Series “Depth” Trendlinel is selected
and click Format Selection.

#* |inear

Change the Trendline to Linear.

You may have to move the equation so you can see it more easily.

River Depth vs. Distance From West Bank
25.0 s
T
20.0 ®
L
L
L
c 15.0
o
]
e
's Oy =-0.0235x ¥ 12569o
% - R*=0.0101
Q w0 ® —
®
5.0
0.0 @ @
0 20 40 60 80 100 120
Distance From West Bank (feet)

The shape of the trendline changed to a straight line, the mathematical
model now has only two terms, and the R2 value of 0.0101 indicates that this
new model does not fit the data very well, which is obvious from the graph.
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3. Change the Trendline to Polynomial and change the Order to 6.

Notice how the shape of the trendline has changed to a more complex
curve that better follows the flow of the data, the displayed equation has
more terms, and the displayed R2 value of 0.9985 indicates that this new
model fits the data even better than the quadratic model. There is an
obvious trade-off here: when the model is more complex it generally fits the
data better, but it also may be more difficult to work with.

4. Click the equation textbox.
* Change the font to dark red 9 pt Arial Black.
» Make the fill of the textbox white.

+ Click inside the box and, just to the right of R2 = 0.9919, type a space,
and then type where y is Depth and x is Distance from West Bank.

Mac: Select the Series “Depth” Trendline 1 Equation. Point to the very edge of
the textbox, right-click, and select Edit Text. | found this tricky on my Mac so
if you cannot get it to work just leave it out.

X
|y = 2E-09x°® - 6E-07X5 + TE-05x% - 0.0037x® + 0.0778x2 + 0.1473x - 0.0165
R? = 0.9985 where y is Depth and x is Distance from West Bank

20 | 40 ! | 60 &0 (100

j. Do the following to add a second graph that shows how bottom temperature
varies from one side of the river to the other: %

1. Click anywhere in the River Depth and Temp Chart.

2. Onthe Chart Design tab in the Data group click Select Data. EEU]
Legend Entries Select

3. Click the Add button. 7 Add Data

Mac: There is no Add button. Under the box labeled Legend entries (Series),
click the +

21 For Mac users, check out https://www.youtube.com/watch?v=99XaQFINf_Q
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4. Fill in the boxes as follows:
» For the Series name type Temperature.
* Next to the Series X values box, click the collapse dialog button. *

e Click the River Data worksheet and select A2:A9, which contains the
distance data. Notice how the location is inserted in the box.

Edit Series
='River Data'!$A$2:5A59 Edit Series ? X
Series name:
* Click the CO"apse dlalog button again. Temperature - Temperature
R i lues:
« For the Series Y values, follow Se:_“isat“f;mmg o0
='River Data'l H - =
the same procedure to select the _
Temperature data in C2:C9 on series Yvalues:
th F\P Dat ksh 't ='River Data"l$C$2:$C$0 2| -700 s
€ Rilver bata worksneet.
. . . -OK Cancel
+ Click OK and then click OK again.
River Depth vs. Distance From West Bank o
80.0 Vs
Y
70.0 ® 1
L]
60.0
L J
50.0 °
L 2
&
H
40.0
<
=
et
2 300
]
Q
20.0 -
10.0
y = 2E-09x® - 6E-07Xx* + 7E-05x4 - 0.0037x? + 0.0778x2 + 0.1473x - 0.0165
R? = 0.9985 where y is pth and x is Di from West Bank
T 0 20 40 60 80 ? 120
-10.0
Distance From West Bank (feet)
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k. Do the following to add a secondary vertical axis scale:

Mac: Instead of steps 1 through 5 below, do this:
* On the Chart Format tab, select Series Temperature.
» On the Chart Design tab click Change Chart Type.

* From the drop-down menu choose X Y (Scatter) and then Scatter with
Smooth Lines and Markers.

+ With Series Temperature still selected, click Format Pane.
» With the Series Options selected, click Secondary Axis.

1. Onthe Chart Design tab in the Type group click Change Chart Type.

2. Atthe bottom of the choices on the left, click | [fly Combao

3. Put a check in the Secondary Axis box next to the right of Temperature.

Choose the chart type and axis for your data series:
Series Name Chart Type Secondary Axis
| Cepth of the River [feet) Clustered Column e |:|
B Temperature Line w <—

Notice the graph types have automatically changed. Use the arrows to
select Scatter for the Depth and Scatter with smooth line and markers
for the Temperature.

Series Name Chart Type Secondary Axis
B Depth Scatter e ]
I Temperature Scatter with Smooth Lines... | ~

4. Click OK.

5. Onthe Chart Format tab, in the Current Selection group select Series
“Temperature” and click Format Selection.

Mac: Continue with Step 6 below.
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6.

Click the paint bucket, change the line color to blue and the Width to 3 pt.

25.0

20.0

i
3
o

Depth (feet)

5.0

0.0

5.0

River Depth vs. Distance From West Bank

80.0

b 70.0

50.0
40.0
30.0

y = 2E-09x® - 6E-07x5 + 7E-05x4 - 0.0037x® + 0.0778x2 + 0.1473x - 0.0165 20.0
J R? = 0.9985 where y is Depth and x is Distance from West Bank

0 20 40 60 80 100 120 100

0.0
Distance From West Bank (feet)

1.

Format the vertical and horizontal axes as follows:

On the Chart Format tab, in the Current Selection group, select Vertical
(Value) Axis, and click Format Selection.

In the Format Axis pane on the right, click the Axis Options icon |||

If necessary, click the triangle to the left of Axis Options to open its menu.
If necessary, under Bounds, change the Minimum to 0 and the Maximum
to 25.

If necessary, click the triangle to the left of Number to open its menu.

Under Category, select Number 4 Number
from the drop-down menu and set Category
the number of decimal places to O. -
MNumber =
Format the vertical axis numbers to _ -
dark red 10 pt Arial Black. Decimal places: | 0

Repeat this process to change the Horizontal (Value) Axis Minimum to O
and Maximum to 100. Also, under Number change the Category to
Number with 0 decimal places. Format the axis numbers to 10 pt Arial
Black. Leave the color as is.
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8. Repeat this process to change the Secondary Vertical (Value) Axis
Minimum to 0 and Maximum to 80. Also, under Number change the
Category to Number with O decimal places. Format the secondary vertical
axis numbers to blue 10 pt Arial Black.

Notice that the right scale numbers shown do not line up with the major
gridlines. It will make the graph look better if those numbers were to line up
with the major gridlines. Since the right vertical axis scale goes from 0 to 80
and there are 5 major gridlines, divide 80 by 5 to get 16.

So, change the Major Units to 16.

4 Aads Options
Bounds
Minimum 0.0 Auto
Maxirnurm 80.0 Auto
Units
Major 16.0 Reset

9. Click the Green Cross to open the Chart Elements menu, click the
triangle to the right of Axis Titles, and put a check next to Secondary

Vertical.
| L
4 CHART ELEMENTS _
t Options
Axes
o Auis Titles 3 Primary Horizontal
Chart Title Primary Vertical
Y [ ] Data Labels L] Secondary Horizontal
Secondary Vertical

10. Click the Secondary (Right) Vertical Axis title and type Bottom
Temperature (deg F). Make the font blue 14 pt Arial Black.

—
11. With the Right Vertical Axis title selected, click the Size and Properties icon [2
and, under Alignment Text direction, select Rotate all text 90°.

Format Axis Title v X
Title Options ¥  Text Options

4 Alignment

Vertical alignment Center Mid... ~

Text direction Rotate all t.. | =

ABC | Horizontal

=
g Rotate all text 90°




PROJECT 5: EXCEL: CUSTOMIZING CHARTS, MAKING DECISIONS, AND SORTING SG133

12. Make the left vertical axis title Depth (feet) dark red.

River Depth vs. Distance From West Bank
25 80

20 54'.,'
[
=
=]
3

= =
T 15 a8 ©
0 3
A= °
= (1]
= 3
o -
® 10 32 €
- o
_—
e
(1]
Q@

5 16 oy

-

y = 2E-09x® - 6E-07x° + 7E-05x4 - 0.0037x3 + 0.0778x2 + 0.1473x - 0.0165
R2? = 0.9985 where y is Depth and x is Distance from West Bank

0 10 20 30 40 50 60 70 80 20 100
Distance From West Bank (feet)

The two graphs show that the depth and temperature are inversely related.
That is, as you go from the shore to the middle of the river the depth
increases while the temperature decreases.

m. Color code the graphs, equation, and labels to make it easier to distinguish
them by doing the following:

1. Click the title and change it to River Depth and Bottom Temperature
vs. Distance From West Bank.

2. In the title, select the word Depth and make its color dark red.

Mac: | don’t think you can change individual words on a Mac so skip it.

3. Inthe title, select the Bottom Temperature and make its color blue.

4. Center the equation textbox just above the horizontal axis.

n. Set up the River Depth and Temp Chart chartsheet to print in Landscape
orientation and include a footer that contains the file name on the left and the
sheet name on the right. Compare the preview with the key. Make needed
corrections, save the workbook, and close it.
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HWO05-2 Loans IF
Problem: How can you determine if a loan payment is overdue?

The worksheet you develop for this problem will determine if a loan payment is more
than 30 days past due and, if so, it will calculate the number of days it is overdue.
This project and the next two will give you more experience in working with the IF
function, which you used to calculate regular and overtime pay on page SG67.

a. Open the workbook HWO05-2 Loans IF Original, which is one of the files you
downloaded at the start of the term.

b. Save the workbook using the name HWO05-2 HWID Loans IF Done
c. As you did on page SG70, create a named range for cell B3. Call it Today.

d. For cells D7:D10, construct a formula that uses the IF function to display the
word OVERDUE if the payment is more than 30 days overdue. Here is the form:

=IF(logical test, value if true, value if false)
To help you write the IF function, consider the following three parts:

Logical test — how will Excel choose between the two possibilities (to display
the word OVERDUE or to display a blank)? The difference of Today's Date
and the Due Date must be greater than 30. Write this inequality as you
would in algebra using cell references instead of variables.

Value if true — if the Logical test is true, what should be displayed?
You want to display the word OVERDUE. You must put OVERDUE inside
quotation marks or Excel will think it is a special function or a named range
(see page SG70) and not know what to do with it.

Value if false — if the Logical test is false, what should be displayed?
You want to display a blank so you must type two sets of double quotation
marks next to each other, like this "". This is called a null string since it
contains nothing (it is null).

In the space below, write the IF statement for D7:

display if display if
logical test condition condition
(condition) TRUE FALSE
=1F( ’ ’ )
is difference the word ™ (null string)
in dates more "OVERDUE"

than 30?
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1. Once you have constructed the formula, type it in =

D7 and then fill down to D10. After you fill, be sure Copy Cells
to click the arrow on the Auto Fill Options button o
and select Fill Without Formatting to preserve
the original formatting of the cells. If you do not,
the bottom border of D10 will be incorrect.

Fill Fermatting Only
O Fill Without Formatting
©  FlashFill

1 Loan Payments

2

<M Today's Date: 13 Jul 2021 |

4 More than

3 30 days Number of
6 Loan Due Date Amount overdue days overdue
7 Boat 11 Jun 2021 $450.00 OVERDUE

8 Car 30 Jun 2021 $520.00

9 Home 04 Jul 2021 $980.00
Pl Student 24 May 2021 $300.00 #VALUE!

Notice the #VALUE! error in D10. When you filled down the formula, Excel
changed the row numbers in the formula one at a time. That is, B7 became
B8, and then B8 became B9, and so on. That is what you want. However,
Excel also changed B3 to B4, and then B4 to B5 and so on. That is NOT
what you want because Today's Date is in B3 and so B3 should remain
B3 in all the formulas.

To tell Excel to keep B3 the same use an absolute reference. So, in D7
change B3 to B$3. The $ to the left of 3 means to keep that row number
constant (absolute) when you fill down. Note that you also could use $B$3
but since you are not copying left or right the B will not change anyway.

Correct the formula in D7 and fill down, again preserving the formatting.

Check D7. It should display OVERDUE since Today’s Date, 13 Jul 2021 is
more than 30 days after the Due Date, 11 Jun 2021.

Check D8. It should be blank since Today’s Date, 13 Jul 2021 is only 14
days after the Due Date, 30 Jun 2021.

e. For cells E7:E10, construct a formula that will display the number of days the
loan is overdue, if itis, or a blank, if it is not overdue. These formulas will be
almost the same as the formulas in cells D7:D10 but in place of "OVERDUE"

have Excel calculate the actual difference in dates by subtracting them.
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In the space below, write the IF statement for E7:

display if display if
logical test condition condition
(condition) TRUE FALSE
=1F( ’ ’ )
is difference difference in a blank
in dates more dates

than 30?

In your formula, use the named range Today rather than B$3. Using a named
range means you need not worry about absolute referencing and it makes the
formula a bit easier to understand: =IF(Today-B7>30,Today-B7,"") The value
in E7 should be 32.

Fill the formula in E7 down to E10 and preserve the format.

f. Set up the Loan Data worksheet to print in Landscape orientation, all on one
page, centered horizontally but not vertically, and include a footer that
contains the file name on the left and the sheet name on the right. Compare
the preview with the key. Make needed corrections, save the workbook, and
close it.

HWO05-3 Rent IF

Problem: How can you determine which of two rates should be applied to rental
properties?

The worksheet you develop for this problem will determine the payment that is
due for renting floor space in a mall. In this situation, there are two possible rates:
a low, introductory rate of $5.00 per square foot for clients that have been renting
for under a year, and a regular rate of $9.00 per square foot for older clients. To
make the formulas easier to understand, you will use several named ranges.

a. Open the workbook HWO05-3 Rent IF Original, which is one of the files you
downloaded at the start of the term.

b. Save the workbook as HW05-3 HWID Rent IF Done

c. In order to make the formulas easier to read, create several named ranges by
doing the following:

1. Click B3 and create a named range called Today. A Today -
quick way to do this is to click B3 and then type Today @
in the name box (on the left side of the formula bar)

and tap Enter.

2. Click B6 and create a named range called NormRateB.
3. Click B7 and create a named range called IntroRateB.

4. Create a named range called Space for B10:B20. This is similar to
creating a single cell named range except that you first select several cells.
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5. Create a named range called PayDue for D10:D20.

6. On the Formulas tab, in the Defined Names group, click Name Manager.
You will see listed the named ranges you just created.

Name Manager

New... Edit... Delete
MName Walue Refers To Scope
::EélntroRateB =Data!$B%$7 Workbook
@Norm RateB 9 =Data!$B%6 Workbook
@PayDue ooy, o =Data!$D$10:3D%20 Workbook
@Space {"5000%;"1500""800""... =Data!$B$10:$B%$20 Workbook
@Today 11 Jul 2022 =Data!$B$3 Workbook

Click Close to close the Name Manager dialog box.

d. For cells D10:D20, construct a formula that displays the payment for renting
floor space. The condition in the IF function should test to see if the difference
of Today's Date and the Initial Date is greater than 365 (that is, one year). If it
is, the payment is calculated by multiplying the Floor Space by the Normal
Rate (in B6); otherwise, the payment is calculated by multiplying the Floor
Space by the Introductory Rate (in B7).

To help you write the IF function, consider the following three parts:

Logical test — how will Excel choose between the two possibilities (what
criteria will Excel use to choose between the formula that uses the Normal
Rate or the Introductory Rate)?

Value if true — if the Logical test is true, what should be displayed (which
formula should be used)?

Value if false — if the Logical test is false, what should be displayed (which
formula should be used)?

In the space below, write the IF statement for D10:

display if display if
logical test condition condition
(condition) TRUE FALSE
=IF( ’ ’ )
is difference Floor Space times Floor Space Times
in dates more Normal Rate Introductory Rate

than 365?

1. Once you have constructed the formula, type it into D10. Use the named
ranges in your formula. If you do not use the names ranges, then you must
use absolute references (the $) where appropriate. 22

22 z|F(Today-C10>365,B10*NormRateB,B10*IntroRateB) or =IF(B$3-C10>365,B10*B$6,B10*B7)
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2. Check D10. The Initial Date, 10 Oct 2015 is more than 365 days
from Today’s Date, 11 July 2022, so the payment should use the
Normal Rate: 9*5000 = 45000.

3. If your formula displays 45000, fill it down to D20. Otherwise, fix it. After
you fill, be sure to click the arrow on the Auto Fill Options button and
select Fill Without Formatting to preserve the original formatting of the
cells. If you do not, the bottom border of D20 will be incorrect.

4. Check the value in D11. The difference between Today’s Date and the
Initial Date is less than 365 so the Introductory Rate should be used:
5*1500 = 7500. If that does not check, look at your formula. Did you put in
absolute referencing for the cells that should not change (B3, B6, and B7)?
If you used the name ranges for these cells, then the absolute referencing is
automatic. If you used the cell reference, such as B3, then you must add a $
between the B and the 3 to indicate that the 3 is to remain constant
(absolute) when you fill down. In that case, the cell reference would be B$3.

5. Format the dollar amounts in D10:D20 as currency with two decimal places and
the dollar sign (e.g., $45,000.00).

e. The rates in B6 and B7 are given using dollars per square foot rather than
dollars per square meter. The U.S., Liberia, and Myanmar are the only
countries in the world that still use the antiquated British Imperial measurement
system. All other countries use the Metric system 23,

Use the CONVERT function to see what the Metric values of the rates are. This
function has the form: CONVERT(number,from_unit,to_unit). The from_unit
and to_unit are codes that Excel requires. For example, the square foot code
is “ft2” and the square meter code is “m2”. 24 Do the following:

1. Incell C6, type
=NormRateB/convert(1,"ft2","m2"). Here, the
normal rate in B6 is divided by the conversion of
one square foot to square meters.

Metric System
96.87519375
53.81955208

2. Enter a similar formula in C7.

f. Apply some custom formats to several cells by doing the following:

1. Select cells B6:B7, right-click B6, select Format Cells, click the Number
tab, and click Custom. The shortcut for displaying Format Cells is Ctrl + 1.

23 The Metric System of measurement was developed in the 1790’s in France. The official name for
this system today is the International System of Units (SI). Although most U.S. citizens are ignorant
of this system, it is used by many institutions in the U.S. including science, medicine, electronics,
the military, automobile production and repair, and international affairs. Thomas Jefferson was the
one who decided to use the British system. The U.S. does not convert because it would cost a lot of
money in the short term, although it would save a lot more money in the long term.

24 To see a list of CONVERT codes, tap F1 and type convert in the search box.
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2. Change the text in the Type box to $#.00" per sq. ft." (the quotation marks
are needed) and then click OK.

$ says to display the dollar sign.

#.00 is a place holder that says to display the number, rounded to two
decimal places.

" per sq. ft." says to display the text between the quotation marks exactly
as it is shown.

3. Select cells C6:C7 and follow the same procedure to apply this custom
format: $#.00" per sq. m." Cell C6 should display $96.88 per sq. m.

4. Select cells B10:B20 and follow the same procedure to apply this custom
format: ####" sq. ft." Cell B10 should display 5,000 sq. ft.

#,##+# says to display the number with a comma if the number is over one
thousand.

" sq. ft." says to display text between quotation marks exactly as it is shown.

I. In D21, insert a formula that uses a named range and calculates the Total
Payment Due for all companies by doing the following:

1. In D21, use the SUM function to find the sum of all payments due. To do
that, type =sum(paydue) and tap Enter.

2. Format the dollar amount in D21 as currency with two decimal places and
the dollar sign.

J. Set up a conditional format so that the rows of the companies whose payments
are less than $8,000 have a light orange fill. To do that, Select A10:D20 since
that is where you want the formatting to appear. On the Home tab, in the
Styles group, click Conditional Formatting, New Rule, Use a formula, and
type =$d10<8000. Note the use of the dollar sign to indicate an absolute
reference. Finally, click Format, Fill and choose light orange.

Mac: Click the plus sign inside a box| + |in lower left corner. From Style select Classic.

k. In D23, enter a formula that displays the number of payments that are less
than $8,000. Here, you are counting something so use the COUNTIF
function. If you forget the form, type =countif( and a _
ScreenTip will remind you. If you have an internet [ =countif] ]
connection, you can click the underlined blue
COUNTIF for a more extensive explanation.

| COUNTIF(range, criteria) |

1. Type your formula. Remember to use quotation marks around the condition. 2°

2. Check your answer. The second and third payments are less than $8,000
so the number should be 2.

3. Format the value as a number with zero decimal places.

25 =COUNTIF(PayDue,"<8000") For the condition, you could also use “<$8,000”



SG140 PROJECT 5: EXCEL: CUSTOMIZING CHARTS, MAKING DECISIONS, AND SORTING

l. In D24, display the sum of the payments that are less than $8,000.
1. Type your formula. Here, you are finding a sum so use the SUMIFS function. 26

2. Check your answer. The second and third payments are less than $8,000
(these should be highlighted in light orange). So, the sum should be $7,500
+ $7,200 = $14,700.

3. Format the value as currency with two decimal places and the dollar sign.

m. In D25, display the sum of payments where the floor space is less than 2,200.

1. Type your formula. Here, you are finding a sum so use the SUMIFS
function. Note that the range where the criterion is checked (B10:B20) is
different from the sum_range that you will sum (D10:D20). 2/

2. Check the result. The second, third, and fourth floor spaces are less than
2,200 so the sum of the payments for those should be $7,500 + $7,200 +
$10,000 = $24,700.

3. Format the value as currency with two decimal places and the dollar sign.
4. Left align cells D23:D25.

n. Set up a conditional format to highlight with yellow fill the rows of the
companies whose payments are over the average of all the payments. 28

A quick way to check that what you have is correct, is to select D10:D20 and
look at the status bar at the bottom of the window.

Average: $70,209.09 Count 11 Sum: $772,300.00

This shows the average of the selected cells is $70,209.09. A quick glance at
the Payments Due confirms that Cub, Gertins, and Menards have Payments
Due over this amount while all the other companies do not.

0. Remove the words inside parentheses in column A. To do this quickly, use
Excel’s Find and Replace feature and wildcards. Wildcards are symbols that
take the place of one or several characters. Do the following:

1. Select A10:A20.

2. Tap Ctrl + h (Shift + Command + h on Mac) to open the Find and
Replace dialog box.

The Find what box tells Excel what you are looking for. If you were to enter
(Outdoors) and click the Find Next button, Excel would highlight cell A10. You
could then delete (Outdoors). Don’t do this because you want to delete ALL
instances of words and their surrounding parentheses in A10:A20.

26 =SUMIFS(PayDue,PayDue,"<8000") For the condition, you could also use “<$8,000”

27 =SUMIFS(PayDue,Space,"<2200") Note how the use of named ranges makes this formula easier
to understand..

28 Select A10:F20 since that is where you want the formatting to appear. Click Conditional
Formatting, New Rule, Use a formula, and type =$d10>average($d$10:$d$20) Note the use of
the dollar signs to indicate absolute references. Finally, click Format, Fill.
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3. Inthe Find what box, type (*). The asterisk * is a wildcard that takes the
place of ANY string of characters. Leave the Replace with box empty
because you want to replace the parentheses and characters with nothing;
that is, you want to delete them.

B Company Find and Replace

BN Badtke Burger Barn (Fast Food) Find Replace

Find what: ™ ~

1:3 Panera (Food) Replace with:
153 Cub (Groceries) —

' Replace All Replace Find All Close
(2] Mary's Malts (Food)

4. Click the Replace All button. Excel tells you it has made 11 replacements.
Click OK. All the parentheses and words inside them are deleted.

5. Close the Find and Replace dialog box.

The two most useful wildcards in Excel are the asterisk and the question mark. 2°

* asterisk represents any number of characters. For example
ch* matches any text string that begins with ch such as Charles, check, and chess.
*ch matches any text string that ends with ch such as March, inch, and fetch.

*ch* matches any text string that contains ch in any position such as Chad,
headache, and arch.

? question mark represents any single character. For example:
pri?e matches price, pride, and prize.

??7?-?7? matches any string containing 2 groups of 3 characters separated
with a hyphen such as ABC-DEF, ABC-123, and 111-222.

p. Set up the Rent IF Data worksheet to print in Landscape orientation, all on one
page, centered horizontally but not vertically and include a footer that contains
the file name on the left and the sheet name on the right. Compare the preview
with the key. Make needed corrections, save the workbook and close it.

HWO05-4 Commission IF

Problem: How can you determine an employee's commission, total pay, and target
pay based on their sales record?

a. Open the workbook HWO05-4 Commission IF Original, which is one of the files
you downloaded at the start of the term.

29 This information is from https://www.ablebits.com/office-addins-blog/2020/10/14/excel-wildcard-
find-replace-filter-formulas/ It has lots more information on wildcards.
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https://www.ablebits.com/office-addins-blog/2020/10/14/excel-wildcard-find-replace-filter-formulas/
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b. Save the workbook using the name HW05-4 HWID Commission IF Done

c. In D4, enter a formula that will calculate Sherri’s hardware commission. Use the
following rules to construct the formula:

« If an employee sells up to $20,000 worth of hardware, she earns a hardware
commission of 10% of her hardware sales. For example, Mary will earn 10%
of $13,500, which is $1,350.

« If an employee sells more than $20,000 worth of hardware, she earns a
hardware commission of 10% of $20,000 plus 12% of the amount that her
hardware sales were over $20,000. For example, Sherri will earn 10% of
$20,000 plus 12% of $3,000, which is $2,000 + $360 = $2,360.

Basically, you want to use the IF function to select between two formulas: one
that calculates the commission if the hardware sales are $20,000 or less and

the other if the sales are over $20,000. This commission problem is similar to

the overtime pay problem described in Project HW03-4 on page SG66.

In the space below, write the IF statement for D4. To find the sales over
$20,000, subtract 20000 from the Hardware Sales (so Sherri would be 3000).
Be sure to put that in parentheses so Excel does the subtraction before the
multiplication by 12%.

display if display if
logical test condition condition
(condition) TRUE FALSE
=IF( ’ ’ )
is Hardeware Sales 10% times 10% times 20000
20000 or less? Hardware Sales +12% of excess

1. Type the formula in D4 and tap Enter. Do you need to use absolute or
relative references. Absolute, which uses the $, says to NOT change any
row numbers when you fill down. Relative says to change row numbers.

2. Check the result. Sherri's Hardware Sales were 23000. So, her commission
should be 10%*20000 + 12%*3000 = 2360.

3. Fill D4 down to row 80. Check the result for Mary in D5. Her Hardware
Sales were 13500 so her commission should be 10%*13500 = 1350.

d. Click E4 and enter an Excel formula to calculate the software commission. An
employee earns 8% on software sales. You do not need an IF function here
because there is no decision to be made—every software commission is
calculated in the same way.

e. Click F4 and enter an Excel formula to calculate the total commission (the sum
of the Hardware Commission and the Software Commission).
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f. Click G4 and enter an Excel formula to calculate the Total Earnings for Sherri.
Employees earn a base salary plus their Total Commission. The base salary
is calculated as follows:
$10,000 if the Total Commission is $1,200 or less;
$11,000 if the Total Commission is between $1,200 and $1,400;
$12,000 if the Total Commission is $1,400 or over.

Follow the directions below to do this calculation using “nested” IF formulas.
You use nested IF logic in your daily life. For example, when you approach a
traffic signal while driving your car:
IF green light THEN keep going, ELSE
IF red light THEN stop ELSE
the light is yellow so speed up or slow down depending on how far you
are from the light.
For this problem the logic will go like this:
IF Total Commission <= 1200 THEN 10000 + Total Commission ELSE
IF Total Commission < 1400 THEN 11000 + Total Commission ELSE
12000 + Total Commission
When you write your Excel formula, you will use the cell reference for Total
Commission (F4 for Sherri) rather than the words, and commas instead of

THEN and ELSE. If your version of Excel has the IFS function you could use
that instead of nested IF, but the logic will be the same.

Do the following:

1. Type your formula in G4 and tap Enter. Do NOT put commas in the
numbers in the formula. Excel considers commas delimiters (separators)
between parts of a formula and will give you an error message.

THEN ELSE THEN ELSE
=IF| F4<=1200 , 10000+F4 , IF| F4<1400 , 11000+F4 , 12000+F4
[ —_——
Condition 1 Condition 2 ﬂ

4

Here is the formula using IFS: Default value is 12009 + F4

THEN ELSE THEN ELSE THEN\
=IFS|F4<=1200 , 10000+F4 , F4<1400 , 11000+F4 , F4>=1400 , 12000+F4
—_— —_— —_—
Condition 1 Condition 2 Condition 3

2. Check the result. Sherri's Total Commission is 2,424. Since this is over
1,400 her base will be 12,000. So, her Total Earnings should be 12,000 +
2,424, which is 14,424.
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3. Fill E4:G4 down to row 80.

Check the result for Mary in G5. Her Total Commission is 1,390, which is
between 1,200 and 1,400, so her base is 11,000. Her Total Earnings
should be 11,000 + 1,390, which is 12,390.

Check the result for Monica in G8. Her Total Commission is 970.24,
which is less than 1,200, so her base is 10,000. Her Total Earnings
should be 10,000 + 970.24, which is 10,970.24.

g. In cells B81:G81, enter formulas for the Totals of columns B:G.
h. In cells B82:G82, enter the formulas for the Averages of columns B:G.

i. Perform a Goal Seek for Lawrence to see what his Hardware Sales would
have to be to make his Total Earnings $15,000 (Data, Forecast, What-If,
Goal Seek). The answer is $28,200.00

Click B6 and insert a note that says Used Goal Seek here (right-click, New Note).

=M Mary $ 13,500.00 Douglas F. Roberm::r?:n
M Lawrence $ 28,200.00 ' {ysed Goal Seek here.
[&) Brady $ 75,192.00 960.

j. Set up a conditional format to highlight the high performers by making the cell
fill for Employee names yellow if their Total Earnings is over $20,000.%°

k. Split the worksheet below row 10 (View, Split) and adjust things so you can
see the top and bottom rows.

30 Select A4:A80 since that is where you want the formatting to appear. Click Conditional
Formatting, New Rule, Use a formula to determine which cells to format, =G4>20000,
Format, Fill.
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|. Format the worksheet so that it looks like the following:

-..A_/ B8 Cc_ . D ____E___ __F |

1 MicroMania, Inc., Sales and Earnings Summary
2

Hardware Software Hardware Software Total Total
N Employee Sales Sales Commission Commission Commission Earnings
23 Sherri $ 2300000 $ 80000 % 2360.00 $ 6400 $ 242400 3 1442400
S Mary $ 1350000 $ 50000 % 1,350.00 $ 40.00 $ 1,390.00: % 12.390.00
W Lawrence | $ 28,200.00 "$ 200.00 ' $ 2,984.00 $ 16.00 $ 3,000.00 : $ 15,000.00
& Brady $ 75,192.00 9YpouglasF. Robertson: }23.04 ' $ 7680 $ 869984 § 20,699.84
3 Monica $ 9,500.00 §Used Goal Seek here.  )50.00 = §$ 2024 $ 970.24 ' $ 10,970.24
Ll Jezebel $ 7994400 $ 919.00 $ 919328 % 7352 $ 9266.80 % 21,266.80
I{:} Marisa $ 2527100 $ 78200 % 263252 3 6256 $§ 269508 $ 1469508
[ Sean $ 98630.00 $ 81000 3% 1143560 3 6480 $ 1150040 $ 2350040
748 Max $ 6235700 $ 95800 . % 708284 S 7664 $ 715948 '§ 1915948
TENAMyY $ 33883.00 $ 97400 % 366596 % 7792 $ 374388 : % 15,743.88
;0N Jessica $ 5841800 $ 38800 % 6,610.16 % 3104 $ 664120 $ 18,641.20
38 Totals $4,050,169.00 $44,539.00 $456,120.06 $ 3,563.12 $459,683.18 $1,378,683.18
s7BAverages | $§ 52,599.60 § 57843 §$§ 592364 $ 46.27 $ 596991 ' $ 17,904.98

There is no AutoFormat style that you can use to do the formatting. So, you
will have to use the buttons on the Home tab and the Format Cells dialog box.
For example:

+ For Row 1, merge and center the title across the table, and make it 16 pt
bold, italic.

* For Row 3, bold the cells. To make the text wrap where you want, use a
manual line break. For example, in B3 place the insertion point to the left of
the S in Sales and tap Alt + Enter. This places Sales below Hardware. If it
is not done automatically, wrap the text.

* AutoFit the columns.

* For Row 3 through Row 82, use Format Cells and the Border tab to set the
different border types. For the borders, be sure you select the cells whose
borders you wish to set before choosing Format Cells. Once you are in the
Border tab, click the style of the line you want (light line, double line, thick
line) in the Line Style box, click where you want the line to be applied in the
Border box, and then click OK.

There is a light border around most of the cells and a bold border around
the entire table and between row 80 and 81.

There is a double line border between rows 3 and 4, and between
columns A and B.

This will take some experimentation on your part and will help you gain
familiarity with these powerful formatting features.
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m. Do the following to print the worksheet:
1. Remove the split screen.

2. Hide rows 11 through 75 as you did on page SG56.

Do NOT go to the View tab, Window group, and click Hide. | [ZIHide

That will hide the entire workbook! If you do that, click Unhide FJunhide
to get the window back.

3. Setthe Print Areato A1:G82.

4. Set up the Commission IF Sales Data worksheet to print in Landscape
orientation, all on one page, centered horizontally but not vertically and
include a footer that contains the file name on the left and the sheet name
on the right. Set the note to print (Page Layout, Page Setup, Sheet,
Comments and notes, As displayed on sheet). Compare the preview
with the key. Make needed corrections, save the workbook, and close it.

HWO05-5 Sorting Values

Problem: How can you create summary information on home values and then
display particular values based on certain conditions?

a. Open the workbook HWO05-5 Sorting Values Original, which is one of the files
you downloaded at the start of the term.

b. Save the workbook using the name HW05-5 HWID Sorting Values Done.

c. Freeze the pane so that rows 1 and 2 are always on the screen (select row 3,
then View, Window, Freeze Panes, Freeze Panes).

d. Number the addresses by doing the following:

1. In B3, to display the row number of the cell, type =row() click the Enter
checkbox. The number 3 is displayed.

2. Change B3 to =row()-2 and tap Enter. The number 1 is displayed. This is
the first entry in the list. Later, when you sort the rows, the number 1 will
remain in B3 indicating that there is a new number 1 in the list.

3. Fill the formula down to B15. You can see that there are 13 items in the list.

e. Often, it is useful to be able to distinguish between cells that contain formulas
and those that contain labels or raw data. To see how this works, do the
following:
: . . AdA B
1. Click the Select All triangle in the upper left corner of the worksheet. ; i
2. On the Home tab, in the Styles group, click Conditional Formatting, and
select New Rule.

Mac: From Style: select Classic.

3. Select Use aformula to determine which cells to format.
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4.

5.
6.

Type this into the formula box: =isformula(al). This is true if a cell contains
a formula (that is, it begins with an = sign). While the formula indicates only
cell A1, it will apply to all the cells of the worksheet because you selected
all the cells before Conditional Formatting.

Click Format and set the font color to dark red.

Click OK three times. The numbers in cells B3:B15 now are red.

f. Create a conditional format so that the data for homes whose Lot Sizes are
greater than 1 will have an orange fill. If you need help, follow the steps below:

1.
2.

You want to apply the formatting to all the data so select B3:115.

On the Home tab, in the Styles group, click Conditional Formatting,
select New Rule, and click Use a formula to determine which cells.

Type this into the formula box: =$f3>1 This tells Excel to see if the value in
F3 (the Lot Size for the first home) is greater than 1. If it is, Excel will apply
a special format; otherwise, the format will not change. Note the use of the
$. You need that so that Excel will always check the value in column F and
not values in other columns.

Click Format and set the fill to light orange.

Click OK three times.

Home Values
Estimated | Property Lot Size | Cable TV | Small Lot = Small Lot
Num Address Value Tax (acre) Hookup | with Cable | or Cable
1 1457 Via Colinas $ 252,467 | $ 1,969.00 0.80 Yes
2 1459 Via Colinas $ 301,582 : $ 2,352.00 1.20 Yes
3 11461 Via Colinas $ 285,456 : $ 2,227.00 0.94 Yes
4 23 Fourth Street $ 242,467 @ $ 2,051.00 1.12 No

g. Create additional summary information by doing the following:

1.

In C17, enter a formula that will display the number of houses that have a
Cable TV Hookup. Check the result. 3!

In C18, enter a formula that will display the number of properties that are
over one acre in size and whose Property Taxes is under $2,100. Check
the result. 32

31 You are counting the number of houses based on a condition so use =COUNTIF(G3:G15,"Yes")
32 You are counting the number of houses based on two conditions so use
=COUNTIFS(F3:F15,">1",E3:E15,"<2100")
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3. In C19, enter a formula that will display the sum of the Property Taxes for
lots that are over one acre.3® Check the result. A quick way of checking is
to click the Property Tax of home 2, hold down the Ctrl key, and then click
the Property Taxes of homes 4, 9, and 10. Now, look in the bottom right
corner of the window, on the Status Bar, and you can see the SUM of the
selected cells is $8,724.00.

| Average: $2,181.00 Count:4 Sum: $8,724.00 |

4. In C20, enter a formula that will display the sum of the Estimated Value of
the properties whose Lot Size is over 1 and that do not have Cable TV
Hookup. Check the result. 34

5. In C21, type Click here to open Zillow.com to see more home values.
Click the Enter checkbox to keep C21 active.

6. With C21 still active, tap Ctrl + k. This is the shortcut for Insert Hyperlink.
You can also click Hyperlink on the Insert tab.

7. Near the bottom of the Insert Hyperlink dialog box, in the Address box,
type the URL for Zillow: http://www.zillow.com/

Address: http://www.zillow.com/

8. Click OK. The hyperlink is created and the style for the URL is
automatically set to Hyperlink (underlined blue text).

9. Point to (do NOT click) C21 to see the hyperlink.

Click here to open Zillow.com to see more home values

http://www.zillow.com/ - Click once to
follow. Click and hold to select this
cell.

10. Click cell C21 and your web browser will open and take you to the web site.
Just for fun, if you wish, type your home address and Zillow will show you
its estimated value. Here is what you will see if you type 1600
Pennsylvania Ave NW, Washington, DC 20006. This is the White House,
valued at about $459 million. Note the 35 bathrooms!

2 Zillow 7 8

' 16bd 35ba 55,000 sqft
~ g 1600 Pennsylvania Ave NW, Washington, D(
b |

Off market Zestimate®: $459,108,000

11. Close the web browser.

33 You are looking for a sum with certain conditions so use =SUMIFS(E3:E15,F3:F15,">1")
%4 =SUMIFS(D3:D15,F3:F15,">1",G3:G15,"No")
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If you want to select the cell that contains the hyperlink, point to it and hold
down the left mouse button for 3 seconds. That selects the cell without
activating the link.

If you want to remove the link, select the cell, tap Ctrl + k, and the click the
Remove Link button.

h. In Project 1 you used Boolean Operators when searching for files that
contained specific words. Those operators, AND, OR, and NOT can be
used in IF functions. To see how this works, do the following:

1. Click H3. You want to create a formula that will determine which homes
have a small lot AND cable TV. To do that you can use the AND operator
inside an IF formula.

Type =if(and(f3<1,g3="Yes"),"Yes","No") and click the Enter checkbox.
Here, the AND function requires that both conditions be met. That is, F3,
the Lot Size, must be less than 1 and also G3, Cable TV Hookup, must
be Yes. If either is not true, then the condition is not true.

Check the result. The Lot Size for the first home is 0.80, which is
less than 1, AND the Cable TV Hookup is Yes so the result should
be Yes.

2. Fill the formula down to row 15. Check the result for the second home.
It's Lot Size is 1.20, which is greater than 1, and the Cable TV Hookup
is Yes. Since one of the two conditions is not true, the entire condition is
not true and so H4 displays No.

3. Click I3. Create a formula that determines which homes have a small lot OR
cable TV. To do that you can use the OR operator inside an IF formula.

Type =if(or(f3<1,9g3="Yes"),"Yes","No") and click the Enter checkbox.

Here, the OR function requires that either condition be met. That is, F3,
the Lot Size, must be less than 1 OR G3, Cable TV Hookup, must be
Yes. If both are not true then the condition is not true.

Check the result. The Lot Size for the first home is 0.80, which is less than 1,
and the Cable TV Hookup is Yes so, the result should be Yes.

4. Fill the formula down to H15. Check the result for the second home.
It's Lot Size in 1.20, which is greater than 1 so that does not match.
But, the Cable TV Hookup is Yes and that does match. So, it meets
at least one of the conditions and so 14 displays Yes.

For the fourth home, the lot size is over 1 and there is no cable. Since
neither condition is true the entire condition is false and a blank is displayed.



SG150 PROJECT 5: EXCEL: CUSTOMIZING CHARTS, MAKING DECISIONS, AND SORTING

I. Do the following to filter the data in the table so that only rows with the
Property Tax between 1500 and 2100, inclusive, are displayed:

1. Select the range B2:12

2. Onthe Home tab, in the Editing group, click Sort & Filter, and select
Filter. This puts little upside down triangles in row 2.

1 Home Values

Estimated | Property | Lot Size ;| Cable TV = Small Lot Small Lot
2 BLUAS Address | ~i Value i Tax ~ (acre)|~ Hookug ~ with Cab ~ or Cabl(~
<9 1 1457 Via Colinas $ 252,467  $1,969.00 0.80  Yes Yes Yes

3. Click the triangle in E2, select Number Filters, and select Between.

2] Sort Smallest to Largest 0.80 Yes
2] Sort Largest to Smallest 1.20 Yes
Sort by Color b 0.94 Yes
1.12 No

Filter by Color r dee —
n 7N
Mumber Filters k Equals...
Search 2 Does Not Equal.
[ [Select All] - Greater Than,
[+ $390.00
[ $1,891.00 Greater Thafl Or Equal Te..

-+ 51,969.00
[+ 52,035.00
[+ 52,040,00
-] §2,051.00 — Between...

ol e omem o

4. Enter 1500 and 2100 in the Custom Autofilter dialog box.

Less Thay..

m

Less Or Egual To...

Custom AutoFilter

Show rows where:
Property Tax

is greater than or equalto |~ 1500

@®@and Oor
is less than or equal to b 2100
5. Click OK.

1 Home Values

Estimated | Property | Lot Size Cable TV | Small Lot | Small Lot
2 Nu ~ Address ~ Value |~ Tax -¥: (acre) . Hookup ~: with Cab ' or Cabl -
=) 1 1457 Via Colinas $ 252,467 ' $ 1,969.00 0.80 Yes Yes Yes
6 4 23 Fourth Street $ 242 467 : $ 2,051.00 112 No No No
7 5 13579 Lake Avenue $ 252,467 @ $ 2,056.00 0.90 No No Yes
8 6 11458 Via Colinas $ 260,890  $2,035.00 0.70 Yes Yes Yes
11 9 13580 Lake Avenue $ 262,890 : $ 1,891.00 1.05 No No No
1) 13 22 Fourth Street $ 263,578  $ 1,969.00 0.82 Yes Yes Yes
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j. Add a second filter so that only rows whose Address has an orange fill are
displayed. To do this, click the filter button in cell C2 and select Filter by Color
and click the orange box.

Filter by Cell Color

Text Filters »

Now, the only data displayed are for those whose Property Tax is between
1500 and 2100, inclusive, AND whose Address cell fill is orange (which
corresponds to Lot Size is greater than 1).

Home Values

1

Estimated Property : Lot Size Cable TV Small Lot Small Lot
12 R Address |-T! Value |~ Tax |-¥. (acre ~ Hooku ~  with Cab ™ orCab ~
6 | 4 23 Fourth Street $ 242467 $ 2,051.00 1.12
e 9 3580 Lake Avenue $ 262,890 % 1,891.00 1.05

k. Do the following to sort the data in ascending order by Cable TV Hookup
status and then, within that, in descending order by Estimated Value.

1. Copy the Values Original worksheet and rename the new worksheet
Values Sorted.

2. Remove the filters so all rows show (Home, Editing, Sort & Filter, Filter).

3. Select rows 2:15 (be sure to select the entire rows by clicking the row
numbers on the left).

4. On the Home tab, in the Editing group, click Sort & Filter, and then select
Custom Sort. Be sure My data has headers is checked.

5. Inthe Sort by drop-down menu, select Cable TV Hookup and confirm that
the Order is A to Z.

6. With the Sort dialog box still open, click Add Level.

Mac: Add Level, Delete Level, and Copy Level are in the lower left corner of the
Sort dialog box.

7. Inthe Then by section select Estimated Value and choose Largest to
Smallest from the drop-down menu under Order.

Sort ? X
+ Add Level > Delete Level [Bgopy Level N Options... My data has headers
Column Sort On Order

Sortby | cable TV Hookup ~ | | cell values ~| |AtoZ w

Then by  Estimated Value £ Cell Values £ Largest to Smallest s
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8. Click OK. The data are sorted by Cable TV Hookup with the No’s first,
and then the Yes’s. Within the No’s, the data are sorted by Estimated
Value in reverse numerical order. Likewise, within the Yes’s, the data are
sorted by Estimated Value in reverse numerical order.

Home Values

Estimated | Property Lot Size | Cable TV | Small Lot | Small Lot

Num Address Value Tax (acre) Hookup  with Cable | or Cable
1 :24 Fourth Street $ 262,990 : $2,430.00 1.10 No No No
2 3580 Lake Avenue $ 262,890 : $ 1,891.00 1.05 No No No
3 13578 Lake Avenue $ 261,578 | $ 2,149.00 0.80 No No Yes
4 3579 Lake Avenue $ 252,467 @ $ 2,056.00 0.90 No No Yes
5 23 Fourth Street $ 242 467 $ 2,051.00 1.12 No No No
6 25 Fourth Street $ 50,000 @ $2313.00 0.95 No No Yes
7 1459 Via Colinas $ 301,582 : $ 2,352.00 1.20 Yes No Yes
8 1460 Via Colinas $ 297,566 @ $ 2,321.00 0.97 Yes Yes Yes
9 3582 Lake Avenue $ 296,566  $ 390.00 0.77 Yes Yes Yes
10 11461 Via Colinas $ 285456 : $ 2227.00 0.94 Yes Yes Yes
11 122 Fourth Street $ 263,578 | $ 1,969.00 0.82 Yes Yes Yes
12 1458 Via Colinas $ 260,890 : $ 2,035.00 0.70 Yes Yes Yes
13 1457 Via Colinas $ 252,467 @ $ 1,969.00 0.80 Yes Yes Yes

Notice that the Num column is still in order but the numbers are assigned to
different houses. That is because rather than typing the numbers individually
you used the ROW() function to have them keyed to the row number.

Set up the Values Sorted worksheet to print in Landscape orientation, all on
one page, centered horizontally but not vertically and include a footer that
contains the file name on the left and the sheet name on the right. Include row
and column headings. Compare the preview with the key. Make needed
corrections, save the workbook and close it.
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HWO05-6 Find and Macros

Problem: How can you download data, break up the values into meaningful pieces,
and use buttons to sort data and to move about a worksheet?

Before the start of each semester, | download from the University’s database Excel
files that contain my class lists. A typical file looks like this:

10 {I»] Name Sec Type Unts Grd Basis Acad Career Acad Level Program Primary Plan Email FERPA
I8 7023072 Berg,Alex D 1 LAB 4 A-F UGRD Senior CEHD Business Ed berg7023@umn.edu Suppress
|78 7266721 Bets,Sam A 1 LAB 4 A-F UGRD Senior Design Retail Mer  bets7266@umn.edu

48 2106779 Biff, Timothy B 1 LAB 4 A-F UGRD Freshman Design Retail Mer

For each student, | need to place the last name and first name in separate cells so |
can access each individually. In HW03-4 Payroll IF (page SG67) you did just that by
using the Flash Fill feature in the Data Tools group on the Data tab. That was quick
and easy and is fine if you occasionally need to break up or join simple data strings.
Text within a cell also can be split up by selecting the data and, on the Data tab, in
the Data Tools group, clicking Text to Columns. Our data are too complex to use
either of those. Also, every semester | have to set up a gradebook for each of the
sections of courses that | teach so using either method would not be efficient.

To get around this | created Excel formulas to do the separation automatically. To
see how this works, do the following.

a. Open the workbook HW05-6 Find and Macros Original, which is one of the
files you downloaded at the start of the term. This is a simplified version of my
gradebook for CI 1871 for section 1. | pasted the raw data from the U of M
database into the Server tab. | have scrambled the names, ID’s and email’s to

protect privacy.

b. Save the workbook using the name HW05-6 HWID Find and Macros Begin.

c. We need to put the Last Name and First Name in separate
cells, but they are in a single cell that has this structure:

ID Name
Last Name, comma, First Name, space, middle initial. |7023072 Berg,Alex D

This means that the Last Name consists of the characters from the start of the
name until the comma. You can use the FIND function to find the position of the
comma and then display the letters to the left of that position.

The FIND function has the form: =FIND(find text,within text)
You are looking for the comma in the cell that has the student’s name:
=FIND( what to look for,where to look)

Looking for comma C3 has the name
so use ", so use C3

To see how this works, do the following:
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1. On the Server sheet, in V3 type =find(",",c3) and click the Enter checkbox.
For Berg,Alex D the comma is the 5™ character from the left so 5 will be
displayed. That means the last name is the first 4 characters in the string.

If there had been no comma in C3, then #VALUE! would have been
displayed.

2. The First Name consists of the characters between the comma and the
space. Use FIND to find the position of the space.
=FIND( what to look for,where to look)

Looking for space C3 has the name
souse " "™ so use C3

In W3 type =find(" ",c3) and click the Enter checkbox.

For Berg,Alex D the space is the 10™ character from the left so 10 will be
displayed. If there had been no space in C3, then #VALUE! would have
been displayed.

Note that the FIND function does not help you “find” something in a range.
For that you would use one of the LOOKUP functions (see page SG79).
Also, the FIND function is case sensitive so in the “what to look for” words
like Beans and beans are considered different. To ignore case, use the
SEARCH function.

d. Use the LEFT function to display in U3 the Last name. LEFT has the form:
=LEFT(text,num chars)

You are looking in the cell that contains the student’s name and want to display
the characters up to the comma.

=LEFT(where to look,number of characters)

C3 has the name Position of comma -1

The position of the comma is in V3 so the number of characters for the first
name is V3—-1. Thatis, 5 -1 = 4 for Berg.

In U3 type =left(c3,v3-1) and click the Enter checkbox. Since the value in V3 is 5,
this will pick off the first 4 characters in C3. Berg will be displayed.

U3 © » « fe | =LEFT(C3,V3-1)

Scratch Area
Last name Comma . Space
Berg 5 10

e. The First Name consists of the characters between the comma at position 5
and the space at position 10.

5
BerglAlex D

S — %/_JT
Last First | Ml

10



PROJECT 5: EXCEL: CUSTOMIZING CHARTS, MAKING DECISIONS, AND SORTING SG155

The MID function can be used to display text in the middle of a string.
It has the form: =MID(text,start_num,num_chars)

You are looking in the cell that contains the student name, starting to the right of
the comma, and choosing the characters between the comma and the space.

=MID( where to look,position where to start, number of characters

C3 has the name Position of comma + 1 Position of space - 1- Position of comma

The position of the comma is in V3 so the position where to start is one more
than that, V3+1.

The number of characters is the difference between the position of the space
(in W3) and the position of the comma (in V3) minus 1, which is W3-V3-1.

Click T3 and type =mid(c3,v3+1,w3-v3-1) and click the Enter checkbox.
This will pick off the characters in the middle of the string between the comma
and the space. Alex is displayed.

T3 v > v  Jk | =MID(C3,V3+1,W3-V3-1)

Scratch Area
Major Email First name Last name Comma @ Space
Alex Berg 5 10

OK, whew, that was a fair amount of work but now that you know how to do it
you can use the formulas and techniques to automatically break up any string
of characters you wish. This is too complicated to ask you to do on a test. |
show it here so you can see what Excel is capable of.

. The worksheet has both raw data and formulas. It will be helpful to make their

fonts different colors so you can easily distinguish them. As you did in HWO05-5
(page SG147) use a conditional format to make red characters in cells that
contain formulas.

. In cell N3, display the Last name and First name, separated by a comma and

a space. For Berg,Alex D it should look like Berg, Alex. You can use the & to
concatenate the Last name, the comma and space, and the First name.®®

. In cells O3:S3 insert formulas to display the ID, College (Program), Year

(Acad Level), Major (Primary Plan), and email for each student. These will be
simple reference statements. For example, to display the ID in O3 you would
enter =B3 since B3 is where the ID is displayed.

Scratch Area

|Name ID College Year Major Email {First name __:Last name Comma | Space

[Berg, Alex 7023072 CEHD _ Senior Business Ed berg7023@umn.edu_|Alex Berg 5 | 10

8 =U3&","&T3

)



SG156 PROJECT 5: EXCEL: CUSTOMIZING CHARTS, MAKING DECISIONS, AND SORTING

I.  Fill the formulas for N3:W3 down to row 42 and preserve the formatting.

The rows that have no student data (38 to 42) have #VALUE! and zeros
displayed. You will get around this problem later.

The error #VALUE! also appears in N6 and T6. That indicates the formulas
cannot be calculated. The problem is that the name in cell C6 looks like this:
Bing Jr,William Bill. Here, a space appears to the left of the comma and that
means in the formula =MID(C6,V6+1,W6-V6-1) the W6-V6 is a negative
number and the MID function does not know what to do with it. You could put in
more formulas to take such a situation into account, but it would make the
worksheet much more complicated and since this seldom occurs it is easiest to
simply change the raw data Bing Jr to Bing. Do NOT do that now.

This brings up the important point that unexpected errors can occur and so you
should always eyeball your formula results to be sure things look OK. To make
locating errors like this easier to find, set up a conditional format to make them
stand out by doing the following:

1. Select the entire Server worksheet.

2. Onthe Home tab, in the Styles group, click Conditional Formatting and
choose New Rule.

3. Click Use a formula to determine which cells to format.

4. In the box, type =iserror(al) The ISERROR function is TRUE if the cell
contains one of these errors: #N/A, #VALUE!, #REF!, #DIV/0!, #NUM!,
#NAME? or #NULL!

5. Set the format so the cells with an error have an orange fill.

6. Click OK three times. The cells that contain #VALUE! are highlighted.

Scratch Area
Name ID College Year Major Email First name _ :Last name Comma ;| Space

1

2

3 Berg, Alex 7023072 :CEHD Senior Business Ed berg7023@umn.edu :Alex Berg 5 10
4 Bets, Sam 7266721 :Design | Senior Retail Mer bets7266@umn.edu : Sam Bets 9
5

6

7

Biff, Timothy 2106779 :Design Freshman  Retail Mer 0 Timothy Biff 13
#VALUE! 3263672 CLA Sophomore Undeclaired bing3263@umn.edu #VALUE! Bing Jr 5
Cheng, Recca 2172092 :CLA Freshman Undeclaired chen2172@umn.edu  Recca Cheng 12

;i i

7. Fix the problem for Bing Jr,William Henry by deleting space Jr in C6.
The #VALUE! error disappears.

8. There is also a problem with Tondryk,Marvin in row 33. Marvin has no
middle name so there is no “space” for the FIND function to locate. Fix this
by clicking C33 and adding a space to the end of the name Marvin. Again,
you could take care of this automatically by adding more code, but it
seldom occurs so do not bother.

If you are interested, here is a fix:

=IF(ISERROR(FIND(" ",C33)), LEN(C33)+1, FIND(" ",C33) )

If no space is found THEN pretend OTHERWISE show
space is at end position of space
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This says if there is an error in attempting to find the space then pretend
there is a space at the end of the string. Otherwise, display the location of
the real space.

j. Set up the gradebook by doing the following:

1. Onthe Server worksheet, copy N3:U37. You are leaving off the rows that
have no data and so show errors.

2. Click the Sec 1 worksheet tab, click B11, and use Paste Special to paste
the values only. To save you lots of typing, | have already entered scores
for the students so you can test the formulas you will enter that calculate
the HW, Tot Pts, and Grade.

3. AutoFit columns B:K.

4. Some students will add the course after | have downloaded the data. Add
the following student, Ben Apple, and his data to row 46. When you add
the email address, Excel probably will convert it to a hyperlink with
underlined blue text. To undo that, tap Ctrl + z right after moving to the
next cell.

T 136 Apple, Ben 11233212 CEHD Freshman  Business Ed appl1234@umn.edu Ben Apple

5. Like the Server worksheet, the Sec 1 worksheet has both raw data and
formulas. As you did on page SG147, set up a conditional format that uses
ISFORMULA to make the font red for all cells that contain formulas.

k. This workbook is larger than can fit on a single screen. Do the following to
freeze the panes so that the column headings (row 10) and the student
names (column B) are always visible.

1. Click C11. When you apply Freeze Panes the rows above 11 and the
columns to the left of C will be frozen.

2. Onthe View tab, in the Window group, click Freeze Panes and select
Freeze Panes.
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3. To see how freeze panes works, scroll horizontally and vertically until the
screen looks like the following. Freeze lines are indicated by the vertical
line just to the right of column B and the horizontal line just below row 10.

8 Cl 1871 sec 1, Professor Rok

2

3 S Vertical Freeze Line

4

5

6 Pct of

7 Final Horizontal
8 Grade Freeze
9 35% Line

(18 HWID [Name HW | Tot Pts | Grade [

Gy 135 :Yang, Bryan

;8 136 :Apple, Ben

vy 137

In AG11, enter a formula that will calculate the score for homework, rounded to
the nearest whole number. A student's homework score is the sum of the
student’s scores divided by the sum of the points possible for each homework
project, and then multiplied by 100. That is, for AG11

HW - sum of R11 through AF11 *100
sum of R9 through AF9

Written in Excel code this is =SUM(R11:AF11)/SUM($R$9:$AF$9)*100

Notice the use of the absolute references (the $ signs) in the denominator.
Those are needed so that when the formula is filled down the data in row 9 are

always used in the denominator.

1. Type the formula in AG11. The result is 96.203.

2. To round off the homework score to a whole number, use the ROUND
function, which has the form:

=ROUND(number,num digits)
You want to round SUM(R11:AF11)/SUM($R$9:$AF$9)*100 to O digits:
=ROUND(SUM(R11:AF11)/SUM($R$9: $AF$9)*100,0)

Modify the formula in AG11. The result is 96.

3. If a student name is blank, you want a blank displayed rather than a 0. Use
an IF function to do that. That is, if the name in B11 is blank, display a
blank, which is called a null string. It is two double quotes "" Otherwise,
display the results of the formula.

=IF(B11="","" ROUND(SUM(R11:AF11)/SUM($R$9: $AF$9)*100,0))
Modify the formula in AG11.
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4. Fill the formula down to row 50 and preserve the format. As a result of the
IF formula, cells AG47:AG50 are blank.

Think about how this formula was constructed. It was built up in three steps.
That is a good technique to use when constructing complicated formulas. If you
find a formula is incorrect, you can reverse the process — that is, remove parts
one at a time until you see where the error occurred.

m. Calculate the total points and letter grade for each student by doing the following:

Total points is calculated using weightings of 35% for the Excel exam,
20% for the Word exam, 10% for the PowerPoint exam, and 35% for the
homework score. That is:

Total points = 35% * Excel exam score + 20% * Word exam score +
10% * PowerPoint exam score + 35% * Homework score

The weights for the exams are listed in O5:Q5 and the weight for the homework
is in AG9. The Excel code will use those cell references along with the cell
references of the individual scores. Type the following in AG9. Notice the use of
absolute references (the $) on the cells that contain the percentage weightings:

=($0$5*011+$P$5*P11+ 5055 Q11+ S$SAG$9*AG11) / 100

Excel Word PowerPoint Homework

—
Converts
to a
percent

1. Enter your formula in AH11. The answer should be 86.75.

2. Add ROUND and IF functions as you did for the homework score and
type your formula in cell AG11.%6 |Be sure to read footnotes

3. In All11, enter a formula that will display the letter grade based on the total
points in AH11 and the table of points and letter grades in U1:AE2. You
are looking up a letter grade in a horizontal table so use HLOOKUP or
XLOOKUP. Remember to use absolute references, $, where appropriate.

4. Use an IF function to display a blank if the student name is blank.3’

5. Fill the formulas in AH11:Al11 down to row 50 and preserve the formatting.

36 =|F(B11="","" ,ROUND(($0$5*011+$P$5*P11+$Q$5*Q11+$A G$9*AG11)/100,0))
37 =IF(B11="","" ,HLOOKUP(AH11,3U$1:$AE$2,2)) or
=IF(B11="","" XLOOKUP(AH11,$U$1:AE1,3U$2: $AES$2,"Not Found",-1))
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n. If a student registers for a class, and then drops, instructors are required to
keep their name in the gradebook and record a grade code of either NOL or W.

NOL stands for Not On List. This is for students who drop before week 3 of
the semester. In that case, the course will not appear on their transcript.

W stands for Withdraw. This is for students who drop after week two of the
semester. In that case, the course will appear on their transcript with a
grade of W.

It helps to keep track of such students by using a conditional format to gray fill
the cells that contain their data. Do the following:

1. In K14 enter NOL and in K15 enter W so you can see if your conditional
format works properly.

2. Select A11:Al50. A quick way of doing that is to type A11:AI50 in the name
box.

3. Onthe Home tab, in the Styles group, click Conditional Formatting,
select New Rule, and click Use a formula to determine which cells to
format.

4. Enter a formula that will be true if K11 is either NOL or W. Since there are
two conditions, use the OR function to make the cells have a gray fill if
either condition is true.

The formula is =or($k11="NOL",$k11="W")

Note that a $ is needed to the left of K11 to ensure that Excel only checks
column K, where the grade code is located. If you leave off the $ the
formula will still work but only the cells in column A will be shaded.

5. Set the format to gray fill and then click OK twice.

0. There are some operations that you have to do repeatedly within a workbook.
For example, in my gradebook | sometimes need student names in alphabetical
order, such as when | check registrations and submit my final grades, while
other times | need the names in HWID order, such as when | insert scores from
the paper grader. Since | do these two types of sorts many times throughout
the semester for each of my gradebooks, | have constructed macros so | can
do the sorts with a single mouse click. A macro is a small app (set of
commands) that you can have Excel carry out with a single mouse click or
keystroke. While very useful, macros have the potential to completely mess up
a worksheet, so it is a good idea to make a backup copy of the workbook
before constructing macros.

1. Tap Ctrl + s to save your workbook. This is a good idea when working with
macros because they can really mess up things if done improperly. If that
happens, just close the workbook without saving and try again.

To see how macros work, do the following:
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2. Ifthe Developer tab is not showing, click the File tab, click Options, click
Customize Ribbon.

Mac: Click Excel, Preferences, Ribbon & Toolbar.

Down on the right, put a check in the box next to Developer. Then, click
OK. The new Developer tab appears on the ribbon.

Home Insert Page Layout Formulas Data Review View Developer

Excel macros use a programming language called Visual BASIC. If you know
the language you can directly write your own macros. If you do not know the
language, you can ask Excel to record your keyboard and mouse actions and it
will write the code for you. To see how this works, do the following:

3. Click the Developer tab.
4. In the Code group, click Record Macro.

5. In the Macro name: box, type SortByName. Macro names can contain
only letters and numbers and must begin with a letter.

6. Click OK. Excel will record all of your keystrokes and mouse actions until
you tell it to stop.

7. Select rows 10:50.

8. On the Home tab, in the Editing group, click Sort & Filter, and select
Custom Sort.

9. Be sure that there is a check in My Data has headers. In the Sort by box,
select Name and be sure A to Z is selected.

10. Click OK.
11. Tap Ctrl + Home to make C11 active.

12. Click the Developer tab and click Stop Recording. You should see
136 Apple, Ben at the top of the list.

'l HWID |Name ID College |Year Major

‘FN 136 :Apple, Ben 1233212 CEHD Freshman Business Ed
‘N 101 Berg, Alex 7023072  CEHD :Senior Business Ed
k¥ 102 :Bets, Sam 7266721 Design Senior Retail Mer

13. On the Developer tab, in the Code group, click Macros. |:=;
This will show a list of all the macros in the workbook. Macros

Mac: Click Visual Basic.

Macro name:

I=»

SortByMame
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The new macro is listed. To see what the code looks like, click Edit.

Sub SortByName ()

' SortByName Macro

Rows ("10:50") .Select
ActiveWorkbook.Worksheets ("Sec 1").Sort.SortFields.Clear
ActiveWorkbook.Worksheets ("Sec 1").Sort.SortFields.Add2 Key:=Range ("B11:B50") _
, SortOn:=xlSortOnvValues, Order:=xlAscending, DataOption:=xlSortNormal
With ActiveWorkbook.Worksheets ("Sec 1").Sort
.SetRange Range ("A10:BF50")
.Header = xlYes
.MatchCase = False
.Orientation = x1TopTcBottom
.SortMethod = x1PinYin
-Rpply
End With
Range ("C11") .Select
End Sub

Sub at the top and End Sub at the bottom indicate that this is what
programmers call a subroutine, which is a mini-app within a larger one.
The apostrophes indicate comment lines where you can write any
comments you wish. The rest of the lines are the executable code.

14. Tap Alt + Q to close the Visual Basic window.

15. Tap Ctrl + s to save the file and its macro. You will get an error message
that says:

The following features cannot be saved in macro-free workbooks:
- VB project
To save a file with these features, click No, and then choose a macro-enabled file type in the File Type list.

To continue saving as a macro-free workbook, click Yes.

This says you cannot save a file that has macros (Visual Basic subroutines)
unless you save it as a macro-enabled file. If you click Yes the file will be
saved without the macros. DON’T DO THAT!

16. Click No and the Save As dialog box will open.

17. Navigate to your Excel Files folder.

18. Change the file name to HW05-6 HWID Find and Macros Enabled Done.
19. Change the file type to Excel Macro-Enabled Workbook.

Excel Macro-Enabled Workbook (*.xIsm) v

20. Click Save. Now, each time you save the file the macros will be saved also.
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p. Follow a similar procedure to create a macro called SortByHWID that sorts the
data by the HWID in column A. Now, 101 Berg, Alex will be at the top (row 11)

Don’t Forget to Click Stop Recording!

g. To create buttons that you can click to run the macros, do the following:

1.

o g kA WD

~

10.
11.
12.
13.

14.

15.

On the Insert tab, in the lllustrations group, click Shapes and click
Rectangle: Rounded Corners.

Rectangles

O0DoaonOnO0n0

Rectangle: Rounded Corners

The curser will turn into a small cross.
Drag the cross down and to the right to form the rectangle.
Let up the mouse button to reveal the rectangle. |

Make the height of the rectangle 0.4 and the width 1.5. -

Drag the rectangle to the upper left corner of the window, about at cell A2.

Right-click the rectangle, select Edit text, and type

Sort By Name. Make the font 12 pt Arial Black. C11871 sec 1, Profes

Sort By Name

Click SortByName and then OK. Now, you have a button that will run the
macro with a single mouse click.

Right-click the rectangle and click Assign Macro.

Select the button by holding down the Ctrl key and clicking the button.
Tap Ctrl + D to create a duplicate of the button.
Change the name to Sort By HWID.

Assign the SortByHWID macro to this button.

Ctrl + Click the new button and drag it so that it is
just below the other one.

Click the Sort By Name button and notice how the data
are sorted by Name with 136 Ben Apple at the top.

Click the Sort By HWID button and notice how the data are sorted by
HWID with 101 Berg, Alex at the top.
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r. Macros can be used to move to specific places in a worksheet with the click of
a button. This is useful for large worksheets where scrolling would be time
consuming. To see how this works, do the following:

1.
2.
3.

On the Developer tab, in the Code group, click Record Macro.

In the Macro name: box, type GoTo Grades and then click OK.

In the Name Box, type fx500 and tap Enter. This will move FX500 Y
the active cell to a place far away from the cell you want to = :
go to. This is needed because if the active cell is close to the target cell

Excel may not adjust the screen properly.

In the name box, type agl and tap Enter. This is where you want to be.
Click the Developer tab and click Stop Recording.

Create a button with the label Go To Grades and assign this new macro to
it. Drag the button so it is just below the Sort By HWID button.

Try your new macro by making C11 active (tab Ctrl + Home) and then
clicking the Go To Grades button to make AGL1 active.

Cl 1871 sec 1, Professor Rok

ol |w|e o[ |w|n =
>
(w3}

Sort By Name

Sort By HWID
Go To Grades Pct of
Final
Grade
35%
i} HWID |Name HW | Tot Pts | Grade
‘&N 101 Berg, Alex 96 87 B+
‘N 102 :Bets, Sam 100 97 A

s. Enter formulas that summarize the total points for students in different colleges
and at different academic levels by doing the following:

1.

2.

In D3, enter a formula that will display the number of CLA students in the
gradebook. Since you want the NUMBER of students who meet a certain
criterion, COUNTIF would be a good choice. Because you are going to fill
this formula down, be sure to use $ where appropriate. 38

Fill down the formula in D3 to D8 and preserve the formatting.

8 =COUNTIF($D$11:$D$50,C3)
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3. In ES3, enter a formula that will display the average total points of CLA
students. Since you want the AVERAGE of students who meet a certain
criterion, AVERAGEIFS would be a good choice.

what to average where to look what to look for
=AVERAGEIFS( average range, criteria range , criteria )
%,_J
range that has range that has cell that has
total points stu colleges college of interest
AH11:AH50 D11:D50 c3

Remember to put in $ on cells that you do NOT want to change when the
formula is filled down.

=AVERAGEIFS($AH$11:$AH$50,$D$11:$D$50,C3)
4. Fill down the formula in E3 and preserve the formatting.

5. Since there are no CSE or UC students, AVERAGEIFS displays the
#DIV/O! error. To fix that, modify the formula in cell E3 so that if the number
of students in D3 is 0, then n/a will be displayed.

To do this, put the AVERAGEIFS inside an IF function:
=IF(D3=0,"n/a" ,AVERAGEIFS($AH$11:$AH$50,$D$11:$D$50,C3))

6. Fill down the formula in E3 and preserve the formatting.

College Number : Total Pts Ave
CLA 4 52
CEHD 20 93
CFANS 1 97
CSE 0 n/a
Design 11 95
uc 0 nfa

Except for the CLA students, it looks like everyone did really well. Can the CLA
student average total points really be 52? What happened?

The problem is that CLA student 104 Bing never attended (his code is NOL)
and so his total points is 0, and 105 Cheng withdrew early on (her code is W)
and so her total points is 13. You do not want those numbers to be included in
the average. To not include NOL and W students, add two more criteria to the
AVERAGEIFS function.
=AVERAGEIFS(range to average, criteria range 1, criteria 1, criteria range 2, criteria 2, ...)
* range to average is the total points in AH11:AH50
» criteriarange 1 is K11:K50 and criteria 1 is NOL
» criteriarange 2 is K11:K50 and criteria 2 is W

» criteriarange 3is D11:D50 and criteria 3is C3
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In E3, type the following (note that <> means not equal to):

=IF(D3=0,"n/a" AVERAGEIFS($AH$11: SAH$50,$K $11: $K$50,"<>NOL",
$K$11:$K$50," <>W" ,$D$11:$D$50,C3))

7. Fill E3 down. Now the average for CLA students is 98. That makes more sense.

I know, this one probably blew your socks off, and it took a while. Think about
how the formula was built up in parts, each one addressing a problem caused
by the data.

t. Enter a function that will display the current date and time by doing the following:
1. Merge A9:C9 and left align.
2. In A9, use the NOW function to enter the current date and time.

3. Format the merged cells so they display something like
Printed Fri 3 Jun 2022 at 10:18 AM 3°

u. Set up the worksheet for printing by doing the following:

1. Onthe Sec 1 worksheet, hide columns F:AA (select the columns,
right-click, select Hide).

2. Set the print area of the Sec 1 worksheet so that A1:Al17 will be printed
(select A1:115, click Page Layout, Print Area, Set Print Area).

3. Set up the Sec 1 worksheet to print in Landscape orientation, all on one
page, centered horizontally but not vertically, and set all margins to 0.5 inch.
Include a footer that contains the file name on the left and the sheet name on
the right. Print with row and column headings. Compare the preview with the
key. Make needed corrections, save the workbook and close it.

Step 4 Submit Now, submit the following. Use these names for the pdf files:

HWO05-1 HWID River Done (River Depth and Temp Chart) — This is the River
Depth and Temp Chart chartsheet

HWO05-2 HWID Loans IF Done

HWO05-3 HWID Rent IF Done

HWO05-4 HWID Commission IF Done (Sales Data) — This is the Sales Data worksheet
HWO05-5 HWID Sorting Values Done (Values Sorted) — This is the Values Sorted worksheet
HWO05-6 HWID Find and Macros Enabled Done (Sec 1) — This is the Sec 1 worksheet

Create a pdf file of the output for each of the above, place them in a folder
called HWO05 HWID LastName, FirstName, zip the folder and, by the due date,
upload it to the Canvas folder HWO5 Excel: Customize Charts, Make
Decisions, and Sort.

Step 5 Backup Now would be a good time to backup your files.

39 The Format Cells code is "Printed "ddd d mmm yyyy " at " h:mm AM/PM



Project 6
Sample Exam Questions for Excel

You should do this project in preparation for the Excel exam, but you do not
have to submit it for grading. If you do submit it, you may earn up to 80 extra
credit points which will be added to your homework score. If you do not
submit it, it will not count against you.

Step 1 Read For this project, there are no pages to read in your textbook.
Step 2 Activities For this project, there are no textbook activities.
Step 3 Homework Review for the Excel exam.

HWO06-1 Sample Exam Questions for Excel
Problem: How can you do well on the Excel exam?

Go back through projects 2 through 5 and be sure you know how to do the activities
in both the textbook and this Study Guide. You do not have to re-do them all, just
skim them and, if you think you have forgotten how to do something, read through
the material on that activity.

When | grade your exam, | will look at your formulas as well as the displayed results.
So, if you cannot get something to work don’t waste time trying to figure out the
answer by hand and typing in the result. You will get no points for that. Instead, write
as much of the formula as you can and type it WITHOUT the equal sign. That way, |
will be able to see your formula and you may earn partial credit.

Recall that as you start typing a function, Excel will display a screen tip that will show
its structure. So, for example, typing =viookup( will display the following:

A B C D E
1 |=vlookup( |
2 VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup])

The screen tips should help jog your memory. Here, it shows that you must enter:
lookup_value - the cell reference of the thing you are looking for, e.g. A4
table_array - the range of cells where you are looking, e.g., C5:D12

col_index_num - the number of the column in the table_array that contains the
thing you want to display, e.g., 2

[range_lookup] - TRUE if the table_array is sorted low to high and you want only
an approximate match, or FALSE if you must have an exact match. The square
brackets [ ] mean this is optional. It is assumed to be TRUE if you leave it out.

— SG167 —
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Below are some tips on the functions students find most difficult:

=VLOOKUP(what to find, where to look, what column to display, TRUE or FALSE)

Used to locate an item in a vertical list and then to display something in the same
row. See SG8b. If the list is horizontal, use HLOOKUP. See SG79.

Example: =VLOOKUP(C11,$H$11:$1$20,2) from HWO04-4
If your version of Excel has XLOOKUP, it is better to use that. See page SG82.

=IF(logical test, display if true, display if false)
Used to choose between two things based on a logical test. See SG67.
Example: =IF(F9<=40,0,E9*1.5*(F9-40)) from HWO03-4
If there is more than one condition, use IFS (SG57) or nested IF’s (SG143).

=COUNTIF(where to look, what to look for)

Used to find the number of things that match the what to look for criteria.
Criteria must be inside quotes or a cell reference. See textbook page 395.

Example: =COUNTIF(H9:H36,">0") from HW03-4
If there is more than one condition, use COUNTIFS. See SG71.

=SUMIFS(which cells to sum up,where to look, what to look for, ...)

Used to find a total of things that match the what to look for criteria.
Criteria must be inside quotes or a cell reference. See SG59.

Example: =SUMIFS(A15:A42,F15:F42," Tulips") See page SG59.
Can be used if there is more than one condition. See SG72.
Example: =SUMIFS(F9:F28,D09:D28,"M" ,E9:E28,"<5")

=AVERAGEIFS(which cells to average,where to look, what to look for,...)

This is just like SUMIFS but it calculates the average of things that match the what
to look for criteria. Criteria must be inside quotes or a cell reference. See SG60.

Example: =AVERAGEIFS(D15:D42,F15:F42,”Tulips”)

Can be used if there is more than one condition.
Conditional format: Used to highlight values that match specific criteria. Select the
range you want to format BEFORE you open the conditional formatting dialog box.

Then, choose Conditional Formatting, Manage Rules, New Rule, Type the
condition that describes what you want to find and then choose a format. See SG72.

Example from HWO03-4.

Conditional Formatting Rules Manager

Show formatting rules for: | cyrrent Selection W

E:Eﬂew Rule... E}‘Edi‘t Rule... > Delete Rule

Rule (applied in order shown)  Format Applies to

Formula: =F2=>40 AaBchYyZz =$B$%$BE36
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Do the following (solutions begin on page SG178):

a. Open the workbook HWO06-1a Excel Practice Questions Original, which is
one of the files you downloaded at the start of the term.

b. Save the workbook to your Excel Exam folder using the name
HWO06-1b HWID Excel Practice Questions Done.

Sales Data Worksheet

c. Click the Sales Data worksheet tab and do the following.

1. Insert the following data in between the rows for Braasch and Good:

7 | Clover, May Sales 5584
8 Day, Dennis Marketing 6588

2. In C17, insert a formula that will find the total of the values in C4:C15.

This formula and all the others you construct must work if the
data change. In other words, you cannot simply figure out the
sum on your calculator and then type in the answer.

3. In C18, insert a formula that finds the average of the values in C4:C15.

4. In D4, enter a formula that will calculate the commission for Adams. If her
total sales are below $5,000, the commission is $9,000 plus 8% of her total
sales. Otherwise, the commission is $9,400 plus 12% of the total sales that
are above $5,000. Fill the formula down to D15.

5. In E4, enter a formula that will calculate the percent of Total Sales for
Adams. This is the value in C4 divided by the total in C17 and then
multiplied by 100. Fill the formula down to E15.

6. Format C4:D20 as currency with two decimal places and the dollar sign
showing. Use currency style, not accounting style.

7. Format E4:E15 as a number with one decimal place showing.

8. In F4, display the word Great if Adams’ Total Sales in C4 are over $8,000,
Good, if C4 is between $6,000 and $8,000, and Poor if C4 is $6,000 or
less. Fill the formula down to F15.

9. In D20, enter a formula that will display the sum of the Total Sales for
people whose Commissions are over $9,800.

10. Create a conditional format so that the names and department name of the
people in the Marketing Department whose commissions are over $9,600
have a yellow fill.

11. In D22, enter a formula that will display the number of commissions that
are over $9,600 for people in the Marketing Department.
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12. In D1, enter a formula that will automatically display the date and time the
worksheet is printed. The format should look like Printed on Tue 8 July
2020 at 11:50 AM.

13. Change the value in C4 so that Adam's % of Total Sales is exactly 25.00.

14. Change the widths of all the columns to 12.

15. Merge D1:F1 and left align it.

16. Center and wrap the text in D21.

17. Center D19:D22.

18. Setthe Print Areato A1:F22.

19. Set up the Sales Data worksheet to print in Landscape orientation, all on

one page, centered horizontally but not vertically with 1 inch margins.
Include a footer that contains the file name on the left and the sheet name
on the right. Show gridlines and row and column headings. Compare
the preview with the key. Make needed corrections, save the workbook but
do NOT close it.

Column Chart - New Chartsheet Based on Sales Data

d. Create a chart of the data on the Sales Data worksheet. 1l =

1.

2
3
4.
5
6
7

o

10.

11.

Create a clustered column chart of the data in C4:C15. 2-D Coly

Place the chart on a new chartsheet called Column Chart. hﬂm

Use the data in A4:A15 for the horizontal axis.

Type your four-character HWID as the Chart Title.

. Type Total Sales for the Vertical Axis Title.
. Type People for the Horizontal Axis Title.

Display the Data Labels and make their font red Arial Black rounded to the
nearest whole dollar.

Do not show the Legend.

Add a Thought Bubble: Cloud callout with $24,371
the text Wow! Position the callout as shown. ‘e
Make the font 12 pt Arial Black and the color
yellow.

<P

Set up the Column Chart chartsheet to print in Landscape orientation and
include a footer that contains the file name on the left and the sheet name
on the right. Compare the preview with the key. Make needed corrections,
save the workbook but do NOT close it.

Change the background of the chart to
Newsprint texture.
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Bonus Data Worksheet

e. Click the Bonus Data worksheet.

1.

Click A1 and make the text bold and red and center the text across
columns A:G.

Enter a formula in C4 that will display the bonus for the sales value in B4.
Use the data table in B10:G12. Fill the formula down to C8 and preserve
the formatting.

Sort the rows of data by Bonus in decreasing order.

Create a conditional format that will make the Names, Sales, and
Bonuses bold red and the background of the cell light green if the
bonus for a person is between $300 and $900.

In A2, display this: Highest Bonus Awarded was $x,xxx.00, where xxx is
the largest value in C4:C8. Merge across A2:D2.

1 Bonus Data

»2 Highest Bonus Awarded was $1,000.00

Create an orange Column Sparkline in C9 of the values in C4:C8.

In cell D3, enter a formula that shows the average of the Total Sales on
the Sales Data worksheet. Format D3 so that it displays Average of Total
Sales is $x,xxx.00. Merge and Center D3:F3.

Set up the Bonus Data worksheet to print in Landscape, all on one page,
centered horizontally but not vertically and include a footer that contains
the file name on the left and the sheet name on the right. Include
gridlines and row and column headings. Compare the preview with the
key. Make needed corrections, save the workbook, but do NOT close it.

Sort Data Worksheet

f. Make the Sort Data tab active and do the following:

1.
2.
3.

Delete Row 8 (it has red text).
Delete Column C (it has blue text).

Sort the data by Class in ascending order (A to Z) and, within Class by
Trend in descending order (Largest to Smallest).

Filter the data in A1:D33 so that only rows with Class to C or T are showing.
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Births Data Worksheet

g. Click the Births Data worksheet tab.

1.

Split the screen just below row 9 and then scroll the bottom half of the
screen down so you can see row 28.

9 22 802 36
28 49 30 1

Set up Data Validation for A2:A28. The ages should be whole numbers
between 14 and 50, inclusive. If an error occurs, have a Warning message
display the text Age must be between 14 and 50, inclusive. Here is what
should happen if you type 1 in A2 and tap Enter.

Age of Mother Births/Thousand
| 15

Index
850

Age must be between 14 and 50, inclusive.

continuer
10

No Cancel Help 00

Births Chart - New Chartsheet Based on Births Data

3.

10.

11.

12.

13.
14.

Create an XY Scatter plot of the data in columns A and B. Do not connect
the points by a smooth line.

Move the chart to its own chartsheet called Births Chart.

Make the Chart Title Live Births Per Thousand Women vs. Age
Make the font 14 pt Arial Black.

Make the Horizontal Axis title Age (years) Make the font 12 pt Arial Black.

Make the Vertical Axis Title Live Births Per Thousand Women
Make the font 12 pt Arial Black.

Show the Major and Minor gridlines for both axes.
Make the data points square, green, and 8 point width.

Add a Trendline that is a degree 5 polynomial. Display the equation and R
squared value. Make their font 10 pt Arial Black. Make the trendline solid,
red, and 3 pt width.

Make the color of the Chart and Plot areas pink.

Make the horizontal and vertical axes 4 point width and dark blue and the
numbers Arial Black.

Make the major gridlines 2 point width and dark gray.

Do not display the minor gridlines.
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15. Scale the horizontal axis so that it starts at 12 and ends at 52 and make
the interval between major grid lines 4.

16. Add a second set of data markers using Age for the Horizontal (X) axis and
Fertility Index for the Vertical axis (Y). Use Index for the Series name.

17. Move the equation and R squared value textbox so it is just above the
horizontal axis

18. Add a Thought Bubble: Cloud callout that points to the data gap between
ages 25 and 29. Insert the text Data unavailable

19. Arrange the sheet tabs alphabetically left to right.

Sales Data Column Chart Bonus Data | Sort Data Births Data Births Chart

20. Set up the Births Chart chartsheet to print in Landscape orientation and
include a footer that contains the file name on the left and the sheet name
on the right. Compare the preview with the key. Make needed corrections,
save the workbook, and close it.

PivotTable - Start

h. Open the workbook HWO06-1c Excel Practice Questions PivotTable Original,
which is one of the files you downloaded at the start of the term.

I. Save the workbook to your Excel Files Excel Exam folder using the name
HWO06-1d HWID Excel Practice Questions PivotTable Done

The workbook shows three months of data for an Aquatics Program sponsored
by a Parks and Recreation department.

Pl Month Pool  Item $ Num Staff
vB April  Haven Food $2,009 208 Albe

For example, row 2 shows that in April a total of $2,009 was taken in on Food
supervised by Albe at the Haven pool.

PivotTable - Clean Up Data

j. Remove blank rows, rename a field,
and convert to a table.

File Home Insert Page Layout Formulas Data

Table Name: Summarize with PivotTable F‘ @ D
IncomeTable 5( Remove Duplicates I:? =2 N
Insert Export Refre:

'@’ Resize Table r.,"% Convert to Range Slicer v v

1. On the Data worksheet, in cell D1,
change $ to Income.

Properties Tools Extg

2. Remove all blank rows. . | T
Do NOT sort. 4 B | ¢ | - B F
3. Convert the data into a _1_Month BiPool Hitem B _Inconfd _ Null Staff KI

April Haven Food $2,009 208 Albe
N May Haven Food $2,025 210 Albe
"8 June Haven Food $1,230 200 Albe

table called IncomeTable.
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PivotTable - Construct PivotTable

k. Construct a PivotTable by doing the following:

1. Using the data in IncomeTable, insert a PivotTable on a new worksheet
named Pivot. Place Income under Values, Pool under Rows, and Item
under Columns.

2. Pivot the table so Item forms the rows and Pool forms the columns.

3. Inthe Rows area, display Month above Item.

4. Display the averages rather than sums. Round the numbers to the nearest
dollar and display the dollar sign.

5. Collapse the data so the Items only show for April.

A B C D E F G H

1

2

3 |Average of Income Column Labels -

4 |Row Labels -~ Beach Cape Coral Haven Sands Tropics Grand Total
5 |oApril $1,555 $1,513 $1,797 $1,704 $1,581 $1,511 $1,610
6 Ball $810 $811 $667 $799 $945 $707 $790
7 Dive $882 $910 $1,111 $910 $899  $679 $899
8 Food $2,100 $2,204 $2,230 $2,009 $1,801 $1,799 $2,024
9 Polo $380 $383 $493 $450 $487 $356 $425
10 Spa $2,264 $1,907 $2,102 $2,250 $2,349 $2,196 $2,178
11 Swim $2,894 $2,864 $4,181 $3,805 $3,007 $3,326 $3,346
12 | ®May $1,696 $1,452 $1,613 $1,596 $1,501 $1,384 $1,540
13 @=June $1,567 $1,498 $1,509 $1,413 $1,447 $1,381 $1,469
14 Grand Total $1,606 $1,488 $1,640 $1,571 $1,510 $1,425 $1,540

Notice that A3 displays Average of Income but H4 and A14 display Grand
Total. The values in column H and row 14 are not Totals but Averages.

For example, cell H5 is the average of H6:H11. Also, cell H14 is the

average of H6:H11 and H13:H18 and H20:H25, even though the last two
ranges are not visible. It is also the average of B14:G14. While those totals

might be useful when sums are displayed, they are not useful when

averages are displayed.

PivotTable - Construct 3-D Pie Chart

[. Construct a 3-D Pie Chart of the PivotTable:

1.

S e

Rename the worksheet Pool.

Collapse the fields so that only the Pool field shows.
Create a 3-D Pie Chart of the data.

Place the chart on its own chartsheet called 3-D Pie.

Starting on the Data worksheet, create a new PivotTable with Income under
Values and, Pool, Month, Item, and Staff, in that order under Rows.

Show the Data Labels and format them to be percentages rather than sums.
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7. Make the data labels white 18 pt Arial Black.
8. Make the title Contribution of Each Pool. Make the font 18 pt Arial Black.

Mac: Your graph may not show the Field Buttons. The tilt (perspective) of your

graph may be different from that shown. That is OK.

9. Set up the 3-D Pie chartsheet to print in Landscape orientation. Include a

footer that contains the file name on the left and the chartsheet name on
the right. Compare the preview with the key. Make needed corrections,
save the workbook but do NOT close it.

PivotTable - Slicers

m. Use slicers to filter data:

1. Click the Data tab and insert another PivotTable named Filtered. Place

S e

Income under Values, Month under Filters, Pool under Rows, and Iltem
under Columns.

Format the values as currency with 0 decimal places and the $ showing.
Insert a slicer for the Pool field. Apply a yellow slicer design.

Insert a slicer for the Item field. Apply a green slicer design.

Move the slicers so they are under the table.

Use the two slicers to filter the data to show the Income for Dive and
Swim for the Beach, Haven, and Tropics pools.

A B ¥ D

1 Month (Al -

2

3 | Sum of Income Column Labels -7

4 'Row Labels -T Dive Swim Grand Total
5 |Beach $2,655 $9,147 $11,702
6 Haven $2,799 $9,438 $12,237
7 |Tropics $2.213 $7,735 $9,948
8 |Grand Total $7,567 $26,320 $33,887

Drag the slicers so that they are just under the PivotTable.

Set up the Filtered worksheet to print in Portrait orientation, Adjust to 150
% of normal size, centered horizontally but not vertically. Include a footer
that contains the file name on the left and the worksheet name on the
right. Compare the preview with the key. Make needed corrections, save
the workbook and create the pdf file, but do NOT close it.
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PivotTable - Individual Reports

n. Place the Dive Lessons and Swim Team data for Beach on its own worksheet
named Beach. AutoFit the columns.

Dive 882 95 Melby
April Beach Dive 882 95 Melby
June Beach Swim 2876 295 King
i 345 King
296 King A

86 Melby

Beach BSElGS

Set up the Beach worksheet to print in Portrait orientation, Adjust to 150 % of
normal size, centered horizontally but not vertically. Include a footer that
contains the file name on the left and the worksheet name on the right.
Compare the preview with the key. Make needed corrections, save the
workbook and create the pdf file, but do NOT close it.

PivotTable - Stacked Column Chart

0. Create a Stacked Column Chart based on the PivotTable on the Filtered
worksheet.

1.
2.
3.

From the Filtered worksheet, insert a Stacked Column PivotChart.
Move the chart to its own chartsheet called Stacked.

Filter the chart to show the April and May Income for Dive and Swim for
the Coral, Haven, Sands, and Tropics pools.

Display the Averages rather than the Sums.

Make the chart title April and May Income for Dive and Swim for Coral,
Haven, Sands, and Tropics Pools.

Make the title, legend, and axes 12 pt Arial Black.
Hide the Filter Buttons if they are showing.

Set up the chartsheet to print in Landscape orientation. Include a footer
that contains the file name on the left and the chartsheet name on the
right. Compare the preview with the key. Make needed corrections, save
the workbook but do NOT close it.
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Click the Filtered worksheet and notice how the PivotTable has changed.
This is because you changed the filters on the chart.

A B © D
1 Month (Multiple Items) v
2
3 Average of Income Column Labels -7
4 |Row Labels <Y Dive Swim Grand Total
5 Coral $1,111 $3,522 $2,316
6 Haven $910 $3,350 $2,130
7 |Sands $906 $2,694 $1,800
8 Tropics $734 $2,660 $1,697
9 Grand Total $915 $3,056 $1,986
10 Pool 7= &  ltem = X
:I]; Beach Ball
13| Cape Dive
L Coral Food
15
16 Haven Polo
17 Sands Spa
18 - -
19 Tropics Swim

PivotTable - Change Data and Update PivotTable

p. You are going to update the raw data on the Data worksheet. This will change
all the PivotTables to reflect the new data. However, for this practice activity,
you want to keep those PivotTables as they were so you can go back and look
at them later if you wish. For that reason, you are going to make a copy of the
Data worksheet and base a new PivotTable on those data. Do the following:

1. Make a copy of the Data worksheet and name it Updated Data.

If there are too many tabs in this workbook, you can right-click a tab and
select Hide to make more room. Or, use the arrows on the left of the tab
list to scroll the tab names back and forth.

2. Starting from the Updated Data worksheet, insert a PivotTable that
has Income in the Values box, Pool in the Rows box, and Item in
the Columns box. Name the worksheet Updated Pivot.

A B C D E F G H

1

2

3 |Sum of Income Column Labels -

4 Row Labels - Ball Dive Food Polo Spa Swim Grand Total
5 |Beach 2341 2555 6684 1386 6792 9147 28905
6 |Cape 2043 2813 6612 11556 5721 8432 26776
7 |Coral 2216 2943 6470 1349 6928 9610 29516
8 |Haven 2804 2799 5264 1270 6699 9438 28274
9 |Sands 2872 2713 5502 1473 6985 7630 27175
10 |Tropics 2559 2213 5397 1311 6436 7735 25651

11 |Grand Total 14835 16036 35929 7944 39561 51992 166297
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3. Go back to the Updated Data worksheet and, in cell D2 (April Haven Food)
replace $2,009 with $40,000.

A B C D E F
il Month§d Pool fllitem | Inconfld Nulld Staff &
2 |April Haven Food $40,000] 208 Albe

4. Add the following to the bottom of the table on the Updated Data worksheet.

A B 8] D E F
110 April Cape Souvenirs $100 40 Jones
111 May Cape Souvenirs $200 60 Jones
112/ June Cape Souvenirs $300 80 Jones

5. Click the Updated Pivot worksheet and refresh the PivotTable. You should
see a new column for Souvenirs with data, 600 and the Haven Food
changed from $5,264 to $43,255.

6. Arrange the worksheet tabs as follows:

Data Plvot @ 3-DPie Filtered | Beach | Stacked @ Updated Data & Updated Pivot

Step 4 Submit Submitting this project is optional. However, you may earn extra
credit on your homework score if you submit the following. Use these names for
the pdf files:

HWO06-1b HWID Excel Practice Done (Sales Data)
HWO06-1b HWID Excel Practice Done (Column Chart)
HWO06-1b HWID Excel Practice Done (Bonus Data)
HWO06-1b HWID Excel Practice Done (Births Chart)
HWO06-1d HWID Excel Practice Pivot Done (3-D Pie)
HWO06-1d HWID Excel Practice Pivot Done (Filtered)
HWO06-1d HWID Excel Practice Pivot Done (Beach)
HWO06-1d HWID Excel Practice Pivot Done (Stacked)

Create a pdf file of the output for each of the above, place them in a folder called
HWO06 HWID LastName, FirstName, zip the folder and, by the due date, upload
it to the Canvas folder HW06 Sample Exam Questions for Excel.

How to Solve Sample Exam Questions for Excel

Sales Data Worksheet - Solutions

cl. Question cl is on page SG169. Here is how to solve it:

Click the number for row 7, drag down to row 8, right-click, and select
Insert. This inserts two blank rows. Then, type the new data.

c2. You are finding a total of numbers so use SUM. Type =sum(, drag down
from C4 through C15, type ), and the tap Enter.

c3. Do the same as for c2 but replace the word SUM with AVERAGE.
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c4.

Co5.

c6b.

You are entering a formula that displays one of two things. That is, the
formula will choose between

Choice 1: $9,000 plus 8% of total sales.
Choice 2: $9,400 plus 12% of the total sales that are above $5,000.

The formula makes the choice by seeing if total sales are below $5,000.
So, the condition is C4<5000. Type =IF(C4<5000,

If the condition is true, display Choice 1, which is $9,000 plus 8% of her
total sales. Since total sales are in C4, add this to the formula
9000+8%*C4, to get =IF(C4<5000,9000+8%*C4,

If the condition is false, display Choice 2, which is $9,400 plus 12% of the
total sales that are above $5,000. To find the total sales that are above
5000 subtract C4-5000 (for Adams this will be 5644-5000, which is 644).
Then, take 12% of that. Note that you must use parentheses, so the
computer does the subtraction first and then multiplies by 12%. That is,
12%%*(C4-5000). Finally, add 9400 to this to get 9400+12%*(C4-5000).
Thus, the final formula is

=IF(C4<5000,9000+8%*C4,9400+12%*(C4-5000))
Tap Enter.

To fill the formula, click D4, drag down to D15, and tap Ctrl + D. Or, use
the Fill Handle by pointing to the lower right corner of D4 (so the little black
cross appears), and drag down to D15.

To find the percentage that something is of a whole, divide that something
by the whole. That gives a decimal. Multiply by 100 to convert the decimal
into a percent. For Adams, her total sales are in C4 and the sum of the total
sales for all employees is in C17. So, type =C4/C17*100

You are going to fill this formula down to row 15. You want the C4 to
change to C5, and then to C6 and so on. But, you want C17 to always
remain C17 so you must use an absolute reference (the $ signs).
Thus the formula is =C4/$C$17*100. To fill the formula, click E4, drag
down to E15, and tap Ctrl + D.

Select C4:D20, right-click, Format Cells, Number tab, Currency.
Be sure the Symbol is $ and Decimal places is 2.

Format Cells
PN umber Alignment Font Border Fill
Category:
General Sample
Mumber $5.644.00
Curren T
Accounting Decimal places: |2 =
Date
Time Symbal: | §
Percentage
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c7. Select E4:E15, right-click, Format Cells, Number tab, Number, Decimal
places 1. Note that since you multiplied by 100 in the formula, you do not
use the percentage format. If you did, Adams would show 716.6%.

c8. You need to display one of three words depending on the value in C4.
Since there are three choices you need two IF statements, one nested

inside the other.

THEN

Else THEN Else

=IF| Condition1 , show this , IF Condition2 , show this , show this

Develop the formula in steps:

What to do

Excel Code

Check to see if Total
Sales are over 8000.

=IF(C4>8000,

If that is TRUE, display
the word Great.

=IF(C4>8000,"Great",

If itis FALSE, check to
see if C4 is over 6000.

=IF(C4>8000,"Great",IF(C4>6000,

If that is TRUE, display
the word Good.

=IF(C4>8000,"Great",IF(C4>6000,"Good",

If it is FALSE display
the word Poor.

=IF(C4>8000,"Great",IF(C4>6000,"Good","Poor"))

Or, you could do it in the reverse order like this:
=IF(C4<=6000,"Poor",IF(C4<8000,"Good","Great"))

Or, you could do it this way:
=IF(C4>8000," Great" ,|IF(C4<6000,"Poor","Good"))

If your version of Excel has the IFS function, you could use that instead of
the nested IF’s. In that case, the formula would be:

=IFS(C4>8000,"Great",C4>6000,"Good",C4<=6000,"Poor")

In the key, I put in all four of these formulas so you could see how they
work. Fill down in the usual way.

c9. You want to find a sum of Total Sales for people who meet a certain
condition (Commissions are over $9,800). So, use SUMIFS.

You want to sum the Total Sales, which are in C4:C15, type =SUMIFS(C4:C15,

The range to look in to see if the condition is met is D4:D15.
So, you have =SUMIFS(C4:C15,D4:D15,

The condition is >9800. So you have =SUMIFS(C4:C15,D4:D15,">9800")
Note the quotation marks on the condition. This is different than when using IF.
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¢10. For conditional formats, first select the cells that are to be formatted. Here,

c1l1.

cl2.

cl13.

cl4.

cl5.

you want the names formatted so select A4:B15.

Click Conditional Formatting, New Rule, Use a formula to determine
which cells to format.

The employee must meet two criteria: Department (column B) is Marketing,
and Commission (column D) is over 9600. So, use the AND function:
=AND($B4="Marketing",$D4>9600) The $ are needed because you want
two columns formatted. Also, notice that here you do not put in the range
B4:B15 but only B4. Same goes for column D. For Conditional Formatting,
you select the cells where you want the formatting first, then you put in the
rule for the first person and Excel does it for all the people that you have
selected in A4:B15.

Finally, click the Format button, click Fill, and click yellow. Click OK a
couple of times to close the conditional formatting dialog box.

You are to display the number of things based on two criteria so use
COUNTIFS.

The first condition is that the Commission (in column D) must be over
9600. So, you have =COUNTIFS(D4:D15,">9600"

The second condition is that the department is Marketing (in column B).
So you have =COUNTIFS(D4:D15,">9600",B4:B15,"Marketing")

Note that in each case the condition must be inside quotation marks.

To have the date and time update automatically, NOW(). Do NOT use
DATE since that is used when you need to take three separate values
and combine them to form a date (not very useful).

Once you have entered =NOW() click the green check. The date is stored
as the number of days it is after January 1900. The time is stored as a
fractional portion of a 24 hour day. So, if the date and time are 20 Jul 2020
at 3:23 PM, the number will be 44032.64127.

To format the date and time, right-click, Format Cells, Number tab, and
Custom. The phrase Printed on must be in quotes since it is text. Then,
enter the code for the day (ddd), the date (d), the month (mmm), the year
(Yyyyy), the word “ at “ and the hour (h) a colon, the minutes (mm) and
am/pm so Excel uses our normal 12 hour clock rather than military time.
This is "Printed on " ddd d mmm yyyy" at "h:mm am/pm

Use Data, Forecast, What-If, Goal Seek t0 [ goal seek B

get the exact value. _
Set cell: E4 |§|

The answer is 24370.6624489115. To value: 25

Select the entire worksheet, point to column | By changing cell: [5Cs4 E3

heading A, right-click, select Column width, l o ] | p— |

and enter 12.

Select D1:F1, click Merge and Center, then click Right align.
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c16. Select D21, click Center align, click Wrap text.
c17. Select D19:D22 and click Center align.

c18. Select A1:F23. On the Page Layout tab, in the Page Setup group, click
the Print Area arrow, and click Set Print Area.

c19. Tap Ctrl + p, click Page Setup, and make the settings look like these:

Margins Header/Footer Sheet
Orientation
[, Ty - F =
() Portrait - (® Landscape
Scaling
O Adjust to: 100 =/ % normal size
@ Fit to: 1 = page(s) wide by |1 = tall
Page Header/Footer Sheet
Top: Header:
1 = 0.5
Left: Right:
1 = 1 =
Bottom: Footer:
1 = 05 =
Center on page
Horizontally

Footer

To format text: select the text, then choose the Format Text button.

To insert a page number, date, time, file path, filename, or tab name: position the
insertion point in the edit box, then choose the appropriate button.

To insert picture: press the Insert Picture button. To format your picture, place the
cursor in the edit box and press the Format Picture button.

&

Left section: Center section: Right section:

&(File] E |- &[Tab] -
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Page Margins Header/Footer __________ Sheet
Print area: | A1:G23
Print titles

Rows to repeat at top:
Columns to repeat at left:

Print

Gridlines Comments: (None)
|:| Black and white i

Cell errors as: | displayed
[ ] Draft quality

Row and column headings

Column Chart - Solutions

di.

d2.

d3.

d4.

Select C4:C15. On the Insert tab, in the Charts group, select 2-D column,
and then Clustered Column.

Do NOT copy and paste the chart into a new worksheet. On the Chart
Design tab, in the Location group, click Move Chart, and type the name
Column Chart. This creates a new chartsheet that contains only the chart
and no cells.

On the Chart Design tab, in the Data group, click Select Data, Horizontal

(Category) Axis Labels, Edit. Click | # |to collapse the dialog, switch to

the Sales Data worksheet, select A4:A15, and click| % | again.

Auxis Labels ? >

Axis label range:
='Sales Data"'$A%54:54%15 * = adams, Kathy, ...

Click OK and click OK again.

The green cross allows you to put in many different chart elements.

Mac: There is no green cross. On the Chart Design tab, on the left, use the Add
Chart Element.

d>s.

d6.

Chart Elements
Axes

[ Axis Titles
Chart Title

Put a check next to Chart Title, if necessary. With Chart
Title selected, in the formula bar, type your HWID.

4

Click the green cross and put a check next to Axis Titles.
If necessary, click the vertical axis title so select it.
Type Total Sales and tap Enter.

Click the horizontal axis title and type People and tap Enter.
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d7.

ds.
do.

d10.

dil.

Click the green cross and put a check next to Data Labels. Then, on the
Chart Format tab, way over on the left, click the arrow and select Series 1
Data Labels to select them.

With the Data Labels selected, click the Home tab and change the font.

On the Chart Format tab, in the Current Selection group,
be sure Series 1 Data Labels is selected, and click Format
Selection. In the Format Data Labels pane, click Label
Options. Click the Number triangle and, under Category, select
Currency, and make the Decimal places 0.

il

Label Options

Click the green cross and be sure Legend is NOT checked.

On the Insert tab, in the lllustrations group, select Shapes, Callouts, and
click Thought Bubble: Cloud. Drag to open the callout. Type the text and
then format the font. To point to the Adams column, grab the little orange
circle at the end of the point and drag it to the desired position.

On the Chart Format tab, in the Current Selection group, click the arrow,
select Chart area, and click Format selection. Click the paint bucket and
under Fill click Picture or texture fill. Click the arrow to the right of
Texture and select Newsprint.

Set up to print as usual.

Bonus Data Worksheet - Solutions

el.

e2.

To center across cells, select A1:G1 and, on the Home tab, in the
Alignment group, click Merge and Center.

The sales and bonus data are in B10:G12. This is a horizontal table so use
HLOOKUP.

You want to look up the value in B4 so use =HLOOKUP(B4

You want to lookup that value in the horizontal table B10:G12 so use
=HLOOKUP(B4,$B$10:$3G$12 Note the use of absolute references (the $).
This is because when you fill down this formula you want the location of the
table to remain constant, which is what the $ do.

When the value of B4 is found in row 1 of the table, you want to display the
value in row 3, so use =HLOOKUP(B4,$B$10:$G%$12,3

Since you do not need an exact match and the table is in ascending order,
type TRUE as the last parameter, =HLOOKUP(B4,$B$10:$G$12,3, TRUE).
TRUE is the default so you can leave it off if you wish.

When you fill down, to preserve the formatting be |5 -
sure to select Fill Without formatting from the B copy Cels

Auto Fill Options. 2 Fill Fermatting Only

2 Fill Withgut Formatting
& Flash Fill
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e3.

e4.

e5.

€b.

Be sure you select all the data in each row and not just the data in column
C. That is, click the number for row 4 and drag down to row 8 to select
those five rows and then, on the Home tab, in the Editing group, select
Sort & Filter, Custom Sort. Under Sort by, select Column C and Largest
to smallest, and then click OK.

Select A4:C8 since those are the cells you want to format. Then, on the
Home tab, in the Styles group, click Conditional Formatting, New Rule,
Use a formula to determine which cells to format. There are two
conditions, less than 900 and also greater than 300. Use AND for the
condition, like this: =and($c4<900,$c4>300). Notice the use of the $
because you have selected more than one column and you want all three
to have the format.

20 Name Sales Bonus
8 Maren $38,200 $1,000
Sue $30,123 $800
- Melissa $25,821 $600
@ Elana $22,054 $400
"W Kathy $17,866 $200

Here are two ways of doing this:

Method I: Since you are looking for the highest number in C4:C8 use
=MAX(C4:C8). This gives you the number $1,000. To format the cell
right-click, select Format Cells, click the Number tab, click Custom and
type "Highest Bonus Awarded was "$#,###.00 The part inside quotes
is text that will be displayed exactly as written. To the right of the quote
shows the format for the number: The $ indicates currency, the #
indicates numbers (you cannot use x’s here), the comma indicates that
it should be put there if the value is over one thousand, the period
shows the decimal point, and the 00 shows that zeros should be
displayed. Select A2:D2 and click Merge & Center, and then Align Left.

Method II: This method uses the & to connect (concatenate) the text
Highest Bonus Awarded was with the number 1000. So, use
="Highest Bonus Awarded was "& TEXT(MAX(C4:C8)," $# ###.00")
The TEXT function must be used to show Excel how to format the
number. If you do it this way you will not have to use Merge & Center to
see the result.

Click C9. On the Insert tab, in the Sparklines group, click Column
Sparkline. For the Data Range enter C4:C8 and for the Location enter
C9. Then, on the Sparkline Design Style tab, in the Style group, click
Sparkline color, and select Orange.
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e’.

e8.

Click D3, type =, click the Sales Data worksheet, click C18, tap Enter.
The formula will look like this: ='Sales Data'!C18 This says go to the
Sales Data worksheet and display the contents of cell C18.

Right-click D3, Format Cells, Number tab, Custom, type
"Average of Total Sales is "$#,###.00

Select D3:F3 and, on the Home tab, in the Alignment group,
select Merge & Center.

Set up to print as usual.

Sort Data Worksheet - Solutions

f1.

f2.

f3.

f4.

Click the number for row 8, right-click, and select Delete. Row 9 becomes
row 8. This gets rid of the entire row and not just the data in a row.

Click the letter for column C (Height), right-click, and select Delete.
Column D becomes column C.

Click the number for row 1 and drag down to the number for row 33. This
selects all the data in those rows and not just the data in a particular
column. On the Home tab, in the Editing group, select Sort & Filter,
Custom Sort. Be sure My data has headers is checked. Under Sort by,
select Class and A to Z, click Add Level, select Trend and Largest to
Smallest. Click OK.

Select A1:D1. On the Home tab, in the Editing group, select Sort & Filter
and click Filter. Click the Class arrow and click Select All (to deselect
everything) and then click C and T. Click OK.

A B @ D
1 Level - Trend| -  Width - Class|-¥
5 1 9 7 o
6 5 5 85 C
7 2 3 111 o
8 2 3 111 C
22 5 5 7 T
23 5 5 7 T
24 1 4 114 T
25 2 3 111 T

Births Data Worksheet - Solutions

gl.

g2.

Click the number for row 10 and on the View tab, in the Window group,
click Split. Scroll to the bottom part of the screen so row 28 shows.

Select A2:A28. Since the screen is split, rather than scrolling it will be
faster to click A2, hold down Shift, and click A28.

On the Data tab, in the Data Tools group, click the Data Validation arrow
and select Data Validation. On the Settings tab, under Allow, select
Whole number. Under Data select between, under Minimum enter 14,
and under Maximum enter 50. Click the Error Alert tab and under Style
select Warning, and under Error message type Age must be between 14
and 50, inclusive. Click OK.

In cell A2, type 1 to check if the warning comes up. Click cancel and the 1
will return to its original value.
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Births Chart - Solutions

g3.
g4.

g5.

g6.

gv.

g8.

g9.

g10.

gl1.

gl2.

Select A2:B28. On the Insert tab, in the Charts group, select XY Scatter.

On the Chart Design tab, in the Location group, click Move Chart. Next
to New sheet, type Births Chart, and click OK.

Click the green cross and put a check next to Chart Title, if necessary.
On the Chart Format tab, in the upper left corner, click the arrow and
select Chart Title. In the formula bar, type Live Births Per Thousand
Women vs. Age. Change the font size and type.

Do the same for the Horizontal (Category) Axis Title and type
Age (years). Change the font size and type.

Do the same for the Vertical Axis Title and type Live Births Per
Thousand Women. Change the font size and type.

Click the green cross, click Gridlines » Primary Major Horizontal
the triangle to the right of [] Legend Primary Major Vertical
Gridlines and put a check  [[[] Trendline Primary Minor Horizontal
next to each box. Primary Minor Vertical

On the Chart Format tab, in the upper left corner, click the arrow and
select Series 1. This selects the data points. Just under that click Format
Selection to open the Format Data Series pane. Click the paint bucket
and click Marker and then Marker options.

To the right of Type, select square, to the right of Size, select 8 pt.
Click the triangle next to Fill, click Solid fill, and select green.

Click the green cross, click the arrow to the right of Trendline and select
More Options to open the Format Trendline pane. Click the little column
graph, click Polynomial and set the Order to 5. Put checks next to
Display Equation and Display R-squared. Select those on the chart and,
on the Home tab, make the font 12 pt Arial Black.

Click the Trendline to select it. Click the paint bucket, click the Dash Type
arrow, select the solid line, change the Width to 3, and the color to red.

In the upper left corner select Plot Area from the drop-down menu and
click Format Selection to open the Format Plot Area pane. Click the
paint bucket, click Fill, click Solid fill and select pink as the Color.

Repeat for the Chart Area.

In the upper left corner select Horizontal (Value) Axis from the drop-down
menu and click Format Selection to open the Format Axis pane. Click the
paint bucket and then Line if necessary. Set the width to 4 pt and the
color to dark blue.

On the Home tab, in the Font group, select Arial Black and Blue.

Repeat for the Vertical (Value) Axis.
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gl13.

gl4.

g15.

gl6.

gl7.
g18.

g19.
g20.

On the Chart Format tab, in the Current Selection group, select
Horizontal (Value) Axis Major Gridlines from the drop-down menu and
click Format Selection to open the Format Major Gridlines pane. Click
the paint bucket and then Line if necessary. Set the Width to 2 pt and the
Color to gray. Do the same for the Vertical (Value) Axis Major Gridlines.

On the Chart Format tab, in the Current Selection group, select
Horizontal (Value) Axis Minor Gridlines from the drop-down menu and click
Format Selection to open the Format Minor Gridlines pane. Click No line.
Do the same for the Vertical (Value) Axis Minor Gridlines.

On the Chart Format tab, in the Current Selection group, select
Horizontal (Value) Axis from the drop-down menu and click Format
Selection to open the Format Axis pane. Click the little column graph, |||
click Axis Options and set the Minimum to 12 and the Maximum to 52.
Set Units Major to 4 (no need to set the Minor units since the minor
gridlines are not showing).

On the Chart Design tab, in the Data group, click Select Data, and click
the Add button to open the Edit Series dialog box.

For Series name type Index.

For Series X values, click the collapse dialog button EI click the Births

Data worksheet tab, select A2:A28, and Fdit Series
click the collapse dialog button again. _
Series name:
For Series Y values, click the collapse Index 1
dialog button, click the Births Data Series X values:
worksheet, select C2:C28, and click the _Births Datal$AS2:5A528 *
collapse dialog button again. s T
Click OK. Click OK again. ='Births Data'l$C$2:5C528 L

Select the textbox and drag it under the title.

Click anywhere in the chart. On the Insert tab, in the Illustrations group,
click the Shapes arrow and, near the bottom, select the Thought Bubble:
Cloud callout. Drag the tiny cross to open the callout and enter the text.
Grab the tiny orange circle and drag it to the data gap.

Click each tab and drag it into position.

Set up to print as usual.

PivotTable - Clean Up Data - Solutions

1.
2.

Click cell D1 and type Income.

Click the row number of row 5 so a right pointing arrow appears.

4 June Haven Food $1,230 200 Albe

5[

Right-click and select Delete. Repeat for row 9 (old row 10) and row 85
(old row 87).
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j3. Select the range A1:F109. On the Insert tab, in the Tables group, click
Table and then click OK.

A B

‘Bl MonthEJ Pool Bl itemBl Inconfd Nulld Staff &

2 |April Haven Food
3 May Haven Food

C

D

$2,009
$2,025

208 Albe
210 Albe

On the Table Design tab, in the Properties group, type
IncomeTable in the Table Name box.

Table Name:

IncomeTable

PivotTable - Construct PivotTable - Solutions

k1. Click anywhere inside the table. On the Insert tab, in the Table group, click

PivotTable and click OK.

From the PivotTable Fields pane, drag the Income field so that it is under
Values in the Layout section. Repeat for Pool and Item.

Double-click the new worksheet name and type Pivot.

O~ N R =

A B

Sum of Income Column Labels -
Row Labels - Ball

Beach 2341
Cape 2043
Coral 2216
Haven 2804
Sands 2872
Tropics 2559
Grand Total 14835

Pivot | Data (.B

C

2555
2813
2943
2799
2713
2213
16036

D

6684
6612
6470
5264
5502
5397
35929

E

1386
1155
1349
1270
1473
1311
7944

F

Dive Food Polo Spa

6792
5721
6928
6699
6985
6436
39561

G

9147
8432
9610
9438
7630
7735
51992

H

Swim Grand Total

28905
26776
29516
28274
27175
25651
166297

-

PivotTable Fields ~ X

Choose fields to add to report: @} -
Search ,O
] Month -
] Pool

] Item

[¥] Income

1 num

[ staff hd

Drag fields between areas below:

Filters Columns
Item 5
Rows 2 Values
Pool 5 Sum of Income ¥
Defer Layout Update
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k2. Drag Pool so that it is under Columns and Item so that it is under Rows.

A B

1

2

3 | Sum of Income Column Labels -
4 |Row Labels -~ Beach

5 |Ball 2341
6 Dive 2555
7 |Food 6684
8 |Polo 1386
9 |Spa 6792
10 |Swim 9147
11 |Grand Total 28905
12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

Pivot | Data @

c

Cape Coral Haven Sands Tropics Grand Total

2043
2813
6612
1155
5721
8432
26776

D

2216
2943
6470
1349
6928
9610
29516

E

2804
2799
5264
1270
6699
9438
28274

4

F

2872
2713
5502
1473
6985
7630
27175

G

2559
2213
5397
1311
6436
7735
25651

H a
PivotTable Fields ~ X
Choose fields to add to report: {é} b
14835 ~eareh O
;gggg [ Month -
7944 Pool
39561 0
51992 Income
166297 I Num
[] staff -
Drag fields between areas below:
Filters Columns
:‘OO -
Rows Values
Item 7 Sum of Income ~

, Defer Layout Update

k3. Drag Month down to the Rows area, just above Item.

k4. Right-click Sum of Income in cell A3 and select Value Field Settings. In

the dialog box, click Average and then click Number Format. Under
Category, click Currency, and change the Decimal places to 0. Be sure
the $ is showing next to Symbol. Click OK. Click OK again.

k5. In cell Al12, click H next to May to collapse that field. Repeat for June.

PivotTable - Construct 3-D Pie Chart - Solutions

[1. Click the Data worksheet tab to make it active. On the Insert tab, in the
Table group, click PivotTable and click OK. From the PivotTable Fields
pane, drag the fields to the proper locations in the Layout area.

Rows
Pool 7
Month 4
Item e
Staff 7

Values

Sum of Income

2. Double-click the new tab and type Pool.

13. In cell A4, right-click E next to Beach, point
to Expand/Collapse, and select Collapse

Entire Field.

+ Beach
i Cape

4 Coral
+Haven
+ Sands
# Tropics

O oo~ bk WwWNN-—=

Row Labels ~ Sum of Income

10 |Grand Total 166297

28905
26776
20516
28274
27175
25651
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4. Click anywhere in the PivotTable. On the PivotTable Analyze tab, in the
Tools group, click PivotChart, click Pie select 3-D Pie, and click OK.

Mac: Clicking PivotChart inserts a column chart. To change it, on the PivotChart

Design tab, in the Type, group, click Change Chart Type, select Pie, and
then 3-D Pie.

5.

16.

On the PivotChart Design tab, in the Location group, click Move Chart.
In the dialog box, replace Chartl with 3-D Pie, and click OK.

Click anywhere inside the chart. Click the Green Cross, point to Data
Labels, and click More Options.

Mac: On the PivotChart Design tab, in the Chart Layouts group, click Add Chart

Element, Data Labels, More Data Label Options.

This opens the Format Data Labels pane. Click Percentage Value
and deselect Value.

+/| Percentage

Click any data label to select them all and, on the Home tab, in the Font
group, make the changes.

On the chart, click the title box to select it. Or, on the PivotChart Format
tab, in the Current Selection group, click the arrow and select Chart Title.
Then, click Format selection. In the formula box, type the title. Select the
title and make the font changes.

9. Set up to print as usual.

PivotTable - Slicers - Solutions

m1. Click the Data tab to make it active. On the Insert tab, in the Table group,
click PivotTable and click OK. From the PivotTable Fields pane, drag the
fields to the proper locations in the Layout area.

Double-click the new worksheet tab and type Filtered.

A
Month

Beach
Cape
Coral
Haven
9 Sands
10 Tropics

CO~ N & W h =

B
(A -

Sum of Income Column Labels -
Row Labels ~ Ball

2341
2043
2216
2804
2872
2559

11 Grand Total 14835

12
13
14
15
16

C

D E

F

Dive Food Polo Spa

2555
2813
2943
2799
2713
2213
16036

3-D Pie | Pools | Filtered

6684 1386
6612 1155
6470 1349
5264 1270
5502 1473
5397 1311

6792
5721
6928
6699
6985
6436

35929 7944 39561

G

9147
8432
9610
9438
7630
7735
51992

H

Swim Grand Total

28905
26776
29516
28274
27175
25651
166297

-

PivotTable Fields ~ X

Choose fields to add to report: @ -

Search O

Drag fields between areas below:

Filters Columns

Month 4 Item 5
Rows Values

Poo 7 Sum of Income ~

-
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m2. Right-click Sum of Income in cell A3 and select Value Field Settings. In
the dialog box, click Number Format. Under Category, click Currency,
and change the Decimal places to 0. Be sure the $ is showing next to
Symbol. Click OK. Click OK again.

m3. On the PivotTable Analyze tab, in the Filter group, click Insert Slicer.
Click Pool and then OK.

On the Slicer Options tab, in the Slicer Styles group, click Yellow.

m4. On the PivotTable Analyze tab, in the Filter group, click Insert Slicer.
Click ltem and then OK.

On the Slicer Options tab, in the Slicer Styles group, click Green.

m5. Click each slicer heading and drag into position.

m6. In the Pool slicer, click the Multi-Select button . Then, click the pools
you do not want leaving Beach, Haven, and Tropics.

Repeat the process in the Item slicer, leaving only Dive and Swim.

A B C D E |~ . .

1 Month (All) - PivotTable Fields ~ X
2 -
3 | Sum of Income Column Labels | T Choose fields to add to report: @ =
4 |Row Labels T Dive Swim  Grand Total Search 0
5 |Beach $2.555 $9.147 $11,702 :
6 |Haven $2.799 $9.438 $12 237
7_|Tropics $2,213 87,735 $9,048 Drag fields between areas below:
8 |Grand Total $7,567 $26,320 $33,887
9 | Pool Y= N2 | tem v=| N2 Filters Columns
o
b1 Beach Ball Maonth - Item A
12| Cape Dive
3
H4 Coral Food
H5 Haven Polo Rows Values
16 Poo g Sum of Income ¥
L7 Sands Spa
8 | | Tropics Swim -

4 » ..| Pools | Filtered ... P » -

m7. Set up to print as usual.

PivotTable - Individual Reports - Solutions

n. On the Filtered worksheet, double-click D5, Grand Total for Beach. A new
worksheet appears. Double-click the worksheet tab and type Beach.
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PivotTable - Stacked Column Chart - Solutions

ol. Click inside the table on the Filtered worksheet. On the PivotTable
Analyze tab, in the Tools group, click PivotChart, select Stacked

Column, and click OK

il

Mac: Clicking PivotChart inserts a column chart. To change it, on the PivotChart
Design tab, in the Type, group, click Change Chart Type, select Column,

and then Stacked Column.

02. Onthe PivotChart Design tab, in the Location group, click Move Chart.
Click the New sheet button, type Stacked, and click OK.

03. Windows users can use the Filter Buttons on the chart (they do not exist
on the Mac). Alternatively, Windows and Mac users can use the cells in the
PivotTable on the Filtered tab and/or the slicers

Filter Button on Chart | Cell in PivotTable Slicer
B1

A3

A4 (Row Labels) Pool
B3 (Column Labels) | Item

Here are the steps using the cells in the PivotTable:

* Click the arrow in cell B1, check Select Multiple Items, check April and

May, and click OK.

* Click the arrow in cell B3 (Column Labels), check Dive and Swim, and
click OK. Or, use the Item slicer.

* Click the arrow in cell A4 (Row Labels) and check Coral, Haven,
Sands, and Tropics, and click OK. Or, use the Pool slicer.
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04. Right-click cell A3 (Sum of Income) and select Value Field Settings.
Click Average and then OK.

(Multiple Iltems) ¥ PivotTable Fields

Average of Income Column Labels -7 Choose fields to add to report:
-2 Row Labels -7 Dive Swim Grand Total
4 Coral $1,111 $3,522 $2,316
8 Haven $910 $3,350 $2,130
YA Sands $906 $2,694 $1,800
=0 Tropics $734 $2 660 $1,697
8 Grand Total $915 $3,056 $1,986

Item
Income

%= %

o
=
=]
@
&
=1

|C-:||--J|-.’JJ

©

(=]
o

Y Filters Il Columns

Month e

3%

M
[A*]

(=]

w

Month ¥

]
i

=]
[%)]

Average of Income

[n*]
7]

1] |c-:| |"-J |

$5,000

=]

=]

$4,000 2 Values

Average of Income ¥

=]

$3,000
$2,000
$1,000
S0

()

ol =]

%]
g

5]

R+ ]

w
3

5]

e

Coral Haven Sands Tropics

sl
n

C
o

[=7]

e

Filtered BN @ : Defer Layout Update

05. On the Stacked chartsheet, click the green cross and select Chart Title,
Above Chart.

» ... Pools | Beach

-

Mac: On the PivotChart Design tab, in the Chart Layouts group, click Add Chart
Element, Chart Title, Above Chart.

Select the Chart Title and type the title.

06. Click the title to select it. On the Home tab, in the Fonts group, select 12 pt
and Arial Black. Repeat for the legend, and axes.

07. Onthe PivotChart Analyze tab, in the Show/Hide group, click Field
Buttons, and select Hide All.

Mac: Skip this. There are no Field Buttons on Mac.

08. Set up to print as usual.
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PivotTable - Change Data and Update PivotTable - Solutions

pl. Click the Data worksheet, right-click its tab, select Move or Copy, check
Create a copy, and click OK. Double-click the worksheet tab, type
Updated Data, and tap Enter.
p2. Click inside the data table and, on the Insert tab, in the Table group, click
PivotTable. Drag the fields to the appropriate boxes. Double-click the new
worksheet tab, type Updated Pivot, and tap Enter.
p3. Click the Updated Data worksheet and change the value in cell D2 from
$2,009 to $40,000.
p4. Starting at cell A110, type the new data.
p5. Click the Updated Pivot worksheet. In still shows the original data.
A B C D E F G H
1
2
3 Sum of Income Column Labels ~
4 Row Labels - Ball Dive Food Polo Spa Swim Grand Total
5 Beach 2341 2555 6684 1386 6792 9147 28905
6 Cape 2043 2813 6612 1155 5721 8432 26776
7 Coral 2216 2943 6470 1349 6928 9610 29516
8 Haven 2804 2799 5264 1270 6699 9438 28274
9 Sands 2872 2713 5502 1473 6985 7630 27175
10 Tropics 2559 2213 5397 1311 6436 7735 25651
11 Grand Total 14835 16036 35929 7944 39561 51992 166297
Right-click any number and select Refresh.
A B C D E F G H
1
2
3 |Sum of Income Column Labels -
4 'Row Labels - Ball Dive Food Polo Spa Swim Souvenirs Grand Total
5 Beach 2341 2555 6684 1386 6792 9147 28905
6 Cape 2043 2813 6612 1155 5721 8432 27376
7 Coral 2216 2943 6470 1349 6928 9610 29516
8 Haven 2804 2799|43255|1270 6699 9438 66265
9 Sands 2872 2713 5502 1473 6985 7630 27175
10 Tropics 2559 2213 5397 1311 6436 7735 25651
11 Grand Total 14835 16036 73920 7944 39561 51992 600 204888

p6.

The data are updated and appear in the PivotTable. Cell H6 shows a value
of 600 for the Cape pool in the new column for Souvenirs. Cell D8, Haven
Food, has changed from 5264 to 43255.

Click a tab and drag it into the correct position.







Information on the Excel Exam

The first exam will cover only Excel. You may not submit any Excel homework on
or after the day the exam is sent to you.

Date and Time: Check your syllabus for the date and time.
Location: On your own Windows or Macintosh computer.

Time Allowed: | will email the exam to you in the morning and you will have to
upload your zipped solution folder to Canvas by the afternoon of the next day.

Materials: | will email you a pdf copy of the exam questions and the original files you
are to modify.

Submission: You will submit your exam in the same way as you did for the
homework except you will NOT send pdf files. Instead, you will submit your
modified Excel files so that | can see your formulas as well as the displayed
results. Do the exam as soon as you get it. Do not wait until the last minute. If
you miss the submission deadline you will receive a score of 0.

Preparation: Before exam day, be sure you have gone over HW06-1 Sample Exam
Questions for Excel a few times before exam day. Be sure you have a reliable
internet connection and computer. You may use either a Windows computer or
a Mac. The exam will work on both platforms.

Questions: If you have questions during the exam, email me. Of course, | will not
give you any help or hints, but if you think something is wrong with your copy of
the exam let me know immediately.

Honesty: The exam is open book and notes, but you may NOT discuss the exam or
get any help from anyone else or do the exam with anyone else. Doing so will
result in your receiving a 0 for the exam and an F for the course.
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Project 7
Word Chapter 1: Creating Documents

Step 1 Read Read the introductory material on page 103 of the textbook.

Step 2 Activities Turn on the computer and do the following:
Project 1A: Start at the top of page 105.

Instead of Activity 1.01 step 1 do the following:

1. Open a blank Word document and save it to your Word Files folder using
the name Lastname_Firstname_1A_ Flyer

You are not going to use sub folders (e.g., Word Chapter 1).
Instead, so you can see them all at once, save all your Word files
in the Word Files folder you downloaded on page SG11.

2. Complete the rest of the Activities through step 6 on page 123. Do NOT do
steps 7 and 8 in Activity 1.16 on page 123.

3. Return here when you have completed Project 1A on page 123.

Do NOT do GO! With Google Docs

Project 1B: When you have completed Project 1A, start at the top of page 127.

Instead of Activity 1.17 step 1 do the following:

1. Navigate to your Word Files folder and open wO1B_Programs, which is
one of the files you downloaded at the start of the term.

2. Save the file in your Word Files folder using the name
Lastname_Firstname_1B_Programs

3. Complete the rest of the Activities through step 4 on page 146. Do NOT do
steps 5 and 6 in Activity 1.29 on page 146.

4. Return here when you have completed Project 1B on page 146.

|‘ Do NOT do GO! With Google Docs or GO! To Work

Step 3 Homework After you have completed Projects A and B return here, do
the following additional activities, and turn them in for grading.

— SG199 —
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HWO07-1 Flyer (Based on Project 1A)

Problem: How can you create a flyer to advertise an upcoming event?

a. Open the document Lastname_Firstname_1A_Flyer, which you created while
following the directions in the textbook and saved on page 123.

b. Save the document in the Word Files folder using the name
HWO07-1 HWID 1A Flyer Done

c. The orange textbox is too large and will get in the way of text you soon will add.
1. Make the text in the orange textbox 12 pt.
2. Make the textbox 0.75 inch high and 3.5 inches wide.

3. Move the textbox so it is in the lower right corner of the page.

d. In this project you learned how to insert a field code that displayed the name of
the file in the footer. This is a bit different from Excel but the result is the same.
Insert a few more field codes by doing the following:

1. Move the insertion point to the bottom of the document, just to the right of

the word website. D 4 A

Quick WordArt Drop
Parts ~ - Cap ~

2. Tap Enter twice, type Today's Date: and then a space.

3. Onthe Insert tab, in the Text group, -
click the Quick Parts arrow and select Field. 2l AutoTex
E—] Document Property
4. In the Field names group, scroll down and clmm Field...

5. Inthe Date formats group, select the format that has day, month, date, and year.

Please choose a field Field properties
Categories: Date formats:
(All) v dddd, MMMM d, yyyy
Field names: 7/20/2022

| T - |

Mac: Click Options, click the format you want, click Add to Field.

6. Click OK. The current date will be shown.



PRrRoJECT 7 WORD CHAPTER 1: CREATING DOCUMENTS SG201

7. To make it easy to identify text that is the result of a field code, tell Word to
highlight all fields in the document by doing this:

Click the File tab, click Options, click Advanced, scroll down to the Show
document content group, click the Field shading arrow, and select Always.

General Show document content

Display [] show background colors and in|
Proofing [] Show text wrapped within the d
Save [] show picture placeholders
Language Show drawings and text boxes ¢

Show bookmarks
|:| Show text boundaries

Ease of Access

Advanced

|:| Show crop marks

Customize Ribbon
[T] Show field codes instead of the|

Quick Access Toolbar

Field shading: | Always =

Mac: To have the field codes always shaded, from the Word menu, select
Preferences, View and, next to Field shading, select Always.

8. Click OK. The date now appears with a shaded background. However, the
shading will not appear on the printed copy.

|T0day'5 Date: Wednesday, July 20, 2022|

9. Tap Alt + F9 to view the actual field code. If that does not work, try
Fn + Alt + F9. If that does not work, point to the field, right-click, and
select Toggle Field Codes (works on Mac).

| Today's Date: { DATE \@ "dddd, MMMM d, yyyy" \* MERGEFORMAT }|

To show the results of the field codes, you would tap Alt + F9 again. But,
do not do that yet. Alt + F9 is called a toggle because it switches
(toggles) between two things.

10. Use the same technique to insert, under Today’s Date, enter the following
text and fields, one per line.

Date Last Saved: SAVEDATE
Last Saved By: LASTSAVEDBY

File name full location: FILENAME For this one, when you insert the file
name field, click the box Add path to filename (the path is the location):

Please choose a field Field properties Field options
Categories: Forma [1iAdd path to filename|
(al) v (nore)
Uppercase
Field names: Lowercase
A First capital
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This shows the complete location just like you did in Excel. Tap Alt + F9 to
show the field name results.

Today's Date: Wednesday, July 20, 2022
Date Last Saved: Wednesday, July 20, 2022

Last Saved By: Douglas Robertson

File Name and Path: C:\Users\droberts\Desktop\Cl 1871\Word Files\HW07-1 HWID 1A Flyer Done.docx

e. You are going to add a footer that contains the file name for every Word
document you save. Here is a quick way of doing that using Word’'s AutoText
feature. First, you will add AutoText to the Quick Access Toolbar. Here is
what mine looks like:

OutdentZoZs~| BE [pp M 2+ 9 Q - [/ DocumentMap =~ =
Home Insert Design Layout References Mailings

1. Click the File tab, click Options, and click Quick Access Toolbar.

Mac: From the Word menu, select Preferences, click Ribbon & Toolbar, click
Quick Access Toolbar tab.

2. Inthe list under Choose commands from, click All Commands.

3. Scroll through the list of commands until you see AutoText.

4. Click AutoText. E.E Customize the Quick Access Toolbar,

Choose commands from:
All Commands El

5. Click The AutoText button | <[ ~| appears in the Quick Access Toolbar.

6. Click OK.

f. To add an entry to the AutoText gallery, do the following:

1. Select the text that you want to add to the [Footer |
AutoText gallery. In this case, double-click the
footer area where the file name appears and

select the file name field code. HWO07-1 HWID 1A Flyer Done

2. Inthe Quick Access Toolbar, click AutoText, and
then click Save Selection to AutoText Gallery.

3. Type FileName in the Name box of the  [create New Building Block
Create New Building Block dialog box.
Leave the other boxes as they are. Name: FileName
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4. Click OK.

General

5. Click the AutoText button and you will see the
FileName entry you just created.

FileMame

|me.1 HWID Flyer Do

Even though the actual file name shows the AutoText entry it is really the
field code that will change if you change the file name. Any time you want
the field name inserted, simply select it from the AutoText button.

g. You can have Word insert the file name field code directly into the footer
without having to open the footer first.

1. Onthe Quick Access Toolbar, click the the AutoText button, point to
FileName, right-click, and select Insert at Page Footer.

General

FileName

. .
7.1 HWAID Fiyar D Insert at Current Docu

Insert at Page Header

Insert at Page Footer

The file name field code is inserted directly into the footer (now the file
name is there twice). If necessary, adjust the orange textbox so the file
names in the footer are visible.

www.SturgeonPointProductions.com

HW07-1 HWID 1A Flyer DoneHW07-1 HWID 1A Flyer Done

2. Save the document.

Depending on how your system is set up, the fields may not have automatically
updated their values. To do that select the four lines in the body of the
document that contain field codes, and then tap F9. Remember, on a laptop
you may need to use the fn key also.

Mac: Right-click and select Update Field.

This will update the fields. You may have to do the same for the field names in
the footer.

h. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.
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HWO07-2 Programs (Based on Project 1B)
Problem: How can you create a flyer that advertises available internships?

a. Open the document Lastname_Firstname_1B_Programs, which you created
while following the directions in the textbook and saved on page 146.

b. Save the document in the Word Files folder using the name
HWO07-2 HWID 1B Programs Done

c. Do the following to adjust the title so that it is on two lines.

1. Onthe Home tab, in the Paragraph group, click the Show/Hide button | 4
SO you can see the paragraph codes.

4 | shows where the Enter key has been tapped. It indicates a new paragraph.

a dot shows where the Spacebar has been tapped.
—» a right-pointing arrow shows where the Tab key has been tapped.
------------------------------- Page Break------ indicates a manual page break.
- SECHON Break (Next Page)--- indicates a section break.
2. Inthe title, click just to the left of the word Productions.

3. Tap the Backspace key to remove the blank space.

4. Tap Shift + Enter to insert a manual line break.
It is indicated by a left-pointing arrow (_l

Sturgeon-Point<

Productionsy]

This means the two lines are still considered a single paragraph. If you had
tapped Enter the two lines would be considered separate paragraphs.

d. Scroll down so you can see the break between pages 1 and 2. Notice how the
second list is split between the two pages.

Here-is-a-partial-list-of-internship-positions-currently-available:q

v" = Production-Assistanty]

HWO7-2-HWID-1B_Programs_Donel

If possible, it is a good idea to keep all items of a list on a single page so the
reader can see all lines in the list at once.
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Fix this by doing the following:
1. Select the text from Here is a partial list... through the end of the list.

Right-click and select Paragraph.

Indents and Spacing : Line and Page Breaks :

2
3. Click the Line and Page Breaks tab.
4

Check the first three boxes.

Pagination

Widow is the last line of a paragraph that
appears by itself at the top of a page. It
is considered good form to force a
second line to accompany a widow.

Widow/Orphan control
Keep with next

Keep lines together
|:| Page break before

Orphan is the first line of a paragraph
that appears at the bottom of a page by itself. It is considered good form
to send an orphan to the next page to rejoin its paragraph.

Keep with next forces the current paragraph to appear on the same page
as the next paragraph. This is good for lists and for rows of tables (so
the table will not split across a page break) and subheads (so the
subhead will stay with its following text).

Keep lines together forces a paragraph to have all of its text on the same
page, rather than split between the bottom of one page and the top of
the next. This is good to do for short paragraphs.

Page break before. This puts the text on the next page no matter what.

— v i— - i

I
I

5. Click OK; selected items now are together on page 2.

Bullet Library

e. Change the bullet type on the first page: Nere || @ || O

1. Select the first bulleted list and, on the Home tab, in the » | v
Paragraph group, click the Bullet icon arrow, and
select Define new Bullet.

Click Picture.

Click Browse next to From File. égefne New Bullet..

Navigate to the Word Files folder, select HW07-2 Goldy Original, click

Document Bullets

e VvV | m

Insert and OK. If the image of Goldy cannot be added
to the gallery, drag the file HW07-2 Goldy Original to 28 Short feature films
the desktop and try again. If that fails, use any image. M2 Documentaries

f. Tap Ctrl + p and print only page 1. Your print dialog should look like this:
Printer ,

[P © Page Range
Mac 0
. Adobe PDF

I - T mmm——m— Enter page numbers andfor
Ready page ranges separated by

: : [ - commas (e.g. 2, 5-8)
Printer Properties

Settings =) tefr e i)

Show Quick Preview

o -j Custom Print

-

Type specific pages, secti...

Pages: |1 | ° |

Make needed corrections, print, save the document, and close it.
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HWO07-3 Agenda
Problem: How can you create a draft agenda for a club meeting?

a. Open the document HWO07-3 Agenda Original, which is one of the files you
downloaded at the start of the term.

b. Save the document in the Word Files folder using the name
HWO07-3 HWID Agenda Done

c. Insert a footer that contains the name of the file.
d. Change all four margins to 1.25 inches.

e. Put a border on the page. The border should have a purple thick and thin 3 pt
line (Design, Page Background, Page Borders).

Page Border | Shading

Setting: Style: Preview

diagram below or

Mone eflittons to apply borders

. BDE

m

K
I:l Shadow —————— ‘ g
D 3D Color i i
= I - |
Width:
g—.u Custom 3pt _B
=" Apply to:
Whole document E|
e ]
[ OK ] l Cancel ]

f. Insert a Watermark that says Draft slanted across the page (Design, Page
Background, Watermark)

g. Make the font of the first two lines of the Agenda Arial Black, 18 pt, and red.

h. Set up the agenda as an outline.

1. Select the lines starting with New Business and continuing all the way
through Continue discussion of fundraising projects.

2. Onthe Home tab, in the Paragraph group, click the m

=" and then click this format: | a)

Multilevel List arrow

The list will appear with numbers going from 1 to 12. )
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i. Do the following to change the outline level of the lines from Treasurer’s report
through Other new business so that they are subordinate to New Business.

1. Select those lines.

2. On the Home tab, in the Paragraph group, click the Increase Indent
button |#=| . Notice how the numbers of the selected lines are automatically
changed to letters.

1) New Business

a) Treasurer's report

b) Big brother and big sister project
c) Election of officers

d) President

e) Vice President

f) Treasurer

g) Secretary

h) Other new business

j. Change the outline level of the list of officers.
1. Select the lines from President through Secretary.

2. Click the Increase indent button. The list of officers will be indented and
listed with Roman Numerals.

k. Follow a similar procedure to change the outline level of the last two lines
(Reading of minutes and Continue discussion of fundraising projects) so
that they are subordinate to Old Business.

|. To see how Word will automatically adjust the lettering of the items, add the
following two lines just under Big brother and big sister project:

Food Shelf donations
Tax program

Notice how the items are automatically given letters and the letters of following
items are changed.

a) Treasurer's report

b) Big brother and big sister project
c) Food Shelf donations

d) Tax program

e) Election of officers

m. Delete the line with Vice President. Again, notice how the numbers for
Treasurer and Secretary are automatically updated.
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n. Insert a SmartArt object.

1. Tap Ctrl + Home to move to the top of the document.

2. Onthe Insert tab, in the Illustrations group, click the SmartArt button.

3. From the Relationship category, choose the Basic Venn shape.

Choose a SmartArt Graphic &u
— =1 U5 EE[E
Al == EI@@
EE List 00— 00— O ®
% Process E e+0=0 é'::)@
f:j? Cycle - .
&b Hierarchy EL@E : C%)iz @E|®
: : @ =l =l =
BEd Relationship —
_ © G @
Matrix &
< @0+® L
P id
é yram © © é Basic Venn
Picture —~ - HH;H Q - =l uUseto show overlapping or -
@ Office.com ( - ﬁ? I»Sfi\ interconnected relationships. The first
= o= MRS seven lines of Level 1 text correspond
A with a circle, If there are four or fewer
- ﬁ = Basic Vi lines of Level 1 text, the text is inside
.r'_}:_}:_}:_‘\, ﬁ q.a@ —a;c\}:;n L_I|| the circles. If there are more than four
St @ = . | lines of Level 1 text, the text is outside ~
[ ok || canca |
Click OK.

4. In the top circle, type Service; in the left circle, type Respect; in the right

circle, type Dignity.

5. Apply a Colorful theme.

SMARTART TOOLS
MathType DESIGH FORMAT
L
L ° L
- -
Change " "
Colors =
|| Primary Theme Colors
Colorful
L 4 ' 4
> 'y .‘
Accen Colorful - Accent Colors

6. Make the font purple 12 pt Comic Sans MS.

7. Make the height and width of the object 2 inches.
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8. Setthe Wrap Text to In Front of Text.

Respect

Service

H s H

Age

Campus Service Cli

LAYOUT OPTIONS X

In Line with Text

I

With Text Wrapping

o FRE o TR = B

n:E

Bt stttk In Front of Text

9. Move the object to the upper right corner just inside the page border.

0. Tap Ctrl + p and compare the preview with the key. Make needed corrections,

save the document, and close it.

HWO07-4 Brochures

Problem: How can you create a memo outlining features of a brochure that will be

published?

a. Open the document HWO07-4 Brochures Original, which is one of the files you
downloaded at the start of the term.

b. Save the document in the Word Files folder using the name

HWO07-4 HWID Brochures Done

c. Insert a footer that contains the name of the file.

d. Set up the company logo and memo header by doing the following:

1. Insert the JPG file, HWO07-4 Brochures Logo Original.

2. With the image selected, on the Drawing Format tab, in the Arrange
group, click the Wrap Text arrow and select In Front of Text. You can also
do this by clicking the Layout Options icon [:a:(and selecting the In Front

of Text icon

Fas

Drag the logo so it is in the upper left corner of the page, about a quarter

inch from the top and side.

3. Insert a textbox (Insert, Text, Text Box, Draw Text Box) and enter this

text:

PO Box 75732

Colorado Springs, CO 80970

719-638-9511
JohnWells@ad-excellence.net
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4. Change the font to 10 pt Comic Sans MS.

5. Move the textbox to the upper right corner of the page about a quarter inch
from the top and side. It should have no border or fill (Drawing Format,
Shape Styles, Shape Outline, No Outline).

6. Select the word MEMO and, on the Insert tab, in the Text group, click the
Word Art arrow, and select the pink A

7. Move the Word Art so everything is aligned like this:

PO Box 75732
Colorado Springs, CO 80970

‘ y M @ 719-638-9511
AD JohnWells@ad-excellence.net

e. Change the tab settings on the first 7 lines of the memo. Keep this in mind:

Page Margins are the amounts of blank white space at each side of the page
(left and right, top and bottom).

Paragraph Indents are the little triangles that show where the first line, the left
edge, and the right edge of a paragraph are located.

Tab Stops are locations where you want text to line up. When you tap the Tab
key the text moves to line up with a tab stop.

Type of Tab Stop Left
Click to Change  First Line (Hanging) Tab Stops Right
l Margin  Indent Indent Right Left Center Decimal Indent Margin
f—Aﬁ
S Y e AT L e e e e 2 e T 3 g & e B e A 7
Dr. + Terry - Ann » Lamb -+ Blacksmith -+ 0.3212q Backward P
Ms. - Adeline -+ Sylvia - Robertson -+ Student - 15.234Y| ——— shows where
Mr. - John - Paul + Ozols -  Lecturer - 365.2 Enter Key
Arrows show where Tab Key was}apped was tapped

In the above, notice how the

middle names (Ann, Sylvia, Paul) are lined up on the right

last names (Lamb, Robertson, Ozols) are lined up on the left
occupations (Blacksmith, Student, Lecturer) are lined up in their middles
numbers are lined up on their decimal points

Mac: Tab stops look a bit different on a Mac.

r Tt 4 r
Left Tab Center Tab Right Tab Decimal Tab
Left Tab Cenﬁer Tab Right Tab Decimal Tab
Left Tab Center Tab Right Tab Decimal Tab

1. Select the 7 lines starting with the line that contains TO and ending with the
line that contains DATE. Set a right tab stop 2/ at 1 inch and a left tab
stop ['= at 1.25 inches.
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2.

5.

Click the Show/Hide button to show the codes. Click just to the left of P
in Patricia (between the O in TO and the P) and then tap the Tab key. It
looks like nothing happened! Now, click just to the left of the T in TO: and
tap Tab. Notice how the colon in TO: lines up with the right tab stop and
the P in Patricia lines up with the left tab stop.

2 SRR T RN S KRR

LIl

-+ TDE -+ :Patricia-Smith: -‘Marketing -Director¥

Remember, the Tab stops are the markers on the ruler ['2 and '] that
show where the text will be aligned, while the Tabs are the little arrows -+
that show where the Tab key was tapped to move the text.

Repeat this procedure for the FROM, SUBJECT, and DATE lines.

Click to the right of the tab arrow in the DATE line. Insert the PrintDate
field, which will display the date the memo was printed (Insert, Text, Quick
Parts, Field). Set the date format to show the day, month, date, and year.

Please choose a field Field properties
Categories: Date formats:
(Al v dddd, MMMM d, yyyy
Field names: 7/27/2020
PrintDat Monday, July 27, 2020
p = ~ July 27, 2020
rivate 7127420

Click OK. The field will display XXX, XXX 0, 0000 because you have not
yet printed the document.

| -

DATE: - XXX XXX00, 00007

6.

When you print, the proper date will appear.

Tap Alt + F9 to see the field code.

| -

DATE: + {PRINTDATE-\@"dddd. MMMMdd. yyyy"-\*-MERGEFORMAT}* |

Mac: Right-click and select Toggle Field Codes.

7.

Tap Alt + F9 again to see the result.

f. Click in the paragraph that begins with The concept for the new... and set the

first
and

line indentation to 0.25 inch. You can do this by right-clicking the paragraph
then selecting Paragraph from the shortcut menu or by sliding the upside

down triangle = on the left side of the ruler to 0.25.

g. Click in the paragraph that begins | need to schedule.... Tap Ctrl +y. This is
the shortcut for the Repeat command. It repeats your last action or text entry.
The first line indent is set to 0.25 inch.
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h. Move the insertion point to the left of the first word of the paragraph that begins
Be prepared to discuss. You are to insert a bullet here without using the
automatic bulleted list feature. Like many of Word’s automated features, the
automatic bulleted list feature can save time, but it also can be annoying and do
things behind your back that you do not want.

1. Onthe Insert tab, in the Symbols group, click Symbol and then More Symbols.
2. In the dialog box, if necessary click the Symbols tab.

3. From the Font box drop-down menu, select (normal text)

Mac: Instead of steps 4 and 5, select any symbol you wish.

4. From the Subset box drop-down menu, select Miscellaneous Symbols.

5. Scroll down until you see the symbol for beamed eighth notes
If you have trouble finding it, type 266B in the Character code box near
the bottom of the window. You may \ use a different symbol if you wish.

Symbols Special Characters

Font: |(normal text) o Subseg: | Miscellaneous Symbols b
v o )P EHE|P|R alt|H| KKK
Z|z | AM|V|D v [Wiw|¢ Flole|l|o|a
j V S Z r r r 1 g a TN T § § L o N
2 A A 2 el # ] 52 ]
Recently used symbols:
"l |V | F|EEF|O® T L] >+
|:mddEg:th =] Character code: [2668 | from: |Unicode hey |
AutoCorrect... Shortcut Key..  Shortcut key:

The lower left corner says you have selected Beamed Eighth Notes and it
gives you the option of creating a Shortcut Key for this symbol. Let’s do that so
that if you want to insert this symbol again all you have to do is tap the shortcut.

6. Click Shortcut key.

7. Click in the box under Press new shortcut key and then tap Alt + n (n for note) or
any other key combination you wish.

8. Click Assign and then click Close (or tap Esc key).
9. Click Insert and then click Close. The symbol is inserted.
10. Inthe Symbol dialog box, click Close.

11. Tap Tab to move the text Be prepared to discuss... to the next tab stop.
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12. Follow the same procedure, or use the new shortcut key, Alt + n, to insert
the Beamed Eighth Notes just to the left of Have ready in...

J - Beprepared-to-discuss-in-great-detail-your-ideas-concerning-the-layout-of‘the-
brochure. It-is-a-nice-piece that-we-can-be proud-of.q

T

# - Havereadyin'report-form-your-analysis-of-the marketability-of‘the -new-product.-
Include-the-target-population-as-well -as-revenue-projections.q|

13. Select the two paragraphs you just worked on and use your mouse to slide
the indent markers on the ruler as follows:

First line indent = to 0.25 inch
Left indent (handing indent) & to 0.5 inch.
Right indent « to 5.5 inches.

Y L e e 2 e e 3 e A 0B e
J4->Be prepared-to-discuss-in-great-detail-your-ideas-concerning the-layout-of*
the'brochure. It'1s‘anice piece-that-we-can-be-proud-of.q

14. For the two paragraphs you just worked on, set a right tab stop with a dot
leader at 5.5 inches by doing the following:

First, select the two paragraphs. Then:
Right-click and select Paragraph.
Click the Tabs... button.

Type 5.5 in the Tab stop position box.
Click Right in the Alignment group.
Click 2.... in the Leader group.

Click the Set button.

Tabs ? X
Tab stop position: Default tab stops:
5.5" 0.5" =

-

5 5
Tab stops to be cleared:

Alignment
O Left O Center @ Right
O pecimal () Bar
Leader
O 1 None @:z... O3
Os__
Set Clear Clear All
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15. Click OK. The new right tab stop appears in the ruler.

A SR SRR SR AR B S SR SRR B SR SRR SRR SUR

J4->Be prepared-to-discuss-in-great-detail your-ideas-concerning the-layout-of-
the-brochure. It‘is-a‘nice-piece-that-we-can-be proud-of.q

16. In the first of the two paragraphs, click to the right of the words proud of,
delete the period, tap the Tab key, and then type IMPORTANT!

SRRV SERNEEES SRR SRR SRR SRR SN SRR SRR B R RRIE- SRR SCREE

Ji->Beprepared to-discuss-in-great-detail -your-ideas-concerning the-layout-of*
the-brochure. It-is-a-nice piece-that-we-can-be proud-of .. .\IMPORTAN T

Dot leader

Depending on how your computer is set up, you might have noticed that
the word Be in the first bulleted paragraph has a blue squiggly underline.
Word does this to alert you that the grammar might incorrect. It is like Word
asking you “Are you sure this is the word you want?” In this case, it is.

i. Use tabs to align the items in the list near the bottom of the document.

1. The items are separated by a comma and a space. Replace the comma
and space by a TAB. You can do that in one of two ways:

e Use your mouse and the TAB key and make the changes one by one.
This is easy but soooo unsophisticated and takes time.

e OR, use Word’s Find and Replace feature as you did in Excel on page
SG140. To use that, select the four lines and tap Ctrl + h to open the
Find and Replace dialog box. Note that you can use wildcards in
Word’s Find and Replace, but that is not necessary here.

Mac: From the menu bar, click Edit, Find, Advanced Find and Replace, Replace.

Type a comma and a space in the Find what box, type the TAB code, "t,
in the Replace with box, and click Replace All. Twelve replacemets will
be made. When asked if you want to continue from the top of the
document, click No.

g e
Style— Colors+Price + Thicknessq
Regular —+ onewcolor - 4 -%0000087
Foldeditwo-color -+ 5.25 - 11.67
Multi-stapled+fourcolor - 13.3 + 8.17
a

—— _Little arrow shows TAB key was tapped.

2. Select the four lines and, on the ruler, insert the following tab stops:

-

Right tab stop at 2 inches Mac 0|

Left tab stop at 2.5 inches '~/ Mac r
Decimal tab stops at 4 and 5 inches. /! Mac i

Bar tab stop at 5.5 inches. |




PRrRoJECT 7 WORD CHAPTER 1: CREATING DOCUMENTS

SG215

3. Click at the left of each line. Tap the TAB key to right align the first word of
each line.
& 'EI"""1"""'3"'L"'3'"""i-"""'i-"'l"'a' ! 7
- -+ Style —+ Colors —+  Price + Thickness
. -+ Regular - one-color -+ 4 - .0000089
- Folded -+ two-color - 525 - 11.69
v - Multi-stapled -+  four-color - 13.3 - 8.1
L

j. Changing the locations of the tab stops is easy. Do the following:

1.
2.
3.

B

Select the four lines you just worked on.
Move the right tab stop to 1 inch (click it and drag to the left).

Move the left tab stop to 2 inches and set a dot leader for this tab
(double-click any tab stop to open the Tabs dialog box).

Change the decimal tab stop at 4 inches to a left tab. To do that, click the
tab stop and drag it down off the ruler. Then, set the tab type to Left and
click at 4 inches. Notice that when you do this the numbers in the column
no longer line up on their decimal points.

5. Drag the bar tab to 3 inches.

ATEREEE R T T S S T - T a
=  Style..........: o JUUU Colors - PriceThicknessq
- Regular........... r= JOUO one-color - 4 - .0000089
-  Folded........... = JOTO two-color - 525 - 11.69
->Multi-stapled........... r= SRR four-color - 133 > 819

6. Select only the line with the titles and change the decimal tab at 5 inches to
a left tab at 4.75 inches. This lines up the title Thickness a bit better.

k. Put in some textboxes to highlight parts of the memo.

1. Insert a textbox (Insert, Text, Text Box, Draw Text Box).
2. Type the text Decimals lined up and make it Arial Black 14 point red.
3. Make the textbox border red 3 pt and Format Decimals-lined-up9]
the Shape Fill to No Fill. Thicknessq
_ . _ _ .000008
4. Adjust the position and size of the textbox so its 11.69
box surrounds the last column of numbers. 8.19
5. Insert an oval and place it around the second column of numbers.
6. Set the oval to have no fill. ]
Price
7. Make the border 3 pt and blue. 4
5.25
8. Adjust the position and size so the oval 13.3

surrounds the second column of numbers.
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9. Insert a Cloud Thought Bubble (Insert, Illustrations, Shapes, Callouts).
10. Type Decimals NOT lined up and make the font Arial Black 14 pt white.
11. Setthe Fill to Texture, Purple mesh.

12. Position the callout as shown below. To move the pointer
part of the callout, click the little yellow box and drag it.

p

I'need toschedulethis-with-the printer-so-thev-can-order-paper.-Myv-understanding is-
that we-will-be-printing -copies-as-follows ¥

1 Decimalsdined-upq
-+ Styvle.......... L SO Colors -+ —+) Thickness?

-+ Regular .. - one-color -+ 0000089

-+ Folded......... e T two-color -+ -] 11.67
-+ Multi-stapled ... - four-color -+ — g1y
L)

o

E_s that correct? . .

Here-is-ourlatest promotional-video. -Check-it-out ¥

Decimals-NOT-

lined-upq

I. When you fill out a form or write a paper for publication you typically are given a
limit on the number of words or characters you may use. Word has a feature to
help you determine this.

1. Be sure nothing is selected and, on the Review tab, in the Proofing group,
click Word Count. You should see that this document has about 161
words (plus or minus a few).

2. Use the Snipping Tool to take a screenshot of the Word Count window
and then close the window.

3. Paste the screenshot into the document.

4. Make the image 2 by 2 inches. You may notice that if you change one
dimension to 2 inches, the other dimension automatically changes. Excel,
Word, and PowerPoint do this to keep the same relative dimensions (called
the aspect ratio) on an inserted picture.

To get around this, first select the Word Count image.

On the Picture Format tab in the Size group, click the launch dialog button
to open the Format Picture pane. On the Size tab, uncheck Lock aspect
ratio so you can change each dimension separately. .

Mac: Remove the check in the box to the right of the height and width values.
I o5 -
de w

]

=1 =
-

-1

q

Then, enter 2 in the Height box and 2 in the Width box. Click OK
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5. Click in a white area to deselect the Word Count image. On the Insert tab,
in the lllustrations group, click the Shapes arrow and, under Basic
Shapes, select the oval || This will display a cross. Drag the cross to
display an oval.

6. With the oval selected, on the Shape Format tab, in the Size group, make
the height and width 2.85 inches so it is a circle.

7. On the Shape Format tab, in the Shape Styles group, click the Shape Fill
arrow and select yellow.

8. Right-click the circle, and select Send to Back.
9. Center the Word Count image in the circle.

10. With the Word Count image selected, hold down the Ctrl key and click the
circle. This selects them both.

11. Right-click and select Group. This makes the two images act as one object
S0 you can move both at the same time.

12. Drag the Word Count/Circle group to the bottom right corner of the page.

m. Insert a video on designing a brochure by doing the following:

1. Move to the end of the last sentence and tap Enter twice.

2. Open your browser, type youtube.com in the address bar, and tap Enter.
3. Type brochure design in word in the YouTube search box and tap Enter.
4.

Decide which video you want.

Mac: Take a screenshot of the video window. Switch to Word and paste the image.
Then, switch back to your browser.

Open the video and copy the URL from the address bar. Here is the one |
chose: https://www.youtube.com/watch?v=nY9ayMpARHg

5. Return to your Word document, move to the line just below the last
sentence, paste the URL, and then tap Enter.

Mac: Skip steps 6 and 7 below. Instead, right-click the screenshot, select
Hyperlink, paste the URL in the box, and click OK.

6. On the Insert tab, in the Media group, click Online Video.
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7. Paste the URL in the box.

Insert a video ? X

Enter the URL or embed code for the online video
https://www.youtube.com/watch?v=nY%yMpARHg

Online video use is subject to the video provider's terms of use and privacy policy.

Learn more about inserting online videos

Insert Cancel

Click Insert.

8. Make the video height 2 inches and position it just below the last sentence
of the document. Right-click and select Open link to play the video.

Mac: Click the screenshot to play the video.

9. Save the Word document and close your browser.

n. Insert a motivational shape by doing the following:

1. Just to the right of Is that correct?, on the Basic Shapes
Insert tab, in the Shapes group, under OANLOTNAOOJ
Basic Shapes, select Smiley Face. GLOOOr L ¢ oy

mECISESIN] S VA ge

2. Drag the cross to open the smiley face. — _
CJ{} C J { smileyFace
3. Make the height and width 0.5 inch.
4. Apply the Preset 10 Shape Effect. ’J -
5. Make the fill color red. Preset 10
6.

Change the Layout Option to In Front of Text and move the shape so it is
centered on the line.

0. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.

Step 4 Submit Now, submit the following. Use these names for the pdf files:

HWO7-1 HWID 1A Flyer Done

HWO07-2 HWID 1B Programs Done Page 1 — Do NOT submit pages 2 or 3
HWO07-3 HWID Agenda Done

HWO07-4 HWID Brochures Done

Create a pdf file of the output for each of the above, place them in a folder
called HWO7 HWID LastName, FirstName, zip the folder and, by the due date,
upload it to the Canvas folder HWO7 Word Chapter 1: Creating Documents.

Step 5 Backup Now would be a good time to backup your files.



Project 8
Word Chapter 2: Creating Letters and Tables

Step 1 Read Read the introductory material on page 169 of the textbook.

Step 2 Activities Turn on the computer and do the following:

Project 2A: Start at the top of page 171.

Instead of Activity 2.01 step 1 do the following:

1.

Navigate to your Word Files folder and open wO2A_Experience, which is
one of the files you downloaded at the start of the term.

Save the file in your Word Files folder using the name
Lastname_Firstname_2A Resume

To save time, instead of typing the text shown in several places in the
textbook you may copy the text from the file HW08-1 Resume Extra Text
Original and paste it in the locations described in the textbook:

Page 173, Activity 2.02, Step 2
Page 173, Activity 2.02, Step 3
Page 176, Activity 2.03, Step 11
Page 179, Activity 2.06, Step 4

The Resume Assistant is mentioned in Step 4 on page 174. That is NOT
installed on many computers so skip to Step 9 on page 175.

Complete the rest of the Activities through step 16 on page 186. Do NOT
do steps 17 and 18 in Activity 2.10 on page 186.

Do NOT do Activity 2.11 on pages 186-187.

Return here when you have completed Project 2A on page 185.

Do NOT do GO! With Google Docs

Project 2B: When you have completed Project 2A, start at the top of page 191.

Instead of Activity 2.12 step 1 do the following:

1.

Open a blank Word document and save it to your Word Files folder using
the name Lastname_Firstname 2B Cover_Letter

Complete the rest of the Activities through step 8 on page 205. Do NOT do
steps 9 and 10 in Activity 2.20 on page 206.

Do NOT do Activities 2.21 through 2.24 on pages 206-211.

— SG219 —
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4. Return here when you have completed Project 2B on page 206.

Do NOT do GO! With Google Docs or GO! To Work

Step 3 Homework After you have completed Projects A and B return here, do
the following additional activities, and turn them in for grading.

HWO08-1 Resume (Based on Project 2A)

Problem: How can you create a professional looking resume?

a. Open the document Lastname_Firstname_2A_ Resume, which you created
while following the directions in the textbook and saved on page 185.

b. Save the document to your Word Files folder using the name
HWO08-1 HWID 2A Resume Done

c. Make the following modifications.

1. Onthe Table Layout tab, in the Table group, if necessary, click View
Gridlines so you can see the non-printing cell gridlines.

2. In the first column, select from OBJECTIVE through HONORS AND
ACTIVITIES.

3. Onthe Home tab, in the Font group, click the Change Case button
and select Capitalize Each Word.

HOME INSERT DESIGM PAGE LAYOUT REFEREMCES AT

cut Calibri (Body) ~|11 ~|A & |Aa~- | %o | := - i= -
Copy ot
- I Sentence case,
" Format Painter D dmes=s o
lowercase
board I Font
UPPERCASE

Capitalize Each Word

The letters are converted from all UPPERCASE so that each individual word
is capitalized. This is really useful if you mistakenly tap the CAPS LOCK key
and type a bunch of stuff that you did not want to be UPPERCASE.

d. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.
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HWO08-2 Cover Letter (Based on Project 2B)

Problem: How can you create a cover letter that will catch the attention of the reader?

a. Open the document Lastname_Firstname_2B_Cover_Letter, which you
created while following the directions in the textbook and saved on page 206.

b. Save the document to your Word Files folder using the name
HWO08-2 HWID 2B Cover Letter Done

c. Modify the table in this document by doing the following:

1.
2.

Select the first row of the table.

Right-click and select Insert, Insert Rows Above.

Inzert

Delete Rows

B Merge Cells

b & Insert Columnsto the Left
= Insert Columns to the Right

[:l Insert Rows Abowve

In the new top row, type Program in the left cell and Duty in the right.

Select the entire table. On the Home tab, in the Paragraph group, click the
arrow next to the border icon and select | O gorders and Shading... |

Click ! Custom

affecting others.

so you can change individual cell borders without

Under Color, select red. Under Width, select 3 pt. In the Preview section,
click on the four borders of the table.

Make the Style dashed, the Color blue, and the Width 1 pt. In the Preview
section, click on the inside horizontal and vertical lines.

Borders

Setting:

Page Border Shading

MNone

Grid

Custom

Style: Preview

A Click on diagram below or use buttons
to apply borders

Apply to:
Table
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8. Click OK.

9. Selectrow 1. On the Home tab, in the Paragraph group, click the arrow
next to the border icon and select Borders and Shading.

10. Click the Shading tab and select gray for the Fill.

d. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.

Setting up a resume is a necessary first step in finding a job while you are in
school, and a must as graduation approaches. This project gave you some
experience creating a resume that should help you get started using your own
information. The next step is to make connections with employers and others who
are working at jobs that might be of interest to you. “Networking” often is important
in landing a job and in being effective once you are hired. One way to do that is
through social networking sites like Twitter, Instagram, Facebook, and
LinkedIn. Here are two links with some good information:

http://jobsearch.about.com/od/networking/a/socialmedia.htm

http://www.cehd.umn.edu/career/networking/social/default.html

HWO08-3 Bill of Rights “°

Problem: How can you reformat text from an email to make it easier to read?

During the debates on the adoption of the U.S. Constitution, its opponents
repeatedly charged that the Constitution as drafted would open the way to tyranny
(cruelty and injustice in exercising authority) by the central government. Fresh in
their minds was the memory of the British violation of civil rights before and during
the American Revolution. They demanded a bill of rights that would spell out the
immunities of individual citizens. Several state conventions in their formal ratification
of the Constitution asked for such amendments; others ratified the Constitution with
the understanding that the amendments would be offered.

On September 25, 1789, the First Congress of the United States therefore proposed
to the state legislatures 12 amendments to the Constitution that met arguments most
frequently advanced against it. The first two proposed amendments, which
concerned the number of constituents for each Representative and the
compensation of Congressmen, were not ratified. However, Articles 3 to 12 were
adopted and ratified by three-fourths of the state legislatures. They constitute the
first 10 amendments of the U.S. Constitution. These amendments are collectively
known as the Bill of Rights.

The amendments are necessarily brief and were designed to be applicable for
centuries to come. It is the duty of the U.S. Supreme Court to interpret those rights in
light of our current society. This is not easy. For example, the second amendment
says “A well-regulated Militia, being necessary to the security of a free State, the
right of the people to keep and bear Arms, shall not be infringed.” In 1789 “Arms”
were knives, swords, and front loading single shot muskets. Today “Arms” include
assault weapons, bazookas, and rocket-propelled grenades. Should every citizen be
allowed to own those, or only front loading muskets, or something in between?

40 Adapted from http://www.archives.gov/exhibits/charters/charters.html
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a. Open the file HWO08-3 Bill of Rights Original, which is one of the files you
downloaded at the start of the term.

b. Save the document in the Word Files folder using the name
HWO08-3 HWID Bill of Rights Done

c. Insert a footer that contains the name of the file.

This copy of the Bill of Rights was received as a forwarded email. Instead of
employing word wrap, the email app inserted paragraph marks at the end of each
line. Your task is to reformat the document by removing the paragraph marks,
restoring word wrap, and formatting the document to make it easier to read and
more interesting to look at. This project will provide instruction and practice on
using the Find and Replace feature of Word.

d. Center the first three lines of the document and change the font to Arial Black.
e. Make the font of the first line 18 point.

f. If necessary, click the Show/Hide button to make the paragraph marks [
visible. Notice that most of the lines in the body of the text are separated by
double paragraph marks. Replace the double paragraph marks with a space by
doing the following:

1. Openthe Find and Replace dialog box by tapping Ctrl + h (or, on the
Home tab, in the Editing group, click Replace).

Mac: From the menu bar, click Edit, Find, Advanced Find and Replace, Replace.

2. If the More button is showing, click it to display the advanced
options of the Replace feature. If the Less button is showing the
advanced options are already displayed.

3. Inthe Find What box, type two paragraph codes: “p”p
To type a circumflex, ~, tap Shift + 6. The paragraph codes may also be

selected from the Special menu | Specialv |

4. Inthe Replace With box, type a space Find Replace  GoTo
(tap the Spacebar). Find what: | ~pp

5. Be sure that none of the boxes are
checked and, unless it is dimmed, click the
No Formatting button to be sure character Replace with: | wea
formatting will be ignored. N\

There is a blank space

6. Click Replace All. There should be here but you cannot see it.

56 replacements.

7. Click OK and then close Find and Replace.




S5G224 PRoOJECT 8 WORD CHAPTER 2: CREATING TABLES AND LETTERS

g. Format the paragraphs by doing the following.

1. Right-click anywhere in the paragraph that begins Amendment | and
choose Paragraph.

2. Type 12 in the Spacing before box. This will put some blank space before
(above) each paragraph and help to visually separate the paragraphs.

3. Under the word Special, select First line from the drop-down menu.
Confirm that 0.5" shows in the By box (if not, type it in). This will indent the
first line of each selected paragraph.

In the Spacing group, you can also specify the line spacing. But there is no
need to do that now unless you want to.

4. Click OK.

h. The document will be easier to read if you make each occurrence of the word
Amendment into a heading. To do this, you can use one of Word’s built in
heading styles.

1. Move the insertion point to the top of the document and then tap Ctrl + h to
open the replace dialog box.

Mac: From the menu bar, click Edit, Find, Advanced Find and Replace, Replace.

2. Inthe Find What box, type Amendment

With the insertion point still in the Find What box, click the Match case box to
ensure that words like amendment (lowercase a) will not match the criteria.

Also click the Find whole words only box to ensure that words like
Amendments (it has an s on the end) will not match the criteria.

3. Inthe Replace With box, type "pAmendment. The "p is equivalent to
tapping the Enter key before each occurrence of Amendment so they will
appear on their own lines.

Find and Replace T, t ? I—J&
Replace GoTo
Find what: Amendment E
Options: Match Case, Whole Words
Replace with: | “pAmendment E

<< Less Replace H Replace All ‘[ Find Mext ]‘ Close ‘

Search Options

Search; |All E

Match prefix

| Find whole words only Match suffix
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4. Click Replace All. There should be 10 replacements. Click OK.

Bill-of-Rights ]
First-Ten-Amendments-of-the-Constitution-of-the-United-States-of-America¥
Ratified-December-15,-17919

1

Amendment-|------Congress-shall-make-no-law-respecting-an-establishment-of-religion, -or-
prohibiting-the free-exercise-thereof; .or-abridging-the-freedom-of-speech, -or-of the-press; --or-the-right-
of-the-people-peaceably-to-assemble, -and-to-petition-the-Government-for-a-redress-of-grievances.- 4|

Amendment-ll----A-well.-regulated-Militia, -being-necessary-to-the-security-of-a-free-State, -the-
right-of the-people-to-keep-and-bear-Arms, -shall-not-be-infringed.- 4|

5. Inthe Find What box, type six spaces (tap the Spacebar 6 times). If
necessary, uncheck the Match case and Find whole words only boxes.

6. Inthe Replace With box, type a single paragraph code: "p
7. Click Replace All. There should be 10 replacements. Click OK.

Bill-of-Rights
First-Ten-Amendments-of-the-Constitution-of-the-United-States-of-America¥
Ratified-December-15,-17919

1

Amendment-l-

Congress-shall-make-no-law-respecting-an-establishment-of-religion, -or-prohibiting the-free-
exercise-thereof,-or-abridging-the-freedom-of-speech, -or-of-the-press; --or-the-right-of the-people-
peaceablyto-assemble, -and-to-petition-the-Government-for-a-redress-of-grievances.--|

Amendment-Il-]

A-well-requlated-Militia, -being -necessary-to-the-security-of-a-free-State, -the right-of the-people-
to-keep-and-bear-Arms, -shall-not-be-infringed. -

i. Use Replace to change all occurrences of two spaces to one space. To do
that, put two spaces in the Find What box, one space in the Replace With box,
and click Replace all. There should be 16 replacements. Click OK.



SG226 PRoOJECT 8 WORD CHAPTER 2: CREATING TABLES AND LETTERS

J- Apply a heading style to each line that contains the word [ Find and Replace

Amendment by doing the following: Reglace
1. Inthe Find What box, type Amendment Findwhat:  |Amendment
Options: Match Case, Whole Words

2. With the insertion point still in the Find What box,
make sure the Match case and Find whole words Replace with:
only boxes are checked.

3. Inthe Replace With box, clear any text or spaces | << Less
so that the box is blank. Be sure the insertion point Search Options
is in that box. Search: |All |z|

4. At the bottom of the Find and Replace window, Bl vatch caso
Find whole words only

click the Format button and then select Style. [ use widcards
This will display a list of the styles available to | S
this document.

[] sounds like (English)
[] Find all word forms (English)

5. Scroll down and click Heading 1.

6. Click OK. Replace
= Format ] [ Special » l
Find and Replace | Font..
Paragraph... —
Find what: Amendment Language...
Options: Match Case, Whole Words Frame..
Format: Style... %
. . . Highlight
Replace with: bNothlng in here
Farmat: Style: Heading l@— Style shown here

7. Click Replace All. There should be 10 replacements. Click OK.
All the amendment headings are changed to the Heading 1 style.

Bill-of-Rights Y]
First-Ten-Amendments-of-the-Constitution-of-the-United-States-of-America"
Ratified-December-15,-17919]

1
"Amendment-I-q]
Congress-shall-make-no-law-respecting-an-establishment-of-religion, -or-prohibiting the -free-

exercise-thereof;-or-abridging -the-freedom-of-speech, -or-of the-prass; -or-the-right-of-the-people-
peaceably to-assemble, -and-to-petition-the-Government-for-a-redress-of-grievances . -

"Amendment-11-9]

A-well-regulated-Militia,-being-necessary-to-the-security-of-a-free-State, -the-right-of-the-people-
to-keep-and-bear-Arms, -shall-not-be-infringed. q
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k. To see how replace works within paragraphs, tell Word to find and modify only
words that exactly match The by doing the following:

1. Tap Ctrl + Home to move to the top of the document.

2. Inthe Find What box, type The Confirm that the Find whole words only
and the Match case boxes are checked. This will ignore words like the,
which is not capitalized, and these and thereof, which have the embedded
within them.

3. Click inside the Replace With box and delete any text. Click No
Formatting to remove the reference to the Heading 1 style.

4. In the lower left corner of the Find and Replace window, click Format and
select Font.

5. Change the font to red Arial Black. Click OK.

Find and Replace

Find Replace Go To
Find what: The
Options: Match Case, Whole Words
Format:
Replace with:

Font: arial Black, Font color: Red

Format:

6. Click Replace All. There should be 3 changes. Click OK and then close
Find and Replace. Under Amendment IV you should see a red The.

7. Save the document but do not close it.

|. Excel sometimes can be used to help edit text for Word documents. To see
how this works, do the following:

1. Navigate to your Word Files folder. Right-click the file name HWO08-3 List
of 1789 Senators Original and select Open with Adobe Acrobat.

" HWO08-3 List of 1789 Senators Original Open with Adobe Acrobat DC

Do NOT double-click the file icon. If you do, it may open in a web browser
and will not be useful to us.

This is a pdf file that contains the names of the US Senators in March 1789
when the Bill of Rights was proposed. | downloaded these names from

http://www.senate.gov/artandhistory/history/common/briefing/senators chronological.htm

This file is in pdf format so it can be easily read on any computer. You
want to insert these names at the end of the Bill of Rights document and in
the form FirstName LastName.


http://www.senate.gov/artandhistory/history/common/briefing/senators_chronological.htm
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As will be explained on textbook page 258 in Activity 3.14, you can open a
pdf file directly from within Word and have Word convert it to a Word
document so you can edit it, but that conversion usually is not perfect. For
this project you need only a small part of the file so use copy and paste.

2. Scroll to page 2 and select the lines with the names of the senators as of
March 4, 1789 (Bassett through Wingate).

FIRST CONGRESS
MARCH 4, 1789, TO MARCH 3, 1791
Start of Initial
Senate Service Name/Party End of Service Rank

E 1789 E

March 4 Bassett, Richard {Anti-Admin/Pro-Admin-DE) March 3, 1793 1
Butler, Pierce (Pro-Admin/Anti-Admin/R-8C) October 25, 1796 2

{Served again 1802)
Carroll, Charles (Pro-Admin-MD) November 30, 1792 3
Dalton, Tristram {(Pro-Admin-MA) March 3, 1791 4
Ellsworth, Oliver (Pro-Admin/F-CT) March 8, 1796 5
Elmer, Jonathan (Pro-Admin-NJT) March 3, 1791 6
Few, William (Anti-Admin-GA) March 3, 1793 7
Grayson, William {Anti-Admin-VA) March 12, 1790 8
Gunn, James (Anti-Admin/F-GA) March 3, 1801 9
Henry, John (Pro-Admin/F-MD) November 28, 1797 10
Izard, Ralph (Pro-Admin-SC) March 3, 1795 11
Johnson, William 8. (Pro-Admin-CT) March 4, 1791 12
Langdon, John (Pro-Admin/Anti-Admin/R-NH) March 3, 1801 13
Lee, Richard Hentry (Anti-Admin-VA) October 8, 1792 14
Maclay, William (Anti-Admin-PA) March 3, 1791 15
Morris, Robert (Pro-Admin-PA) March 3, 1795 16
Paterson, William {Pro-Admin-NJT) November 13, 1790 17
Read, George (Pro-Admin-DE) September 18, 1793 18
Schuyler, Philip John (Pro-Admin-NY) March 3, 1791 19
{Served again 1797)

Strong, Caleb (Pro-Admin/F-MA) June 1, 1796 20
Wingate, Paine {Anti-Admin-NH) March 3, 1793 21

3. Tap Ctrl +c. Fle  Home

4. Open a new blank Excel file. Be sure cell Al is active. = X

On the Home tab, in the Clipboard group, click the

Paste arrow, and click Keep Text Only.

5. AutoFit column A. As you can see, all the
data are in A1:A23.

Note: If this paste did not work correctly, close the file and
then open HWO08-3 List of Senators if pdf does not work

Original and use that one.

(A

Keep T

Paste Options:

ext Only (T)
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6. Do the following so all rows have the same structure:

* Inrow 1, delete March 4 <space>

» Delete the entire row 3, which contains (Served again 1802).
Now, Carroll, Charles is in row 3.

» Delete the entire row 20, which contains (Served again 1797).
Now, all 21 remaining rows have this same pattern:
LastName, FirstName (stuff in parentheses) Date Number

7. In Bl type Richard and tap Enter.

8. Onthe Home tab, in the Editing group, click the Fill arrow and select
Flash Fill. This will enter the first names in column B.

9. In C1 type Bassett and tap Enter.

10. On the Home tab, in the Editing group, click the Fill arrow and select
Flash Fill. This will enter the last names in column C.

A B C
1 Bassett, Richard (Anti-Admin/Pro-Admin-DE) March 3, 1793 1 Richard Bassett
2 |Butler, Pierce (Pro-Admin/Anti-Admin/R-SC) October 25, 1796 2 Pierce |Butler
3 |Carroll, Charles (Pro-Admin-MD) November 30, 1792 3 Charles  Carroll

11. In D1 enter a formula to concatenate FirstName space LastName.*!
12. Fill the formula down to row 21.

13. Copy D1:D21.

14. Switch back to HW08-3 HWID Bill of Rights Done

15. Tap Ctrl + End to go to the end of the document.

16. Tap Enter.

17. Type Names of Senators in March, 1789 and, on the Home tab, in the
Styles group, click the Heading 1 style.

18. Tap Enter.

19. Use Paste Special to paste the names as text only.

20. Select the names and remove the space before each paragraph.

21. Save the document HW08-3 HWID Bill of Rights Done but do not close it.

22. Close Excel without saving, and close Adobe Acrobat.

41 The formula is =B1&" "&C1
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m. If your document will be read online it may be useful to include hyperlinks to
web sites so that the user can go directly there with a single mouse click. The
process in Word is similar to the one you used in Excel.

1. Inthe blank line under Ratified December 15, 1791, type the following all
on one line:

The Constitution may be viewed at
http://www.archives.qgov/exhibits/charters/constitution.html

2. Remove the first line indent, if necessary.

3. Select the web address and tap Ctrl + k. This is the shortcut for Insert
Hyperlink. You can also click Hyperlink on the Insert tab.

Insert Hyperlink

Link to: Text to display: http://www.archives.gov/exhibits/charters/constitution.html
Existianile or Look in: Word Files - Keys
R IR ¢ HWO1-4 HWID ZIPPED Done
& current Folder |15 HWO01-1 HWID Practice Save Done
Place in This =] HW01-2 HWID Google Drive Done
Document @ HWO01-3 HWID Lynda Done
Browsed Pages @@= HWO1-4 HWID Email Done

o + HWO01-4 HWID Pdf Done
Create New

@] HWO07-1 HWID 1A_Flyer_ Done
Document .
Regent Files ﬂ_ HWO7-2 HWID 1B_Programs_Done
5 0| HWO07-3 HWID Agenda Done
E-mail Address Address: http:/fwww.archives.gov/exhibits/charters/constitution.html

The top box shows the text that will be displayed. Leave that as is so if
someone is reading a printed copy, they will be able to see what to type to
get to the web page. The bottom box has the actual web address. That is
where you want to send the user when she clicks the link in the online
document.

4. Click OK. The hyperlink is created and the style for the web address is
automatically set to Hyperlink (underlined blue text). Point to the hyperlink
and a screen tip will appear.

First-Ten-Amendments-of-the-Constitutio hito://www.archives.gov/exhibits/charters/ mericaq|
constitution.htm

Ratified-Decembe Ctrl+Click to follow link

The-Constitution-may-be-viewed-at-http://
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5. Hold down the Ctrl key and click the hyperlink. Your web browser will open
and take you to the web site.

America's Founding Documents

Home > America's Founding Documents

America's Founding
Documents

These three documents, known collectively as the Charters of Freedom,
American people for more than two and a quarter centuries and are con{
and philosophy of the United States.

Main Page

Explore the Documents

Declaration of Independence
Constitution of the United

Sign the Declaration

States Declaration of Independence Constitution
Bill of Rights
i i
Special Features I Y v~ g EX > SO l . 3
\ ( ) U S h 5 £AN A VA g -
High Resolution Downloads X \_,( % .{ " ¢ l\k \:jjx: 1&’0};}\\!( I

6. Right-click the image of the Bill of Rights and select Copy Image.
7. Close the web browser.

8. Paste the image in the second page of the Bill of Rights document. Change
the height to 4 inches and set the Wrap Text to In Front of Text. Move the
image so that it is in the lower right corner of the page.

n. Put some text in the background of the document.

1. Onthe Design tab, in the Page Background group, click the Watermark
arrow and select Custom Watermark.

2. Click the button to the left of Text watermark.
3. In the textbox type We the People
4. Inthe Font box, select Script MT Bold (if that is not available, pick another).
5. Inthe Color box, select dark red and leave Semitransparent checked.
@ Text watermark

Language: | English (United States) v

Text: We the People w

Font: Script MT Bold v

Size: w

Color: ~ Semitransparent

Layout: @ Diagonal O Horizontal

Apply oK Cancel

6. Click OK.

0. Tap Ctrl + p and compare the preview with the key (page 2 only). Make needed
corrections, save the document, and close it. When you are ready to submit the
pdf file, you will print only page 2.
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HWO08-4 Park

Problem: How can you create an eye-catching memo that includes tables?

a. Open the document HWO08-4 Park Original, which is one of the files you
downloaded at the start of the term.

b. Save the document in the Word Files folder using the name
HWO08-4 HWID Park Done

c. Insert a footer that contains the name of the file.

d. To the right of DATE in line 3, enter the Date field code. Use the format Day,
Month Date, Year.

e. Format the five lines that start with Days through Sunday by doing the following.

1. The sections of each line are separated by commas. Change the commas
to tabs. A quick way to do this is to use the Replace feature. To do this,
select the five lines, tap Ctrl + h, type a comma in the Find what box and
the tab code, *t, in the Replace with box. Click Replace All. There are 10
replacements. The little arrows show where the tabs have replaced the
commas. You cannot see some of them because you have not yet set up
the Tab Stops.

Days->OpensClosesy
Monday-Thursday- 1-pm->10-pmq
Friday 1-pm->11-pmfq]
Saturday-and-Holidays -» 11-am11-pmfq
Sunday - Noon->11-pmq

2. Click anywhere in the first line. Set a right tab stop at 4 inches and a left tab
stop at 4.5 inches. Make the tab stops have dot leaders.

3. Set the left and first line indents to 1.5 inches.

Days................ = SO Opens ...z....Closesq

4. Change the format of the next four lines to match this first line. You could
do this as you just did for the first line but, like Excel, Word has a Format
Painter that allows you to copy the format of one line or group of
characters and apply it to others. To see how this works, select the line you
just formatted and, on the Home tab, in the Clipboard group, click the

Format Painter paintbrush.

Now, select the next four lines (Monday through Sunday). The result is
that all five lines now have identical formats.

Days............... = ST Opens ...>....Closesf
Monday-Thursday ......: = S 1-pm..=....10-pmq
Friday ................ t 1-pm...=2...11-pmf

Sunday............... = SOUUTOTRR Noon ...z....11-pmq|
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f. Select the 5 lines starting with the line that has Ave, One Day, Season Pass.
Convert the text to a table (Insert, Tables, Table, Convert Text to Table). If
necessary, change the font to 12 pt Arial.

g. Shade some of the cells by doing the following:

1. Select the three column headings and, on the Home tab, in the Paragraph
group, click the Borders arrow, and select Borders and Shading.

2. Click the Shading tab and set the fill to gray. Confirm that the Apply to box
shows Cell.

3. Click OK.

4. Do the same to shade the cells that have Toddler, Junior, Adult, and Senior.

h. Remove the top and left border of the upper left cell by doing the following:

1. Click in the upper left cell and on the Home tab, in the Paragraph group,
click the Borders arrow, and select Borders and Shading.

2. Inthe Apply to box, select Cell so your changes will only affect the one cell.
3. Under Settings, click Custom Cell.

4. To remove the top border, click the border itself
or the box next to the top border.

5. Use the same process to delete the left cell border.

6. Click OK. If the table gridlines are not showing, on the Table Layout tab, in
the Table group, click View Gridlines to show them. It may appear that
there still is a border on the upper left cell.

Ave
Toddler 3&1

himinAr A #~

The lines are not borders but cell gridlines. They will not print. To hide the
gridlines, on the Table Layout tab, in the Table group, deselect View
Gridlines.

I. Adjust the position and size of the columns by doing the following:
1. Select the whole table by clicking the icon at the upper left of the table s

An alternative way of selecting the entire table is to go to the Table Layout
tab, in the Table group, click the Select arrow, and click Select Table.

With the whole table selected, right-click and select Table Properties.
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2. On the Cell tab, in the Preferred width box, enter 1.2”.

Table Row Column Cgll Alt Text
Size
Preferred width: [1.2" : Measure in: | Inches
Click OK.

3. With the entire table still selected, on the Home tab, in the Paragraph
group, click the Center icon. This will center the table between the page
margins.

4. To center the characters inside the cells, select the cells, but not the whole
table, and click the Center icon.

Admission charges are significantly different, with the price of season passes reduced
by $20 for Adults, and increased by $20 for Juniors. Let's hope the 15% increase in
revenue is realistic!

Ave One Day Season Pass
Toddler 3 & under Free Free
Junior 4 to 11 $19 $89
Adult 12 to 59 $39 $129
Senior 60+ $29 $99

j. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.

HWO08-5 Bank Product Report Table

Problem: How can you convert raw data into a table, sort the data, and format the
table?

a. Open the document HWO08-5 Bank Product Report Original, which is one of
the files you downloaded at the start of the term.

b. Save the document in the Word Files folder using the name
HWO08-5 HWID Bank Product Report Done

c. Insert a footer that contains the name of the file.

d. Select the lines starting at Date and down to the last line of data. Convert the
data to a table (Insert, Table, Convert Text to Table).

e. Format the table so numbers and dates are right aligned and headings are
centered and bold.

f. Like Excel, Word allows you to sort rows of data by Text, Number, and Date.
To see how this works, do the following:

1. Select all the rows below the header row.

2. Onthe Home tab, in the Paragraph group, click the Sort button | 2]
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3. Click the Sort by arrow and select Column 1.

Word will recognize the first cell, 16 Jan, as a date and so it will put Date in
the Type box. If it does not, click the Type arrow and select Date.

Because entire rows are selected, Word will put Paragraphs in the Using box.
Confirm that Ascending is checked.
4. Click OK. The rows of data are sorted by the dates in Column 1.

5. Repeat the process except this time, in the Type box, select Text.

Sort by

Column 1 v| Type: |Text + | (@ Ascending

() Descending

Using: |Paragraphs v

6. Click OK. Now, the values in Column 1 are sorted as if they were text
instead of dates. Thus, cells starting with 1 come first, followed by cells
starting with 2, then 3, then 6, then 8, and finally 9.

g. Do another sort using more than one sort level.

1. Click in any cell of the table. On the Home tab, in the Paragraph group,
click the Sort button. Word automatically selects the entire table, including
the column headings.

Be sure Header row is selected in the My list has area. In the Sort by box,
select Sales Rep. Notice that the Type is automatically changed to Text.

2. Inthe Then by box, select Amount. If the Type is not automatically
changed to Number, make this change.

3. Choose Descending order for the Amount column.

Sort by
Sales Rep V| Type: Text v | (@ Ascending
Using:  Paragraphs 1 O Descending
Then by
Amount ~| Type: | Number v | O ascending
Using: |Paragraphs _| ® Descending

4. Click OK. The data are sorted by Sales Rep, in alphabetical order and, for
each Sales Rep, the data are listed by amount, largest to smallest.

Date Product Amount | Sales Rep Points
5 Feb | Savings 6,300 | Betsey 44
12 Feb | Savings 6,000 | Betsey 42
16 Jan | Certificate 5,000 | Betsey 400
26 Jan | Certificate 150 | Betsey 120
13 Jan | Certificate 5,000 | Carolyn 200
22 Jan | Credit 2,000 | Carolyn 16
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h. If necessary, select the entire table and, on the Table Layout tab, in the Cell
Size group, click the AutoFit arrow, and select AutoFit Contents.

-

Calculate the sum of the Amounts column and the average of the Points
column by doing the following:

1.
2.
3.

Click the lower right cell and tap the Tab key. This inserts a new row.

In the cell at the bottom of the Amount column, type Sum = and a space.

On the Table Layout tab, in the Data group, click the Formula button.
Notice that =SUM(ABOVE) automatically appears in the Formula box. This
means that the sum of the numbers above the cell will be calculated.

Click OK. The sum will be 59,500.

In the cell at the bottom of the Points column, type Ave = and a space.

On the Table Layout tab, in the Data group, click the Formula

button. Notice there is a Paste function arrow. Clicking that will
show you all the functions you may use here. In the Formula
box, delete SUM(ABOVE) but leave the equal sign. Click the
Paste function arrow and select AVERAGE.

Word will show =AVERAGE(). Since you want the average of
the numbers above this formula, type above inside the
parentheses. |Eormula:

=AVERAGE(above)

Formula:

Number format:

Paste function:

ABS
AND

Within these Word formulas, you can use positional arguments to indicate
which numbers you would like summed. These include LEFT, RIGHT,

ABOVE, and BELOW.
Click OK. The average should be 315.17.

If you change any numbers in the column, you will have to update the
formulas manually. It is not automatic as it is in Excel. To see how this
works, in the last cell of the Amounts column, change 300 to 900. Notice
that the sum just below this cell has not changed. Select the cell with the
Sum in it and tap the F9 key. This updates the selected fields. The cell will

now show Sum = 60,100.

6 Jan | Certificate 900 | Pam 240
Sum = 60,100 Ave = 315.17

Format the table borders by doing the following:

1.
2.
3.

Center the title and the table on the page.

Bold the last row (with Sum and Ave).

Put a heavy (3 pt width) red border around the outside of the entire table
and a light (1 pt width) red dashed border on each cell on the inside.
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4. Put ared 3 pt width double line border between the column headings and
the data. To do this, select the row with the column headings, open
Borders and Shading, and fill in the parameters.

Borders Page Border Shading

Setting: Style: Preview

~ Click on diagram below or use buttons
to apply borders

Grid

Custom 3 p.t ——

L
EEEE

Apply to:
Cell

It should look like this:

First National Bank January/February Sales Report
Date Product Amount Sales Rep Points
5 Feb | Savings 6,300 | Betsey 44
12 Feb | Savings 6,000 | Betsey 42
16 Jan | Certificate 5,000 | Betsey 400

5. Remove part of the border on the two cells in the last row, as shown below.
You will have to select the cells whose borders you want modified and then
open Borders and Shading and change the borders individually.

8 Feb | Auto Loan 3,000 | Pam 300
6 Jan | Certificate 900 | Pam 240
Sum = 60,100 Ave = 31517

k. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.

HWO08-6 Infections Memo

Problem: How can you create a memo that includes a table of data and a graph of
those data?

Excel tables and charts can be inserted into Word documents. Follow these
directions to copy a data table and chart from an Excel workbook.

a. Open the document HW08-6 Infections Memo Original, which is one of the
files you downloaded at the start of the term.
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b. Save the document in the Word Files folder as HWO08-6 Infections Memo Done
c. Insert a footer that contains the name of the file.

d. Replace <name> with the field code for UserName (Insert, Text, Quick Parts,
Field, UserName). This will insert the name of the owner of the computer you
are using (this may not be you if you are using a friend’s computer or a
computer in a lab).

e. Replace <creation date> with the field code for the present date. Use the
format that shows the day, month, date, and year. If you want to see the field
codes, tap Alt + F9.

To: Infectious Diseases Foundation
From: { USERNAME \* MERGEFORMAT { USERADDRESS \* MERGEFORMAT }
Date: { CREATEDATE \@ "dddd, MMMM d, yyyy" \* MERGEFORMAT }

Re: Data you requested

Mac: Right-click and select Toggle Field Codes.

To hide the field codes, tap Alt + F9 again.
f. Copy information from Excel and paste it into the memo by doing the following:

1. Open the Excel file HW08-6 Infections Data Original, which is one of the
files you downloaded at the start of the term and is in the Word Files
folder. You cannot open the file while you are in Word. Either start Excel
and then open the file, or open your Word Files folder in Windows Explorer
and double-click the file name.

2. Click the Infections Data tab and select A1:C22.
3. Tap Ctrl + ¢ to copy the data table.

4. Switch to Word and tap Ctrl + End to move the insertion point to the
bottom of the document.

Tap Ctrl + v to paste the data as a table into the memo.

Switch to Excel and click the Infections Chart tab.

Select the Chart Area (Chart Format, Current Selection, Chart Area).
Tap Ctrl + ¢ to copy the chart.

© 0 N o 0

Close Excel.

The shape of the graph is called a logistic curve. It shows how infections
spread in a community or, in the case of a pandemic, the world. At the start, the
virus spreads slowly, and then infections rapidly rise as more and more people
come in contact with those infected. Finally, when almost everyone has
become infected, the rate flattens out. This is called Herd Immunity, meaning
that so many people have become infected and developed antibodies that the
spread to new people becomes negligible.

The blue dots represent the actual number of

infections while the red curve represents the 500 05

predicted spread from this mathematical model: f(x) = W
P
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9. Switch to Word and, on the Home tab, in the Clipboard group, click the

Paste arrow, select Paste Special, and select Picture (JPEG).

Paste Special

Source: Microsoft Excel Chart
Infections Chart

As:

@ Paste: Microsoft Excel Chart Object
_— Bitmap
O EEELE Picture (Enhanced Metafile)
Picture (GIF)
Picture (PNG)
Picture (JPEG

Microsoft Office Graphic Object

Click OK. This inserts the chart as a picture that cannot be altered. If you
had wanted the user to be able to edit the chart, you would have chosen
Microsoft Excel Chart Object. That is NOT what you want.

g. Adjust the chart as follows:

1.

3.

Select the chart. Click the Layout Options button |:a:| and select In Front
of Text.

Change the Width to 5 inches. The height should automatically change to
3.62 inches.

Click the edge of the chart and drag it so that it is just to the right of the table.

h. Insert a video by doing the following:

1.
2.
3.

4.

Just under the table, type What you should know about COVID-19.
Open your browser, type youtube.com in the address bar, and tap Enter.

Type What you should know about COVID-19 in the YouTube search
box and tap Enter.

Decide which video you want.

Mac: Take a screenshot of the video window. Switch to Word and paste the image.
Then, switch back to your browser.

Open the video and copy the URL from the address bar. Here is the one |
chose: https://www.youtube.com/watch?v=677pSwGaudgs

2:42

_whao are renarted as asvmntomatic


https://www.youtube.com/watch?v=677pSwGauqs
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5. Return to your Word document, move to just below the last sentence, paste
the URL, and then tap Enter.

Mac: Skip steps 6 and 7 below. Instead, right-click the screenshot, select
Hyperlink, paste the URL in the box, and click OK.

6. On the Insert tab, in the Media group, click Online Video.
7. Paste the URL in the box and click Insert.

8. Make the height of the video 2 inches.
9

. Close your browser.

i. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.

Step 4 Submit Now, submit the following. Use these names for the pdf files:

HWO08-1 HWID 2A Resume Done

HWO08-2 HWID 2B Cover Letter Done

HWO08-3 HWID Bill of Rights Done Page 2 — Do not submit page 1
HWO08-4 HWID Park Done

HWO08-5 HWID Bank Product Report Done

HWO08-6 Infections Memo Done

Create a pdf file of the output for each of the above, place them in a folder
called HWO08 HWID LastName, FirstName, zip the folder and, by the due date,
upload it to the Canvas folder HW08 Word Chapter 2: Creating Letters and
Tables.

Step 5 Backup Now would be a good time to backup your files.




Project 9
Word Chapter 3: Research Papers, Newsletters,
and Mail Merge

Step 1 Read Read the introductory material on page 235 of the textbook.

Step 2 Activities Turn on the computer and do the following:
Project 3A: Start at the top of page 237.

Do not do Activity 3.01 (all_ steps). Instead, do the following:

1. Navigate to your Word Files folder and open
wO03A_ Quantative_Technology, which is one of the files
you downloaded at the start of the term.

2. Save the file in your Word Files folder using the name
Lastname_Firstname_3A_Quantative_Technology

3. Start on Activity 3.02 on page 238 and complete the Activities through step
8 of Activity 3.11 on page 251. Save your file after completing step 8 of
Activity 3.11. Do NOT do Activity 3.12 or 3.13 or 3.14 on pages 251-258.

4. Return here when you have completed Project 3A on page 251.

|‘ Do NOT do GO! With Google Docs

Project 3B: When you have completed Project 3A, start at the top of page 262.

Instead of Activity 3.15 step 1 do the following:

1. Navigate to your Word Files folder and open wO3B_Environment_Newsletter,
which is one of the files you downloaded at the start of the term.

2. Save the file in your Word Files folder using the name
Lastname_Firstname_3B_Environment_Newsletter

3. Complete the rest of the Activities through step 12 on page 279. Do NOT
do steps 13 and 14 in Activity 3.26 on page 279. Do NOT do Activities
3.27 or 3.28 or 3.29 on pages 280-284.

4. Return here when you have completed Project 3B on page 279.

Do NOT do GO! With Google Docs or GO! To Work

Step 3 Homework After you have completed Projects A and B return here, do
the following additional activities, and turn them in for grading.

— SG241 —
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HWO09-1 Research Paper (Based on Project 3A)

Problem: How can you create a short research paper?

a. Open the document Lastname_Firstname_3A_Quantitative_Technology,
which you created while following the directions in the textbook and saved on
page 251.

b. Save the document to your Word Files folder using the name
HWO09-1 HWID 3A Quantitative Technology Done

c. Tap Ctrl + p and compare the preview with the key (page 4 only). Make needed
corrections, save the document and close it. When you are ready to submit the
pdf file, you will print only page 4.

HWO09-2 Newsletter (Based on Project 3B)

Problem: How can you create a newsletter?

a. Open the document Lastname_Firstname_3B_Environment_Newsletter,
which you created while following the directions in the textbook and saved on
page 279.

b. Save the document to your Word Files folder using the name
HWO09-2 HWID 3B Environment Newsletter Done

c. Tap Ctrl + p and compare the preview with the key. Make needed corrections,
save the document, and close it.

HWO09-3 Home Address Label

Problem: How can you create address labels?

In this project you will create labels that have your campus address. You can put
these on your books, USB drive, etc. to identify them as yours. These are not mail
merge labels because there is no data file involved.

a. Create the labels by doing the following:
1. Start Word and open a blank document.
2. Onthe Mailings tab, in the Create group, click Labels.

3. Click the Labels tab and then Options. Under Label vendors, select
Avery US Letter.
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4. Under Product number, select 5160 Address Labels.

Envelopes Labels

Label Options

Printer information
O Continuous-feed printers
@ Page printers Tray:
Label information

Label vendors: | Avery US Letter

Find updates on Office.com

Product number:

5160 Address Labels

Bypass Tray R

Label information

Type: Address Labels
5161 Address Labels .
Height: 1
5162 Address Labels e_lg . .
5163 Shipping Labels W'dth'_ 2.63
5164 Shipping Labels Page size: 85" = 11"

Under Printer information, Page printers may be checked and Bypass
Tray shown. That assumes you will insert blank label sheets one at a time
in the Bypass Tray. If you want to print several sheets you can select
